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Preface

Thank you for selecting the MONITOUCH V10/V9 series.
For correct setup of the V10/V9 series, you are requested to read through this manual to understand more about the product.
For details on other operating procedures for the V10/V9 series, refer to the following related manuals.

For details on devices including PLCs, inverters, and temperature controllers, refer to the manual for each device.

Manual Name Contents Reference 
No.

V10/V9 Series 
Reference Manual 1

Explains the functions and operation of the V10/V9 series. 1065NE

V10/V9 Series 
Reference Manual 2

1066NE

V10/V9 Series
Setup Manual

Explains the installation procedure of V-SFT version 6, the creation process of 
simple screen programs as well as how to transfer a created screen program using 
V-SFT version 6.

1067NE

V10 Series 
Unit Operation / Local Mode / 
Error Screen Manual

Explains the operating procedures, Local mode screens, and error list for the
V10 series.

1093NE

V9 Series 
Troubleshooting/Maintenance 
Manual

Explains the operating procedures, Local mode screens, and error list for the
V9 series.

1068NE

V10/V9 Series Training Manual  
Beginner’s Guide

Explains the screen creation process for the V9 series using V-SFT version 6 with 
examples.

1069NE

V10/V9 Series Training Manual 
Practical Guide

1070NE

V10/V9/X1 Series 
Macro Reference

Provides an overview of macros of V-SFT version 6 and explains macro editor 
operations and macro command descriptions in detail.

1071NE

V10/V9 Series
Operation Manual

Explains the configuration of V-SFT version 6, the editing process of each part and 
limitations regarding operation in detail.

1072NE

V10/V9 Series
Connection Manual 1

Explains the connection and communication parameters for the V10/V9 series and 
controllers in detail.

2210NE

V10/V9 Series
Connection Manual 2

2211NE

V10/V9 Series
Connection Manual 3

2212NE

V10 Series Hardware Specifications Explains hardware specifications and precautions when handling the V10 series. 2025NE
V9 Series Hardware Specifications Explains hardware specifications and precautions when handling the V9 series. 2023NE

Notes:

1. This manual may not, in whole or in part, be printed or reproduced without the prior written consent of Hakko Electronics 
Co., Ltd.

2. The information in this manual is subject to change without prior notice.
3. Microsoft and Windows are registered trademarks of Microsoft Corporation in the United States and other countries.
4. All other company names or product names are trademarks or registered trademarks of their respective holders.
5. This manual is intended to give accurate information about MONITOUCH hardware. If you have any questions, please 

contact your local distributor.





Notes on Safe Usage of MONITOUCH
In this manual, you will find various notes categorized under the following levels with the signal words “DANGER” and “CAUTION”.

Note that there is a possibility that items listed with  may have serious ramifications.

DANGER Indicates an imminently hazardous situation which, if not avoided, will result in death or serious injury.

CAUTION
Indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate injury and could 
cause property damage.

• Never use the output signal of the V10/V9 series for operations that may threaten human life or damage the system, such as signals 
used in case of emergency. Design the system so that it can cope with a touch switch malfunction. A touch switch malfunction may 
result in machine accidents or damage.

• Turn off the power supply when you set up the unit, connect new cables, or perform maintenance or inspections. Otherwise, 
electrical shock or damage may occur.

• Never touch any terminals while the power is on. Otherwise, electrical shock may occur.
• Always close the terminal covers before turning the power on and operating the unit. Otherwise, electrical shock may occur.
• The liquid crystal in the LCD panel is a hazardous substance. If the LCD panel is damaged, do not ingest the leaked liquid crystal. If 

leaked liquid crystal makes contact with skin or clothing, wash it away with soap and water.
• Never disassemble, recharge, deform by pressure, short-circuit, or reverse the polarity of the lithium battery, nor dispose of the 

lithium battery in fire. Failure to follow these conditions will lead to explosion or ignition.
• Never use a lithium battery that is deformed, leaking, or shows any other signs of abnormality. Failure to follow these conditions will 

lead to explosion or ignition.
• Switches on the screen are operable even when the screen has become dark due to a faulty backlight or when the backlight has 

reached the end of its service life. If the screen is dark and hard to see, do not touch the screen. Otherwise, unintended operations 
may occur resulting in machine accidents or damage.

• Tighten the mounting screws on the fixtures of the V10/V9 series uniformly to the specified torque indicated below. 
Excessive tightening may cause deformation, breakage, or malfunction of the touch switch, which may result in damage to the 
machine or an accident. Insufficient tightening may cause the unit to fall down, short-circuit, or malfunction
- V1015, V1010, V1008, V9 series: 5.31 lbf-in (0.6 N·m)
- V1012: 7.97 lbf-in (0.9 N·m)

• Check the appearance of the unit when it is unpacked. Do not use the unit if any damage or deformation is found. Failure to do so 
may lead to fire, damage, or malfunction.

• For use in a facility or as part of a system related to nuclear energy, aerospace, medical, traffic equipment, or mobile installations, 
please consult your local sales representative.

• Operate (or store) the V10/V9 series under the conditions indicated in this manual and related manuals. Failure to do so could cause 
fire, malfunction, physical damage or deterioration.

• Observe the following environmental restrictions on use and storage of the unit. Otherwise, fire or damage to the unit may result.
- Avoid locations where there is a possibility that water, corrosive gas, flammable gas, solvents, grinding fluids, or cutting oil can 

come into contact with the unit. 
- Avoid high temperatures, high humidity, and outside weather conditions, such as wind, rain, or direct sunlight.
- Avoid locations where excessive dust, salt, and metallic particles are present.
- Avoid installing the unit in a location where vibrations or physical shocks may be transmitted.

• Protective functions may not function properly if a device is not used as specified by the manufacturer.
• Equipment must be correctly mounted so that the main terminal of the V10/V9 series will not be touched inadvertently. Otherwise, 

an accident or electric shock may occur.
• Check periodically that terminal screws on the power supply terminal block and fixtures are firmly tightened. Loosened screws or 

nuts may result in fire or malfunction.
• Tighten the terminal screws on the power supply terminal block of the V10/V9 series uniformly to the specified torque indicated 

below. Improper tightening of screws may result in fire, malfunction, or other serious trouble.
- V10 series: 7.1 lbf-in (0.8 N·m)
- V9 series: 7.1 to 8.8 lbf-in (0.8 to 1.0 N·m)

• The V10/V9 series has a glass screen. Do not drop or give physical shock to the unit. Otherwise, the screen may be damaged.
• Correctly connect cables to the terminals of the V10/V9 series in accordance with the specified voltage and wattage. Overvoltage, 

overwattage, or incorrect cable connection could cause fire, malfunction, or damage to the unit.

CAUTION

DANGER

CAUTION



[General Notes]
• Never bundle control cables or input/output cables with high-voltage and large-current carrying cables such as power supply cables. 

Keep control cables and input/output cables at least 200 mm away from high-voltage and large-current carrying cables. Otherwise, 
malfunction may occur due to noise.

• When using the V10/V9 series in an environment where a source of high-frequency noise is present, it is recommended that the FG 
shielded cable (communication cable) be grounded at each end. However, when communication is unstable, select between 
grounding one or both ends, as permitted by the usage environment.

• Be sure to plug connectors and sockets of the V10/V9 series in the correct orientation. Failure to do so may lead to damage or 
malfunction.

• If a LAN cable is inserted into the MJ1 or MJ2 connector, the device on the other end may be damaged. Check the connector names 
on the unit and insert cables into the correct connectors.

• Do not use thinners for cleaning because it may discolor the V10/V9 series unit surface. Use commercially available alcohol.
• Clean the display area using a soft cloth to avoid scratching the surface.
• If a data receive error occurs when the V10/V9 series unit and a counterpart unit (PLC, temperature controller, etc.) are started at the 

same time, read the manual of the counterpart unit to correctly resolve the error.
• Avoid discharging static electricity on the mounting panel of the V10/V9 series. Discharging static electricity on the mounting panel 

may cause malfunction to occur due to noise.
• The V10/V9 series is identified as a class-A product in industrial environments. In the case of use in a domestic environment, the unit 

is likely to cause electromagnetic interference. Preventive measures should thereby be taken appropriately.
• The signal ground (SG) and frame ground (FG) are connected inside the V9150 series unit. Take care when designing systems.
• The V10/V9 series is equipped with a battery that contains lithium metal and therefore observance of transport regulations is 

necessary. Hakko Electronics ships V10/V9 series units packed in accordance with transport regulations. If there is a need to transport 
a V10/V9 series unit after it is once unpacked, transport the unit in accordance with the IATA Dangerous Goods Regulations, 
International Maritime Dangerous Goods (IMDG) Code, and transport regulations of the countries concerned.
Ask your forwarding agent for details of transport regulations.

• Always ground the V10/V9 series. The FG terminal must be used exclusively for the V10/V9 series with the level of grounding 
resistance less than 100 Ω. Otherwise, you may sustain an electric shock, a fire may occur, MONITOUCH may not recognize touch 
operations, and malfunctions may occur.

• Prevent any conductive particles from entering the V10/V9 series unit. Failure to do so may lead to fire, damage, or malfunction.
• After wiring is finished, remove the paper used as a dust cover before starting operation of the V10/V9 series. Operation with the 

dust cover attached may result in accidents, fire, malfunction, or other trouble.
• Do not attempt to repair, disassemble, or modify the V10/V9 series unit yourself. Contact Hakko Electronics or the designated 

contractor for repairs.
• Do not repair, disassemble, or modify the V10/V9 series unit. Hakko Electronics Co., Ltd. is not responsible for any damages 

resulting from repair, disassembly, or modification of the unit that was performed by an unauthorized person.
• Do not use sharp-pointed tools to press touch switches. Doing so may damage the display unit.
• Only technicians are authorized to set up the unit, connect cables, and perform maintenance and inspection.
• Lithium batteries contain combustible material such as lithium and organic solvents. Mishandling may cause heat, explosion, or 

ignition resulting in fire or injury. Read the related manuals carefully and correctly handle the lithium battery as instructed.
• Take safety precautions during operations such as changing settings when the unit is running, forced output, and starting and 

stopping the unit. Any misoperations may cause unexpected machine movement, resulting in machine accidents or damage.
• In facilities where the failure of the V10/V9 series could lead to accidents that threaten human life or other serious damage, be sure 

that such facilities are equipped with adequate safeguards.
• When disposing of the V10/V9 series unit, it must be treated as industrial waste.
• Before touching the V10/V9 series unit, discharge static electricity from your body by touching grounded metal. Excessive static 

electricity may cause malfunction or trouble.
• Insert an SD card into the unit in the same orientation as pictured on the unit. Failure to do so may damage the SD card or the slot 

on the unit.
• The SD card access LED flashes red when the SD card is being accessed. Never remove the SD card or turn off power to the unit 

while the LED is flashing. Doing so may destroy the data on the SD card. Check that the LED has turned off before removing the SD 
card or turning off the power to the unit.

• Be sure to remove the protective sheet that is attached to the touch panel surface at delivery before use. If used with the protective 
sheet attached, MONITOUCH may not recognize touch operations or malfunctions may occur.

• When using V10 series and an analog resistive-film type V9 series unit, do not touch two positions on the screen at the same time. 
If two or more positions are pressed at the same time, the switch located between the pressed positions may be activated.

• When using a capacitive V9 series unit, take note of the following cautions.
- Use a Class 2 power supply for a 24-VDC unit. If an unstable power supply is used, MONITOUCH may not recognize touch 

operations or malfunctions may occur.
- Capacitive touch panel types support two-point touch operations. If a third point is touched, the touch operation will be 

cancelled.
- Capacitive touch panel types are prone to the influence of conductive material. Do not place conductive material such as metals 

near the touch panel surface and do not use the panel if it is wet. Otherwise, malfunctions may occur.

CAUTION



[Notes on the LCD]
Note that the following conditions may occur under normal circumstances.

• Avoid prolonged display of any fixed pattern. Due to the characteristic of liquid crystal displays, an afterimage may occur.
If prolonged display of a fixed pattern is expected, use the backlight auto OFF function.

• The response time, brightness, and colors of the V10/V9 series unit may be affected by the ambient temperature.
• Tiny spots (dark or luminescent) may appear on the display due to the characteristics of liquid crystal.
• Unevenness in brightness and flickering may occur depending on the screen display pattern due to the characteristics of liquid crystal.
• There are variations in brightness and color between units.
• Display colors may vary depending on the viewing angle because a converging lens is used in the backlight unit.

[Notes on Capacitive V9 Series]
• Touch panel operability may not be optimal if used with dry fingers or skin. In such a case, use a capacitive stylus pen.
• Periodically clean the touch panel surface for optimum touch operations.

When cleaning, take note of the following points.
<When cleaning>

- he panel surface is made of glass. Be sure to clean the surface gently with a cloth or sponge. Otherwise, you may scratch or 
damage the glass.

- Take care not to let cleaning detergent to seep into the touch panel unit.
Do not directly apply or spray cleaning detergent on the panel surface.

[Notes on Wireless LAN]
For details regarding supported wireless LAN standards, radio law certifications, and countries where wireless LAN can be used, refer to 
the “About Wireless LAN on V10 Series” / “About Wireless LAN on V9 Advanced Model” / “About Wireless LAN on V9 Standard Model” 
manual provided with the V10/V9 series unit at delivery.
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1.1 System Settings
1.1.1 System Setting

System settings cover a variety of settings including those initially required for the V10/V9 series unit to communicate with 
the PLC, unit settings, and screen program settings. This section only describes the settings important for initial setup.
For details, refer to the relevant item.

Before transferring a screen program to the V10/V9 series unit, be sure to check the system settings.

Group Item Refer to
Unit Setting Edit Model Selection “Edit Model Selection” page 1-3

Multi-language Setting “Multi-language Setting” page 1-4
Unit Setting SRAM/Clock “SRAM/Clock” page 1-9

Backlight “Backlight” page 1-11
Buzzer “Buzzer” page 1-12
System/Mode Switch “System/Mode Switch” page 1-13
Blink/Flash “Blink/Flash” page 1-13
Overlap “2 Overlap”
Video/RGB
(Snapshot)

Reference Manual 2
1.1 Video/RGB Display
1.3 Network Camera

Sound Reference Manual 2
2 Sound

General Setting “General Settings” page 1-14
Local Mode “Local Mode Prohibition Setting” page 

1-30
GD-80E/V609E Compatibility Setting “GD-80E/V609E Compatibility Setting” 

page 1-31
Communication Setting Hardware Setting “Hardware Setting” page 1-32

Device Memory Map Reference Manual 2
11 Device Memory Map

Ethernet Communication Local Port IP Address Reference Manual 2
6 Ethernet Communication FunctionNetwork Table

E-Mail
FTP Server
VNC Server

Common Setting Global Setting Global Function Switch Setting “Global Function Switch Setting” page 
1-36

Global Overlap Setting “2.5 Global Overlap”
Alarm Server “8.2 Alarm Server”
Logging Server “7.2.1 Logging Server”
Recipe Recipe “15 Recipes”

Recipe List
Scheduler Reference Manual 2

3 Scheduler 
Data transfer service Data Transfer Service Settings

Data Transfer Viewer Settings Reference Manual 2
6.11 Data Transfer Service

Other Storage Setting Reference Manual 2
8 Storage Device

MES Setting 6.7 MES Interface Function
Operation log Setting 4 Operation Log
Security Setting 5 Security
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Common Setting Other Remote Desktop Table Setting 6.12 Remote Desktop
Network Camera Table Setting 1.2 Network Camera
Time Display Format Setting “Time display format setting” page 

10-12
Flowing Message “8.2 Alarm Server”
PDF Viewer Setting Reference Manual 2

13 PDF Viewer
Video Player settings Reference Manual 2

15 Video Player
Picture Viewer Setting Reference Manual 2

16 Picture Viewer
Setting Macro Setting Macro Reference Manual

Date and Time Display Setting “8.3 Date and Time Display Setting”
Japanese Conversion Function Setting -

Group Item Refer to
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1.1.2 Unit Setting
This section explains the items in the [Unit Setting] group.

Edit Model Selection
Select the model of the V10/V9 series for which you wish to configure a screen program.
Location of setting: [System Setting] → [Edit Model Selection] or [System Setting] → [Hardware Setting] → [Edit Model]

For information on other settings, refer to “1.1.1 System Setting” page 1-1.

V10/V9 Series 
Model

V-SFT [Edit Model Selection]
Series Edit Model Installation Size Color

V1015iS V10 V1015iS Landscape
Portrait (Left 90°)
Portrait (Right 90°)

1024 × 768 64K-Color w/o blinking
32K-Color w/ blinkingV1012iS V1012iS 800 × 600

V1010iS V1010iS 800 × 600
V1008iS V1008iS 800 × 600
V9150iX V9 V915*iX 1024 × 768
V9120iS V912*iS 800 × 600
V910xiW V910*iW 1024 × 600
V9100iS V910*iS 800 × 600
V9080iS V908*iS 800 × 600
V9100iC V910*iC 640 × 480
V9080iC V908*iC 640 × 480
V907xiW V907*iW 800 × 480
V9060iT V906*iT 640 × 480
Computer (PC) TELLUS TELLUS Ver. 4 1920 × 1080

1280 × 1024
1024 × 768
800 × 600
640 × 480
320 × 240

The screen program cannot be converted to earlier versions.
 e.g.  V10→V9, V9→V8 etc.
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Multi-language Setting
Select the language for display on the V10/V9 series unit.
Location of settings: [System Setting] → [Multi-language Setting]

For details, refer to “9 Language Changeover” in the Reference Manual 2.

Item Description
Interface Language Set the number of interface languages. 1 to 32

Example: Specifying “5” means Languages 1 to 5 can be set.
Font Type Select a font type from [TrueType font], [Bitmap font], or [Gothic font].
Setting Set the languages and comments *1 to use.
Initial Interface Language Select the language to be displayed when the power is turned on.   1 to 32

The interface language is as follows after transfer.

Set the system language 
according to settings in the 
[Multi-language Edit Setting] 
window
(setting available for two or 
more interface languages)

Select this checkbox when setting the interface languages of the following screens. (This setting is 
convenient when all the same fonts are selected using [Setting...].)
The supported languages are Japanese, English/Western Europe, Chinese (Simplified), Chinese (Traditional), 
and Korean.

Local mode screen, error message screen, ladder monitor, PDF viewer, operation log viewer, data transfer 
viewer, storage viewer, video player, picture viewer

The following settings are required.
• Set each language at [Home] → [Registration Item] → [Multi-language] → [Multi-language Edit] → 

[Multi-language Edit Setting].
• Select the checkboxes of the interface languages at [System Setting] → [Multi-language Setting] → 

[Transfer Font Setting].

Operation Interface Language
At power ON The language displayed when the power was 

turned OFF is displayed.
Switching from RUN mode to Local mode The language used in RUN mode is displayed.
Switching from Local mode to RUN mode The language used in Local mode is displayed. *2

In Local mode during screen program transfer The language specified for [Initial Interface 
Language] in the screen program is displayed.In RUN mode during screen program transfer
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*1 Comments are displayed on the [Language Display] menu, multi-language edit sheets, etc.
This is useful when editing multiple languages with the same font.

*2 Exceptions
• Example 1: When the same font is registered multiple times, the language displayed before switching to Local mode is displayed.

[Interface Language]: 2, [Transfer Font Setting]: Japanese Gothic TTF, [Initial Interface Language]: 1
- Language 1: Japanese Gothic TTF
- Language 2: Japanese Gothic TTF

• Example 2: In the following case, the lowest language number in the font settings is displayed.

[Interface Language]: 3, [Transfer Font Setting]: Japanese Gothic TTF, English/Western Europe Gothic TTF, Central Europe TTF, [Initial 
Interface Language]: 1
- Language 1: Japanese Gothic TTF
- Language 2: English/Western Europe Gothic TTF
- Language 3: Central Europe TTF

Operation example:

Font Setting Language Display

Multi-language edit sheet

Display Language

RUN (Japanese Gothic TTF)
↓

Local mode (switch from Japanese to English)
↓

RUN (Language 2 is displayed)
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Font Types
Fonts are roughly divided into four types.
Because the mixed use of fonts is not permitted, select one font type in the [System Setting] → [Multi-language Setting] → 
[Font Setting] window.
However, note that TrueType fonts are always used on the Local mode screen regardless of this setting.

Type
Size 

Specification
Method

Features Image

TrueType font Point 
specification

Supports smoothing.

Used on the Local mode 
screen.

Gothic font Supports smoothing.

There are automatic/manual setting restrictions depending on the 
function.

Stroke font

Bitmap font XY 
magnification 
factor 
specification

Designed in sizes of 16 × 16 
dots and 32 × 32 dots 
(two-byte characters).
Smoothing not supported.

Windows fonts
No font data is stored on MONITOUCH but the fonts used on Windows, such as “Times New Roman” 
or “Arial”, are used as image data. Settings can be configured for each item.
For details, refer to the Operation Manual.
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Supported Language List
The following table lists the fonts and corresponding languages supported by the V10/V9 series.

Font Setting *1 Supported Language Supported Character Code Remarks
TrueType font Japanese Gothic TTF Japanese, English JIS level 1 to level 4 + ANK 

code
Code 8794 
cannot be 
displayedJapanese Times TTF

English/Western Europe 
Gothic TTF

English, Icelandic, Irish, Italian, Dutch, 
Spanish, Danish, German, Norwegian, 
Portuguese, Finnish, Faroese, French, 
Swedish

ISO-8859-1: Latin1
(Extended ASCII code)

English/Western Europe 
Times TTF
Chinese (Traditional) TTF Chinese (traditional), English BIG5 code (A141 to F9FE) + 

ASCII code
Codes A344 to 
A373 cannot be 
displayed

Chinese (Simplified) TTF Chinese (simplified), English GB2312 code (A1A1 to F7FE) + 
ASCII code

Codes A021 - 
A07E
A6A1 - A6B8
A6C1 - A6D8
A7A1 - A7C0
A7D1 - A7F1
A8BB, A8BD, 
A8BE, A8C0
cannot be 
displayed

Korean TTF Hangul, English KS code (A1A1 to FDFE) + ASCII 
code

Codes A2E6 
and A2E7 
cannot be 
displayed

Central Europe TTF Croatian, Czech, Hungarian, Polish, 
Romanian, Slovakian, Slovene, Hrvatska 
(Croatian)

CP1250 code

Cyrillic TTF Russian, Ukrainian, Bulgarian, Kazakh, 
Uzbek, Azerbaijani

CP1251 code

Greek TTF Greek CP1253 code
Turkish TTF Turkish CP1254 code
Baltic TTF Estonian, Latvian, Lithuanian CP1257 code

Bitmap font Japanese Japanese, English JIS level 1, level 2 + ANK code
Japanese 32 Japanese, English JIS level 1 + ANK code
English/Western Europe English, Icelandic, Irish, Italian, Dutch, 

Spanish, Danish, German, Norwegian, 
Portuguese, Finnish, Faroese, French, 
Swedish

ISO-8859-1: Latin1
(Extended ASCII code)

Chinese (Traditional) Chinese (traditional), English BIG5 code (A141 to C67E) + 
ASCII code

Chinese (Simplified) Chinese (simplified), English GB2312 code (A1A1 to FEFE) + 
ASCII code

Korean Hangul, English KS code (A1A2 to C8FE) + 
ASCII code

Central Europe Croatian, Czech, Hungarian, Polish, 
Romanian, Slovakian, Slovene, Hrvatska 
(Croatian)

CP1250 code
ISO code *2
(ISO-8859-2: Latin2)

Cyrillic Russian, Ukrainian, Bulgarian, Kazakh, 
Uzbek, Azerbaijani

CP1251 code
ISO code *2
(ISO-8859-5: Latin5)

Greek Greek CP1253 code
ISO code *2
(ISO-8859-7: Latin7)

Turkish Turkish CP1254 code
ISO code *2
(ISO-8859-9: Latin9)

Baltic Estonian, Latvian, Lithuanian CP1257 code
Gothic font Gothic Japanese, English JIS level 1 + level 2 + ANK code

Gothic (IBM Extended 
Character)

Japanese, English JIS level 1 + level 2 + IBM 
extended code (FA40 to FC4B) 
+ ANK code

English/Western Europe HK 
Gothic

English, Icelandic, Irish, Italian, Dutch, 
Swedish, Spanish, Danish, German, 
Norwegian, Portuguese, Finnish, Faeroese, 
French

ISO-8859-1: Latin1
(Extended ASCII code)

English/Western Europe HK 
Times



1  System

1-8

*1 Different fonts cannot be used together.
*2 Select the [ISO Code] checkbox when selecting the corresponding fonts in the [System Setting] → [Multi-language Setting] → [Font 

Setting] window.

Stroke font Japanese stroke Japanese, English JIS X 0201
JIS X 0208
NEC special characters
IBM extensions
NEC selection of IBM 
extensions

English/Western Europe 
stroke

English, Icelandic, Irish, Italian, Dutch, 
Swedish, Spanish, Danish, German, 
Norwegian, Portuguese, Finnish, Faeroese, 
French

CP1252 code

Chinese (Traditional) stroke Chinese (Traditional), English BIG5 code (A141 to F9FE) + 
ASCII code

Chinese (Simplified) stroke Chinese (Simplified), English GB2312 code (A1A1 to F7FE) + 
ASCII code

Korean stroke Hangul, English KS code (A1A1 to FDFE) + ASCII 
code

Central Europe stroke Croatian, Czech, Hungarian, Polish, 
Romanian,
Slovakian, Slovene,
Hrvatska (Croatian)

CP1250 code

Cyrillic stroke Russian, Ukrainian, Bulgarian, Kazakh, 
Uzbek, Azerbaijani

CP1251 code

Greek stroke Greek CP1253 code
Turkish stroke Turkish CP1254 code
Baltic stroke Estonian, Latvian, Lithuanian CP1257 code

Font Setting *1 Supported Language Supported Character Code Remarks
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Unit Setting
The settings to be configured on the V10/V9 series unit are described below. Select the functions to use and configure the 
required settings.
Location of settings: [System Setting] → [Unit Setting]

SRAM/Clock
Configure the following settings when using SRAM or the built-in clock of the V10/V9 series unit.
Location of settings: [System Setting] → [Unit Setting] → [SRAM/Clock]

Item Description Refer to
Use SRAM Calendar Set the reading target of the clock.

Selected
Use the built-in clock of the V10/V9 series unit.

Unselected
Use the clock in the PLC.

“10 Calendar”

SRAM Auto Format Set the SRAM format method.

Selected
Perform auto-formatting.

Unselected
Perform formatting on the SRAM Setting screen in Local mode.

“Formatting SRAM” page 
1-10

Storage Area for Memo Pad Allocates an area that stores the memo pad data. “13.1 Memo Pad”
Non-volatile Device
(Word) ($L)

Allocates areas used by the addresses $L (word area) and $LD (double word 
area) in user device memory.
The available range is determined by the specified device memory address.

Example: When the set number of words for $L is 10, $L0 to $L9 can be used.

“Non-volatile $L (word) 
and non-volatile $LD 
(double-word)” page 1-10

“Formatting SRAM” page 
1-10

Non-volatile Device
(Double-word) ($LD)

Japanese Conversion 
Function

When the Japanese conversion function is used, 18,728 words are allocated. -

Storage of Logging server When the logging server is used, the required number of words is allocated. “7.2.1 Logging Server”
Storage of Alarm Server When the alarm server is used, the required number of words is allocated. “8.2.1 Alarm Server”
Operation log storage point When operation logs are used, the required number of words is allocated. Reference Manual 2

4 Operation Log
No. of Total Words
No. of Words Free

Indicates the number of used and free words with the current settings.
Set the items within the number of words available. -

The contents of the 
SRAM area is retained by 
battery after power to 
the unit is turned off.
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Non-volatile $L (word) and non-volatile $LD (double-word)
• Difference

The difference between “Word” and “Double-word” is whether only the specified address (word) is guaranteed or two 
words (double-word) from the address are guaranteed when a power failure occurs.

• Data protection when a power failure occurs
When a power failure occurs while writing data to $L or $LD, the data value just before writing is guaranteed. (In case of 
$L, the top word of data just before writing is guaranteed; in case of $LD, the top two words of data just before writing is 
guaranteed.)
However, note that when performing processing where two or more words for $L and three or more words for $LD are 
written simultaneously, the data is not guaranteed.

Example: Character display, “BMOV” macro command, [Screen Setting] → [Screen Setting] → [PLC Device Transfer] etc.

*1 Use $LD to access two word data. To verify whether writing was successful or not, check system device memory 
addresses $s721 to $s726.

Formatting SRAM
When settings are configured in the [SRAM/Clock Setting] window, always format SRAM in Local mode on the V10/V9 series 
unit before use.
If SRAM is not formatted, the message “Screen Data Error : 161 (or 163)” will appear and the screen program will not run.

• SRAM auto format
For example, if the data storage destination or number of words for storage of history data changes in accordance with 
the logging and alarm functions, the sizes displayed in the [SRAM/Clock Setting] window may also change. In such a case, 
SRAM needs formatting every time the size changes.
This formatting can be performed automatically. When the [SRAM Auto Format] checkbox is selected, SRAM will 
automatically be formatted each time a screen program is transferred. For details, refer to the following table.

When the [SRAM Auto Format] checkbox is selected

Device Memory Description Device Type

$s721
Writing result of $L address where data was written last

0: Normal
1: Error

← V
(writing from 
V10/V9 to $s)

$s722 $L address where data was written last if $s721 indicates [1: Error] at power-up
$s723

$s724
Writing result of $LD address where data was written last

0: Normal
1: Error

$s725 $LD address where data was written last if $s724 indicates [1: Error] at power-up
$s726

SRAM Area Condition Auto Format
Storage Area for Memo Pad Size increases No

Size decreases Yes
Non-volatile Device
(Word) ($L)
Non-volatile Device
(Double-word) ($LD)

Size increases Only the increased device memory area is formatted 
while the existing area is not formatted.

Size decreases Only the decreased device memory area is deleted 
while the existing area is not formatted.

Japanese Conversion 
Function

- No

Logging server Changes to server settings, such as number 
of saves

Yes (all history data is cleared)

Alarm Server Changes to server settings, such as number 
of saves

Yes (all history data is cleared)

Operation log Changes to settings, such as number of 
saves

Yes
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Backlight
Configure how the backlight is controlled by the V10/V9 series unit.

Item Description
Action Always ON The backlight is always on.

Auto 1 Backlight OFF conditions:
The backlight is turned off when the time specified by [Backlight OFF Time] has elapsed from 
the instant when all the following conditions are met. *1

• Control device memory: OFF
• Screen display (lamp, data display, calendar, etc.): No change
• Touch switch: OFF

Backlight ON conditions:
The backlight is turned on when any of the following conditions is met. *2

• Control device memory: ON (always ON)
• Screen display: Changed
• Somewhere on the screen is touched.
• Normal/call-overlap: ON/OFF_
• Multi-/global overlap: ON/OFF, overlap number changed

Auto 2 Backlight OFF conditions:
The backlight is turned off when the time specified by [Backlight OFF Time] has elapsed from 
the instant when all the following conditions are met. *1

• Control device memory: OFF
• Touch switch: OFF

Backlight ON conditions:
The backlight is turned on when any of the following conditions is met. *2

• Control device memory: ON (always ON)
• Somewhere on the screen is touched.

Auto 3 Backlight OFF conditions:
The backlight is turned off when the time specified by [Backlight OFF Time] has elapsed from 
the instant when all the following conditions are met. *1

• Control device memory: OFF
• Touch switch: OFF

Backlight ON conditions:
The backlight is turned on when any of the following conditions is met. *2

• Control device memory: ON (always ON)
• Screen changeover
• Somewhere on the screen is touched.
• Normal/call-overlap: ON/OFF
• Multi-/global overlap: ON/OFF, overlap number changed

Manual Backlight OFF conditions:
The backlight is turned off when either of the following operations is performed.

• Press [SYSTEM] → [F5] on MONITOUCH. *3
• Control device memory: OFF (bit changes from 1 to 0)

Backlight ON conditions:
The backlight is turned on when any of the following conditions is met. *2

• Somewhere on the screen is touched.
• A function switch is pressed. *3
• Control device memory: ON (bit changes from 0 to 1)

Control Device This setting is available when an option other than [Always ON] is set. This device memory 
controls the backlight.

0: Backlight turned off when conditions are met
1: Backlight turned on

Info. Output Device Stores the ON/OFF state of the backlight.
0: Backlight turned off
1: Backlight turned on

*  This bit is 1 when the backlight is turned on even if the control device memory is OFF.
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*1 When the entire screen display is refreshed, such as when changing over the entire screen or turning on/off or switching an overlap 
display, the time measured for [Backlight OFF Time] is cleared.

*2 No switch data is output if a switch is pressed with the backlight off. When a switch is pressed with the backlight off, the backlight is 
turned on. Switch data is output from switch operations made after 500 ms has elapsed since the backlight was turned on.

*3 Disabled when the control device memory is ON.

Buzzer

*1 If the [Detail] → [A buzzer sounds individually] checkbox is selected in the switch settings window, the setting made on the switch 
settings window takes priority.
For details on switch settings, refer to “3.1.3 Detailed Settings” page 3-6.

Backlight OFF Time 0~65535 (sec)
This setting is only available when [Auto 1], [Auto 2] or [Auto 3] is selected for [Action].
Set the length of time that elapses before the backlight is turned off after the OFF conditions 
have been met.

Control during Backlight Power ON This setting is only available when [Manual] is selected for [Action].
Select the backlight ON/OFF status for when the power is turned on and when the mode 
changes from STOP to RUN.

Item Description
Action Set the buzzer sound that is output when a switch is pressed. *1

• Standard: 100 msec
• Short: 10 msec
• Continuous: Continuous
• OFF: No buzzer sounding

Control Device Sound the buzzer using an external command.

* The [Use Continuous Buzzer Sound] checkbox must be selected at [Unit Setting] → [General Settings]. 
For details, refer to page 1-14.

Info. Output Device This device memory stores the state of the control device memory.

Item Description

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

Single shot buzzer
0 → 1: Execute

Not used (always set to “0”)

Error buzzer
0 → 1: Execute

Continuous buzzer *
1: Execute

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

Single shot buzzer

Not used (always set to “0”)

Error buzzer

Continuous buzzer



1.1    System Settings

1-13

1

2

3

4

5

6

7

8

9

10

System/Mode Switch
These settings relate to the operation of the [SYSTEM] switch and [MODE] (F1) switch in RUN mode.

Switching from RUN mode to Local mode
The procedure varies depending on the setting for [System Switch Prohibited] and [Mode Switch Prohibited].

Mode Change Delay Time: t (0 to 30 seconds)

Blink/Flash
The blink/flash time for the blink color can be set.

Item Description
System Switch Prohibited Prohibit the display of the system menu. The system menu is not displayed even if the [SYSTEM] switch is 

pressed. The status bar is not displayed either.
For details on switching to Local mode, refer to the following section.

Mode Switch Prohibited Prohibit the display of the [Local] switch on the system menu (for switching to Local mode).
Other switches on the system menu remain available.
For details on switching to Local mode, refer to the following section.

Mode Change Delay Time 0 - 30 (sec)
Set the mode change delay time for switching from RUN mode to Local mode.

* The same delay time is applied when disabling [System Switch Prohibited] and [Mode Switch 
Prohibited].

Status Bar Prohibited Prohibit the display of the status bar at the bottom right of the screen.

Settings Method
Not prohibited Press [SYSTEM] to display the system menu and hold down the [Local] switch for “t” seconds.

System Switch Prohibited Hold down [SYSTEM] and [F7] ([F5] for V9060) together for “t” seconds.

Mode Switch Prohibited Press [SYSTEM] to display the system menu and hold down [F1] and [F7] ([F5] for V9060) together for “t” 
seconds.

Item Description
OFF Time
(× 100 msec)

0: Blinking at about 500 msec intervals
1 to 100: Blinking at about × 100 msec intervals

ON Time
(× 100 msec)
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Overlap
Select the unit for overlap coordinates.

Video/RGB (Snapshot)
Configure these settings when using the video/RGB display function and network camera.

Sound
Configure these settings when selecting a WAV file by designating a device memory address in the sound function.

General Settings
These options are classified into two groups: settings compatible with older models, and other additional settings.
Settings compatible with older models are set automatically when converting screen programs to the V10/V9 series.

For details, refer to “2 Overlap”.

For details, refer to “1.1 Video/RGB Display”, “1.2 USB Camera Display”, and “1.4 Network Camera” in 
Chapter 1 of the Reference Manual 2.

For details, refer to “2 Sound” in the Reference Manual 2.

Item Description
Use Continuous Buzzer 
Sound

Used to set whether or not to use a continuous buzzer.

• Unselected
Do not use a continuous buzzer.

• Selected
The buzzer sounds continuously while the control device memory of the buzzer is ON. For details, refer 
to page 1-12.

Display Overlap during bit 
ON

Used to set the operation of normal/call-overlaps (when using control device memory).

• Unselected
Recognized at the edge. Even if the bit is ON when a screen is opened, the overlap is not displayed.

• Selected
Recognized at the level. The overlap is displayed while the bit is ON.

Clear the text when inputting 
the first character in the 
character input mode

Used to set the operation performed when a character key is first pressed in the character input mode.

• Unselected
Existing text remains in the entry display part.

• Selected
Existing text in the entry display part is automatically cleared.

Read Data from Barcode in 
Words

Used to set the unit of counting read data to be output to the I/F device memory for barcode setting.

• Unselected
Unit: bytes

• Selected
Unit: words (same as GD-80)
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Mode Operation: Make 
messages the same as GD-80 
if [Action Area] is 
[Switch/Lamp].

This is valid when [Action Area: Switch/Lamp] is selected for bit order alarming, page mode or direct mode.
Used to set the message display format on a switch or lamp part.

• Unselected
Messages are wrapped if they cannot be display on one line.

• Selected
If a message cannot be display on one line, the part of the message 
protruding from the area is not shown.

Num. Display: Displays the 
significant figures upon 
overflow

Used to set the display on MONITOUCH when an overflow occurs on a numerical display part.

Example: When D100 = 1234
• Unselected

4-digit display: “1234”  2-digit display “--”

• Selected
4-digit display: “1234”  2-digit display “34”

Num. Display: Displays the 
special characters A to F in 
BCD

Used to set the display on MONITOUCH when BCD is selected for a numerical display part.

When operating the +/−block 
switch, skip keypad blocks 
that do not exist

Used to set the operation performed if there is an unregistered block between the block numbers [Min. 
Block] and [Max. Block] for the target of switching the keypad block.

• Unselected
Switching is stopped when an unregistered block is encountered.

• Selected
Switching is performed while skipping unregistered blocks.

Item Description

ABCDEFGHIJKLMNO

ABCDEFGHIJKLMNOP
QRSTU

PLC
Display on MONITOUCH

Unselected Selected
0~9 0~9 0~9

A 0 .
B 0 :
C 0 −

D 0 +
E,F 0 (Space)

No. 0 No. 4No. 1 No. 2 No. 3

Not registered

Switching not possibleSwitching possible

No. 0 No. 4No. 1 No. 3
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Regard the origin of graphic 
relay on an overlap as the 
origin of a screen

Used to set the reference position when the graphic relay function is set for an overlap.

• Unselected
Graphics are placed with respect to the origin of the overlap display part.

• Selected
Graphics are placed with respect to the origin of the screen.

If a switch/lamp OFF color is 
the same as the base, do not 
make it solid filled

Used to set the OFF color display when the screen background color is the same as the OFF color of a switch 
or lamp.

• Unselected
The switch or lamp part placed on top covers the part that is underneath it on both the editor and 
MONITOUCH.

• Selected
The part on top covers the part underneath it on the editor. On MONITOUCH, the OFF color becomes 
transparent.

Make the action of bit items 
the same as GD-80

Select this checkbox when the Hitachi HIDIC-S10 is connected and a screen program created for the GD-80 
or V4 series converted for use on a V10/V9 series unit.
If this checkbox is not selected, compatibility cannot be retained because bit weights are inverted from the 
GD-80 and V4 processing when they are converted for use on a V10/V9 series unit.

Make the offset processing 
for graphic call the same as 
GD-80

If two or three conditions shown below are present, the graphic display position at bit ON is different from 
that on the GD-80. To make it the same as the GD-80, select this checkbox.

• Graphic relay used
• Graphic call used
• Graphic call with offset and parameter settings

Use Vertical Text If you want to place Japanese characters, select this checkbox.
Use Internal Flash ROM as 
Back-up Area

Select this checkbox to use part of the FROM area on MONITOUCH as a device memory backup area (PLC 
and internal). This function cannot be used with the station number table.

Station number table
Station numbers of target devices can be set as desired for PLC communication or temperature control 
network communication using the following devices.

• PLC: Mitsubishi QnA series (Ethernet), 1:n connection only
• PLC: Mitsubishi QnH (Q) series (Ethernet), 1:n connection only
• PLC: OMRON SYSMAC CS1/CJ1/CJ2/CP series (Ethernet Auto), 

1:n connection only
• PLC: OMRON SYSMAC CS1/CJ1/CJ2/CP series DNA (Ethernet Auto), 

1:n connection only
• Temperature controller: Fuji Electric F-MPC04P (loader)
• Temperature controller: Fuji Electric F-MPC04S (UM03)

Print Alarm Logging Data (V8 
compatible) in the Displayed 
Format

Used to make print settings for alarm logging.

• Unselected
Both bit ON data and bit OFF data are printed.

• Selected
Data is printed in the currently displayed format (if bit ON data is shown, only bit ON data is printed).

Item Description

Graphics library Reference point Overlap

Screen

Graphics library
Reference point

Overlap

Screen

Lamp (on top)

Switch (on bottom)
On the V9 
series unit

Lamp covers the switch

Lamp (on top)

Switch (on bottom)
On the V9 
series unit

Lamp is invisible when OFF
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Validate the Character Order 
Setting for Text in JIS Codes

Used to set the display of JIS codes for character display parts.

• Unselected
Displayed in MSB → LSB format regardless of the setting for [Text Process] ([Char. Display] → [Text 
Process]).

• Selected
The setting for [Text Process] ([Char. Display] → [Text Process]) takes effect.

Use 3-D Parts If a screen program that uses 3D parts for a 128-color monitor has been converted into data for a 64k-color 
or 32k-color monitor, this checkbox is selected automatically. Use the setting as is.

Hide the launcher Screen Used to set the display on the monitor for the interval from when MONITOUCH is turned ON to when RUN 
mode starts.

• Unselected
“Data Loading...” → splash screen → RUN mode

• Selected
Black screen → splash screen → RUN mode

Convert NULL to Space with 
the LD/RD Macro

Used to set how NULL data processing is performed when reading a CSV file that contains NULL data.
([Data Type] of recipe format table: CHAR)

Applicable commands
LD_RECIPE, LD_RECIPE2, LD_RECIPESEL, LD_RECIPESEL2, RD_RECIPE_FILE, RD_RECIPE_COLUMN, 
RD_RECIPE_LINE

• Unselected
Loaded as NULL (00H)

• Selected
Converted into space (20H) and loaded

Permit Double-Word Transfer 
by BMOV

Used to set the action to be taken when the transfer source (transfer target) device is a double-word device.

Example: Fuji Electric MICREX-F series BD (data device)
• Unselected: Only the lower-order word is transferred.    $u100 = BD100 C:4 (BMOV) 

• Selected: Both the upper- and lower-order words are transferred.    $u100 = BD100 C:4 (BMOV) (D)

Compatible when the video 
input signal is only in the odd 
or even field

Used to set the video input signal.

• Unselected
Both odd- and even-numbered fields

• Selected
Either the odd- or even-numbered fields

Set the Height of the 
Windows Font to Gothic

Used to set the font size to be applied when the screen program created using Windows fonts on V-SFT 
version 2.1.3.0 or earlier is opened on V-SFT version 2.1.4.0 and later.

• Unselected
Created with version 2.1.3.0 or earlier → Opened with version 2.1.4.0 or later

• Selected
Retains compatibility with screen programs created with version 2.1.3.0 or earlier.

Item Description

$u100 1111H ←
←

BD100 22221111H
$u101 3333H BD101 44443333H
$u102 5555H ←

←
BD102 66665555H

$u103 7777H BD103 88887777H

$u100 1111H ← BD100 22221111H
$u101 2222H
$u102 3333H ← BD101 44443333H
$u103 4444H

(Arial  36pt)
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Decimal Point Compatible in 
Reading Recipe File

Used to set the action to take when a CSV file contains values without a decimal point even though “with 
decimal point” is set on the attribute table.

Example:
Attribute table
Type: DEC, decimal point: 1, word count: 1

• Unselected: Data is read assuming that the decimal point is specified

• Selected: Data is read without assuming that the decimal point is specified

Fix the Width of the Windows 
Font

Used when numerical data display or character display parts are created using Windows fonts on Windows 
XP/Vista/7/8/8.1/10/11.

• Unselected
Depending on the OS, text width may change on MONITOUCH.

• Selected
Regardless of the OS, text width is standardized on MONITOUCH.

Delete folders from the 
oldest if Storage is lacking in 
space for backup

Used to set the operation that is performed when the storage device capacity is not sufficient for creating a 
backup file of logging servers/alarm servers or a PDF output of data sheet printing.

• Unselected
A backup file is not created.

• Selected
- If a folder for the previous day or earlier exists, the folder with the oldest date is retrieved and 

deleted entirely.
- If only the folder for the current day exists, only the file with the oldest date in the history of the 

specified logging server or alarm server is retrieved and deleted.
* The setting for automatically deleting folders is also provided at [System Setting] → [Other] → [Storage 

Setting] → [Deletes the backup folder].
Delete folders from the 
oldest when the remaining 
storage space is less than 
100 MByte.

This option is available when the [Delete folders from the oldest if Storage is lacking in space for backup] 
checkbox is selected.
This option determines the action taken when the remaining storage space is less than 100 Mbytes.

• Unselected
Delete old folders equivalent to the space required to create logging/alarm backup files (V8 
specifications) or to output a data sheet in PDF.

• Selected
Delete old folders when the remaining storage space is less than 100 Mbytes (V10/V9 specifications).

* The setting for automatically deleting folders is also provided at [System Setting] → [Other] → [Storage 
Setting] → [Deletes the backup folder].

Do Not Delete the Alarm 
Now Occurring

Used to set the action to take when the [DEL] key on an alarm display is pressed.

• Unselected
All the alarms being displayed can be deleted using the [DEL] key.

• Selected
* The alarms currently occurring cannot be deleted using the [DEL] key.

Adjust the position of 
Windows Font Multi Text

Used for position correction when using a Windows Font in multi-text.

• Unselected
Process character height of multi-text as a fixed value.

• Selected (default):
Correct the character height of multi-text so it fits within the specified area.

Follow to the PLC1 setting for 
the text process in a recipe 
file.

Used to determine how to recognize LSB and MSB when processing text strings in recipe files.

• Unselected: Depends on the attribute setting

• Selected: Depends on the [Text Process] setting of PLC1

Item Description

CSV file 123.4 12.34 0.123 1234 12340

D100 D101 D102 D103 D104
Data in device memory 1234 123 1 12340 57864
MONITOUCH display 123.4 12.3 0.1 1234.0 5786.4

Overflow

D100 D101 D102 D103 D104
Data in device memory 1234 123 1 1234 12340
MONITOUCH display 123.4 12.3 0.1 123.4 1234.0
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SW Word Operation 
(Transfer) Code Conversion

When a switch with [Word Operation] set for [Function] is operated under the following conditions, the 
action performed depends on this setting.

Condition 1: [Hardware Setting] → [PLC Properties] → [BCD] for [Code]
Condition 2: [Word Operation] for switch [Function] → [→ (Transfer)] for [Operation Mode]
Condition 3: [Constant (DEC/DEC-)] for [Operation Memory]
Condition 4: [PLC Device] for [Operand Device]

• Unselected
The constant (DEC/DEC-) specified in the operation device memory is stored as DEC/DEC- data in the 
PLC.

• Selected
The constant (DEC/DEC-) specified in the operation device memory is converted into BCD and stored 
in the PLC.

Avoid the use of upper three 
bits in the Read Area (n + 2)
(V8 compatible)

This option determines how the three high-order bits in the read area “n + 2” (screen number designation) 
are treated following specification changes relevant to screen number extension.

• Unselected: The three high-order bits are used for screen number designation.

• Selected: The three high-order bits are system reserved (0).
Screen number designation range
- DEC: 0 to 4095
- BCD: 0 to 1999 (values “2000” and after invalid)

File name designation in 
Recipe Macro (V7 
compatible)

This option determines the number of characters used to specify a recipe macro file name.

• Unselected: Maximum of 10 characters

• Selected: Maximum of 8 characters (same operation as V7)
Automatically selected when converted from V7 to V10/V9.

<Applicable commands>
SET_RECIPEFOLDER, RD_RECIPE_FILE, RD_RECIPE_LINE, RD_RECIPE_COLUMN, WR_RECIPE_FILE, 
WR_RECIPE_LINE, WR_RECIPE_COLUMN, GET_RECIPE_FILEINFO

Save the pitch setting of the 
texts of Switch/Lamp

Used to set [Char. Prop.] → [Set line spacing] in the switch and lamp settings window.

• Unselected
The value specified for line spacing is cleared at the end of screen program editing.
The setting is unselected for the next editing.

• Selected
The value specified for line spacing is saved in the screen program.
The setting is selected and the value is also displayed for the next editing.

Maintain the letter alignment 
of a switch/lamp

Used to set the text alignment in the switch and lamp settings window.

• Unselected
The text alignment setting is cleared at the end of screen program editing.
The alignment setting for every switch and lamp is cleared for the next editing.

• Selected
The text alignment setting is saved in the screen program.
The setting is retained for the next editing.

Allow to use Insert/DELETE 
keys when entering values

This option is relevant to using the [←] and [→] keys for data insertion and using the [DELETE] and [BS] keys 
for deletion.
For details, refer to “6.1 Numerical Data Entry” “Style” page 6-13.

Format the SRAM forcefully This option determines the action taken when “error: 163 (SRAM: )” occurs, which indicates an SRAM 
formatting error, no SRAM data immediately after shipment, or loss of SRAM data due to battery 
disconnection.

• Unselected (default):
Formatting the SRAM is executed in Local mode while the battery is connected to the V10/V9 series 
unit.

• Selected
A forced formatting is executed.
Whether automatic formatting was executed can be checked at $s1085.
(After execution, “1” is stored at $s1085. Switching MONITOUCH to Local mode again clears the value 
to “0”.)

Retain compatibility with 
negative value handling of 
CVFD macro command

Used to set the action to taken when converting negative values.

• Unselected (default): An action according to the value at $s99 is taken.

• Selected: A truncation is performed irrespective of the value at $s99.
* For details on the “CVFD” macro command and address $s99, refer to the Macro Reference Manual.

Item Description
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Backup the recipe file Used to set the action taken when an error occurs in writing to a CSV file in recipe mode.

• Unselected (default):
No backup file is created.

• Selected
- Normally ended: A CSV file and backup file “xxx.BAK” are created.
- Abnormally ended: A temporary file from “xxx.000” to “xxx.999”* is created.

* If temporary files “xxx.000” through “xxx.999” already exist, the oldest file is retrieved and deleted.
Display the recipe mode after 
executing SV/WR macro 
commands

Used to set whether or not to update the data in recipe mode when the RECIPE folder on the storage device 
is reread at the time of execution of the macro commands given below.

• Unselected (default):
The recipe mode item is not updated.

• Selected
The recipe mode item is updated.
The recipe mode item is reset to the default status. If editing is disabled by the command device 
memory, the current display status is kept.

Applicable commands
SV_RECIPE, SV_RECIPE2, SV_RECIPESEL, SV_RECIPESEL2, WR_RECIPE_FILE, WR_RECIPE_LINE, 
WR_RECIPE_COLUMN

Return switch prohibited 
when switching the screen by 
an external command

Used to set the action taken when a switch with [Return] set for [Function] is used.

• Unselected (default):
It is possible to go back to the previously displayed screen even if it was switched by an external 
command.

• Selected
It is not possible to go back to the previously displayed screen if it was switched by an external 
command.

Cancel the restriction on the 
number of registerable 
characters for Switch and 
Lamp (127 characters)

Used to set the number of characters that can be displayed on a switch or lamp.

• Unselected (default):
The number of registerable characters is limited according to the width of the item.

• Selected
A maximum of 127 characters can be registered regardless of the width of the item.

* When the [Char. Prop.] → [Auto-adjust the size according to the style] checkbox is selected in the 
switch/lamp settings window, the settings of [Auto-adjust the size according to the style] take 
precedence.

Scale the upper/lower limit of 
the alarm for num. display

Used to set the range of values associated with issuing alarms for numerical data display.
Example: Numerical data display to be colored blue for a value 101 or above

• Unselected (default):
The maximum and minimum values for alarms are set in the range according to “After range change.”
- Alarm maximum value: $u1000 = 100

• Selected
The maximum and minimum values for alarm are set in the range according to “Before range change.” 
(With constant designated, the operation in the case of “unselected” will take place.)
- Alarm maximum value: $u1000 = 1000

Change the display from 
“00:00 AM/PM” to “12:00 
AM/PM”

Used to set the time display to the 12-hour format.

Applicable parts
Time Display

• Unselected
Midnight → Displayed as “00:00 AM”
Noon → Displayed as “00:00 PM”

• Selected (default):
Midnight → Displayed as “12:00 AM”
Noon → Displayed as “12:00 PM”

Item Description

Numerical data display device memory : D100
Alarm maximum value device memory : $u1000, Alarm color: Blue
Before range change : 0 - 1000
After range change : 0 to 100 (101 or above: Normal color → Blue)
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Output operation of Write 
Area (V7 compatible)

This option determines whether the switch action or the outputting to write area has priority immediately 
after the screen is switched over.

• Unselected
The switch action is performed prior to output to the write area.

• Selected (default, V7 compatible operation)
The switch action is performed after output to the write area is complete.

* This setting is only available when the [System Setting] → [Unit Setting] → [General Setting] → [Use 
read/write area (V8 compatible)] checkbox is selected.

Synchronize system cycle and 
drawing cycle 
(V8 compatible)

Used to set the processing method of MONITOUCH.

• Unselected (default):
Perform the system cycle and drawing cycle asynchronously.
For details, refer to “1.2 Process Cycle” page 1-40.

• Selected
Operate using V8 specifications.

Inhibit simultaneous 
execution of multiple macros 
(V8 compatible)

Used to set the action taken when execution of multiple macros occur at the same time.

• Unselected (default):
Process macros simultaneously.

• Selected (V8 compatible operation):
Finish execution of the current macro before executing the next macro.

Retain the previous picture in 
graphic mode (V8 
compatible)

Used to set the drawing method when using graphic mode.

• Unselected (default):
Do not retain the image from the last drawing.

• Selected (V8 compatible operation):
Retain the image from the last drawing.

High speed drawing of the 
paint in graphic mode

If the drawing of paint in graphic mode/graphic relay display is slow, select this checkbox.

Make the Entry mode 
operation command the 
same as V8

Used to allocate [Control Device] and [Info. Output Device] in entry mode (when using a keypad).

• Unselected (default):
Operate using V10/V9 specifications.
For details, refer to “6 Entry”.

• Selected
Operate using V8 specifications.

Inhibit automatic 
optimization of memory 
reading operation (V8 
compatible)

Used to set the action taken when the V10/V9 series unit reads a PLC device memory.

• Unselected (default):
Optimize reading in accordance with screen registration.

• Selected
Operate using V8 specifications.

Invalidate cache for device 
writing operation (V8 
compatible)

Used to set V10/V9 series processing of keypad entry.

• Unselected (default):
Write to the V10/V9 series unit internally first and then update the display.

• Selected
Operate using V8 specifications.

Disable Switch Word 
Operation cache

This option is available when [Invalidate cache for device writing operation (V8 compatible)] is selected.
This option sets the cache operation for switches with [Word Operation] selected under [Function].

• Unselected (default)
Cache enabled (values in the cache may be displayed)

• Selected
Cache disabled

Allow max. 8 characters for 
naming files used in V8 
recipe mode (V8 compatible)

Used to set the maximum number of characters available for recipe filenames.

• Unselected (default): Maximum of 64 characters

• Selected (V8 compatible operation): Maximum of 8 characters

<Applicable commands>
SET_RECIPEFOLDER, RD_RECIPE_FILE, RD_RECIPE_LINE, RD_RECIPE_COLUMN, WR_RECIPE_FILE, 
WR_RECIPE_LINE, WR_RECIPE_COLUMN, GET_RECIPE_FILEINFO

Item Description
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Use read/write area (V8 
compatible)

Used to set the action taken when changing to the V10/V9 series from V6, V7, and V8 series units.

• Unselected (default):
Use [System Setting] → [Hardware Setting] → [Control Area].

• Selected
Operate using V8 specifications.
Use [System Setting] → [Hardware Setting] → [Control Area].

Gray out interlocked switches Used for display settings of a switch with an interlock set.

• Unselected (default):
The switch is displayed using the colors specified in the screen program.

• Selected
The switch is displayed grayed-out during interlock activation.

Retain compatibility of 
logging server’s SRAM 
storage

Used to set the processing method of MONITOUCH when saving logging history data to SRAM. (V9 only)

• Unselected (default)
Processing is performed according to V8 specifications to reduce the amount of SRAM used.

• Selected
Processing is performed according to V9 specifications.
(This setting is automatically selected when creating a new screen program or when converting a V8 
screen program to a V9 screen program in the editor of versions 6.0.0.0 to 6.0.10.0.)

* If this setting is changed, the SRAM will require reformatting because the amount of SRAM to be used 
will change.

Output logging data in 
binary format

Used to set the processing method of MONITOUCH when saving logging history data to a storage device. 
(V9 only)

• Unselected
Processing is performed according to V9 specifications.
(This setting is automatically selected when creating a new screen program or when converting a V8 
screen program to a V9 screen program in the editor of versions 6.0.0.0 to 6.0.10.0.)

• Selected (default)
Processing is performed according to V8 specifications to increase the speed of writing to the storage 
device.

Retain compatibility of alarm 
server’s SRAM storage

Used to set the processing method of MONITOUCH when saving alarm history data to SRAM. (V9 only)

• Unselected (default)
Processing is performed according to V8 specifications to reduce the amount of SRAM used.

• Selected
Processing is performed according to V9 specifications.
(This setting is automatically selected when creating a new screen program or when converting a V8 
screen program to a V9 screen program in the editor of versions 6.0.0.0 to 6.0.11.0.)

* If this setting is changed, the SRAM will require reformatting because the amount of SRAM to be used 
will change.

Output alarm data in binary 
format

Used to set the processing method of MONITOUCH when outputting alarm history data to a storage device. 
(V9 only)

• Unselected
Processing is performed according to V9 specifications.
(This setting is automatically selected when creating a new screen program or when converting a V8 
screen program to a V9 screen program in the editor of versions 6.0.0.0 to 6.0.11.0.)

• Selected (default)
Processing is performed according to V8 specifications to increase the speed of writing to the storage 
device.

Text/multi text display 
position (V8 compatible)

Used to set position correction for text and multi-text.

• Unselected (default)
Text/multi-text is placed at the specified coordinates.

• Selected
If using a bitmap font and “Shadow” is set in the text properties, text/multi-text is placed at a position 
shifted by one pixel upward to the left from the coordinates.

Activate auto-scroll display of 
the alarm

Used to set the operation that is performed when an alarm message is longer than the display area width.

• Unselected
The alarm message is displayed cut off and automatic scrolling is not performed.

• Selected (default)
When the message is selected with the cursor, automatic scrolling is performed to display the entire 
message.

Item Description
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Use the point size specified in 
the message edit window for 
alarm parts using Windows 
fonts.

Used to set the text size when using Windows fonts in alarm messages.

• Unselected
Alarm messages are displayed using the size set at [Contents] → [Point] in the alarm settings window.

• Selected (default)
Alarm messages are displayed using the size set at [Edit] (or right-click menu) → [Char. Prop.] → [Point] 
in the message editor.

* This setting is only available when [Display Mode] → [Alarm History/Event History/Real Time] is selected 
in the alarm settings window.

* Always check when using Windows fonts.
No code conversion when 
using the Device Memory 
Map (V8 compatible)

Used to set the operation that is performed when “Word” or “Double Word” is set for “Data Type” in a device 
memory map.

• Unselected (default)
Data is transferred according to the setting of [System Setting] → [Hardware Setting] → [PLC1 to 8 
Properties] → [Code].

• Selected
Data is transferred as is without code conversion.

Lower switch is valid when 
switches are overlapped (V8 
compatible)

Used to set the operation that is performed when two switches overlap each other. *1

Applicable parts
Switch, Num. Display/Char. Display (with [Function] set to “Entry Target” and the [Display the keyboard] 
checkbox selected), Slider Switch, Memo Pad, Recipe, Alarm parts, and Trend parts

Display on the editor
Placement order: Switch No. 0, which was placed earlier is 
superimposed by switch No. 1 which was placed later.

Operation on MONITOUCH
• Unselected (default) *2

The upper switch (No. 1) is enabled.

• Selected *2
The lower switch (No. 0) is enabled.

*1 If any part that is not overlapping is pressed, the operation of the relevant switch is performed.
*2 The default setting used after changing the model differs depending on the model and settings prior 

to the change.
- Change from V4/GD-80 series to V10/V9 series

Default setting: unselected
- Change from V8/V7/V6 series to V10/V9 series

Differs depending on whether the [System Setting] → [Unit Setting] → [General Setting] → [If a 
switch is overlaid on another, enable the upper switch] checkbox is selected for the screen program 
of the V8/V7/V6 series.
(Before change) Default setting when checkbox is selected: Unselected
(Before change) Default setting when checkbox is unselected: Selected

Shift subsequent record 
numbers of recipe data by 
one after a record is deleted.

Used to set the operation that is performed when deleting records from the recipe list settings window.
* Only available when [Record-based transfer] is set for [Transfer Data].

The operation that is performed differs depending on whether the transfer target setting at [System Setting] 
→ [Recipe] → [File Format] is set as data only or the record name and data.

• Transfer target: Data
- Unselected (default)

Record names remain because only data is deleted in the recipe file.

- Selected
Rows are shifted up because both record names and data are deleted in the recipe file.

• Transfer target: Record name and data
- Unselected (default)

Record names and data are deleted in the recipe file and empty rows remain.

- Selected
Rows are shifted up because both record names and data are deleted in the recipe file.

Item Description

No. 1

No. 0
Lower
Upper

No. 0

No. 1

No. 0

No. 1

Press here.

The upper switch is 
enabled.

No. 0

No. 1

No. 0

No. 1

Press here.

The lower switch is 
enabled.
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Drawing process 
(V8 compatible)

Used to set the processing for when a screen change occurs.

• Unselected (default)
The screen is changed over after all data is ready to be displayed.

• Selected
When the screen is changed over, 3D parts and items are drawn first. Then data is displayed.

Draw background when 
switching screen 
(V8 compatible)

This option is available when [Drawing process (V8 compatible)] and [Unhiding of items with [Show/Hide] 
settings (V8 compatible)] are selected.
Use this option to set the drawing behavior for drawing items, such as text, shapes, and paint.

• Unselected (default)
Draw drawing items as individual parts.
Although this prevents screen flickering when using the show/hide function, the display speed may 
decrease.

• Selected
Draw drawing items as part of the screen background.
Screen flickering will occur when using the show/hide function as on V8 series units.

Draw switch/lamp at the 
same timing with numerical 
data display

This option is available when the [Drawing process (V8 compatible)] checkbox is selected.
Used to set the processing for drawing switches and lamps when a screen change occurs.

• Unselected (default)
Display switches and lamps at the same time as the background (initially OFF display).

• Selected
Display switches and lamps after displaying the background (display with the bit status reflected).

Allow switch operation 
during screen switching

This option is available when the [Drawing process (V8 compatible)] checkbox is selected.
Used to set switch operation during a screen change.

• Unselected (default)
Switches are inoperable until a screen change is complete.

• Selected
Switches are operable during a screen change.

Read every 10 alarm parts Used to set the number of alarm parts read when displaying alarm parts.

• Unselected (default)
Read 50 parts at a time.

• Selected
Read 10 parts at a time (display speed becomes faster when the display area is 10 lines or less).

Read alarm blocks of the 
same cycle at one time

Used to set the reading operation of alarm blocks.
The operation is determined when all of the following conditions are satisfied.
Condition 1: [Alarm Device] → [Monitoring Intervals] are the same (excluding 0)
Condition 2: [Control Device Settings] is not configured
Condition 3: [Others] → [Read Monitoring Device per cycle] is not selected

• Unselected
Read device memory for each alarm block.

• Selected (default)
Read all device memory at once.

XOR drawing of switch/lamp Used to set XOR display of switches and lamps.
Applicable parts

• Numerical data/message display parts and switches/lamps
• Text and switches/lamps
• Text (graphic library) and switches/lamps
• Patterns and switches/lamps

Example: Placing a numerical data display part overlapped with a switch/lamp

• Unselected (default)
The numerical data display part is not affected by the ON color of the switch/lamp.

• Selected
Operates according to V8 specifications and the numerical data display part is XOR displayed with the 
ON color of the switch/lamp.

Item Description

1234
Numerical display
Text color: Black
Background color: White

Lamp
OFF color: Yellow
ON color: White
Drawing mode: XOR

1234 1234

Lamp OFF Lamp ON

1234 1234

Lamp OFF Lamp ON



1.1    System Settings

1-25

1

2

3

4

5

6

7

8

9

10

Use the VNC server function 
without user authentication

This option determines the settings required on the user authentication screen of the VNC server function.

• Unselected (default)
Enter a user ID and password on the authentication screen.

• Selected
The authentication screen is not displayed. The VNC server function can be used without entering the 
user ID and password.

Prohibit remote operation This option is available when the [Use the VNC server function without user authentication] checkbox is 
selected.
VNC client operation settings

• Unselected (default)
Both remote monitor and remote operation are available.

• Selected
Remote monitor is possible while remote operation is prohibited.

Enlarged sizes of the 
video/RGB display items 
(V8 compatible)

Used to set the operation that is performed when the display is enlarged by double-tapping the display area 
(only when [Free] is selected for [Display Size per Channel]).

• Unselected (default)
The display is fixed to VGA (640*480).

• Selected
Display is performed at the resolution of the V9 series unit or the size specified using the “CLIP_POS” 
and “CLIP_SIZE” macro commands.
However, display is performed using SVGA (800*600) for the V910xiW (1024*600).

Expand the available area in 
SRAM for operation logs

Used to set the method for calculating the amount of SRAM to use for operation logs.

• Unselected
The amount of SRAM to use is calculated using the plain formula.

• Selected (default)
The amount of SRAM to use is calculated using the formula for gaining an expanded area.

Do not execute CYCLE macro 
between ON and OFF macros 
(V8 compatible)

Used to set the action to take when an OFF macro is set to a switch with [Write] selected under [Function] on 
an overlap display.

• Unselected (default)
Execute the cycle macro when a write switch is pressed.

• Selected
Do not execute the cycle macro when a write switch is pressed.

Bring the data display to top 
(V8 compatible)

Used to set the display order of data displays (numerical data displays, character displays, and message 
displays).

• Unselected (default)
Display all items (including data displays) in the order of placement.

• Selected
Display data displays at the front.

Unhiding of items with 
[Show/Hide] settings 
(V8 compatible)

This option determines whether to monitor hidden items when using the show/hide function.

• Unselected (default)
Include hidden items in cycle reading (V10/V9 specifications).
Although flickering is prevented when the screen is updated with the show/hide function used, the 
performance of screen switching may decrease.

• Selected
Do not include hidden items in cycle reading (V8 specifications).
Flickering occurs when the screen is updated with the show/hide function used.

Synchronize cursor of Entry 
Target with drawing cycle 
(V8 compatible)

Used to set cursor behavior in data displays (entry targets).

• Unselected (default)
Do not synchronize the cursor to the drawing cycle. This will improve keypad responsiveness.

• Selected
Synchronize the cursor to the drawing cycle. This will provide the same keypad responsiveness as V8 
series units.

Restart Automatically If a 
System Error has Occurred

Used to set the action to take when a system error occurs.

• Unselected
Stop the unit when the system error screen is displayed.

• Selected (default)
Automatically restart the unit.

Write Area n+2: timing of 
screen number updating 
compatible with V8

This option determines the update timing setting of write area n+2 (screen number).

• Unselected (default)
Use the V10/V9 update timing (faster than when the checkbox is selected).

• Selected
Use the same update timing as V8 series units.

Item Description
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Validate superimpose when 
displaying over the 
video/RGB image

Contact your local distributor.

Validate superimpose when 
displaying over the 
video/RGB image 
(V8 compatible)

This option determines the superimposition setting for overlaps placed on [Video/RGB Display] items.

• Unselected
Superimposition cannot be used. Video/RGB images are always displayed at the front.

• Selected (default)
Superimposition can be used.

Ignore SYS(SET_SCRN) macro 
being used in the screen 
currently displayed 
(V8 compatible)

This option sets the action to take when executing the SYS(SET_SCRN) macro that displays the same screen 
as the currently displayed screen.

* Only the initial occurrence of SYS(SET_SCRN) in a macro sheet is valid. Differences in operation will occur 
if the SYS(SET_SCRN) macro is registered multiple times in a macro sheet.

• Unselected (default)
Enable the SYS(SET_SCRN) macro.

• Selected
Disable the SYS(SET_SCRN) macro.

Draw background when 
switching an overlap 
(V8 compatible)

This option sets the library number switching behavior during multi-overlap display.

• Unselected (default)
Hide overlaps while switching library numbers.

• Selected
Switch library numbers with overlaps displayed.

Suppress SRAM access of 
$L/LD used in macro block

This option determines the writing setting of internal device memory ($L/$LD) in macros.
Select this checkbox if $L/$LD writing is slow.

Synchronize interval timer 
macro and cycle 
(V8 compatible)

This option determines settings for the interval timer macro and drawing cycle.

• Unselected (default)
Execute the interval timer macro and drawing cycle at the same time.

• Selected
Stop the drawing cycle during interval timer macro execution.

Touch switch emulation 
(V8 compatible)

This option determines the setting when using the touch switch emulation function for RGB input.

• Unselected (default)
Output coordinate data in the SVGA (800 × 600) and XGA (1024 × 768) resolutions of the V9 series 
units.

• Selected
Output coordinate data in switch resolution (1023 × 1023) (V8 specifications).

Clear the display of 
overlapping trends when bit 
for redraw after clear trend 
graph is ON

This option determines the operation setting of redraw after clear bit when trend graphs areas are placed 
overlapping *.

* [Detail] → [Overlap] checkbox is unselected.

• Unselected (default)
Only clear the specified graph area (V10/V9 specifications).

• Selected
Clear all graph areas (V8 specifications).

Reset $T device and execute 
screen open macro before 
generating parts on the 
screen

This option determines the processing order when a screen change occurs.

• Unselected (default)
Perform operations in the order of screen library device memory → show/hide device memory → 
device memory of each part → $T reset → open macro/cycle macro * execution.

• Selected
Perform operations in the order of $T reset → open macro/cycle macro * execution → screen library 
device memory → show/hide device memory → device memory of each part.

* The cycle macro is executed only when the [Synchronize system cycle and drawing cycle] checkbox is 
selected in the [General Settings] tab window.

Allow use of recipe 
temporary device memory $R

This option determines the setting when using internal device memory $R in the recipe function.

• Unselected (default)
$R is not used.

• Selected
$R is used (65,536 words).
When data transfers are executed using the switch functions [Recipe Save Data] and [Recipe Load 
Data], values can be checked by transferring to $R in advance.
$R is an area common to all screens. Clearing occurs upon switching from RUN to STOP and power OFF.

Item Description
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Stop drawing cycle during 
the switch operation (V8 
compatible)

This option determines the drawing cycle setting during switch operation (output, function, ON macro).

• Unselected (default)
Allow the drawing cycle to occur during switch operation.

• Selected
Stop the drawing cycle during switch operation (V8 specifications).

Startup Settings: Allow 
short-time startup

This option sets whether to use short-time startup.

• Unselected (default)
Normal startup

• Selected
The [Startup Settings] tab is displayed in the [System Setting] → [Unit Setting] window.

Update info output device 
(data block No.) of entry 
mode at the start of 
switching data block.

This option sets the action to take when switching data blocks and the operation of entry mode information 
output device memory on overlaps.

• Unselected (default)
- Perform operations in the order of reading device memory on the data block → storage of block 

number output device memory of entry mode information output device memory/data block area.
- Clear the value of the information output device memory when the overlap display is hidden.

• Selected
- Perform operations in the order of storage of block number output device memory of entry mode 

information output device memory/data block area → reading device memory on the data block.
Make data block switching wait for the duration of the value held by $s1669.

- Hold the value of the information output device memory even when the overlap display is hidden.
Display file/folder names of 
FTP server function in 
uppercase letters
(V8 compatible)

This option sets the display of file names and folder names when executing LS/DIR.

• Unselected (default)
Uppercase and lowercase characters are used (V10/V9 specifications).

• Selected
Only uppercase characters are used (V8 specifications).

Clear the status of Storage 
Removal when switching a 
screen (V8 compatible)

This option sets the screen switching operation for switches with [Storage Removal] selected under 
[Function].

• Unselected (default)
Save the removed state after switching screens (V10/V9 specifications).

• Selected
Clear the removed state after switching screens (V8 specifications).

Overlap display upon 
switching the screen 
(V8 compatible)

This option sets the screen switching operation during overlap display via an external command.

• Unselected (default)
Display overlaps in the initial cycle when switching screens (V10/V9 specifications).

• Selected
Display overlaps after one cycle when switching screens (V8 specifications).

Graph drawing 
(V8 compatible)

This option determines the drawing settings of bar graphs, pie graphs, and closed area graphs.

• Unselected (default)
Do not draw if the current value is less than 1 with respect to the graph width (V10/V9 specifications).

• Selected
Draw one dot if the current value is less than 1 with respect to the graph width (V8 specifications).

Disable the animation effect 
of the trend (history).

This option sets the animation effect that occurs when selecting trend items ([Display Mode] set to 
[Historical Display], [Display Method] set to [Graph]).

• Unselected (default)
Enable animation for smooth display (V10/V9 specifications).

• Selected
Disable animation for improve display performance (V8 specifications).

Put a message with multiple 
lines in one cell in CSV 
created by alarm data.

This option determines the CSV output setting when an alarm message in the alarm history contains 
multiple lines.

• Unselected (default)
Divide the message into several cells.

• Selected
Merge multiple lines into one cell.

Enable transition function by 
macro commands.

This option determines whether to enable the transition function in macros.

• Unselected (default)
The transition function is not supported in macros.

• Selected
The transition function is supported in the SYS (SET_SCRN), SYS (SET_MOVLP), and SYS (OVLP_SHOW) 
macros. Refer to the Macro Reference Manual.

Item Description
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Synchronize the wait for PLC 
device write of cycle macro 
by cycle (V8 compatible)

This option determines the PLC writing operation setting in the cycle macro.

• Unselected (default)
Wait for PLC writing to complete before proceeding to the next processing (V10/V9 specifications).

• Selected
Proceed to the next processing without waiting for PLC writing to complete (V8 specifications).

Double-word device 
designation in Bit Order 
Alarming/Graphic Relay (V8 
compatible)

This option sets the operation of bit order alarming and graphic relays.
Available when double-word device memory is set to the top device memory.

• Unselected (default)
Operate using consecutive numbers from the designated bit address (V10/V9 specifications).

• Selected
Operate using V8 specifications.
- When the lower-order 16 bits are designated, ignore the higher-order 16 bits and use the 

lower-order 16 bits consecutively.
- When the higher-order 16 bits are designated, ignore the lower-order 16 bits and use the 

higher-order 16 bits consecutively.
Interlock device reading 
operation (V8 compatible)

This option sets the reading operation of switch interlock device memory.

• Unselected (default)
Link with the switch process cycle to increase responsiveness (V10/V9 specifications).
Note that switches with [Process Cycle] set to “Refresh” may not function.

• Selected
Perform interlock judgment upon switch operation (V8 specifications).

Windows fonts (data display), 
Windows98 compatible

This option sets the character width of Windows fonts (data display, flush right, and no zero suppression).

• Unselected (default)
Obtain the character width from Windows OS (obtained size differs depending on the OS) (V10/V9 
specifications). 
Note that the display position may shift for screen programs created using versions earlier than 
Windows 98.

• Selected
Obtain the character width from bitmap information in the screen program (V8 specifications).

Prohibit touch operation 
while processing overlap 
display

This option determines the function of touch operations while processing overlap displays.
• Unselected (default):

Touch operations are accepted even while processing overlap displays (V10/V9 specifications).
• Selected

Touch operations are prohibited while processing overlap displays (V8 specifications).
Display logging No. of Data 
Sampling area 
(V8 compatible)

This option sets the logging number which appears in a display area of the Trend (data sampling area).

• Unselected (default)
V10/V9 specifications: to count from 1 and continue counting even when the number of stored data is 
exceeded.

• Selected
V8 specifications: to count from 0 and when the number of stored data is exceeded, it returns to 0 and 
counts again.

Connect remote desktop 
function using RGB 32-bit 
color.

This option is for the remote desktop function.
• Unselected (default):

Connect using RGB 16-bit color.
• Selected

Connect using RGB 32-bit color.
Operation of animation (V8 
compatible)

This options sets the operation of animations.
• Unselected (default):

Show animations behind video and overlap displays (V10/V9 specifications).
• Selected

Show animations superimposed on video and overlap displays (V8 specifications).
Yaskawa Memobus special 
conversion (V8 compatible)

This option specifies whether or not to perform special processing when communicating with a Yaskawa 
Electric PLC using Memobus (transmission mode: type 1).

• Unselected (default)
Perform special conversion for all device memory (V10/V9 specifications).

• Selected
Do not perform special conversion for the following device memory (V8 specifications)

<Applicable device memory>
Entry mode: Control device memory, information output device memory
Recipe mode (V8 compatible): Command device memory “n”
Operation log: Control device memory
Trend sampling: Graph show/hide control device memory, zoom in/out control device 

memory
Animation: Display command device memory
JPEG display: File number designation
Audio: File number designation

Item Description
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Make text rendering for 
printing extended data sheet 
PDF clear

This option sets whether or not to make text rendering for printing extended data sheet PDF clear.
• Unselected (default)

All text are output as images.
• Selected

Text of applicable parts are output using fonts. (printed clearly)
<Applicable parts>
Numerical data display, character display, message display, text, multi-text, and trend graph
<Supported fonts>
TrueType font

Double-word access by 
TBL_WRITE macros (V7 
compatible)

This option sets the operation for double-word device memory when executing the “TBL_WRITE” macro 
command.

• Unselected (default)
Operate according to V10/V9 specifications (V10/V9 specifications).

• Selected
Operate according to V7 specifications (V7 specifications).

Prohibit input in Entry Mode 
by USB barcode (V8 
compatible)

This option specifies the operation of an entry mode for when a USB barcode reader is selected in the 
hardware settings.

• Unselected (default)
Input to both the I/F device memory address specified in the USB barcode reader settings and an entry 
target is possible (V10/V9 specifications).

• Selected
Input to an entry target using a USB barcode reader is not possible (V8 specifications).

Update relay information 
output devices at the same 
timing (V8 compatible) 

This option sets the update timing of [Relay information output device] “n+1” (ON Relay No.).
• Unselected (default)

Depends on [Process Cycle] of a item (V10/V9 specifications).
• Selected

Linked to the update of [Relay information output device] “n” (V8 specifications).
<Applicable parts>
Alarm: Time Order Alarming (V8), Bit Order Alarming (V8)

Multi link2 device reading 
operation (V8 compatible) 

This option sets the reading operation for Multi link2 connection.
• Unselected (default)

Operate according to V10/V9 specifications (V10/V9 specifications).
• Selected

Operate according to V8 specifications (V8 specifications).
<Applicable connections>
Multi link 2, Multi link 2 (Ethernet)

Item Description
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Local Mode Prohibition Setting
This section explains how to prohibit configuration of settings in Local mode.

Item Description
Prohibit Setting Prohibit configuration of settings in Local mode.
Prohibited Items Select the screens to prohibit configuration in Local mode.

A prohibited mark is displayed on the menu icon of the selected screens and the prohibited settings are 
grayed out.

LAN Setting Screen (LAN/LAN2)
SRAM Setting Screen
Communication Setting Screen
E-Mail Setting Screen
System Setting Screen
Date/Time Setting Screen
User Setting Screen

Prohibition Cancel Setting Set the password used to disable the prohibition setting for Local mode. Maximum of 16 one-byte 
alphanumeric characters
The password is entered on the [System Information] → [Screen Data Information] screen in Local mode.
Press [Relock] to validate the prohibition setting.

After disabling the prohibition setting, the prohibition setting will be validated when the power is turned off and on again, or a 
screen program is transferred.
For details on Local mode, refer to the following manuals.

- V10 Series Unit Operation / Local Mode / Error Screen Manual
- V9 Series Troubleshooting/Maintenance Manual

Prohibited mark

Prohibited 
settings are 
grayed out

Password entry

Changes
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GD-80E/V609E Compatibility Setting
This is a compatibility setting for when an EL-type MONITOUCH, such as the GD-80E or V609E (production discontinued), is to 
be replaced.

Item Description
Color Batch Change Converts any colors other than black into the color specified here to make the display color the same as the 

one used on GD-80E/V609E (2 colors).

* The color data cannot be restored to the original after conversion. For pattern data, there are some 
colors that cannot be converted. In such a case, the following dialog box is displayed.

GD-80E/V609E data displayed on computer V9080iC data displayed on computer
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1.1.3 Communication Setting
This section explains the items in the [Communication Setting] group.

Hardware Setting

For information on other settings, refer to “1.1.1 System Setting” page 1-1.

Click to change the 
menu.
([PLC Setting] and 
[Other Devices])

Click to 
add/change 
devices.

Click to add/change 
devices.
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PLC Settings and Other Devices (Left Menu)

Edit Model and Other Options (Bottom Menu)

Item Description Refer to
PLC1 - 8 Configure settings for PLCs, temperature controllers, and inverters etc.

Depending on the device connected, the available connection modes vary.
Connection Manual

Printer Set this option when connecting a printer for hard copies, data sheet 
printing, or logging data printing.

“16 Print”

V-I/O Configure settings for the V-I/O. -
USB Camera Configure settings for a USB camera. Reference Manual 2

1.2 USB Camera Display
TouchSW (CH5/CH6) Set this option to use touchswitch emulate function when the 

GUR-01/10/11 unit is installed.
Reference Manual 2
1.1 Video/RGB Display

Simulator Set this option when the simulator communication program and the screen 
program are to be saved to a storage device using the storage manager 
application.

-

Item Description Refer to
Edit Model Select the model for which you wish to configure a screen program. “Edit Model Selection” page 

1-3
Control Area Configure the control area. “Control area” page 1-34
Buzzer Set the buzzer sound used by the V10/V9 series unit. “Buzzer” page 1-12
Backlight Configure how the backlight is controlled by the V10/V9 series unit. “Backlight” page 1-11
Local Port IP Address Configure the IP address, port number and other settings of the 

V10/V9 series unit.
This is useful when the IP address is specific to the V10/V9 series unit 
on which the screen program is used.

Reference Manual 2
6 Ethernet Communication 
Function

Video/RGB Configure video/RGB input settings. Reference Manual 2
1.1  Video/RGB Display

Local Mode Prohibit configuration of settings in Local mode. “Local Mode Prohibition 
Setting” page 1-30

Ladder Transfer Configure the ladder transfer settings. Reference Manual 2
12  Ladder Transfer

Click to change 
the menu.

PLC settings menu Other devices menu
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Control area

Item Description
Displaying Screen Device This device memory is used for switching the screen via an external command. When a screen number is 

specified to this device memory, the screen is displayed.
Note that the screen number of the currently displayed screen is also stored in this device memory.

Initial Screen Specify the screen number to display when power to MONITOUCH is turned on.
If a nonexistent screen number is specified, the lowest screen number in the screen program is displayed.

Use a screen displaying device
Display the screen of the number stored in the [Displaying Screen Device] memory.

Control Device

Change the 
screen number 
using a switch

Changeover screens using a switch with [Screen Change-over] or [Return] set for 
[Function].

[0]: Allow changeover
[1]: Prohibit changeover

Data read 
refresh

All the data display items on the screen are refreshed when the bit changes from 0 to 1. 
This is applied to every data display item regardless of the setting for [Process Cycle]. For 
details on [Process Cycle], refer to “1.2 Process Cycle”.

Info. Output Device This device memory stores the state of the [Control Device].
PLC Selection Set the reading target of the calendar.   PLC 1 to 8

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
MSB LSB

Screen numbers 0 to 9999

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

Change the screen number using a switch
1: Prohibited, 0: Permitted

Not used (always set to “0”)

Data read refresh
0 → 1: Execute
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* The calendar data is automatically loaded once a day when the date changes. MONITOUCH recognizes the date change (00:00:00 AM), and 
then reads calendar data at 01:23:45 AM. However, if MONITOUCH reads calendar data by using the calendar read device memory or macro 
commands between 00:00:00 AM and 01:23:44 AM, MONITOUCH does not read the calendar data at 01:23:45 AM.

Device Memory Map
Configure device memory maps when batch transferring addresses between equipment. 128 addresses can be registered to a 
single device memory map.

Ethernet Communication
Configure settings to use the Ethernet function for sending e-mail notifications or using the FTP server function.

Calendar Read Device

Calendar 
setting

This bit is valid when the built-in clock of the V10/V9 series unit is not used. This bit should 
be used differently depending on whether the connected PLC is equipped with a calendar 
function.
For details on the built-in clock, refer to “10 Calendar”.

When connecting to a PLC with a calendar function
When calendar data in the PLC is updated, it can be forcibly read by setting this bit to 
ON (when 0 changes to 1). In addition, calendar data is also read at the following 
timings.

- At power-on
- Local→RUN
- When the date changes (01:23:45 AM) *

When connected to a PLC without a calendar function
Allocate a tentative calendar data area by specifying a device for [Calendar Device] and 
set the calendar data by setting this bit to ON.
For details, refer to “10 Calendar”.

Calendar Information Output 
Device

This device memory stores the state of the [Calendar Read Device] memory.

Watchdog Device
Answer-back Device

When any data is saved to [Watchdog Device], the same data is also written to [Answer-back Device] after 
the screen display operation is complete. In addition to watch dog monitoring, these device memory 
addresses can be used for display scanning.

Calendar Device For details, refer to “10 Calendar”.

For details, refer to “11 Device Memory Map” in the Reference Manual 2.

For details, refer to “6 Ethernet Communication Function” in the Reference Manual 2.

Item Description

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

Calendar setting
0 → 1: Read

Not used (always set to “0”)
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1.1.4 Common Setting
This section explains the common items in the [Common Setting] group.

Global Setting
Global Function Switch Setting
The V10/V9 series has function switches from [F1] to [F7] ([F1] to [F5] on the V9060iT).
These switches can be used on all screens in RUN mode.

For information on other settings, refer to “1.1.1 System Setting” page 1-1.

• Global settings are not available on the V910xiW/V907xiW because these models do not have function 
switches.

• The unit changes to system menu operation mode when the system menu is displayed by pressing the 
[SYSTEM] switch.

• When a screen with a local function switch setting is displayed, the setting of local function switch has 
priority.
Location of setting: [Screen Setting] → [Local Function Switch Setting]

Item Description
Use Function Switch Select this checkbox to use the corresponding global function switch.
Function Set the function of the switch.
Action This option is available when the [Output Device] checkbox is selected.

Select the write operation for the output device memory.
Output Device When the switch is pressed, output information is written into the specified device memory.
ON Macro Set the ON macro for the function switch.

For details on macros, refer to the Macro Reference Manual.
OFF Macro Set the OFF macro for the function switch.

For details on macros, refer to the Macro Reference Manual.
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Global Overlap Setting
Configure settings to keep the same overlap display shown even if the screen changes to another screen.

Alarm Server
Configure settings when using the alarm function.

Logging Server
Configure settings when using the logging function.

Recipe
Configure settings when using the recipe function.

Scheduler
Configure settings when executing specific operations at specified times.

Data Transfer Service
Configure settings when uploading (PUT) files and folders saved to the storage device connected to a V10/V9 series unit, and 
downloading (GET) files from the server by accessing the server from the client V10/V9 series unit via Ethernet.

Interlock Set an interlock to the function switch.
Device Memory Set the interlock bit device memory.
Condition ON:

Bit device memory “ON“: switch operation is allowed

OFF:
Bit device memory “OFF“: switch operation is allowed

When switch is OFF This setting is available when [Momentary/Momentary W] is selected for [Output Action].
Set whether the system judges the conditions for interlock activation when the switch is released (i.e. 
when your finger is released from the switch).

Invalid:
The system does not judge the condition when the switch is OFF.

Valid:
The system judges the condition even when the switch is OFF. If the condition is not satisfied, the 
switch will not be turned OFF even when a finger is removed.

For details, refer to “2.5 Global Overlap”.

For details, refer to “8 Alarm”.

For details, refer to “7 Trends”.

For details, refer to “15 Recipes”.

For details, refer to “3 Scheduler” in the Reference Manual 2.

For details, refer to “6 Ethernet Communication Function” in the Reference Manual 2.

Item Description



1  System

1-38

Others
Configure settings when using each function.

Item Refer to
Others Storage Setting “8 Storage Device” in the Reference Manual 2

MES Setting “6 Ethernet Communication Function” in the Reference Manual 2
Operation log Setting “4 Operation Log” in the Reference Manual 2
Security Setting “5 Security” in the Reference Manual 2
Remote Desktop Table Setting “6 Ethernet Communication Function” in the Reference Manual 2
Network Camera Table Setting “1 Image Display” in the Reference Manual2
Time Display Format Setting “Time display format setting” page 10-12
Flowing (scrolling) Message “8.2 Alarm Server”
PDF Viewer Setting “13 PDF Viewer” in the Reference Manual 2
Video Player Settings “15 Video Player” in the Reference Manual 2
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1.1.5 Settings
This section explains the items in the [Setting] group.

Macro Setting
Configure settings when using initial macros, a global macro device memory, or event timer macros.

Date and Time Display Setting
Use these settings to define a calendar data format.

For information on other settings, refer to “1.1.1 System Setting” page 1-1.

For details, refer to the Macro Reference Manual.

For details, refer to “8.3 Date and Time Display Setting”.
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1.2 Process Cycle
The screen display speed during communication between the V10/V9 series unit and the PLC depends on the number of parts 
(mainly the number of device memory addresses read from PLC) placed on the screen.

When displaying more parts on the screen, the display speed and switch response may be slower. In such a case, it is possible 
to speed up the display process by differentiating between the data to be viewed in real time (high speed) and other parts 
(low speed). This setting can be made at [Detail] → [Process Cycle] in the settings window of each part.

1.2.1 Setting the Processing Cycle
The read timing of PLC device memory addresses can be set. (A lamp part is used in the following example.)

*1 Location of [Control Device] setting: [System Setting] → [Hardware Setting] → [Control Area]

- When the [System Setting] → [Unit Setting] → [General Setting] → [Use read/write area] checkbox is selected, bit 15 of the read area “n 
+ 1” is changed from OFF to ON.

Item Description
Refresh • One cycle when the screen is opened

• Bit 1 of [Control Device]: OFF → ON *1

High Speed • Every cycle
Low Speed • Once per several cycles. (For details, refer to page 1-43.)

• One cycle when the screen is opened
• Bit 1 of [Control Device]: OFF → ON *1

Constant 1
Constant 2
Constant 3
*2

• The cycle specified for each screen at [Screen Setting] → [Screen Setting] → [PLC Device Transfer] → 
[Processing Cycle setting]
Range: 1 to 3600 (100 ms to 360 s)

• When unselected, the following cycles are applied.
Constant Cycle 1: 100 ms
Constant Cycle 2: 200 ms
Constant Cycle 3: 1000 ms

For details, refer to “Control area” page 1-34.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
Data read refresh
executed at OFF → ON

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
Data read refresh
executed at OFF → ON
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*2 Use these settings when reducing communication with connected devices.
If multiple constant cycles are specified for a single connected device, communications may be combined depending on the device 
address that is used. It is recommended to specify different cycles for each separate connected device.
The settings for the displayed screen are stored at $s1647 to $s1649.

Exceptions
• Regardless of the process cycle setting, all data is read in the first cycle when a screen is opened and when bit 1 of the 

control device memory changes from OFF to ON. With this operation, all data is displayed on the screen when the screen 
is opened.

• When [Internal] is selected for the device memory, [High Speed] is automatically selected for [Process Cycle] regardless of 
any other settings.

For details, refer to “System Device Memory” page 1-45.
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1.2.2 Processing Sequence in the V10/V9 Series
Processing in the V10/V9 series unit is performed in the following order.

• Device memory that frequently perform reading are put into communication cycle blocks and optimized. This improves 
processing speed.

• PLC device memory registered to a screen are analyzed and put into blocks for reading.
• All blocks corresponding to data set as high-speed are read in one cycle.
• Data set as low-speed is read at one block per cycle. The next block is read in the following cycle.

• When bit 1 of [Control Area] → [Control Device] is detected as ON, all data is read in the next cycle regardless of the 
settings.

• Reading of the device memory required for display and operation is performed at the same time using two programs.
• Writing of switch activation and other operations is performed in the interval between reading blocks.

1 cycle

* Reading of the control device memory is included in a high-speed block from 1 to m.

High-speed 
block 1 reading

High-speed 
block m reading

Low-speed 
block 1 reading

High-speed 
block 1 reading

High-speed 
block m reading

Low-speed 
block 2 reading

High-speed 
block 1 reading

High-speed 
block m reading

Low-speed 
block n reading

High-speed 
block 1 reading

High-speed 
block m reading

Low-speed 
block 1 reading

1 cycle 1 cycle 1 cycle

1 cycle

High-speed 
block 1 reading

High-speed 
block m reading

Low-speed 
block 1 reading

High-speed 
block 1 reading

High-speed 
block m reading

Low-speed 
block 2 reading

1 cycle

1 cycle

High-speed 
block 1 reading

High-speed 
block m reading

Low-speed 
block 1 reading

High-speed 
block 1 reading

High-speed 
block m reading

Low-speed 
block 2 reading

1 cycleLow-speed 
block n reading

Refresh block 1 
reading

Refresh block t 
reading

Bit 1 of the control device 
memory is detected to change 
from OFF to ON in this cycle.

All data is read in this 
cycle.
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One-cycle Processing
Communication cycles, system cycles, and drawing cycles are performed independently on the V10/V9 series.
In the communication cycle, the data of device memory set on the currently displayed screen is read. System cycle and 
drawing cycle processing is performed based on the data read in the communication cycle. On the initial display of screens 
and multi-/global overlaps, display is performed after reading all of the device memory necessary for display. After display, 
operation is performed with the following cycles.

*1 When the [System Setting] → [Unit Setting] → [General Setting] → [Synchronize system cycle and drawing cycle (V8 
compatible)] checkbox is selected, the drawing cycle is performed after the system cycle is complete.

Notes
Processing is not exactly the same as shown above because for the single cycle executed when the screen is opened, the data 
of all parts placed on the screen is read in addition to the execution of the screen OPEN macro.

n = 0

n = n + 1

n < 8

YES

YES

YES

NO

NO

NO

High-speed 
block 1 reading

1 cycle

Cycle start

No. “n” present in event 
timer macro

Timer map of event timer

Execute No. “n” event 
timer macro

Event timer macro
Scheduler
PLC device memory transfer
Cycle macro
Control area writing
Logging control device memory etc.
Alarm control device memory etc.
Device memory map control device 
memory etc.
Recipe
Operation log
Control area (status storage)

Placed part 1 processing

High-speed 
block m reading

Low-speed 
block n reading

Placed part 2 processing

Placed part 3 processing

Placed part m processing

Placed part n processing

*1

Communication cycle System cycle

Drawing cycle

1 cycle

1 cycle
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1.2.3 If Communication is Slow
Try the following methods to speed up communication.

Methods for Creating Screens

*1 Example of changing [Process Cycle]:
• For data display parts where data is written from such as a keypad, and there are no or hardly any changes in the PLC, 

select [Refresh].
• For data display parts where the display speed on the V10/V9 series unit does not need to be fast in response to data 

changes in the PLC, select [Low Speed].
• For data display parts that must be displayed in real time, select [High Speed].

*2 Example of refining macro commands:
[MOV] command, 5 lines
Line No. 0 D200 = $u200 (W)
Line No. 1 D201 = $u201 (W)
Line No. 2 D202 = $u202 (W)
Line No. 3 D203 = $u203 (W)
Line No. 4 D204 = $u204 (W)

[BMOV] command, 1 line
Line No. 0 D200 = $u200 C: 5 (BMOV)

Others
• Baud rate setting (serial communications)

Increase the baud rate between the V10/V9 series unit and the PLC. The V10/V9 series unit supports a maximum of 115 
kbps (direct connection with Siemens MPI port: maximum 187,500 bps). Set the maximum baud rate that the PLC 
supports.

• Ethernet communication
The baud rate available with Ethernet communication is 1000Mbps (for V10 only), 100 Mbps or 10 Mbps (depending on 
the PLC model).
This allows for faster communication than serial communication.

• On the PLC, set a shorter scan time for ladder programs.

Method Effect
Consecutively allocate PLC device memory addresses that are used for the same 
screen.

The number of blocks decreases so the cycle time can be 
shorter.

Parts Change the [Process Cycle] setting. *1 The number of accesses to the PLC can be reduced.
Macro Refine commands. *2 The number of accesses to the PLC with macros can be 

reduced.
Logging
Alarm

When specifying device memory addresses 
individually, allocate the addresses consecutively.

The number of blocks decreases so the cycle time can be 
shorter.

Multi-link
Multi-link2

Place all connected V10/V9 series units in RUN 
mode.

This eliminates recovery confirmation access on ports 
where communication is not possible.

PLC is written to five times

Change to the [BMOV] command

PLC is written to only once.
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1.3 List of Internal Device Memory
Internal device memory is the device memory in the V10/V9 series unit that is available to users.
Since processing is done internally within the V10/V9 series unit, communication speed can be made quicker by using for 
operations that do not require data communication with a PLC.

1.3.1 Types of Internal Device Memory
Internal device memory can be generally divided into two types: user device memory and system device memory.

User Device Memory
These device memory allow read/write operations and can be used freely by users.

*1 $u, $T, $M, and $MC are volatile device memory. When switched to Local mode or the power is turned off (reset), data is erased.
*2 $L and $LD are non-volatile device memory. Data is retained even after the power is turned off. To use $L or $LD, it is necessary to make 

[SRAM/Clock] settings.

System Device Memory
This device memory is for use by the system and there two types: device memory for reading and device memory for writing.

*1 $s and $P are volatile device memory. When switched to Local mode or the power is turned off (reset), data is erased.

• Internal device memory operate with “DEC (with sign)” regardless of the numeric code set via the [System 
Setting] → [Hardware Setting] window. (Except items for which the numeric code is specified individually.)

• Text processing depends on the setting for [Text Process] under [Communication Setting] in the [System 
Setting] → [Hardware Setting] window.

Symbol Range Description

$u *1 0 - 65535
(65536 words)

This is an area common to all screens.

$L
$LD *2 Depends on user setting This is an area common to all screens.

$T *1 0 - 1023
(1024 words)

Each screen can have up to 1024 words. When the screen is switched, all the areas are 
reset to “0”. Therefore, these device memory can be used for macro commands executed 
for each screen.

$M *1 0 - 2047
(2048 words)

Each macro command can have up to 2048 words. When the macro command has been 
executed, or another macro command is called, all the areas are reset to “0”.
Therefore, these device memory can be used for macro commands that are executed on a 
macro basis.

$MC *1 0 - 2047
(2048 bytes)

Each macro command can have up to 2048 bytes. When the macro command has been 
executed, or another macro command is called, all the areas are reset to “0.”
Therefore, these device memory can be used for macro commands that are executed on a 
macro basis.
The difference from $M is that these are device memory in byte units, which makes byte 
access possible.

$C *1 0 - 4095
(4096 words)

These device memory addresses are exclusively used for component parts.
These are available only when editing component parts.

For details, refer to “SRAM/Clock” page 1-9.

Symbol Range Description

$s *1 0 - 2047
(2048 words)

This device memory is used for performing input and output with the system using, for 
example, macro commands.
Do not use device memory addresses indicated with “Not used” because they may be 
reserved for future use.

$P *1 0 - 511
(512 words)

This read/write device memory is used to control 8-way communication or indicate the 
status of 8-way communication.
For details, refer to the Connection Manual.

For details on $s, refer to “1.3.2 System Device Memory Details” page 1-46.
For details on $P, refer to the Connection Manual.
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1.3.2 System Device Memory Details
The details of the $s system device memory are shown below.

Meaning of “Device Type” in the table
• ← V  Data written to $s from MONITOUCH
• → V  Definitions and settings written to $s by the user

Table
$s Description Device Type Refer to
0 Stores the currently displayed screen number (0 to 9999). ← V -
1
2 Overlap 0 Registration/display status

← V page 1-61

3 Overlap 0 Display position X
4 Overlap 0 Display position Y
5 Overlap 0 Overlap library number
6 Overlap 1 Registration/display status
7 Overlap 1 Display position X
8 Overlap 1 Display position Y
9 Overlap 1 Overlap library number

10 Overlap 2 Registration/display status
11 Overlap 2 Display position X
12 Overlap 2 Display position Y
13 Overlap 2 Overlap library number
14
15
16 Printer status

← V
page 1-61

17 Backlight status page 1-61
18
19
20 V7 compatible Buffer 0 Specified number of buffers

← V page 1-61

21 Buffer 0 Number of buffers
22 Buffer 0 Executed number of buffers
23 Buffer 1 Specified number of buffers
24 Buffer 1 Number of buffers
25 Buffer 1 Executed number of buffers
26 Buffer 2 Specified number of buffers
27 Buffer 2 Number of buffers
28 Buffer 2 Executed number of buffers
29 Buffer 3 Specified number of buffers
30 Buffer 3 Number of buffers
31 Buffer 3 Executed number of buffers
32 Buffer 4 Specified number of buffers
33 Buffer 4 Number of buffers
34 Buffer 4 Executed number of buffers
35 Buffer 5 Specified number of buffers
36 Buffer 5 Number of buffers
37 Buffer 5 Executed number of buffers
38 Buffer 6 Specified number of buffers
39 Buffer 6 Number of buffers
40 Buffer 6 Executed number of buffers
41 Buffer 7 Specified number of buffers
42 Buffer 7 Number of buffers
43 Buffer 7 Executed number of buffers
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44 V7 compatible Buffer 8 Specified number of buffers

← V page 1-61

45 Buffer 8 Number of buffers
46 Buffer 8 Executed number of buffers
47 Buffer 9 Specified number of buffers
48 Buffer 9 Number of buffers
49 Buffer 9 Executed number of buffers
50 Buffer 10 Specified number of buffers
51 Buffer 10 Number of buffers
52 Buffer 10 Executed number of buffers
53 Buffer 11 Specified number of buffers
54 Buffer 11 Number of buffers
55 Buffer 11 Executed number of buffers

(Blank)

64
Switch function Repeat setting

Adds the repeat function to a switch not configured with the repeat function.
Set a number other than “0” to the switch ON macro.

→ V

-

65
Switch function Repeat prohibited setting

Prohibits the repeat function for a switch configured with the repeat function.
Set a number other than “0” to the switch ON macro.

-

66 Switch ON Macro repeat setting page 1-61

(Blank)

72
Stores the result of the “SYS” (system call) macro command.

0: Normal termination
Other than 0 (usually -1): Error (second screen setting, etc.)

← V

-

73

Result of switch function
Stores the operation result of the switch function when the “SWRET” command is used with 
the switch ON macro. Use this device memory when the next operation varies depending 
on the result of the switch function.
0: Normal termination
Other than 0 (usually -1): Error

-

74
75 Buzzer sound for overlap → V page 1-62

76

Keypad overlap AUTO OFF  Prohibited
If a keypad is placed on an overlap display, it is possible to close the overlap display with the 
[ENT] key on the keypad. This device memory can be used to prohibit this function.
0: Permitted
Other than 0: Prohibited → V

-

77 Exclusive function of overlap display
When a value other than “0” is set, the overlap exclusive function is set. “2 Overlap”

78 Entry mode  Display type of entry target ← V page 1-62
79 Entry mode  Selection of entry target → V page 1-62
80 Universal serial Switch output 0 Output codes 0 to 15

← V Connection Manual

81 Universal serial Switch output 1 Output codes 16 to 31
82 Universal serial Switch output 2 Output codes 32 to 47
83 Universal serial Switch output 3 Output codes 48 to 63
84 Universal serial Switch output 4 Output codes 64 to 79
85 Universal serial Switch output 5 Output codes 80 to 95
86 Universal serial Switch output 6 Output codes 96 to 111
87 Universal serial Switch output 7 Output codes 112 to 127
88 Universal serial Switch output 8 Output codes 128 to 143
89 Universal serial Switch output 9 Output codes 144 to 159
90 Universal serial Switch output 10 Output codes 160 to 175
91 Universal serial Switch output 11 Output codes 176 to 191
92 Universal serial Switch output 12 Output codes 192 to 207
93 Universal serial Switch output 13 Output codes 208 to 223
94 Universal serial Switch output 14 Output codes 224 to 239
95 Universal serial Switch output 15 Output codes 240 to 255

(Blank)

99 “CVFD” macro command setting → V page 1-62

$s Description Device Type Refer to
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100
PLC calendar status

The calendar status of the PLC (with built-in calendar) is written.
0: Normal
1: Error (The calendar information could not be read correctly.)

← V -

101

Setting for writing calendar data to PLC
When $s100 = 1, writing calendar data to the PLC is permitted or prohibited.
0: Writing prohibited
1: Writing permitted at all times (No error handling is performed even if an error is 
detected.)

→ V -

102
Stores the execution result of the “HMI-FUNC” macro command.

0: Normal
[Other than 0]: Error

← V -

103
104 PLC error handling during macro execution → V page 1-62
105 (When $s104 is other than 0: Result of error handling is written) ← V page 1-62

106
Memo pad Page number storage

Stores the operation setting for when a screen change occurs and the memo pad 
number that is currently displayed.

← V
→ V page 13-6

107 Memo pad Data Registered/ Unregistered

← V

page 1-63
108 Memo pad Remaining storage area

Stores the amount of remaining storage area for memo pad data. (Unit: bytes)
-

109 -
110 Stores the local port number of the V10/V9 series unit for multi-link/multi-link 2 connections.

Connection Manual
111 Stores the local port number of the V10/V9 series unit for 1 : n connection on the universal 

serial port.
112
113
114 V7 compatible 1 : n connection PLC1 down information (port number 32 to 47)

← V page 1-63

115 1 : n connection PLC1 down information (port number 48 to 63)
116 1 : n connection PLC1 down information (port number 64 to 79)
117 1 : n connection PLC1 down information (port number 80 to 95)
118 1 : n connection PLC1 down information (port number 96 to 111)
119 1 : n connection PLC1 down information (port number 112 to 127)
120 1 : n connection PLC1 down information (port number 128 to 143)
121 1 : n connection PLC1 down information (port number 144 to 159)
122 1 : n connection PLC1 down information (port number 160 to 175)
123 1 : n connection PLC1 down information (port number 176 to 191)
124 1 : n connection PLC1 down information (port number 192 to 207)
125 1 : n connection PLC1 down information (port number 208 to 223)
126 1 : n connection PLC1 down information (port number 224 to 239)
127 1 : n connection PLC1 down information (port number 240 to 255)
128 1 : n connection PLC1 down information (port number 0 to 15)
129 1 : n connection PLC1 down information (port number 16 to 31)

130 MODBUS TCP/IP sub station information
Specify the sub station number with the “MOV” macro command. → V Connection Manual

131

132 Cycle time (system cycle)
Stores the cycle time of the currently displayed screen. (Unit: 10 msec) ← V -

(Blank)

160 Calendar Year

← V page 1-63

161 Calendar Month
162 Calendar Day
163 Calendar Hour
164 Calendar Minute
165 Calendar Second
166 Calendar Day of the week (0: Sunday, 1: Monday, 2: Tuesday, ... 6: Saturday)

167
Battery voltage drop detection  Bit 4

0: Battery normal
1: Battery voltage drop, no battery

← V -

168 GMT-based UNIX time
Stores the Greenwich Mean Time. ← V -

169
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170 Video Overlap 
Displays

Channel No.

→ V
Reference Manual 2

1.1 Video/RGB 
Display

171 Dither (fixed to 1 (yes))
172 Brightness
173 Contrast
174 Color intensity

(Blank)

177 V8 compatible Sampling buffer number → V page 1-63
178 Overflow flag  

← V page 1-63
179
180 V8 compatible

Buffer Word 0 Average

← V page 1-63

181
182

Buffer Word 0 Maximum
183
184

Buffer Word 0 Minimum
185
186

Buffer Word 0 Total
187
188

Buffer Word 1 Average
189
190

Buffer Word 1 Maximum
191
192

Buffer Word 1 Minimum
193
194

Buffer Word 1 Total
195
196

Buffer Word 2 Average
197
198

Buffer Word 2 Maximum
199
200

Buffer Word 2 Minimum
201
202

Buffer Word 2 Total
203

204 - 211 Buffer Word 3 Average, maximum, minimum, total
212 - 219 Buffer Word 4 Average, maximum, minimum, total
220 - 227 Buffer Word 5 Average, maximum, minimum, total
228 - 235 Buffer Word 6 Average, maximum, minimum, total
236 - 243 Buffer Word 7 Average, maximum, minimum, total
244 - 251 Buffer Word 8 Average, maximum, minimum, total
252 - 259 Buffer Word 9 Average, maximum, minimum, total
260 - 267 Buffer Word 10 Average, maximum, minimum, total
268 - 275 Buffer Word 11 Average, maximum, minimum, total
276 - 283 Buffer Word 12 Average, maximum, minimum, total
284 - 291 Buffer Word 13 Average, maximum, minimum, total
292 - 299 Buffer Word 14 Average, maximum, minimum, total
300 - 307 Buffer Word 15 Average, maximum, minimum, total
308 - 315 Buffer Word 16 Average, maximum, minimum, total
316 - 323 Buffer Word 17 Average, maximum, minimum, total
324 - 331 Buffer Word 18 Average, maximum, minimum, total
332 - 339 Buffer Word 19 Average, maximum, minimum, total
340 - 347 Buffer Word 20 Average, maximum, minimum, total
348 - 355 Buffer Word 21 Average, maximum, minimum, total
356 - 363 Buffer Word 22 Average, maximum, minimum, total
364 - 371 Buffer Word 23 Average, maximum, minimum, total
372 - 379 Buffer Word 24 Average, maximum, minimum, total
380 - 387 Buffer Word 25 Average, maximum, minimum, total
388 - 395 Buffer Word 26 Average, maximum, minimum, total
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396 - 403 V8 compatible Buffer Word 27 Average, maximum, minimum, total

← V page 1-63
404 - 411 Buffer Word 28 Average, maximum, minimum, total
412 - 419 Buffer Word 29 Average, maximum, minimum, total
420 - 427 Buffer Word 30 Average, maximum, minimum, total
428 - 435 Buffer Word 31 Average, maximum, minimum, total

436
Alarm function Auto operation time

← V -

437
438

Alarm function Auto operation stop time
439
440

Alarm function Program stop time
441
442 Alarm function Number of stops
443 Alarm Function Rate of operation(XX.X)

(Blank)

456 V8 compatible Alarm Function Normal Operation Bit ← V -
457
458 V8 compatible Alarm Function Sampling bit ← V -
459
460 V8 compatible Read area n

← V -461 Read area n + 1
462 Read area n + 2
463
464 V8 compatible Write area n

← V -465 Write area n + 1
466 Write area n + 2
467
468 V8 compatible Memory card Card number

← V page 1-64

469 Memory card Card name
470 Memory card File name No. 0
471 Memory card File name No. 1
472 Memory card File name No. 2
473 Memory card File name No. 3
474 Memory card File name No. 4
475 Memory card File name No. 5
476 Memory card File name No. 6
477 Memory card File name No. 7
478 Memory card File name No. 8
479 Memory card File name No. 9
480 Memory card File name No. 10
481 Memory card File name No. 11
482 Memory card File name No. 12
483 Memory card File name No. 13
484 Memory card File name No. 14
485 Memory card File name No. 15

(Blank)

496
Storage access status (V-Server)

0: No access
1: Accessing

← V

-

497 Storage device error state page 1-64
498 Remaining space on storage device

Stores the amount of free space on the storage device. (Unit: kbyte) -
499

500
[Storage Removal] switch status

0: Switch OFF (removal disabled)
Other than 0: Switch ON (removal permitted)

-

(Blank)
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512

Ethernet Port selection
Select the port used for sending and receiving Ethernet macro commands (“EREAD”, 
“EWRITE”, “SEND”, or “MES”).
0: LAN (built-in)
1: Ethernet unit
2: LAN2 (built-in)
3: WLAN (wireless)

→ V -

513 (Blank)
514 Ethernet Result of macro wait request_ → V page 1-64
515 Ethernet Macro wait request execution result_ ← V page 1-64

516
Ethernet Transmission speed (for built-in LAN port)

0: Auto
1: 10Base

← V -

517 (Blank)

518
Ethernet Status (for built-in LAN port)

0: Normal
801: Link down

← V Connection Manual

519 Ethernet Status (for Ethernet unit) ← V -
520 Network table 0 status

← V Connection Manual

521 Network table 1 status
522 Network table 2 status

                    

617 Network table 97 status
618 Network table 98 status
619 Network table 99 status

620 - 654
Stores the information in the FL-Net communications.

← V
Specifications for 
Communication 

Unit FL-net 
(OPCN-2)

(Blank)

700 Stores the language number (0 to 31) of the currently displayed language. ← V -

(Blank)

719 Memo pad Pen color → V
← V page 13-6

720
SRAM Memo pad save result

0: Normal
1: Data contains an error and is deleted.

← V

-

721
SRAM Internal device memory $L save result

0: Normal
1: Error

-

722 SRAM Internal device memory $L last written device memory
Stores the $L address of the last write operation when $s721 = 1 at power-up.

-
723 -

724
SRAM Internal device memory $LD save result

0: Normal
1: Error

-

725 SRAM Internal device memory $LD last written device memory
Stores the $LD device memory of the last write operation when $s724 = 1 at power-up.

-
726 -

727
Memo pad save overflow (judgment result of whether data is of a size that can be saved)

0: Normal
1: Save area insufficient

-

728
FROM_RD/FROM_WR macro execution result

0: Normal
1: Error

-

$s Description Device Type Refer to
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729 V7 compatible PLC2 Macro execution result

← V

Connection Manual

730 PLC2 Port No. 00 Status
731 PLC2 Port No. 01 Status
732 PLC2 Port No. 02 Status

            

758 PLC2 Port No. 28 Status
759 PLC2 Port No. 29 Status
760 PLC2 Port No. 30 Status
761 PLC2 Port No. 31 Status
762 PLC2 Constant/synchronized read Interrupt setting

→ V763 PLC2 TEMP_RD/TEMP_WR macro forced execution setting
764 PLC2 Constant/synchronized write Interrupt setting
765 PLC2 Error code

← V
766 PLC2 Extended error code 1
767 PLC2 Extended error code 1
768 PLC2 Extended error code 1

(Blank)

800 Modbus slave communication Reference table number

→ V
Modbus Slave 

Communication 
Specifications

801 Modbus slave communication Reference device memory setting
802 Modbus slave communication Reference device memory setting
803 Modbus slave communication Reference device memory setting
804 Modbus slave communication Reference device memory setting
805 Modbus slave communication Reference device memory setting

(Blank)

810 - 813 Stores the IP address in the LAN settings of the V10/V9 series unit
← V

-
814 - 817 IP address of another port page 1-65

818 Network table number designation → V page 1-65
819
820 V7 compatible PLC2 Port No. 32 Status

← V Connection Manual

821 PLC2 Port No. 33 Status
822 PLC2 Port No. 34 Status

885 PLC2 Port No. 97 Status
886 PLC2 Port No. 98 Status
887 PLC2 Port No. 99 Status
888
889
890 Japanese conversion function  Number of user-defined words ← V -

(Blank)

900 Stores the touch switch status.

← V “3.1.6 Coordinate 
Output”

901 Touch switch X coordinate output
Stores the X coordinate of the touch switch that is pressed.

902 Touch switch Y coordinate output
Stores the Y coordinate of the touch switch that is pressed.

(Blank)

910 Video CH1 Brightness

← V
Reference Manual 2

1.1 Video/RGB 
Display

911 Video CH1 Contrast
912 Video CH1 Color intensity
913 Video CH1 Operation mode (GUR-00/GUR-10)
914
915 Video CH2 Brightness

← V
Reference Manual 2

1.1 Video/RGB 
Display

916 Video CH2 Contrast
917 Video CH2 Color intensity
918 Video CH2 Operation mode (GUR-00/GUR-10)
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919
920 Video CH3 Brightness

← V
Reference Manual 2

1.1 Video/RGB 
Display

921 Video CH3 Contrast
922 Video CH3 Color intensity
923 Video CH3 Operation mode (GUR-00)
924
925 Video CH4 Brightness

← V
Reference Manual 2

1.1 Video/RGB 
Display

926 Video CH4 Contrast
927 Video CH4 Color intensity
928 Video CH4 Operation mode (GUR-00)
929
930 Video/USB camera Status ← V Reference Manual 2

1.1 Video/RGB 
Display

1.2 USB Camera 
Display

931 Video Snapshot function Composition of superimpose screen → V
932 Video/RGB/USB camera Automatic Stores the snapshot file number. ← V

933

934 Stores the channel number (1 to 4) corresponding to the location touched in the display area. 
Default: 1 ← V

Reference Manual 2
1.1 Video/RGB 

Display
935 Video Brightness of the selected video area

← V936 Video Contrast of the selected video area
937 Video Color intensity of the selected video area

(Blank)

956 Stores the current brightness adjustment value (0 to 127). ← V -
957 Video  Display change (640 × 240 dots only)

0: Upper half display
1: Lower half display

→ V
Reference Manual 2

1.1  Video/RGB 
Display

(Blank)

961 Video  Standard size setting (for V9150iX only)
0: 640 × 480
1: 800 × 600
2: 1024 × 768

→ V Reference Manual 2
1.1  Video/RGB 

Display
962 Video  Number of periodic snapshots executed

Cleared to 0 when taking of snapshots starts. ← V

(Blank)

965

File transfer communication timeout setting
Set the monitoring timeout time when storage device of MONITOUCH is accessed from a 
client, such as V-Server, storage access DLL etc., in RUN mode.
Set value is 0: 60 sec (default)
Set value is other than 0: Set value × 10 sec

→ V -

966 Video/USB camera Current clip start position (X coordinate at the top left corner)

← V
Reference Manual 2

1.1  Video/RGB 
Display

1.2 USB camera 
Display

967 Video/USB camera Current clip start position (Y coordinate at the top left corner)
968 Video/USB camera Current image clip size (width)
969 Video/USB camera Current image clip size (height)
970 RGN IN  Limit on number of snapshot executions using SET_RGB macro

Setting value: 0 to 255
→ V971 RGB IN  Processing to perform when the number of snapshot executions exceed the limit 

specified with $s970
0: Stop
1: Overwrite

(Blank)

976

Network camera Saving snapshot image, specification of image rotation
0: 0°
1: 90° clockwise
2: 180°
3: 90° counterclockwise

→ V Reference Manual 2
1.4 Network Camera

(Blank)

990 Recipe GET_RECIPE_FILEINFO macro execution result ← V Macro Reference 
Manual

(Blank)
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1000 Audio Stores the remaining seconds of audio playback.
← V Reference Manual 2

“2 Sound”1001 Audio Stores the adjusted volume value of channel L.
1002 Audio Stores the adjusted volume value of channel R.
1003
1004
1005 E-mail send Number of e-mails waiting to be sent

← V
Reference Manual 2

“6.8 E-mail 
Notification”1006 E-mail send Error information

1007 EPSON ESC/P-R supported Hard copy
→ V

page 16-2

1008 JPEG Used to set accuracy of reduced JPEG images. Reference Manual 2
“1.1 JPEG Display”

1009
Data sheet Consecutive printing (STA_LIST macro command)

0: Prohibited
1: Permitted

→ V -

1010
Data sheet Number of data sheets in print queue (STA_LIST macro command)_

Stores the number of data sheets in printing queue.(eight maximum)
* Enabled when $s1009 = 1. If the “STA_LIST” macro command is executed while eight data 

sheets are already in the queue, a macro execution error occurs.
← V -

1011
Data sheet Cancel (STA_LIST macro command)

Specifying “1” cancels the printing of data sheets in the queue. The value is automatically 
reset to “0” after cancellation.

* Enabled when $s1009 = 1.

→ V
← V -

(Blank)

1016

Version information acquisition
When the value is set with the MOV macro command, the version information is stored 
in $s 1018.
0: System program version 3: Font version 4: OS version
10: PLC1 driver version 11: PLC2 driver version
12: PLC3 driver version 13: PLC4 driver version
14: PLC5 driver version 15: PLC6 driver version
16: PLC7 driver version 17: PLC8 driver version
18: Simulator version 22:  Japanese conversion function (FEP) program version

→ V -

1017 (Blank)

1018 Version information
Stores version information based on the value set in $s1016. ← V -

(Blank)

1024

External storage device access result
Stores the result of when a file on a storage device of MONITOUCH is accessed from a 
client, such as V-Server, storage access DLL etc., in RUN mode.
0: Normal
−1: Error

← V -

(Blank)

1030 Built-in socket (drive: C) Storage device error state

← V

page 1-65
1031 Built-in socket (drive: C) Remaining space on storage device

Stores the amount of free space on the storage device. (Unit: kbyte) -
1032

1033
Built-in socket (drive: C) [Storage Removal] switch status

0: Switch OFF (removal prohibited)
Other than 0: Switch ON (removal permitted)

-

1034
1035 USB-A (drive: D) Storage device error state

← V

page 1-65
1036 USB-A (drive: D) Remaining space on storage device

Stores the amount of free space on the storage device. (Unit: kbyte) -
1037

1038
USB-A (drive: D) [Storage Removal] switch status

0: Switch OFF (removal prohibited)
Other than 0: Switch ON (removal permitted)

-

(Blank)

1050 Background Storage device access Background processing flag
← V

page 1-65
1051 Background Storage device access Background processing completion flag page 1-65
1052 Background Storage device access Background processing error flag page 1-65
1053
1054
1055
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1056 Macro execution result Arithmetic operation

← V Macro Reference 
Manual

1057 Macro execution result Conversion, transfer
1058 Macro execution result Comparison
1059 Macro execution result Macro operation control
1060 Macro execution result Printer
1061 Macro execution result Video/RGB/USB camera
1062 Macro execution result Storage device
1063 Macro execution result Others
1064
1065
1066 PictBridge Status output ← V page 1-66

1067
PictBridge Printer control

When a printer error occurs, set “1” to send an error reset signal to the printer.
After resetting the error, reset the value to “0”.

→ V -

1068 Network printer Status output ← V page 1-66

(Blank)

1070 Stores FTP information. ← V
Reference Manual 2

“6.9 FTP Server”1071 FTP client Stores the number of FTP clients logged into the server (maximum of 
3 clients). ← V

1072 FTP connection Forcibly disconnect the connection. → V

(Blank)

1085 SRAM forced formatting ← V page 1-66

(Blank)

1098 V8 compatible Sampling macro Background processing selection → V page 1-66
1099

1100 V8 compatible Buffer No. 0 Stores the number of sampling times set for the 
primary storage destination.

← V

page 1-68
when logging 

(alarm history/event 
history) is used

1101
Buffer No. 0 Stores the current number of sampling times of the 

primary storage destination.
(Set number of sampling times ($s1100) ≥ current number of sampling 
times ($s1101))

1102 Buffer No. 0 Stores the number of sampling times set for the 
secondary storage target.1103

1104 Buffer No. 0 Stores the current number of sampling times of the 
secondary storage destination.

(Set number of sampling times ($s1102 and1103) ≥ current number of 
sampling times ($s1104 and 1105))1105

1106 Buffer No. 0 Stores the number of sampling times executed.
1107
1108 Buffer No. 0 Secondary storage destination access status

page 1-66

1109 Buffer No. 0 Background processing flag
1110 Buffer No. 0 Sampling macro executing flag
1111 Buffer No. 0 Sampling macro execution completion flag
1112 Buffer No. 0 Sampling macro error flag
1113 Buffer No. 0 Sampling error flag
1114 Buffer No. 0 Sampling error forced storage flag → V

(Blank)

1120 - 
1134

V8 compatible Buffer No. 1  (Equivalent to buffer No. 0 $s1100 to 1114)  → V 
← V

Refer to
$s1100 - 1114

(Blank)

1140 - 
1154

V8 compatible Buffer No. 2  (Equivalent to buffer No. 0 $s1100 to 1114) → V 
← V

Refer to
$s1100 - 1114

(Blank)

1160 - 
1174

V8 compatible Buffer No. 3  (Equivalent to buffer No. 0 $s1100 to 1114)  → V 
← V

Refer to
$s1100 - 1114

(Blank)

1180 - 
1194

V8 compatible Buffer No. 4  (Equivalent to buffer No. 0 $s1100 to 1114)  → V 
← V

Refer to
$s1100 - 1114
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(Blank)

1200 - 
1214

V8 compatible Buffer No. 5  (Equivalent to buffer No. 0 $s1100 to 1114)  → V 
← V

Refer to
$s1100 - 1114

(Blank)

1220 - 
1234

V8 compatible Buffer No. 6  (Equivalent to buffer No. 0 $s1100 to 1114)  → V 
← V

Refer to
$s1100 - 1114

(Blank)

1240 - 
1254

V8 compatible Buffer No. 7  (Equivalent to buffer No. 0 $s1100 to 1114)  → V 
← V

Refer to
$s1100 - 1114

(Blank)

1260 - 
1274

V8 compatible Buffer No. 8  (Equivalent to buffer No. 0 $s1100 to 1114)  → V 
← V

Refer to
$s1100 - 1114

(Blank)

1280 - 
1294

V8 compatible Buffer No. 9  (Equivalent to buffer No. 0 $s1100 to 1114)  → V 
← V

Refer to
$s1100 - 1114

(Blank)

1300 - 
1314

V8 compatible Buffer No. 10  (Equivalent to buffer No. 0 $s1100 to 1114)  → V 
← V

Refer to
$s1100 - 1114

(Blank)

1320 - 
1334

V8 compatible Buffer No. 11  (Equivalent to buffer No. 0 $s1100 to 1114)  → V 
← V

Refer to
$s1100 - 1114

(Blank)

1360 Security function Stores the security level (0 to 15) of the currently logged-in user.

← V -
1361 Security function Stores the user ID of the currently logged-in user.
1362
1363
1364
1365 Operation log viewer Stores the number of the log file being displayed.

← V
-

1366 Operation log viewer Stores the number of the log folder being displayed. -

(Blank)

1380
Remote desktop Stores the start-up status.

0: Hidden (disconnected)
1: Shown (connected)

← V

Under development

1381
Remote desktop Stores the connection status._

0 or greater: Remote desktop table No.
−1: Disconnected
−2: Connection failure

Under development

(Blank)

1387
Stores EtherCAT connection errors.

← V
Communication 

Unit Specification 
EtherCAT

(Blank)

1400 Network table 100 status

← V Connection Manual

1401 Network table 101 status
1402 Network table 102 status

1553 Network table 253 status
1554 Network table 254 status
1555 Network table 255 status

(Blank)
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1560 Global overlap 3 Registration/display status_

← V

page 1-67

1561
Global overlap 3 Stores the X coordinate of the global overlap display position.

Dot: 0 to 1023
Column: 0 to 127

-

1562
Global overlap 3 Stores the Y coordinate of the global overlap display position.

Dot: 0 to 768
Column: 0 to 37

-

1563
Global overlap 3 Stores the global overlap library number.

Show: 0 to 9999
Hide: −1

-

(Blank)

1576

V8 compatible Logging [Constant Cycle]   Operation setting after start bit ON 
0: V10/V9 specifications   
    The first logging is performed after the set logging time has elapsed.
1: V8 specifications   
    The first logging is performed when the start bit is turned ON.

→ V page 7-1

(Blank)

1590

Details of the VNC client
0: Unconnected
1: Connected, monitor only
2: Connected, remote operation enabled
3: Connected, remote operation enabled (occupied: input from the V10/V9 unit disabled.)
-1: Connection prohibited
-2: Connection prohibited due to MAC address control

← V
Reference Manual 2

6.10 VNC Server

1591 - 
1598

Username of connected VNC client (16 bytes) ← V

(Blank)

1600 Drawing cycle time (msec) ← V -
1601
1602 PLC1 read cycle time (msec)

← V -

1603 PLC2 read cycle time (msec)
1604 PLC3 read cycle time (msec)
1605 PLC4 read cycle time (msec)
1606 PLC5 read cycle time (msec)
1607 PLC6 read cycle time (msec)
1608 PLC7 read cycle time (msec)
1609 PLC8 read cycle time (msec)

(Blank)

1617 Overlap 4 Registration/display status

← V page 1-61

1618 Overlap 4 Display position X
1619 Overlap 4 Display position Y
1620 Overlap 4 Overlap library number
1621 Overlap 5 Registration/display status
1622 Overlap 5 Display position X
1623 Overlap 5 Display position Y
1624 Overlap 5 Overlap library number
1625 Overlap 6 Registration/display status
1626 Overlap 6 Display position X
1627 Overlap 6 Display position Y
1628 Overlap 6 Overlap library number
1629 Overlap 7 Registration/display status
1630 Overlap 7 Display position X
1631 Overlap 7 Display position Y
1632 Overlap 7 Overlap library number
1633 Overlap 8 Registration/display status
1634 Overlap 8 Display position X
1635 Overlap 8 Display position Y
1636 Overlap 8 Overlap library number
1637 Overlap 9 Registration/display status
1638 Overlap 9 Display position X
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1639 Overlap 9 Display position Y
← V page 1-61

1640 Overlap 9 Overlap library number

1641
Screen magnification

Stores the current magnification of the screen (unit: %).
100 (includes case when no magnification is set), 150, 200

← V
Reference Manual 2
“7.1 Enlarging and 
Scrolling Screens”

(Blank)

1647 Processing cycle Stores the time set at [Constant Cycle 1] for the currently displayed screen. 
(Unit: 100 ms)

← V page 1-401648 Processing cycle Stores the time set at [Constant Cycle 2] for the currently displayed screen. 
(Unit: 100 ms)

1649 Processing cycle Stores the time set at [Constant Cycle 3] for the currently displayed screen. 
(Unit: 100 ms)

1650 Scheduler Time setting (device memory specification) error flag (No. 0 to 15)
Correct: 0, Incorrect: 1

← V Reference Manual 2
“3 Scheduler”

1651 Scheduler Time setting (device memory specification) error flag (No. 16 to 31)
Correct: 0, Incorrect: 1

1652 Scheduler Time setting (device memory specification) error flag (No. 32 to 47)
Correct: 0, Incorrect: 1

1653 Scheduler Time setting (device memory specification) error flag (No. 48 to 63)
Correct: 0, Incorrect: 1

(Blank)

1655

Data sheet: PDF output error information
0: Normal termination
1: Out of storage capacity
2: File size error (the PDF file will exceed 50MB after appending data)
3: Other errors

← V page 16-28

1656 STA_LIST macro command Specification of data sheet output destination and output method → V page 1-67

1657
Ethernet Status (LAN2)

0: Normal
801: Link down

← V Connection Manual

1658
Ethernet Status (WLAN)

0: Normal
801: Link down

← V Connection Manual

(Blank)

1669
Wait time setting for data block switching

0 to 65535 msec
* Enabled when the [Update info output device (data block No.) of input mode at the start 

of switching data block.] checkbox is selected in the [General Settings] tab window.
→ V page 1-27

(Blank)

1671

Operation designation with the following macro commands
SMPL_BAK,  SMPL_CSV,  SMPL_CSV2,  SMPLCSV_BAK,  SMPLCSV_BAK2, SYS(SET_BUFNO),  SYS 
(GET_SMPL)

0: V8 compatible operation
1: Logging server designation
2: Alarm server designation
3: Item designation (SYS (GET_SMPL) only)

→ V
Macro Reference 

Manual
1672

SYS (GET_SMPL) macro command  Obtained alarm data type designation
(only when $s1671 = 2)

0: Event history data
1: Real time alarm data
2: Alarm history data

1673
SAMPLE, SMPL_SAVE macro commands  Operation designation

0: V8 compatible operation
1: V10/V9 initial operation

1674 VNC server state (SYSTEM PROGRAM Ver. 1.050 or higher)
0: Not connected, 1: Connected ← V Reference Manual 2

6.10 VNC Server

1675 VPN connection status
0: No VPN setting, 1: VPN connected, −1: VPN disconnected → V Web Machine 

Interface

(Blank)

1679 VPN server link status
0: No VPN setting, 1: VPN connected, −1: VPN disconnected → V Web Machine 

Interface

(Blank)
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1690
Data transfer service  Confirmation of FTP communication status

0: No communicating
1: Uploading
2: Downloading

← V
Reference Manual 2
6.11 Data Transfer 

Service1691 Data transfer service  Record number in execution
(only when $s1690 = 1 or 2)

1692 Data transfer service  Server table number in execution
(only when $s1690 = 1 or 2)

(Blank)

1705
SYS(SET_BUFNO) macro command  Storage of logging block number
(only when $s1671 = 1)

Stores the logging block number specified by the macro. Default value: -1
← V Reference Manual

1706
SYS(SET_BUFNO) macro command  Storage of alarm block number
(only when $s1671 = 2)

Stores the alarm block number specified by the macro.
← V Macro Reference 

Manual

(Blank)

1720

Function setting for the logging block 0 or the alarm block 0
$s1100 through $s1114 stores the information of block 0 by setting the value with the initial 
macro.

0: Logging or alarm (V8 compatible)
1: Logging (V10/V9)
2: Alarm history (V10/V9)
3: Event history (V10/V9)

→ V page 1-68

1721
Function setting for the logging block 1 or the alarm block 1
$s1120 through $s1134 stores the information of block 1 by setting the value with the initial 
macro.

1722
Function setting for the logging block 2 or the alarm block 2
$s1140 through $s1154 stores the information of block 2 by setting the value with the initial 
macro.

1723
Function setting for the logging block 3 or the alarm block 3
$s1160 through $s1174 stores the information of block 3 by setting the value with the initial 
macro.

1724
Function setting for the logging block 4 or the alarm block 4
$s1180 through $s1194 stores the information of block 4 by setting the value with the initial 
macro.

1725
Function setting for the logging block 5 or the alarm block 5
$s1200 through $s1214 stores the information of block 5 by setting the value with the initial 
macro.

1726
Function setting for the logging block 6 or the alarm block 6
$s1220 through $s1234 stores the information of block 6 by setting the value with the initial 
macro.

1727
Function setting for the logging block 7 or the alarm block 7
$s1240 through $s1254 stores the information of block 7 by setting the value with the initial 
macro.

1728
Function setting for the logging block 8 or the alarm block 8
$s1260 through $s1274 stores the information of block 8 by setting the value with the initial 
macro.

1729
Function setting for the logging block 9 or the alarm block 9
$s1280 through $s1294 stores the information of block 9 by setting the value with the initial 
macro.

1730
Function setting for the logging block 10 or the alarm block 10
$s1300 through $s1314 stores the information of block 10 by setting the value with the initial 
macro.

1731
Function setting for the logging block 11 or the alarm block 11
$s1320 through $s1334 stores the information of block 10 by setting the value with the initial 
macro.

(Blank)

1752
USB camera port number

Fixed to “1” ← V
Reference Manual 2

1.2 USB Camera 
Display

(Blank)

1760

TELLUS HMI Charged state of tablet
1:  Battery capacity more than 66%
2:  Battery capacity less than 33%
4:  Battery capacity less than 5%
8:  Charging
128:  No system battery exists (desktop PC etc.)
255:  Unknown state (unable to read battery flag information)

← TELLUS -

1761 TELLUS HMI Remaining battery, Unit: % (255 is stored when $s1760 = 128) ← TELLUS -

1762 TELLUS HMI AC power supply state
0: Offline, 1: Online, 255: Unknown state ← TELLUS -

$s Description Device Type Refer to
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(Blank)

1770 - 
1773

Stores the IP address in the LAN2 settings of the V10/V9 series unit ← V -

1774 - 
1777

Stores the IP address in the WLAN settings of the V10/V9 series unit (when WLAN setting is 
enabled) ← V -

(Blank)

1807
Data sheet printingLine spacing setting (serial connection only)

0: 1/6 inches (default)
1: 1/8 inches (minimum) Same as line spacing setting “0” of “OUT_PR” macro command

→ V page 16-28

(Blank)

1815

[Comm. Error Handling: Disconnect] Reconnection processing setting
0: After disconnection, reconnection is attempted at the interval set at [Recovery Time] only 

if there is a need to access a device memory of the disconnected station for the currently 
displayed screen (V10/V9 specifications).

1: After disconnection, reconnection is attempted at the interval set at [Recovery Time] (V8 
specifications).

→ V -

(Blank)

1840

SAMPLE macro Operation setting
0: Acquire data of the specified logging/alarm block.
1: Acquire data of the logging part that is currently displayed (data of backup files can also 

be acquired).
When cursor is displayed: Data at the cursor position is acquired.
When cursor is hidden: The latest value of the currently displayed data is acquired.

→ V Macro Reference 
Manual

(Blank)

2047

$s Description Device Type Refer to
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Details
• $s2 - 13, $s1617 - 1640

Stores the current overlap display status.

• $s16
Stores the current printer status.

• $s17
Stores the current backlight status. Whether the backlight is burnt out is stored.

• $s20 to 55 (V7 compatible)
Stores sampling buffer conditions.

• $s66
Repeat the switch ON macro. Set a number other than “0” to $s66 using the ON macro.
Example: Set the switch ON macro as shown below.

$u100 = $u100 + 1
$s66 = 1
RET

While the switch is held down, $u100 is continuously incremented.
* Before executing the switch ON macro, the system clears addresses $s64 to 66 to “0”.

Set “1” to these addresses as necessary.
When a macro is repeatedly commanded to repeatedly execute the function of switch, the macro will be prohibited if 
the function cannot be executed. (For example, when the switch function is [+ Block] and the block number has 
reached the maximum value.)

Buffer No. 0 to 11
n + 0 [No. of Samples] specified in the [Buffering Area Setting] window
n + 1 Number of sampling times in buffer (n + 0 ≥ n + 1)
n + 2 Number of sampling times executed

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

Overlap registration *
0: None 1: Registered

n + 0 (Display status)

Display status
0: Hidden 1: Shown

* For multi-overlap display, this bit is set to “1” only during display.
However, the bit remains set to “1” even during display hidden status when [Read PLC Device when 
OFF] is checked in the [Detail] settings of overlap library settings.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

X coordinate display dot: 0 to 1023
Column/line: 0 to 127

n + 1 (X coordinate)

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

Y coordinate display dot: 0 to 767
Column/line: 0 to 37

n + 2 (Y coordinate)

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

Multi-overlap number: 0 to 9999
For hiding multi-overlap display: −1
For normal overlap or call-overlap: −1

n + 3 (Multi-overlap number)

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
Printer status
0: READY 1: BUSY

n + 0 (Printer status)

0: Print standby
1: Printing

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

n + 0 (Backlight status)

0: OFF 1: ON0: Backlight burnt out 1: Backlight normal
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• $s75
This address is used to activate or deactivate the buzzer which sounds when the top overlap display among multiple 
overlap displays is switched over. For an overlap display with [Superimpose] selected, the buzzer is inactive regardless of 
the setting of $s75.

[0]: Buzzer ON
[1]: Buzzer OFF

• $s78
Stores the display format of data in the entry target.

• $s79
This setting is available when the entry mode is switched through the overlap activation (ON/OFF) or by multi-overlap 
number change on one screen.

* Do not set any value other than “0” or “1”.
[0]: Selects the last entry target selected in the entry mode.
[1]: The entry target currently selected remains selected even after the mode is switched.

• $s99
Specify the rounding operation to use with the CVFD macro command.

• $s104 and $s105
Specify the error handling performed when an error occurs during the reading/writing of data to the PLC using a macro 
command via communications.
Example:
When an indirect PLC device memory is set as the writing destination using the MOV command, a communication error 
will occur if the value in the indirect PLC device memory exceeds the range of the PLC device memory.
Use these addresses to avoid such a communication error.
- $s104: [0]

When the write macro command is executed, the next command is started without waiting for the result of the macro 
write command.
If an error occurs during writing, error handling is performed.
The error handling to be performed depends on the setting for [Comm. Error Handling] (“Stop” or “Continue”) under 
[Communication Setting] in the [PLC Properties] window.

- $s104: Other than [0]
When the write macro command is executed, the next command is started only after receipt of the result of the write 
operation. If an error occurs during writing, error handling is not performed and the result is stored in $s105. It will take 
a longer time compared to when “0” is set.

$s105: When $s104 ≠ 0, the result of the macro write error is stored.
[0]: Normal
Other than [0]: Error

Output Code Entry Target Display Format
−2 No entry mode -
−1 No entry target -
0

Numerical data display

Decimal without sign
1 Decimal with sign (−)
2 Decimal with sign (+)
3 Hexadecimal
4 Octal
5 Binary
6 Character display -
7 Message display other than entry target -
8 Numerical data display Real number (floating decimal point)

Setting Value Description Operations

Other than 1 or 2 Rounding
When the fraction remainder is 0.5 or 
greater, it is rounded up; when it is less than 
0.5, it is rounded down.

1 Rounding down The fraction remainder is rounded down.

2 Rounding up The fraction remainder is rounded up 
unless it is “0”.
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• $s107
The information of whether or not data is registered in each page of the memo pad (maximum 8 pages) is stored.

• $s128, 129, 114 to 127 (V7 compatible)
When the connection mode is [1 : n] and a timeout is detected in communication with PLC1, “1” is set at the related bit. 
After that, it is not possible to communicate with the PLC on the same screen.
When the screen display changes, all bits in these device memory are cleared to “0” to enable communication with the 
PLC set to the screen program.

• $s160 - 166
Stores the calendar data that is read from the PLC or is currently displayed on MONITOUCH at the start of communication.

• $$s177
Stores the buffer number for which the SET_BUFNO macro command was executed. When the power is turned on, the 
lowest buffer number in the [Buffering Area Setting] window is stored.

• s178, 179
When the total value overflows after the execution of the SET_BUFNO macro command, the bits corresponding to sample 
word numbers 0 to 31 are set to “1”.
Sample buffer word numbers 32 to 128 are not available.

• $s180 - 435
Stores the result of the SET_BUFNO macro command execution.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0: Data not registered
1: Data registered

Page 0
Page 1

Page 2
Page 3

Page 4
Page 5

Page 6
Page 7

$s107

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

Port No. 15 Port No. 00

$s128

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

Port No. 31 Port No. 16

$s129

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

Port No. 47 Port No. 32

$s114

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

Port No. 255 Port No. 240

$s127

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

Word 15 Word 00

$s178

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

Word 31 Word 16

$s179
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• $s468 - 485
Stores memory card information (card number, card name, file number) to the specified device memory address. Use the 
MOV macro command.
The value in $s468 to 485 is always “0“.

- Read: [n = $s468 (to 485)] macro is executed and device memory “n“ is monitored.
- Write: [$s468 (to 485) = n] macro is executed and data in device memory “n“ (to n + 16) is stored on the storage 

device.
Example 1

Macro  $u100 = $s468
Stores the card number in $u100.

Example 2
Macro  $u101 = $s469
Stores the card name (32 bytes) in $u101 to 116.

Example 3
Macro  $u117 = $s470
Stores the file name of the file No. 0 (32 bytes) in $u117 to 132.

• $s497
Outputs the result of accessing the storage device.

• $s514, 515
These devices are relevant to the EREAD, EWRITE, SEND, and MES macro commands.

- $s514: Macro wait request
In the case of successive accesses to the same port on a single macro sheet, always specify a value other than “0” 
(with wait). If “0” (no wait) is specified, macro commands issued afterward will not be accepted.
[0]: No wait
During the execution of a macro command, the execution of the next macro command takes place before the 
completion of the current command.
[Other than 0]: With wait_
During the execution of a macro command, the next macro command is put on hold and is executed after the 
completion of the current command.

- $s515: Storage of the macro execution result
When $s514 is “0”, the macro command request is stored (response not included). When a value other than “0” is set, 
the response returned to the command request is stored.

4 Card not mounted
5 Format error
9 JPEG/BMP file read error
12 Card write error
15 Disk error (open failure)
16 Card read error

Code Description Solution
0 Normal -

200 to 2001

Communication error between a device 
targeted by a macro command and a 
connected device
Target device

V10, V9, X1: 801 (link down)
V8, TS2060i, V7, V6: 200 to 2001

A communication error code is stored when the device 
targeted by a macro command and a device are connected via 
Ethernet.
For error contents and solutions, refer to the connection 
manual of the target device.

−8 Communication unavailable  Inaccessible Check whether the counterpart unit is running normally.
−32 The specified table is not used. Check the network table settings.

−34 The specified table is in use. Check whether system device memory address $s514 is set. If 
not setting $s514, reduce the number of communications.

−40
Setting data error Check that [Write], [Read], and [Search condition] settings are 

configured for the specified MES setting number.
Check that the configured data is correct.

−51 Specified address error Check whether the specified address is correct.
For a $L address, check whether the address has not been set.

−60 to −65 MES stand-alone error Refer to “6.7 MES Interface Function” in the Reference Manual 
2.
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• $s814 - 818
Stores the IP address of the network table number corresponding to the value *1 set for $s818. If no network table exists, 
“0.0.0.0” is stored.

*1 Use the MOV (W) macro command to set the network table number.

• $s1030
Outputs the result of access to the storage device at the built-in socket (drive: C).

• $s1035
Outputs the result of access to the storage device at USB-A (drive: D). Same details as $s1030.

• $s1050
Outputs the status of the operation related to the storage device.

* When a screen program contains a V8-compatible logging block or alarm block and a macro command is used to 
trigger backup or CSV output, set $s1098 to other than “0”.

• $s1051
Outputs the status of the completed operation related to the storage device.

• $s1052
If an error occurs on completion of processing related to the storage device, the result is output.

4 Card not mounted
5 Format error
9 JPEG/BMP file read error
12 Card write error
15 Disk error (open failure)
16 Card read error

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

Sampling data 
backup/CSV output *

0: Not processed
1: In processing

Hard copy macro
0: Not processed
1: In processing

Operation log
0: Not processed
1: In processing

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

Sampling data 
backup/CSV output

0: Not completed
1: Completed

Hard copy macro
0: Not completed
1: Completed* The user must clear data in the device 

memory on completion of the operation.

Operation log
0: Not completed
1: Completed

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

Sampling data 
backup/CSV output

0: Normal
1: Error

Hard copy macro
0: Normal
1: Error* The user must clear data in the device 

memory on completion of the operation.

Operation log
0: Normal
1: Error



1  System

1-66

• $s1066
Outputs the status of printing performed on the PictBridge printer.

* The error may be output as “−1” (printer error related to hardware) depending on the printer used.

• $s1068
Outputs the status of printing performed on the network printer.

• $s1085
Stores information regarding forced formatting of the SRAM area.
This is available when the [Format the SRAM forcefully] checkbox is selected in the [General Settings] window.

[0]: Forced formatting not executed.
[1]: Forced formatting executed (cleared to “0” when the mode changes from RUN to STOP).

• $s1098
Other than [0]:
Executes background processing of the “SMPL_BAK”, “SMPL_CSV”, and “SMPL_CSV_BAK” macro commands. However, if 
background processing is being executed to the buffer that has been specified, the next processing is started on 
completion of the current macro processing.

• $s1108
The media status at the secondary storage destination, sampling formatting condition, etc. are comprehensively judged 
and the valid/invalid state of the secondary storage destination is output.

[0]: Writing or browsing the secondary storage destination is not possible.
[1]: Writing or browsing the secondary storage destination is possible.

• $s1109
Outputs the status of creating a backup file or CSV output.

Other than [0]: Backup file being created or CSV file outputted

• $s1110
Outputs the status of sampling macro commands when $s1098 is set to other than “0”.

Other than [0]: Execution of the “SMPL_BAK”, “SMPL_CSV”, or “SMPL_CSV_BAK” macro command is in progress.

• $s1111
Outputs the status of sampling macro commands.

Other than [0]: Execution of the “SMPL_BAK”, “SMPL_CSV”, or “SMPL_CSV_BAK” macro command is complete.
* This is cleared when $s1110 (executing flag) is set to ON.

Value Description Cause and Remedy
0 The PictBridge printer is not connected or it is in the 

normal state.
-

1 Printing in progress using the PictBridge printer. -
−1 Printer error (hardware related) The cable is not connected. Check the USB cable connection.

Check if the printer is out of order.
−2 Printer error (paper related) The printer ran out of paper. Add paper.

The type of paper is not correct. Set the correct type of paper.
−3 Printer error (ink related) * The ink is not installed. Install an ink cartridge.
−4 The ink level is low. Install a new ink cartridge.

Value Description Cause and Remedy
0 The network printer is not connected or it is 

in the normal state.
-

1 Printing is in progress. -
−1 Printer error (hardware related) Check if the printer is out of order.
−2 Printer error (paper related) The printer ran out of paper. Add paper.

The type of paper is not correct. Set the correct type of paper.
−3 Printer error (ink related)* The ink is not installed. Install an ink cartridge.

The ink level is low. Install a new ink cartridge.
−4 Printer error (network related) A connection with the network printer cannot be established. Check the 

network connection settings of the V10/V9 series unit and the printer.
* The error may be output as “−1” (printer error related to hardware) depending on the printer used.
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• $s1112
Outputs the status of sampling macro commands.

Other than [0]: Execution error of the “SMPL_BAK”, “SMPL_CSV”, or “SMPL_CSV_BAK” macro command
* This is cleared when $s1110 (executing flag) is set to ON.

• $s1113
Outputs the sampling status.

Other than [0]: A communication error occurred during sampling.
* This is cleared when sampling is performed normally. Sampling information of device memory map (V8 specifications) is not output.

• $s1114
Outputs the sampling status.

Other than [0]: If a communication error occurs during sampling, sampling will continue by resetting the data to “0” 
in the device memory where the error occurred.

* Sampling of device memory map (V8 specifications) is performed regardless of the setting of this flag, with the data regarded as “0” in 
the device memory where an error occurred.

• $s1560
Stores the global overlap 3 display status.

• $s1656
Selects the data sheet output destination and the output method using bit statuses.
This setting is available when using the STA_LIST macro.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

Overlap registration *
0: None 1: Registered

n + 0 (Display status)

Display status
0: Hidden 1: Shown

* This bit is set to “1” only during display.
However, the bit remains set to “1” even the display hidden status when [Read PLC Device when 
OFF] is checked in the [Detail] settings of overlap library settings.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0: Printer
1: Storage device (PDF output)

0: With time stamp
1: Without time stamp

0: Use default sub-folder
1: Designate sub-folder name

0: Overwrite
1: Add
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• $s1720 - 1731
Used to store information in $s1100 through $s1134 for blocks that do not display (V8 compatible) on the logging/alarm 
server.
Set the following value in the initial macro according to the function used in blocks No. 0 to No. 11.

0: Logging or alarm (V8 compatible)
1: Logging (V10/V9)
2: Alarm history (V10/V9)
3: Event history (V10/V9)

Example)  For the settings shown below:

Execute the following macro commands in the initial macro.
$s1722=1(W) ;Logging block No.2
$s1723=2(W) ;Logging block No.3 Alarm history
$s1724=3(W) ;Logging block No.4 Event history

Caution
• If both the logging server and the alarm server have the same block number, information for either one is stored.

If both pieces of information are required, avoid overlapping block numbers.
• The logging server and alarm server can create 12 blocks each, but the $s to store the information is a total of 12 

blocks for logging and alarms.
• It works by setting the value with the initial macro. Changes made during the RUN mode are invalid.



2 Overlap

2.1 Overview

2.2 Normal Overlap

2.3 Call-overlap

2.4 Multi-overlap

2.5 Global Overlap

2.6 Display Transparency





2.1    Overview

2-1

1

2

3

4

5

6

7

8

9

10

2.1 Overview
2.1.1 Overlap Displays

Windows can be displayed on the screen. These overlaying windows are called “overlap” displays.

Each screen has an overlap display area ID from 0 to 9, and 10 overlaps can be displayed at once.
* Overlap ID: An ID that identifies an overlap display on the screen.

000,000

00 sec.

Line A Paint Process Line A Paint Process

Counter
Timer

Error contents Error contents

Screen 
Change Screen 

Change

A

Error 
Detail

Error 
Log

B C D

Num. 
Display

Monitor

Menu

1135

120

1564

554

1653

10.23

9.89

7.23

11.02

12.03

849

988

489

156

484

5548

6615

4485

9981

1165

0 . +/- CR

1 2 3 CL

4 5 6 DW

7 8 9 UP

Line B Monitor

Line A Error!

Error Detail

Do you want to save the setting?

YES NO

Base screen

Overlap ID 0

Overlap ID 1

Overlap ID 2

Overlap ID 3 (global overlap)

Line A

Overlap ID 9

Line B Line C Alarm
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When several overlap displays are shown at the same time, it is possible to move an overlap display that is partly behind 
another to the foreground by touching the screen.

* However, when a value other than “0” is entered for system device memory $s77, only the switches (including system 
buttons) on the overlap display in the foreground are available (exclusive function).

• Scrolling function
Overlap displays up to four times larger than the normal overlap display size can be registered. When an overlap display 
is partially off-screen, the overlap display can be scrolled to display the off-screen content.

• Transition function
Slide and fade effects can be added when displaying overlap displays using a switch function.

“1.3 List of Internal Device Memory”

“Scroll” page 2-10

“Transition” page 3-12

1135

120

1564

554

1653

10.23

9.89

7.23

11.02

12.03

849

988

489

156

484

5548

6615

4485

9981

1165

0 . +/- CR

1 2 3 CL

4 5 6 DW

7 8 9 UP
1135

120

1564

554

1653

10.23

9.89

7.23

11.02

12.03

849

988

489

156

484

5548

6615

4485

9981

1165

0 . +/- CR

1 2 3 CL

4 5 6 DW

7 8 9 UP

Line B Monitor

Line A Error!

Error Detail

Do you want to save the setting?

YES NO

Line B Monitor

Line A Error!

Error Detail

Do you want to save the setting?

YES NO

Only the switches on 
this overlap display 
are available.

Menu

1135

120

1564

554

1653

10.23

9.89

7.23

11.02

12.03

849

988

489

156

484

5548

6615

4485

9981

1165

1135

120

1564

554

1653

10.23

9.89

7.23

11.02

12.03

849

988

489

156

484

5548

6615

4485

9981

1165

849

988

489

156

484

5548

6615

4485

9981

11651651484

OverlapOverlap
5

0

10.23

9.89

849

988

5548

66150

55

Registration size
2 times vertical × 
2 times horizontal V10/V9 series unit

Top left quadrant is displayed. Scroll toward the top left to display 
the bottom right quadrant.

V10/V9 series unit

ONON ON

lap Overlap

Overlap display

Slide in from left side Transition complete



2.1    Overview

2-3

1

2

3

4

5

6

7

8

9

10

2.1.2 Overlap Display Formats
Overlap displays comprise the following four formats.

Normal Overlap
This overlap display format is unique to each screen.
An overlap display created for screen 1 cannot be displayed on other screens.
A normal overlap display can be shown or hidden using a switch or command from the PLC.

Overlap Refer to
Normal overlap page 2-3, page 2-8
Call-overlap page 2-4, page 2-14
Multi-overlap page 2-5, page 2-18
Global overlap page 2-6, page 2-24

Directly place a “normal overlap” display on overlap ID 0.

Menu

Screen 1

Overlap ID 0 Overlap ID 1 Overlap ID 9

Screen 10

Menu

Overlap ID 0 Overlap ID 1 Overlap ID 9
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Call-overlap
This overlap display format calls and displays overlaps registered to the overlap library.
Because overlap displays are called from the library, they can be shared between multiple screens.

An overlap library number is set with respect to the overlap IDs from 0 to 9 on each screen.
A maximum of ten overlaps can be displayed at once. A call-overlap display can be shown or hidden using a switch or 
command from the PLC.

1135

120

1564

554

1653

10.23

9.89

7.23

11.02

12.03

849

988

489

156

484

5548

6615

4485

9981

1165

4407

4508

4356

4640

4412

10.23

9.89

7.23

11.02

5.89

849

988

489

156

780

126

129

189

172

168

540

561

587

510

532

9.81

9.89

7.23

11.02

6.92

1154

1141

1205

1195

1179

105.6

100.6

99.8

115.2

92.5

0 . +/- CR

1 2 3 CL

4 5 6 DW

7 8 9 UP

Line B Monitor

Menu

Line D Monitor

Menu

Line G Monitor

Menu

Menu

Screen 5 Screen 12 Screen 15

Overlap library

Error Detail
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Multi-overlap
This overlap display format calls and displays overlaps registered to the overlap library.
Because overlap displays are called from the library, they can be shared between multiple screens.

An overlap library number that can be switched between 0 and 9999 can be set with respect to a single overlap ID.
A maximum of 10 overlaps can be displayed at once and 4000 types of overlaps can be selected by switching the overlap 
library number. A multi-overlap display can be shown or hidden using a switch or command from the PLC.
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Global Overlap
This overlap display format calls and displays overlaps registered to the overlap library.
Because overlap displays are called from the library, they can be shared between multiple screens.
An overlap library number that can be switched between 0 and 9999 can be set with respect to a single overlap ID. A 
maximum of 10 overlaps can be displayed at once and 4000 types of overlaps can be selected by switching the overlap library 
number. A global overlap display can be shown or hidden using a switch or command from the PLC.

The same overlap display is shown even if the screen changes to another screen.
Because this overlap format is not affected by screen changes, it is well suited to high-urgency alarm displays.
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the setting?
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2.1.3 Overlap Auxiliary Functions
System Buttons
The system button overlap auxiliary function operates in the following two ways.

Overlap Movement
Touch the top left corner (2 x 2 switch grid) of the overlap display to make the overlap frame blink.
With the overlap frame blinking, touch a position on the screen once to move the overlap display to that position. (The frame 
stops blinking after the overlap display is moved.)

If the overlap display will protrude off-screen at the new position, the protrusion is automatically adjusted so that the entire 
overlap display is shown on-screen.
To stop the overlap frame blinking (and cancel the movable state), touch the top left corner of the overlap display again.

Hiding the Overlap Display
Double-touch (touch the screen twice within one second) the top left corner (2 x 2 switch grid) to hide the overlap display.

Setting system buttons
The system button can be set in the [Detail] setting of the setting window for each overlap.

Display Transparency
When an overlap is displayed, it blocks the display of anything behind it. By using transparency, an overlap can be displayed 
while retaining the ability to check information behind it.

“Detail” page 2-10

Touch somewhere outside the overlap 
display on the screen while the frame 
is blinking.

The overlap display is moved with its 
top left corner aligned to the touched 
position and the frame stops blinking.

Overlap

Overlap

Touch within the 2 x 2 switch 
grid twice.

The overlap display disappears 
from the screen.

Blip!
Blip!
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5548

66158 688 68 6668 6

Overlap
(with transparency)

Line A Error!

Error 
Detail

“2.6 Display Transparency”
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2.2 Normal Overlap
2.2.1 Creation Procedure

Use the following procedure to create a normal overlap.

1. Click [Parts] → [Overlap] → [Normal Overlap] and place an overlap.

2. Adjust the size of the overlap.
3. Select [Overlap Editing] → [ID 0] on the right-click menu. The overlap editing window is displayed.

4. Place switches, lamps, and other items on the overlap.
5. Select [Overlap Editing] → [ID 0] on the right-click menu. The user is returned to the screen editing window.

6. If performing showing/hiding with a switch, place a switch. page 2-11

7. If performing showing/hiding with commands from a PLC, configure the [Control Device] settings. page 2-13
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2.2.2 Detailed Settings
Status of Use

Style

Item Description
Registration Status Check the registration status of overlap IDs 0 to 9. “- Editing -” is shown for the ID that is currently being 

edited.
The overlap ID can also be changed to an unregistered ID.

Control Device Specify a device using one bit. Showing and hiding is performed according to the value of the least 
significant bit.

0 → 1: Show
1 → 0: Hide

* Select the [Display Overlap during bit ON] checkbox at [System Setting] → [Unit Setting] → [General 
Setting] to allow level operation. Refer to page 2-13.

Information Output Device Specify a device using one bit. Stores the overlap display status.
0: Hide
1: Shown

Item Description
Area Setting
Frame

Set the design and color of the area.

Make display area 
transparent

Make the overlap area transparent.
Only the items placed on the overlap are displayed on the V10/V9 series unit.
The transparency of placed items can be set via [Detail] → [Transparency Display].

Refer to the Operation Manual.
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Scroll

Detail

Item Description
Display Size Setting Use [Magnification] to set the editing size of the overlap.

1 times vertical × 1 times horizontal / 1 times vertical × 2 times horizontal 
1 times vertical × 3 times horizontal / 1 times vertical × 4 times horizontal
2 times vertical × 1 times horizontal / 2 times vertical × 2 times horizontal 
3 times vertical × 1 times horizontal / 4 times vertical × 1 times horizontal

Detail Settings Display a scroll bar 
during scroll

Display a scroll bar at the right edge and bottom when scrolling. The scroll bar itself cannot be 
operated.

Enable inertial 
scrolling

Allow scrolling to continue after releasing your finger from the screen when scrolling. The speed of 
scrolling gradually decreases until it stops.

Enable bounce 
scrolling

Scrolling will bounce to indicate that movement in the particular direction has reached its limit.
A black frame is displayed momentarily.

Refer to “7.1 Enlarging and Scrolling Screens” in the Reference Manual 2.

Item Description
Auxiliary 
Function

System buttons Select this checkbox to use system buttons. Refer to page 2-7.
Transparency 
Display

Select this checkbox to enable transparency. Refer to page 2-32.

Input Cursor Movement Control 
Device

This setting is required to use the “entry function” on an overlap display.
For details, refer to page 6-37.

Coordinate Start X/Start Y Set the display position of the overlap using X and Y coordinates.
Width/Height Set the size of the overlap.

Scroll and then 
release finger

Scrolling continues

Right edge of the screenRight edge of the screen Black bar
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2.2.3 Show/Hide Settings
There are three methods for showing and hiding normal overlap displays.

Switch
Settings for showing
1. Display the settings menu of the normal overlap display.
2. Click [Go to Control SW Placement] and place a switch.

3. Set the function of the switch.

Method Error Detail Refer to
Internal command Switch Function: Overlap Control

Set Display No.: Unselected
page 2-11

Macro OVLP_SHOW
OVLP_POS

page 2-12

External Command Control device memory 0 → 1: Show
1 → 0: Hide

page 2-13

Function Overlap Control
Overlap ID Specify the same ID as the [Overlap ID] of the normal overlap.
Control Operation ON: Show

ALT: Alternate between show and hide
Set Display No. Unselected

Used by setting a control switch.
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Settings for hiding
1. Display the settings menu of the normal overlap display.
2. Click [Go to Control SW Placement] and place a switch.
3. Set the function of the switch.

• Hiding using a switch placed on the base screen

• Hiding using a switch placed on the overlap display

Macro
A macro can be used to show and hide normal overlap displays. In this case, use the “OVLP_SHOW” command.
The “OVLP_POS” command is used to specify the display position. For details, refer to the Macro Reference Manual.

Setting
1. Creating a macro for showing an overlap display

1) Display the [Macro Block No. Editor] window.
2) Register the following macro.

3) Execute the macro block in a switch ON macro or global macro.

2. Creating a macro for hiding an overlap display
1) Display the [Macro Block No. Editor] window.
2) Register the following macro.

3) Execute the macro block in a switch ON macro or global macro.

Function Overlap Control
Overlap ID Specify the same ID as the [Overlap ID] of the normal overlap.
Control Operation OFF: Hide

ALT: Alternate between show and hide
Hide the overlap where this 
switch is placed

Unselected

Set Display No. Unselected

Function Overlap Control
Hide the overlap where this 
switch is placed

Selected

Set Display No. Unselected

$u100 = 2 (W) Set an overlap ID from 0 to 9 (ID2 in this example).
$u101 = 1 (W) Overlap display
SYS (OVLP_SHOW) $u100 Execute the command.

$u100 = 2 (W) Set an overlap ID from 0 to 9 (ID2 in this example).
$u101 = 0 (W) Hide the overlap display
SYS (OVLP_SHOW) $u100 Execute the command.
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Control Device Memory
Setting
1. In the normal overlap settings menu, click [Status of Use] and configure the [Control Device] settings.

2. The overlap is shown when the [Control Device] bit is ON and hidden when the bit is OFF.

* Recognition of bit status
The method used for bit recognition differs depending on the setting of [Display Overlap during bit ON] on the [General 
Settings] tab accessible by clicking [System Setting] → [Unit Setting] → [General Setting].
• Unselected:

The change (edge) from 0 to 1 or 1 to 0 is used to recognize bit status.
• Selected:

Level recognition is used to determine the bit status.
Suppose that an overlap display was shown on the screen using an external command, the screen was switched to 
another screen, and then the first screen is displayed again. In this case, the overlap display that corresponds to the bit 
being turned ON appears on the screen.

* Notes on showing an overlap display using an external command
A switch for [Function: Overlap Control = OFF] can be used to hide the overlap display. Using this type of switch hides the 
overlap display with the bit of the control device memory still turned ON. To show the overlap display again, the bit needs 
to be turned OFF and ON again.
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Bit 0 of [Control Device]: 0 → 1 Bit 0 of [Control Device]: 1 → 0

Line B Monitor

Line A Error!

Error Detail

Line B Monitor
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2.3 Call-overlap
2.3.1 Creation Procedure

1. Creating from an Overlap Library
1) Display an [Overlap Library Edit] tab window by clicking [Home] → [Registration Item] → [Overlap Library].

2) Click [Parts] or [Home] → [Overlap] → [Normal Overlap] and place an overlap.

3) Adjust the size of the overlap.
4) Select [Overlap Editing] → [ID 0] on the right-click menu. The overlap editing window is displayed.

5) Place switches, lamps, and other items on the overlap.
6) Select [Overlap Editing] → [ID 0] on the right-click menu. The user is returned to the screen editing window.

2. Placing Call-Overlaps
1) In the screen editing window, click [Parts] → [Overlap] → [Call-Overlap] and place an overlap.
2) Click the icon and display the settings menu.
3) Configure the [Operation Select] settings.

3. If performing showing/hiding with a switch, place a switch. page 2-16
4. If performing showing/hiding with commands from a PLC, configure the [Control Device] settings. page 2-15

Overlap Setting Call
Overlap Screen Setting Set the overlap library number.
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2.3.2 Detailed Settings

Operation Select

Detail

Item Description
Registration Status Check the registration status of overlap IDs 0 to 9. “- Editing -” is shown for the ID that is currently being 

edited.
The overlap ID can also be changed to an unregistered ID.

Overlap Setting Call

Overlap library number
Set the library number of the overlap for display from those registered in the overlap library.
Click [Refer to] to select using a list display or thumbnails.

Control Device Specify a device using one bit. Showing and hiding is performed according to the value of the least 
significant bit.

0 → 1: Show
1 → 0: Hide

* Select the [Display Overlap during bit ON] checkbox at [System Setting] → [Unit Setting] → [General 
Setting] to allow level operation. Refer to page 2-13.

Information Output Device Specify a device using one bit. Stores the overlap display status.
0: Hide
1: Shown

Item Description
Input Cursor Movement Control 
Device

This setting is required to use the “entry function” on an overlap display.
For details, refer to page 6-37.

Coordinate Start X/Start Y Set the display position of the overlap using X and Y coordinates.
Call-overlap icon

Menu
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2.3.3 Show/Hide Settings
There are three methods for showing and hiding call-overlap displays.

Switch
Settings for showing
1. Display the settings menu of the call-overlap display.
2. Click [Go to Control SW Placement] and place a switch.

3. Set the function of the switch.

Method Error Detail Refer to
Internal command Switch Function: Overlap Control

Set Display No.: Unselected
page 2-15

Macro OVLP_SHOW
OVLP_POS

page 2-12

External Command Control device memory 0 → 1: Show
1 → 0: Hide

page 2-13

Function Overlap Control
Overlap ID Specify the same ID as the [Overlap ID] of the call-overlap.
Control Operation ON: Show

ALT: Alternate between show and hide
Set Display No. Unselected

Used by setting a control switch.
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Settings for hiding
1. Display the settings menu of the call-overlap display.
2. Click [Go to Control SW Placement] and place a switch.
3. Set the function of the switch.

• Hiding using a switch placed on the base screen

• Hiding using a switch placed on the overlap display

Function Overlap Control
Overlap ID Specify the same ID as the [Overlap ID] of the call-overlap.
Control Operation OFF: Hide

ALT: Alternate between show and hide
Hide the overlap where this 
switch is placed

Unselected

Set Display No. Unselected

Function Overlap Control
Hide the overlap where this 
switch is placed

Selected

Set Display No. Unselected
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2.4 Multi-overlap
2.4.1 Creation Procedure

1. Creating from an Overlap Library
1) Display an [Overlap Library Edit] tab by clicking [Home] → [Registration Item] → [Overlap Library].

2) Click [Parts] or [Home] → [Overlap] → [Call-Overlap] and place an overlap.

3) Adjust the size of the overlap.
4) Select [Overlap Editing] → [ID 0] on the right-click menu. The overlap editing window is displayed.

5) Place switches, lamps, and other items on the overlap.
6) Select [Overlap Editing] → [ID 0] on the right-click menu. The user is returned to the screen editing window.

2. Placing a Multi-Overlap
1) In the screen editing window, click [Parts] → [Overlap] → [Multi-Overlap] and place an overlap.
2) Click the icon and display the settings menu.
3) Configure the [Operation Select] settings.

Overlap Setting Multi
Control 
Settings

Display Method Switch Use switches for showing and hiding. Refer to page 2-21.
Control Device Use commands from a PLC for showing and hiding. Refer to page 2-23.
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2.4.2 Detailed Settings
Operation Select

Display method
• Switch

Item Description
Registration Status Check the registration status of overlap IDs 0 to 9. “- Editing -” is shown for the ID that is currently being 

edited.
The overlap ID can also be changed to an unregistered ID.

Overlap Setting Multi
Control Settings Select the overlap display method (Switch/Control Device).

Item Description
Switch Control showing and hiding of the overlap using the switch function.
Information Output Device Store the overlap library number.

Show: 0 to 9999
Hide: −1 (FFFFHex)
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• Control Device

*1 Set the unit of the placement coordinates. [System Setting] → [Unit Setting] → [Overlap] → [Overlap Coordinates]
Line/Column: X coordinate in 8 pixels, Y coordinate in 20 pixels
Dot: X coordinate in 4 pixels, Y coordinate in 1 pixel

Detail

Item Description
Control Device Specify a device memory using one bit. Showing and hiding is performed according to the value of the 

least significant bit.
1 (level): Show
0 (level): Hide

Information Output Device

Device for Overlap Library 
No. to Display

Specify the display position 
by device

Store and set the following information using a maximum of 4 words.

Item Description
Input Cursor Movement 
Control Device

This is required for using “entry mode” on an overlap display.
For details, refer to page 6-37.

Coordinate The coordinates of the multi-overlap icon. This setting is unrelated to the operation of MONITOUCH.

Information Output 
Device

n Stores the overlap library number.
Show: 0 to 9999
Hide: −1 (FFFFHex)

V →

Device for Overlap 
Library No. to Display

n+1 Set the overlap library number of the overlap for display. V ←

Specify the display 
position by device *1

n+2 Set the X coordinate. V ←
n+3 Set the Y coordinate. V ←
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2.4.3 Show/Hide Settings
There are three methods for showing and hiding multi-overlap displays.

Switch
A switch can be used to show and hide multi-overlap displays.

Settings for showing
1. Display the settings menu of the multi-overlap display.
2. Click [Go to Control SW Placement] and place a switch.

3. Set the function to use.

Method Error Detail Refer to
Internal command Switch Show Function: Overlap Control

Set Display No.: Selected
page 2-21

Hide Function: Overlap Control
Control Operation: OFF
Set Display No.: Unselected

Macro SET_MOVLP
OVLP_POS

page 2-22

External Command Control device memory 0: Hide
1: Show

page 2-23

Function Overlap Control
Overlap ID Specify the same ID as the [Overlap ID] of the multi-overlap.
Set Display No. Selected
Overlap Library No. Set the overlap library number of the overlap for display.
Display Position Set the X and Y coordinates.



2  Overlap

2-22

Settings for hiding
1. Display the settings menu of the multi-overlap display.
2. Click [Go to Control SW Placement] and place a switch.
3. Set the function of the switch.

• Hiding using a switch placed on the base screen

• Hiding using a switch placed on the overlap display

Macro
A macro can be used to show and hide multi-overlap displays. Use the “SET_MOVLP” and “OVLP_SHOW” commands.
The “OVLP_POS” command is used to specify the display position. For details, refer to the Macro Reference Manual.

Setting
1. Creating a macro for showing an overlap display

1) Display the [Macro Block No. Editor] window.
2) Register the following macro.

3) Execute the macro block in a switch ON macro or global macro.

2. Creating a macro for hiding an overlap display
1) Display the [Macro Block No. Editor] window.
2) Register the following macro.

3) Execute the macro block in a switch ON macro or global macro.

Function Overlap Control
Overlap ID Specify the same ID as the [Overlap ID] of the multi-overlap.
Control Operation OFF: Hide
Hide the overlap where this 
switch is placed

Unselected

Set Display No. Unselected

Function Overlap Control
Hide the overlap where this 
switch is placed

Selected

Set Display No. Unselected

$u100 = 2 (W) Set an overlap ID from 0 to 9 (ID2 in this example).
$u101 = 12 (W) Set an overlap library number from 0 to 9999 (No. 12 in this example).
$u102 = 150 (W) X coordinate
$u103 = 50 (W) Y coordinate
SYS (SET_MOVLP) $u100 Execute the command.

$u100 = 2 (W) Set an overlap ID from 0 to 9 (ID2 in this example).
$u101 = 0 (W) Hide the overlap display
SYS (OVLP_SHOW) $u100 Execute the command.
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Control Device Memory
Setting
1. In the multi-overlap settings menu, click [Operation Select] and configure the [Control Device] and [Information Output 

Device] settings under [Control Settings].

2. Set the library number of the overlap for display to the [Device for Overlap Library No. to Display].
When specifying the display position, also set the X and Y coordinates.

3. The overlap is shown when the [Control Device] bit is ON and hidden when the bit is OFF.

* Notes on showing an overlap display using an external command
• Suppose that an overlap display was shown on the screen using an external command, the screen was switched to 

another screen, and then the first screen is displayed again. In this case, the overlap display that corresponds to the bit 
being turned ON appears on the screen.

• A switch for [Function: Overlap Display = OFF] can be used to hide the overlap display. Using this type of switch hides 
the overlap display with the bit of the control device memory still turned ON. To show the overlap display again, the bit 
needs to be turned OFF and ON again.

Information Output Device
n Store the overlap library number.

Show: 0 to 9999
Hide: −1 (FFFFHex)

V →

Device for Overlap Library No. to 
Display

n+1 Set the overlap library number of the overlap for display. V ←

Specify the display position by 
device

n+2 Set the X coordinate. V ←
n+3 Set the Y coordinate. V ←
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D0100 3 D0100 3
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Specify the number for [Overlap Library No.]. Bit 0 of [Control Device]: 0 → 1

Overlap library No. 3

Line B Monitor Line B Monitor

Do you want to save the setting?

YES NO

Do you want to save the setting?

YES NO
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2.5 Global Overlap
2.5.1 Creation Procedure

1. Creating from an Overlap Library
1) Display an [Overlap Library Edit] tab window by clicking [Home] → [Registration Item] → [Overlap Library].

2) Click [Parts] or [Home] → [Overlap] and place an overlap.

3) Adjust the size of the overlap.
4) Select [Overlap Editing] → [ID 0] on the right-click menu. The overlap editing window is displayed.

5) Place switches, lamps, and other items on the overlap.
6) Select [Overlap Editing] → [ID 0] on the right-click menu. The user is returned to the screen editing window.
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2. Global Overlaps
1) Click [System Setting] → [Global Setting] → [Global Overlap Setting].
2) Select the [Use Overlap] checkbox.
3) Select the [Use Global Overlap] checkbox on the tab corresponding to the ID to use from IDs 0 to 9.

* Do not use IDs that are already specified for screens with normal overlaps, call overlaps, or multi-overlaps.

4) Select a display method under [Designate].

Item Description
Designate Switch Use switches for showing and hiding. Refer to page 2-28.

Control Device Use commands from a PLC for showing and hiding. Refer to page 2-30.
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2.5.2 Detailed Settings
Display Method Selection

• Switch

• Control Device

Item Description
Switch Control showing and hiding of the overlap using the switch function.
Information Output Device Store the overlap library number.

Show: 0 to 9999
Hide: −1 (FFFFHex)

Input Cursor Movement 
Control Device

This setting is required to use the “entry function” on an overlap display.
For details, refer to page 6-37.

Item Description
Control Device Specify a device using one bit. Showing and hiding is performed according to the value of the least 

significant bit.
1 (level): Show
0 (level): Hide

Information Output Device

Device for Overlap Library 
No. to Display

Display Position

Store and set the following information using a maximum of 4 words.

Information Output 
Device

n Stores the overlap library number.
Show: 0 to 9999
Hide: −1 (FFFFHex)

V →

Device for Overlap 
Library No. to Display

n+1 Set the overlap library number of the overlap for display. V ←

Specify the display 
position by device *1

n+2 Set the X coordinate. V ←
n+3 Set the Y coordinate. V ←
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*1 Set the unit of the placement coordinates. [System Setting] → [Unit Setting] → [Overlap] → [Overlap Coordinates]
Line/Column: X coordinate in 8 dots, Y coordinate in 20 dots
Dot: X coordinate in 4 dots, Y coordinate in 1 dot
When the [Specify the display position by device] check box is not selected, the overlap display is shown in the position as registered 
in the overlap library.

Input Cursor Movement 
Control Device

This setting is required to use the “entry function” on an overlap display.
For details, refer to page 6-37.

Item Description
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2.5.3 Show/Hide Settings
There are three methods for showing and hiding global overlap displays.

Switch
A switch can be used to show and hide global overlap displays.

Settings for showing
1. Click [Parts] → [Switch] and place a switch.

2. Set the function to use.

Method Error Detail Refer to
Internal command Switch Function: Overlap Control

Set Display No.: Selected
page 2-28

Macro SET_MOVLP
OVLP_SHOW
OVLP_POS

page 2-29

External Command Control device memory 0: Hide
1: Show

page 2-30

Function Overlap Control
Overlap ID Specify the same ID as the [Overlap ID] of the global overlap.
Set Display No. Selected:
Overlap Library No. Set the overlap library number of the overlap for display.
Display Position Set the X and Y coordinates.
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Settings for hiding
1. Click [Home/Parts] → [Switch] and place a switch.
2. Set the function of the switch.

• Hiding using a switch placed on the base screen

• Hiding using a switch placed on the overlap display

Macro
A macro can be used to show and hide global overlap displays. Use the “SET_MOVLP” and “OVLP_SHOW” commands.
The “OVLP_POS” command is used to specify the display position. For details, refer to the Macro Reference Manual.

Setting
1. Creating a macro for showing an overlap display

1) Display the [Macro Block No. Editor] window.
2) Register the following macro.

3) Execute the macro block in a switch ON macro or global macro.

2. Creating a macro for hiding an overlap display
1) Display the [Macro Block No. Editor] window.
2) Register the following macro.

3) Execute the macro block in a switch ON macro or global macro.

Function Overlap Control
Overlap ID Specify the same ID as the [Overlap ID] of the global overlap.
Control Operation OFF: Hide
Hide the overlap where this 
switch is placed

Unselected

Set Display No. Unselected

Function Overlap Control
Hide the overlap where this 
switch is placed

Selected

Set Display No. Unselected

$u100 = 3 (W) Set an overlap ID from 0 to 9 (ID3 in this example).
$u101 = 12 (W) Set an overlap library number from 0 to 9999 (No. 12 in this example).
$u102 = 150 (W) X coordinate
$u103 = 50 (W) Y coordinate
SYS (SET_MOVLP) $u100 Execute the command.

$u100 = 3 (W) Set an overlap ID from 0 to 9 (ID3 in this example).
$u101 = 0 (W) Hide the overlap display
SYS (OVLP_SHOW) $u100 Execute the command.
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Control Device Memory
Setting
1. In the global overlap settings menu, configure the [Control Device] settings.

2. Set the library number of the overlap for display to the [Device for Overlap Library No. to Display].
When specifying the display position, also set the X and Y coordinates.

3. The overlap is shown when the [Control Device] bit is ON and hidden when the bit is OFF.

* Notes on showing an overlap display using an external command
A switch for [Function: Overlap Display = OFF] can be used to hide the overlap display. Using this type of switch hides the 
overlap display with the bit of the control device memory still turned ON. To show the overlap display again, the bit needs 
to be turned OFF and ON again.

Information Output Device
n Store the overlap library number.

Show: 0 to 9999
Hide: −1 (FFFFHex)

V →

Device for Overlap Library No. to 
Display

n+1 Set the overlap library number of the overlap for display. V ←

Specify the display position by 
device

n+2 Set the X coordinate. V ←
n+3 Set the Y coordinate. V ←

M0000
D0100 3 D0100 3

1135

120

1564

554

1653

10.23

9.89

7.23

11.02

12.03

849

988

489

156

484

5548

6615

4485

9981

1165

1135

120

1564

554

1653

10.23

9.89

7.23

11.02

12.03

849

988

489

156

484

5548

6615

4485

9981

1165

Specify the number for [Overlap Library No.]. Bit 0 of [Control Device]: 0 → 1

Overlap library No. 3

Line B Monitor Line B Monitor

Do you want to save the setting?

YES NO

Do you want to save the setting?

YES NO
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2.5.4 Notes
• Global overlaps are redisplayed when the display language is changed.
• Global overlap displays cannot be set for component parts nor called upon from component parts.
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2.6 Display Transparency
2.6.1 Overview

• When an overlap is displayed, it blocks the display of anything behind it. By using transparency, an overlap can be 
displayed while retaining the ability to check information behind it.

• All overlaps from ID 0 to 9 can be set to be transparent.
• The level of transparency for the overlap can be determined by the [Blend] value setting.

The blend value for transparency can be set in the [Screen Setting] window that is displayed from the [Screen Setting] 
menu. This setting applies to the relevant screen and cannot be configured for individual overlaps.

• The blend value for superimposing a global overlap display depends on the settings made for the screen, on which the 
overlap is first displayed.

2.6.2 Setting Procedure
1. Display the [Screen Edit] window.
2. Click [Screen Setting] → [Screen Setting] → [Others].

3. Set a [Blend] value under [Transparency Setting].

4. Click the [OK] button to close the window.

1135

120

1564

554

1653

10.23

9.89

7.23

11.02

12.03

849

988

489

156

484

5548

6615

4485

9981

1165

849

988

5548

66158 688 68 6668 6

Overlap
(with transparency)

Line A Error!

Error 
Detail

Item Description
Blend Set the ratio of transparency used for overlap display.

0 (transparent) to 255 (opaque)

Normal overlap display:
Transparency can also be set by clicking [Detail] → [Transparency Display] in the overlap settings.
This setting is the same as the setting in [Screen Setting].
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3.1 Switch
3.1.1 Overview

Basic Function of Switches
• Switches can send ON/OFF information to specific bits in PLC or internal device memory.

• When a switch is pressed, the following processes can be executed:
- Changing the screen for display

- Showing an overlap display

- Performing the configured calculations and writing the results to the device memory

- Printing the displayed screen

For example settings, refer to “Setting the PLC bit to ON.” page 3-4.

For example settings, refer to “Changing Screens” page 3-5.

PLC

M0 to 15

M16 to 31

M32 to 47

.....
.....M26

Turns ON.

ON information

PLC 
device memory

Screen 1

Z Z Z

Labeller

Z

OK
Hard
Copy

Change
Screen

Animation

Overlap

Overlap
Display

Overlap

65+36=

PLC

D100
D200

D300

.....
.....

65+36=101

Word
Operation

PLC 
device memory

Change
Screen

Z Z Z

Labeller

Z

Hard
Copy

OK
Change
Screen

Z Z Z

Labeller

Z

Hard
Copy

OK

Animation
Animation
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• Turning a device memory bit ON and showing an overlap display at the same time

• When a switch is pressed, ON/OFF information or a value can be sent for multiple bits or words at the same time to a PLC 
device memory or internal device memory.

• A delay function can be added to switches.
“ON delay” functions can be set, where device memory output cannot occur unless the switch is pressed continuously for 
a fixed time, and “OFF delay” functions can be set, where the device memory cannot go OFF until a fixed time has elapsed 
after the switch is released.

• A confirmation pop-up window, which asks whether to proceed with the operation or cancel the operation ([OK] or 
[Cancel]), can be configured to be displayed automatically when a switch is pressed.
These settings for confirmation and operation execution can be configured entirely on the MONITOUCH, without any 
troublesome programming.

• A macro can be executed when a switch is pressed or released.

Overlap

PLC

M0 to 15

M16 to 31

M32 to 47

.....
.....

Overlap

Overlap
Display

Turns ON.
ON information

PLC 
device memory

Pressing the [High speed] switch can serve 
not just to turn M30 ON, but to turn M10 
and M20 OFF at the same time.
This makes it simple to create radio buttons.

M10=ON M20=OFF M30=OFF

M10=OFF M20=OFF M30=ON

Low 
speed

Medium 
speed

High 
speed

Low 
speed

Medium 
speed

High 
speed

PLC

M0 to 15

M16 to 31

M32 to 47

.....
.....M10

Turns ON.

ON information

For example, on pressing a switch for which [Output 
Device: M10] and [ON delay: 3 sec] have been set, M10 
will be turned ON after the switch has been pressed 
continuously for 3 seconds.

Pressed for 3 seconds

PLC 
device memory

PLC

M0 to 15

M16 to 31

M32 to 47

.....
.....

M10 M10

OK Cancel

Will start operation?

Turns ON.

ON information

PLC 
device memory
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Lamps in Switches
• There are switches available with lamps that light up (ON color) when the switch is pressed and turn off (OFF color) when 

released.

• Lamp activation can be instructed from an external device memory.

• When instructing lamp activation from an external device memory, a maximum of 128 patterns can be registered for a 
single lamp part.
This can be done using consecutive device memory addresses or by using desired addresses (N-state lamp).

• Lamps can be set to light up when multiple conditions are satisfied. (N-state lamp)
Up to four conditions can be defined using AND and OR operators.

For a detailed setting example, refer to “4 Lamp”.

Switch Switch Switch

M0 to 15

M16 to 31

M32 to 47

.....
..... Switch

Switch

PLC

PLC device memory

(OFF) (ON) (P3) (P4) (P5) (P6)

(P128) (P127) (P8) (P7)

(   ): Bit lamp patterns

Pattern 0 Pattern 1 Pattern 2 Pattern 3 Pattern 4 Pattern 5

Pattern 6Pattern 7Pattern 126Pattern 127

Operation 
stop

Operation 
start Tank alarm Temperature 

increase
Temperature 

decrease
Water 

pressure drop

Voltage 
drop

Electric leak 
warning!

In 
preparation

Production 
discontinued!

PLC

M 0~15

M16~31

M32~47

.....
.....

LAMP

PLC device 
memory

Condition 1  M0: ON
AND

Condition 2  M10: ON
AND

Condition 3  M20: ON
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3.1.2 Setting Examples
Setting the PLC bit to ON.
Set PLC device memory M26 to ON while the switch is pressed and OFF after the switch is released.

1. Click [Parts] → [Switch] and place a switch on the screen.

2. Double-click on the switch to display the settings window.
Configure the following settings for [Output Device] and then click [Finish].

This completes the necessary settings.

PLC

M0 to 15

M16 to 31

M32 to 47

.....
.....M26

Turns ON.

ON information

PLC 
device memory
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Changing Screens
Change to screen No. 1 when the switch is pressed.

1. Click [Parts] → [Switch] and place a switch on the screen.

2. Double-click on the switch to display the settings window.
Configure the following settings for [Function] and then click [Finish].

This completes the necessary settings.

Press button
Screen No. 1

Screen 1

Screen No. 0

Screen 1
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3.1.3 Detailed Settings
Style

*1 Multiple frame dimensions can be set at once by selecting the items to change via [Tool] → [Fix 3D parts frame].
*2 Notes on 3D type and 2D type parts

Part shapes differ depending on the selection made in the catalog.
• 3D type: Plain, Animation, Flat, Real, Sign, 3D, 3D_128, HA
• 2D type: 2D

Selection of an image file corresponds to the 3D type.
*3 This setting is linked to [Use lamp function] in the [Output Device] settings. When the [Use N-state lamp] checkbox is selected, the setting 

is hidden.

Item Description
No. of Patterns (2 to 128) Set the number of times the display of the switch lamp can be changed.
Area Setting Select from catalogs Select the part design.

After selecting the part, select the part color.
Select the [Select a transparent switch] checkbox to change to the transparent design.

Select from image files Select a PNG file.
The PNG file can be set to all patterns by clicking [Apply to All Patterns].

Frame Type Select the frame type of the switch. * Only available with 2D (Square2) parts.
Color Select the frame color of the switch. * Only available with 2D (Square2) parts.

Detail Settings Fix the frame size *1 Set the top, bottom, left, and right dimensions of the frame. Zooming in and out can be 
performed while maintaining the specified frame size.
Applicable parts: Only real type and square type parts with frames and 3D parts (excluding 

some parts)
Enable flash display function
(flashing with OFF pattern)

This item is available when a 3D pattern type*2 other than an OFF pattern (excluding “Sign” 
and “3D_128” parts) is selected.
Select this checkbox to flash the display between the selected pattern and the OFF pattern.

Other Settings Draw Mode
REP/XOR

REP: Display using the color set in [Area Setting].
XOR: When the lamp device memory is ON, the frame and text are displayed in the color 

resulting from an XOR operation.
For the difference between REP and XOR, refer to “4.4 Draw Mode” page 4-16.

Clear graphic displayed 
before switching 
(transparency function)

The previous graphic is not retained when the checkbox is selected.
For details, refer to “Notes on the transparency function” page 4-10.

Use lamp function *3 Select this checkbox to change the display in the switch area.
Unselected:
When the switch is pressed, the lamp lights up automatically.
The switch changes to the ON color when pressed and the OFF color when released.
Selected:
Setting for the lamp device memory become available. Specify a device memory address for 
the lamp display.

* When placing multiple switches, set up consecutive addresses for the lamp device 
memory to ensure high-speed processing.

For details, refer to “4 Lamp”.
Device Designation Bit:

The lamp display is changed by setting (ON) and resetting (OFF) bits.
The required number of bits depends on the number of display patterns.
(127 bits maximum)

* When multiple bits are set (ON), the most significant bit has priority.
Word:
The lamp display is changed according to the value specified for the device memory.
The range of setting values varies with the number of patterns.
(Range: 0 to 127)
If a value outside the specified range is set, the lamp display is not changed.

Input Type (DEC/BCD) Specify the input format of the device memory.
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Char. Prop.

*1 Cannot be set to transparent.

Item Description
[OFF] [ON] - [P128] When [Style] → [Other Settings] → [Draw Mode] is [XOR]:

Only [OFF] can be selected. Specify the text to be displayed.

Pattern No.
(0 to 127)

When [Style] → [Other Settings] → [Draw Mode] is [REP]:
Specify the text to be displayed on each pattern.

Text Enter the text to be displayed on the switch.
Up to 4 lines can be registered. Text properties can be set for each line.
Text can be justified within the switch part.

String table Select this checkbox when using strings registered to the string table.
For details, refer to the Reference Manual 2.

Color
(text color, background color)

Set the color for text.
The background color can also be set if set as “no transparency” in the following [Style] setting.

Style Set the text style.
Character Size
(1 to 8)

Specify the enlargement factor for text.
* When [Bitmap font] is selected at [System Setting] → [Multi-language Setting] → [Font Type]

Point
(6 to 999)

Set the text size.
* When a font type other than [Bitmap font] is selected at [System Setting] → [Multi-language Setting] 

→ [Font Type]
Rotation + Direction Set the combination of text rotation and direction.

Four combinations are displayed in the drop-down menu.

When selecting an option other than the above, click the icon at the bottom.
The window that allows selection from all options is displayed.

Use Windows fonts Select this checkbox to use a Windows font.
Smooth Font *1 Smooth the edges of text. (Only settable for TrueType Windows fonts.)

Alignment Set the text alignment.

Text copy
Copy only characters

The text and its attributes for the current pattern (OFF, ON, P3) are copied to the other patterns.
Select the [Copy only characters] checkbox to copy text and coordinate information to all other patterns.
Note that the text properties will not be copied. If the destination for copy has no text, text properties will 
also be copied.

Set line spacing Set the pitch between lines.
Use the same style for all 
patterns

Select this checkbox to configure the same settings as the opened pattern attributes with respect to all 
switch patterns (for each respective line if multiple lines are included).

Auto-adjust the size according 
to the style

Select this checkbox to automatically adjust the switch size to the entered text.

Retain the coordinates when 
changing character string

Newly registered text is placed by centering. When any registered text is changed while this checkbox is 
selected, the coordinates remain the same.
When a line is added to the existing text while this checkbox is selected, the added line is aligned with the 
upper line.

4-Line Display When using Windows fonts, selecting this checkbox divides the text entry area into four lines.
This allows different properties to be specified for each line when using Windows fonts.

Flush RightFlush Left
Center
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Output Device

Item Description
Output Setting Select this checkbox to execute the specified output operation for the set output device 

when the switch is pressed.
Number of Outputs
(1 to 16)

A maximum of 16 types of output operations can be executed at once when the switch is 
pressed.
This value sets the number of operations to execute.

When the number of outputs is set to “2” or more, output operations are processed in 
sequence from No. 0.
The output operations performed when the switch is released are also processed in 
sequence from No. 0.

Output Action *1 Momentary:
Set the output device memory to ON. When the switch is released, set the output device 
memory to OFF.
Set:
Set the output device memory to ON.
Reset:
Set the output device memory to OFF.
Alternate:
Inverse the state of the output device memory (set to OFF if ON, set to ON if OFF).
Momentary W:
Set the output device memory to ON. When the switch is released, set the output device 
memory to OFF.
Word Operation:
Execute the set arithmetic expression.
For details, refer to “Word operation” page 3-10.

Device to Output Specify a PLC device memory, internal device memory, or tag.
Processing speed will be faster when an internal device memory is selected than when a 
PLC device memory is selected.
(Specify a bit for [Device to Output] when [Output Action] is set to a value other than 
[Word Operation].)

Match Output Device 
with Lamp Device

Select this checkbox to set the lamp device memory address to the same address set for 
[Device to Output].
When [Alternate] is set for [Output Action], the display reflects the status of the output 
device memory.

Use lamp function *2 Select this checkbox to change the display in the switch area.
Unselected
When the switch is pressed, the lamp lights up automatically.
The switch changes to the ON color when pressed and the OFF color when released.
Selected
Settings for the lamp device memory become available. Specify a device memory address 
for the lamp display.

* When placing multiple switches, set up consecutive addresses for the lamp 
device memory to ensure high-speed processing.

For details, refer to “4 Lamp”.
Device Designation Bit:

The lamp display is changed by setting (ON) and resetting (OFF) bits.
The required number of bits depends on the number of display patterns.
(127 bits maximum)
When multiple bits are set (ON), the most significant bit takes precedence.
Word:
The lamp display is changed according to the value specified for the device memory.
The range of setting values varies with the number of patterns.
(Range: 0 to 127)
If a value outside the specified range is set, the lamp display is not changed.

Input Type (DEC/BCD) Specify the input format of the device memory.
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*1 Notes on [Momentary] and [Momentary W] operation
Processing differs depending on the type of PLC device memory specified for output (whether bits are writable or not).
For information on PLC device memory types, refer to the relevant PLC manual.
• When a bit-writable device memory is specified:

Processing for [Momentary] and [Momentary W] is the same.
• When a non-bit-writable device memory is specified:

Because processing for switch operations is performed in units of bits on the V10/V9 series, processing differs as described below

For a bit-writable device memory, select either [Momentary] or [Momentary W]. For a non-bit-writable device memory, it is 
recommended to select [Momentary W] for high-speed processing.

*2 This setting is linked to [Use lamp function] in the [Style] settings.
When the [Use N-state lamp] checkbox is selected, the setting is hidden.

0 0 0 0 0 0 0 0 0 0 0 0 0 1 1 1

0 0 0 0 0 1 0 0 0 0 0 0 0 1 1 1

(1) Data in D100 is read.

(2) The bit of D100 - 10 is set (ON) and written to D100.

- Processing when [Momentary] is selected:
(1) One word of [Device to Output] is read.
(2) The result of [Output Action] is written to one word of 

[Device to Output].
(Other bits are kept intact.)

Example: When [D100 - 10] is specified for [Device to Output]:

- Processing when [Momentary W] is selected:
The result is directly written to one word of [Device to Output]. 
(Other bits are cleared.)
Therefore, always secure one-word for [Device to Output].

Example: When [D100 - 10] is specified for [Device to Output]:

0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0
The bit of D100 - 10 is 
set (ON) and one 
entire word is written.
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Word operation

• Usage Example

Operation Setting

Condition Setting

Operation Type: DEC

When the data in D100 is less than “500”, the operation (D500 + 10 → D500) is executed.

• Notes
- If the value of the [Address to Output Operation Result] device memory is changed by an external command, the latter 

value has priority.
- MONITOUCH processes operations in the following order:

1) Reads the [Operation Device] and [Operand Device].
2) Operation processing
3) Writes the operation result to the [Address to Output Operation Result] device memory.

Item Description
Operation 
Setting

Operation Device Specify the device memory address for operation.
Operation Mode Transfer Perform the specified arithmetic operation with [Operation Device] and 

[Operand Device] and write the result to the device memory set for [Address to 
Output Operation Result]. When performing division, the quotient is output to 
the device memory set for [Address to Output Operation Result] and the 
remainder is output to the device memory set for [Address to Output Operation 
Result] + 1.

Add
Subtract
Multiply
Divide
OR Perform the specified logical operation with [Operation Device] and [Operand 

Device] and write the result to the device memory set for [Address to Output 
Operation Result].

AND
XOR

Operand Device Specify the device memory address for the operand. It is possible to use a 
constant.

Address to Output Operation Result Specify the device address where the operation result is output.
Condition 
Setting

Comparison 
Condition

None Operation is executed when the switch is pressed.
=, ≠
<, >
≤, ≥

Set the condition for executing the word operation.
Condition satisfied: Word operation is executed.
Condition not satisfied: Word operation is not executed.

Comparison Device Specify the device memory address where the comparison value is stored.
Constant Specify a constant.

Operation Type (DEC/BCD) Specify the operation format (format of writing to the specified device memory 
address).

Operation Device Operation Mode Operand Device Address to Output 
Operation Result

D500 Add 10 → D500

Comparison 
Device

Comparison 
Condition Constant

D100 < 500
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Function

*1 When the screen display is changed, all the switches and switch outputs should be turned OFF.
This is to prevent accidental activation of any switch that may be caused by inadvertent contact with the screen.

*2 It is possible to change the screen display without using the switch function by instead using an external command from the PLC.
For information on changing the screen from a PLC, refer to “1.1.3 Communication Setting”.

*3 When the screen is printed with a [Function: Hard Copy] switch, the switch is also printed out.
To prevent the switch from appearing on the printout, use an external command or function switch to print instead.
For details on printing using an external command, refer to “16 Print”.

*4 When the screen display reverts using the [Function: Return] switch, the initial screen state is displayed, that is, the state in which no 
scrolling or block changes have been specified.

*5 It is possible to disable returning for screens that are displayed by an external command.
Navigate to [System Setting] → [Unit Setting] → [General Setting] and select the [Return switch prohibited when switching the screen by 
an external command] checkbox on the [General Settings] tab. For details, refer to “1.1 System Settings”.

Item Description
Function Select the function to assign to the switch, that is, how the switch should work when 

pressed.
Standard Standard (No Function) No function to perform.

Screen Change-over *1 *2 Change to the specified screen number (0 to 9999).
Hard Copy *3 Print the currently displayed screen image.

Operations can be performed normally on the screen during printing.
Overlap Control Show or hide an overlap.

For details, refer to “2 Overlap”.
Return *4 *5 Return to the previously displayed screen.

Up to 8 previous screens can be displayed.
Word Operation Execute the set arithmetic expression.

Select the [Changeover the screen] checkbox to change to the specified screen number 
after executing an operation.
For details on word operations, refer to “Word operation” page 3-10.

Language changeover Change the display language.
For details, refer to “9 Language Changeover” in the Reference Manual 2.

Storage Removal Stop access to a storage device.
For details, refer to “Storage Removal (Stopping Access to a Storage Device)” page 3-26.

Operation Log Viewer 
Display

Used in conjunction with the operation log.
For details, refer to “4 Operation Log” in the Reference Manual 2.

Ladder Monitor Used in conjunction with the ladder monitor function.
For more information, refer to the Ladder Monitor Specifications manual.

PDF Viewer Display Used in conjunction with the PDF viewer.
For details, refer to “13 PDF Viewer” in the Reference Manual 2.

Video Player Display Used in conjunction with the video player.
For details, refer to “15 Video Player” in the Reference Manual 2.

Data transfer viewer 
display

Used in conjunction with the data transfer viewer.
For details, refer to “6.11 Data Transfer Service“ in the Reference Manual 2.

Storage viewer display Used in conjunction with the storage viewer.
For details, refer to the following manuals.

- V10 Series Unit Operation / Local Mode / Error Screen Manual
- V9 Series Troubleshooting/Maintenance Manual

Picture Viewer Display Used in conjunction with the picture viewer.
For details, refer to “16 Picture Viewer” in the Reference Manual 2.

Recipe Recipe Data Load Used in conjunction with the recipe function.
For details, refer to “15 Recipes”.Recipe Data Save

Recipe Data Delete
Security Log In Used in conjunction with the security function.

For details, refer to “5 Security” in the Reference Manual 2.Log Out
Display All Display all switch functions.

For details, refer to “3.1.4 Basic Function of Switches” page 3-21.
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Transition
This item is available when [Screen Change-over] or [Overlap Control] is selected for [Function] in the switch settings.

* Transitions are disabled when performing screen changes or overlap control using a macro or from a PLC.

* The switching time range differs depending on the transition type.
• For [Function: Screen Change-over]:

• For [Function: Overlap Control]:

Item Description
Transition Type Specify the animation effect to use when the screen changes or an overlap is displayed.
Switching Direction
(Right, Left, Up, Down)

Specify the switching direction.

Switching Type
(Type 1, 2, 3, 4)

Specify the switching type.

Time * Specify the duration in which to execute the transition.

Transition Type Time
Slide In

2 to 10 × 100 ms

Slide In (with fade effect)
Box In
Box In (with fade effect)
Fade In
Slide Out
Slide Out (with fade effect)
Box Out
Box Out (with fade effect)
Slide
Slide (with fade effect)
Switch

5 to 10 × 100 ms
Jump
Card Flip 3 to 10 × 100 ms
Gallery 5 to 20 × 100 ms

Transition Type Time
Slide (from outside screen)

2 to 10 × 100 ms
Slide (from outside screen, with fade effect)
Slide (short distance, with fade effect)

2 to 5 × 100 ms
Fade
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Macro

Item Description
Macro to Edit ON Macro Register a macro command to be executed once when the switch is pressed.

OFF Macro Register a macro command to be executed once when the switch is released.
Edit Start the macro editor. Register a macro command to be executed.
Delete Delete the macro command.
Cut Cut the macro command. This is convenient when copying a macro command to a 

different switch.
Copy Copy the macro command. This is convenient when copying a macro command to 

a different switch.
Paste Paste a copied macro command.

This is used when copying a macro command from a different switch.
Setting Method Use switch macros Use a macro for the switch itself.

Click the [Edit] button to register a macro.
Specify the macro block number Specify the macro registered to a macro block.

If nothing is registered, click the [Edit] button to register a macro.
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Delay

*1 If the [Repeat ON function] checkbox is selected and the ON macro repeat function is also set (at $s64 to 66), the repeat operation of the 
ON macro will be executed first when the switch is pressed.

*2 When the screen has a switch currently performing an OFF delay operation, the screen cannot be switched (no switch operation 
acceptable) until the OFF delay operation is completed.
Likewise, when an overlap display has a switch currently performing an OFF delay operation, the overlap display cannot be switched or 
cleared until the OFF delay operation is completed.

Item Description
ON delay Select this checkbox to specify a delay for when the switch is turned ON.

ON after a lapse of preset time
(Setting Time: 1 to 300 × 100 ms)

The switch is activated for the function as specified for [Output Device], [Function], 
and [Macro] when the switch is held down for the specified time.

Pressed twice within the setting 
time
(Setting Time: 10 to 300 × 100 ms)

The switch is activated for the function as specified for [Output Device], [Function], 
and [Macro] when the switch is pressed within the specified time interval.
When the switch is pressed once, the frame of the switch starts blinking. The switch 
is activated when pressed again while blinking.
If another switch is pressed or another screen is displayed while the switch frame is 
blinking, the switch operation is canceled.

* If an overlap display is shown while the switch frame is blinking, the switch 
operation continues.

Sound a buzzer when the switch is 
pressed for the first time

Selected:
Always sound a buzzer when the switch is pressed.
Unselected:
When this checkbox is unselected, a buzzer only sounds when the switch is 
activated after the ON delay time.

ON repeat *1 Repeat ON function
(Repeat interval: 
15 to 150 × 10 ms)

When this checkbox is selected, the repeat function is added to the switch 
function.

Repeat ON macro
(Repeat interval: 
15 to 150 × 10 ms)

When this checkbox is selected, the repeat function is added to the switch ON 
macro.

Sound a buzzer during repeat Select this checkbox to sound a buzzer when a repeat operation is executed.
OFF delay *2
(Setting Time: 1 to 300 × 100 ms)

Select this checkbox to specify a delay for when the switch is turned OFF.
A switch OFF operation (momentary output device memory, OFF macro, etc.) will 
be processed at the conclusion of the specified time after the switch has been 
released.

* The OFF delay setting can be configured for a maximum of eight switches on 
a single screen.



3.1    Switch

3-15

1

2

3

4

5

6

7

8

9

10

Interlock

Item Description
Use interlock Select this checkbox to enable the interlock function for the switch.

Click [Add] to set up to 5 conditions that must be satisfied for the interlock to 
activate.

Condition Setting Click a condition number to configure a condition that must be satisfied for the 
interlock to activate.

Bit device Set the interlock bit address.

Bit device “ON”: switch operation is allowed
When [Bit device] is OFF, switch operation is prohibited.
When [Bit device] is ON, switch operation is allowed.

Bit device “OFF”: switch operation is allowed
When [Bit device] is OFF, switch operation is allowed.
When [Bit device] is ON, switch operation is prohibited.

Word Device Set the comparison condition expression of the interlock device memory.

Data Length: Set the data length of the condition value.
1-Word/2-Word

Constant Display Type: Set the format of the comparison condition expression.
[DEC +-]/[DEC]/[BCD]/[HEX]

Comparison condition expression: Set a comparison sign, value, and device 
memory as the conditions for comparison.

Security Level Used in conjunction with the security function.
Allow users of levels higher than the set level to operate the switch.
For details on security functions, refer to “5 Security” in the Reference Manual 2.

AND/OR Setting When two or more conditions are set for activating the interlock, set whether to 
perform AND and OR operations on the conditions.

Detailed 
Settings

Judge the condition 
when the switch is 
OFF *1

This setting is available when [Momentary/Momentary W] is selected for 
[Output Action].
Set whether the system judges the conditions for interlock activation when the 
switch is released (i.e. when your finger is released from the switch).

Unselected:
The system does not judge the conditions when the switch is OFF.

Selected:
The system judges the conditions even when the switch is OFF.
If the conditions are not satisfied, the switch will not be turned OFF even when 
your finger is released.

Sound an error 
buzzer when the 
condition is not met

Set whether an error buzzer sounds when the switch is pressed and the 
conditions are not satisfied.

Unselected: A buzzer does not sound.

Selected: A buzzer will sound.
Display ladder diagram Select this checkbox to display the configured conditions for interlock activation 

as a ladder diagram.
Display setting details Select this checkbox to configure condition settings on the ladder diagram.
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*1 Example of operation when the switch is OFF

Display when switches are disabled
When the [Gray out interlocked switches] checkbox at [System Setting] → [Unit Setting] → [General Setting] is selected, 
switches that do not satisfy the interlock conditions can be displayed grayed out.

ON

OFF

ON

ON

OFFON

OFFON

OFF

M1

M1

M1

M1

When the switch is ON: When the switch is OFF:

Judge conditions when the 
switch is OFF.

Co
nt

ro
l 

pa
ne

l

Switch settings window
Device to Output: M0
Output Action: Momentary
Use interlock

Condition 1
Bit device: M1
Bit device “ON”: switch operation 
is allowed

Condition 
satisfied

Condition 
satisfied

Condition satisfied

Condition 
satisfied

Condition not 
satisfied

Condition 
satisfied

Ineffective

Ineffective

Lamp OFF graphicLamp ON graphic

Lamp OFF graphicLamp ON graphic

Lamp OFF graphicLamp ON graphic

Lamp ON graphicLamp ON graphic

Output Device Memory
M0 remains ON.

Output Device Memory
M0 is OFF.

Output Device Memory
M0 is OFF.

Output Device Memory
M0 is OFF.

Co
nt

ro
l 

pa
ne

l

Press
Release

V10/V9 seriesV10/V9 series

Do not judge conditions when 
the switch is OFF.

Conditions satisfied Conditions not satisfied
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Message Box

• While a message dialog box is displayed, no switch operations other than those in the message dialog box are accepted 
(except for the function switches).

• If the screen is changed while a message dialog box is displayed, this has the same effect as pressing [Cancel].

Item Description
Use message call function Select this checkbox to automatically display a message dialog box when the switch is 

pressed.
When [OK] is pressed, the switch is activated for the function as specified for [Device to 
Output], [Function], and [Macro].
When [Cancel] is pressed, no operations are performed and the message dialog box closes.

Message Box Type OK/Cancel Switch
Use a message dialog box that displays an [OK] and [Cancel] switch.
OK Switch
Use a message dialog box that only displays an [OK] switch.

Messages to Display Reference one line of the message registered in the [Message] window.
A maximum of 96 one-byte characters (48 two-byte characters) can be displayed.

Click [Open] to display the [Message Edit] window.
For details on editing messages, refer to the Operation Manual.
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N-State Lamp

Precedence
The V10/V9 series unit checks conditions in order starting from ON, P3, P4, and through to P128. The pattern for which 
conditions are determined to be satisfied the earliest is displayed.

If all conditions are not satisfied, the OFF pattern is displayed.

Item Description
Use N-state lamp Select this checkbox to use the N-state lamp function.

Specify bit device memory or word device memory for each pattern.
Condition Setting Set the conditions for operating a lamp.

Click [Add] and set up a maximum of four conditions for lighting up the selected pattern.
Bit Device Light the lamp by setting the specified bit device memory to ON or OFF.
Word Device Light the lamp by setting a conditional expression for the specified word device memory.

Security Level This setting is available when using the security function.
Light the lamp according to the security level of the user that is currently logged in.
For details, refer to “5 Security” in the Reference Manual 2.

AND/OR Setting When setting two or more conditions, set whether to perform AND or OR operations on 
the conditions.

Pattern No. Precedence
ON High
P3
:

P128 Low

For a detailed setting example, refer to “4 Lamp”.

The number of patterns specified 
in the [Style] settings is displayed.

Constant Display 
Type

Select the data type of the conditional expression.
[DEC+−] / [DEC] / [BCD] / [HEX]

Condition 
expression

Set an equal sign, value, and device memory address as the 
conditions for comparison.
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Show/Hide

Item Description
Show Show the part on the screen.
Hide Do not show the part on the screen.
Show/hide according to the condition The part is shown or hidden according to the specified conditions.

Click [Add] and set up a maximum of five conditions.
Condition Setting Click a condition number to configure a condition that must be satisfied for showing or 

hiding the part.
Bit Device Show the part if the bit device memory condition is satisfied and hide the part if the 

condition is not satisfied.
Word Device Show the part if the conditional expression of the specified word device memory is 

satisfied and hide the part if the expression is not satisfied.

Security Level This setting is available when using the security function.
Show or hide the part according to the security level of the user that is currently logged in.
For details, refer to “5 Security” in the Reference Manual 2.

AND/OR Setting When setting two or more conditions, set whether to perform AND or OR operations on 
the conditions.

Constant Display 
Type

Select the data type of the conditional expression.
[DEC+−] / [DEC] / [BCD] / [HEX]

Condition 
expression

Set an equal sign, value, and device memory address as the 
conditions for comparison.



3  Switch

3-20

Detail

*1 When the buzzer is set to OFF in [System Setting] → [Unit Setting] → [Buzzer], the setting here is disabled (i.e. buzzer OFF).

Item Description
Coordinates Start X/Start Y Set the display position of the switch using X and Y coordinates.

Width/Height Set the size of the switch by specifying width and height.
Others Process Cycle Set a cycle for the V10/V9 series to read PLC data while the V10/V9 series is communicating with the PLC.

For details, refer to “1.2 Process Cycle”.
A buzzer 
sounds 
individually

Unselected:
This depends on the setting configured in [System Setting] → [Unit Setting] → [Buzzer].
Selected
A buzzer sound is set for each switch.
Standard/Short/Continuous/Error *1/OFF

Save an 
operation log

Used in conjunction with the operation log.
For details, refer to “4 Operation Log” in the Reference Manual 2.

ID
(0 - 255)

Set the ID.
For details on IDs, refer to the Operation Manual.
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3.1.4 Basic Function of Switches
List of Functions
If the [Display All] checkbox is selected next to [Function] in the switch settings, all of the switch functions are displayed for 
selection.
When nothing is listed in the “Linked Part” column of the table, the switch activates alone with the set function. When one or 
more functions are listed in the “Linked Part” column, the switch will not perform its set function unless a link is established 
with a corresponding part (i.e. the IDs of the switch and corresponding part must match).
For details, refer to the relevant pages.

Standard

*1 For details, refer to the Reference Manual 2.
*2 For details, refer to the Ladder Monitor Specification Manual.
*3 For details, refer to the following manuals.

- V10 Series Unit Operation / Local Mode / Error Screen Manual
- V9 Series Troubleshooting/Maintenance Manual

Name Description Linked Part Refer to
Standard (No Function) No function to perform. − −
Screen Change-over Change to the screen of the specified screen number. − −
Hard Copy Print the currently displayed screen image. − page 

16-16
Overlap Control Control normal/call/multi-/global overlap display. − page 2-1
Return Return to the previous screen (you can go back up to 8 screens). − −
Reset Clear logging and alarm data. Alarm

Trend
page 8-1
page 7-1

Word Operation Perform operations on device memory data. − page 3-10
Item Select Act as an entry selection switch if data is placed in the same switch. Entry page 6-36
Language changeover Change the display language. − *1

Switching to Local Mode Change to Local mode. - -
+Block Increment the display block by one. Message mode

Graphic
Alarm
Trend
Memo Pad
JPEG

page 12-1
page 11-1
page 8-1
page 7-1
page 13-1

*1

− Block Decrement the display block by one.

Roll Up Scroll up. Message mode
Alarm
Trend

page 12-1
page 8-1
page 7-1Roll Down Scroll down.

Block Call Change the display block. Message mode
Graphic
Memo Pad

page 12-1
page 11-1
page 13-1

Mode Display messages that correspond to functions on the switch. Message mode
Alarm

page 12-1
page 8-1

Occupy Make a 1:1 connection with the PLC (multi-link connection only). − −
Storage Format
(Buffer)

Format the sampling or logging file on the storage device. − −

Storage Removal Stop access to the storage device. − page 3-26
Operation Log Viewer 
Display

Display the operation log viewer. − *1

Ladder Monitor Display the ladder monitor screen. − *2

PDF Viewer Display Display the PDF viewer. − *1

Video Player Display Display the video player. − *1

Data transfer viewer 
display

Display the data transfer viewer. − *1

Storage viewer display Display the storage viewer. − *3
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Entry

*1 The decimal point and signs cannot be deleted from numerical data displays.
*2 For numerical displays, the [Allow to use Insert/DELETE keys when entering values] checkbox must be selected on the [General Settings] 

tab of the [Unit Setting] window, which is displayed by navigating to [System Setting] → [Unit Setting]. The above setting applies to the 
entry modes of all screens.

Name Description Linked Part Refer to
Character Input Enter text onto switches. Entry

(DELETE key available for 
alarm usage)

page 6-1
Write Write the entry data to the device memory.
Clear Clear the entry data.
Toggle Sign Invert the entered sign (for numerical input).
Space Enter a one-byte space (for character input).
Back Space Delete the character to the left of the cursor *1.
Delete Delete the character at the cursor position *1*2.
+1 Increment the number at the cursor position by one (for numerical 

input).
−1 Decrement the number at the cursor position by one (for numeric 

input).
Add Add a set number to the number display at the cursor position.
Subtraction Subtract a set number from the number display at the cursor position.
Cancel Restore the initial display state during entry operation.
LFT Move the cursor left *2.
RGT Move the cursor right *2.
UP Move the cursor to the previous option (−1).
DW Move the cursor to the next option (+1).
>> Move to the next screen page (+1)
<< Move to the previous screen page (−1).
Graphic Library Change characters by reading a graphics library.
Conversion of Kanji Select the Kanji mode.
80 Compatible HEX Key Use when converting GD-80 series screen programs
80 Compatible HEX Key 
Change
Max. Value Entry Display the maximum value at the entry display position.
Min. Value Entry Display the minimum value at the entry display position.
Multi-char. Input Change the text on the switch.
Switching
(Entry Mode Change)

Change the text entry mode (when the Japanese conversion function is 
used).

Switching
(1-byte/2-byte Char. 
Change)

Change between one-byte and two-byte characters (when the 
Japanese conversion function is used).

Switching (Caps Lock) Change between uppercase and lowercase characters (when the 
Japanese conversion function is used).

Direct Input Perform direct text input (when the Japanese conversion function is 
used).

Word Edit Edit registered words (when the Japanese conversion function is used).
Word Registration (Not used.)

* Register new words with a [Word Edit] switch.
Char. Switching (+) Increment the character entry switch by one.
Char. Switching (−) Decrement the character entry switch by one.
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Logging

Alarm

Memo Pad

Table Data

Digital Switch

Name Description Linked Part Refer to
Graph Return Return to the latest logging data. Trend page 7-1
Print Print the logging information.
Zoom in (X Direction) Increase the display magnification of the currently displayed graph in 

the X direction.
Zoom out (X Direction) Reduce the display magnification of the currently displayed graph in 

the X direction.
Zoom in (Y Direction) Increase the display magnification of the currently displayed graph in 

the Y direction.
Zoom out (Y Direction) Reduce the display magnification of the currently displayed graph in 

the Y direction.
Reset Display 
Magnification

Reset the display magnification to actual size and reset the reference 
position to its initial state.

File Select Display the file selection window.

Name Description Linked Part Refer to
Graph Return Return to the latest monitoring data. Alarm page 8-1
Display Change-over Change the display between date display and time display.
Print Print the alarm information.
Change Display Order Change the display order between order of occurrence and newest 

first.
Acknowledge Display the acknowledgement time of the alarm.
File Select Display the file selection window.
Filter Display Display the filter window.

Name Description Linked Part Refer to
Pen Color Select the pen color. Memo Pad page 

13-1Pen Size Select the pen thickness.
Line Draw a straight line.
Delete Area Delete the selected area of the memo pad.
Delete All Delete all memo pads on the screen.

Name Description Linked Part Refer to
Cursor Movement to 
Right

Move the cursor right within the table. Table Data Display page 
5-33

Cursor Movement to Left Move the cursor left within the table.
Table Move + Move the table in the positive direction.
Table Move − Move the table in the negative direction.

Name Description Linked Part Refer to
Digital Switch + Increment the selected digit by one. Numerical Display page 3-25
Digital Switch − Decrement the selected digit by one.
Digital Switch Sign 
Inversion

Inverse the sign of the numerical data display.
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Video

*1 For details, refer to the Reference Manual 2.

JPEG

*1 For details, refer to the Reference Manual 2.

Recipe

Security

*1 For details, refer to the Reference Manual 2.

Network Camera Display

*1 For details, refer to the Reference Manual 2.

Name Description Linked Part Refer to
Pause Stop video playback. Network camera display *1

Restart Resume video playback.

Name Description Linked Part Refer to
File Delete Delete the JPEG file currently displayed or recipe file currently selected. JPEG *1

File Call Load the JPEG file of the specified number.
JPEG Search Set an increment/decrement value for JPEG file selection.

Name Description Linked Part Refer to
Recipe Data Save Save the specified recipe data. − page 

15-1Recipe Data Load Load the specified recipe data.
Recipe Data Delete Delete the specified recipe data.

Name Description Linked Part Refer to
Log In Change the security level. − *1

Log Out Change the security level to “0”.

Name Description Linked Part Refer to
Step Up Point the camera up. Network camera display *1

Step Down Point the camera down.
Step Left Point the camera left.
Step Right Point the camera right.
Zoom In Zoom in on the camera image.
Zoom Out Zoom out of the camera image.
Focus Far Focus the camera on a distant point.
Focus Near Focus the camera on a nearby point.
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Switch Function Examples
Digital Switch
Usage example

• Switch
- Function

- [Detail] → [Detail settings]
ID: Same as the numerical data display part.

• Numerical Display
- [Function: Digital Switch]

Carryover to higher/lower digits: When selected, carryover to higher/lower digits is performed.
When not selected, only the specified digit changes.

- [Detail] → [Detail settings]
ID: Same as the switch.

Without carryover:
• Without sign or with “+” sign

Pressing the [+] key on the first digit changes “129” → “120”.
Pressing the [−] key on the first digit changes “120” → “129”.

• With “−” sign
Pressing the [+] key on the first digit changes the display as shown below.
“−008” → “−009” → “000” → “001” → “002”
Change the sign using a switch ([Function: Digital Switch Sign Inversion]).

With carryover:
• Without sign or with “+” sign

Pressing the [+] key changes “129” to “130”.
Pressing the [−] key changes “120” to “119”.

• With “−” sign
Pressing the [+] key changes “-129” to “-128”.
Pressing the [−] key changes “-129” to “-130”.

Notes
• Maximum and minimum values can be set when [Alarm] is selected for [Operation/Alarm].
• [Word Operation] and [Scaling] can be used.
• If multiple numerical data display parts ([Function: Digital Switch]) of the same ID exist, the part that is placed first is 

targeted for operation.

Item Description
Digital Switch + Target digits (1 to 17) The selected digit is incremented by one.
Digital Switch − Target digits (1 to 17) The selected digit is decremented by one.
Digital Switch Sign Inversion - Inverse the sign of the numerical data display

3
+

-
2
+

-
1
+

-

+

-
4

Switch [Function: Digital Switch +]

Numerical display [Function: Digital Switch]

Switch [Function: Digital Switch −]

0
+

-
2
+

-
1
+

-

Only the third digit changes in order 
of 0, 1, 2, 3, ... 9, 0, 1.

Only the first digit changes in order 
of 0, 9, 8, 7, ... 2, 1, 0.

0
+

-
2
+

-
1
+

-

Carry down

Carry up
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Storage Removal (Stopping Access to a Storage Device)
The switch lamp status changes as shown in the following table. Information on the switch status is stored at $s500 in the 
system device memory.

* If the [Upon storage removal] checkbox is selected in the storage output settings of the alarm server or logging server, alarm/logging data 
is output in CSV format.

Notes
• A [Storage Removal] switch with [Drive] set to [All Drives] stops access to all connected storage devices (SD card and USB 

storage devices). To individually remove an SD card or USB storage device, either specify the drive or perform removal 
from the system menu. For details, refer to the following manuals.
- V10 Series Unit Operation / Local Mode / Error Screen Manual
- V9 Series Troubleshooting/Maintenance Manual

• When intending to cancel the switch ON status (access stopped) and start accessing the storage device, press the switch 
again.

• If the screen is changed when the switch is ON, the state of the storage device does not automatically return to the 
accessing state.
Always press the switch to change it to the OFF state (accessing).
However, if the [Clear the status of Storage Removal when switching a screen (V8 compatible)] checkbox is selected under 
[System Setting] → [Unit Setting] → [General Setting], the storage device will automatically return to the accessing state.

• The lamp device memory address specified for the switch becomes unavailable.

Lamp Storage Removal Storage Access Status
OFF Prohibited Normal access

Blinking ON/OFF Prohibited Data writing triggered by switch turning ON
ON Permitted Access stopped
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3.1.5 Flowchart
When the Switch is ON (Pressed)

*1 [Output Action] or [Macro] should be selected for execution.
*2 Macro B starts after macro A is finished with the “SWRET” command.

For details on macro commands, refer to the Macro Reference Manual.
*3 The switch function is executed after the ON macro is executed. However, the “SET_SCRN,” “SET_MOVLP,” “OVLP_SHOW,” 

and “OVLP_POS” commands are executed after the switch function has been executed.
*4 Operation “C” is repeated until the switch is turned OFF (released).

A

B

C

ON delay

ON delay

Delay finished

Interlock

Interlock 
condition

Buzzer

Error buzzer ON

Delay cancel

Delay finished

Yes

Not satisfied

No

Satisfied

No buzzer

Buzzer

Switch ON

Interlock

Interlock 
condition

Normal switch

Lamp

Lamp ON graphic

Buzzer ON

Output operation

ON macro

Function execution

Continue ON 
macro?

ON macro

ON repeat

ON repeat

Ending

No

Not satisfied

Satisfied

Yes

No ON delay

Internal

External

No

No

Yes

Yes

Buzzer

Error buzzer ON

No buzzer

Buzzer
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ON delay

ON delay

First-touch buzzer

Buzzer ON

ON delay timer up

Delay finished Delay cancel Delay finished Delay cancel

Second touch

Switch frame blink

ON delay

ON delay

Buzzer ON

Confirmation pop-up 
window displayed

Confirmation pop-up 
window clear

ON processing finished CANCEL processing 
finished

Confirmation pop-up 
window clear

Buzzer ON

ON delay

First-touch buzzer

Buzzer ON

ON delay timer up

Delay finished Delay cancel

Buzzer ON

Confirmation pop-up 
window displayed

Confirmation pop-up 
window clear

ON processing finished CANCEL processing 
finished

Confirmation pop-up 
window clear

Buzzer ON

No

Switch OFF

Yes

Yes

[OK] pressed

[CANCEL] pressed

timer up

Yes

Yes

No

Yes

Switch OFF

[OK] pressed

[CANCEL] pressed

ON delay Double-touch

Message dialog box ON delay + message dialog box
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Output action

ON repeat

Output operation

Multi-output

Output operation 
execution

Output operation 
finished

Output device 
memory No. 0

Output device 
memory

Output operation 
execution

Output device 
memory No. + 1

Yes

No

Yes

No

ON repeat

Repeat buzzer

Buzzer ON

ON repeat 
macro

ON macro

ON function 
repeat

Function execution

Repeat finished

No

No

No

Yes

Yes

Yes
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When the Switch is OFF (Released)
Set, reset, alternate

Momentary, momentary W

* For details on [Output Action] settings, refer to “Notes on [Momentary] and [Momentary W] operation” page 3-9.

Release the switch.

OFF delay

OFF delay 
timer up

Delay finished Delay cancel

Switch OFF

Lamp

Lamp OFF graphic

OFF macro

Ending

No

Switch ON

Yes

Yes

Internal

External

Release the switch.

OFF delay

OFF delay 
timer up

Delay finished

Switch OFF

Delay cancel

No

Switch ON

Yes

Yes

Interlock

When the 
switch is OFF

Interlock 
condition

Lamp

Lamp OFF graphic

Output operation

OFF macro

Ending

Lamp

Lamp OFF graphic

No

Ineffective

Yes

Effective

Satisfied

Internal

Not satisfied

External External

Internal

*
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3.1.6 Coordinate Output
The current touch switch information is output to $s900 to 902 of the system device memory.
This information is useful when linking to an image processing device.

• $s900
Touch switch status

• $s901
X coordinate (absolute)

• $s902
Y coordinate (absolute)

X: 320 Y: 300

0: Switch OFF
1: Switch ON

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Not used
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3.1.7 Notes

Placement
Minimum Switch Size and Maximum Number of Switches

• Minimum size: 2 pixels × 2 pixels
(For safety reasons, however, using switches greater than 18 pixels × 14 pixels is recommended.)

• Maximum number of switches: 4096
* This includes scroll bars and slide switches.

Placing Switches Overlaying Other Switches

• If switches are overlaid, the top switch will always be enabled and the bottom switch disabled.

Switch Area
The operable area that is sensitive to screen presses is basically identical to the switch part area. However, the operable area 
may differ depending on the part type, placement method, and enlargement or reduction.

Check the action area as described below.

Location of settings
[View] → [Display Environment] → [Display] tab → [Display Area] checkbox

When the [Display Area] checkbox is selected, a dotted box is shown around each placed switch part as shown below. This 
dotted box indicates the switch’s operable area. Pressing within the switch’s operable area will activate the switch.
The outline of each switch part is called the “part area” of the switch. Pressing anywhere outside of this area does not activate 
the switch.

Do not use switches where they could cause injury to people or damage machinery. Moreover, do not use 
switches as emergency switches.

Do not overlay one switch on another switch.

Part area

Operable area
Part area
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3.2 Scroll Bars
3.2.1 Overview

Scroll bars can be used to display portions of messages or JPEG images that lie off screen.

Position to press and data write timing
• The scroll bar operates when either the slide switch or rail is pressed.
• Writing of a value occurs when the slide or rail is released.

Conceptual diagram of slide switch movement
• The slide switch moves together with your finger during movement.

* The V10/V9 series allows scrolling by dragging the display area instead of using a scroll bar.
For details, refer to “7.1 Enlarging and Scrolling Screens” in the Reference Manual 2.

Applicable Items

*1 The scroll bar is not supported for other alarm items.
(Scrolling is performed automatically for long messages.)

*2 The scrolling direction depends on the [Direction] setting in the [Trend Graph] window.
[↑] [↓]: vertical scrolling, [→] [←]: horizontal scrolling

Scroll the screen by moving the slide switch 
or pressing the desired position on the rail.

Item Scroll Direction
JPEG Vertical and horizontal
Alarm sub-display *1 Vertical and horizontal
Message Mode Vertical and horizontal
Trend graph/sampling Vertical or horizontal *2

Moving

Slide switch Rail
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3.2.2 Setting Examples
Scroll bars can be added to screens that display JPEG images.

* For details on JPEG display settings, refer to “1.1 JPEG Display” in the Reference Manual 2.

1. Click [Parts] → [Catalog] to display the catalog window.
Configure the following settings and drag and drop a vertical scroll bar onto the screen.

2. Double-click on the scroll bar to display the settings window.
Configure the [Output Setting] settings as shown below.

Drag and drop
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3. Click [Other Settings] → [Detail].
Click [Detail] → [Detail Settings], link [ID] to the ID of the JPEG display, and then click [Finish].

4. Drag and drop a horizontal scroll bar onto the screen from the catalog window in the same manner as step 1.

5. Double-click on the scroll bar to display the settings window.
Configure the [Output Setting] settings as shown below.

Drag and drop
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6. Click [Other Settings] → [Detail].
Click [Detail] → [Detail Settings], link [ID] to the ID of the JPEG display, and then click [Finish].

This completes the necessary settings.
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3.2.3 Detailed Settings
Style

Output Setting

Item Description
Edit Parts Select the parts to edit (rail/slide).
Area Setting Select from catalogs Select the part design of each pattern.

After selecting the part, select the part color.
Select from image files Select a PNG file.

Item Description
Output Action Direction

(RGT, LFT, UP, DW)
Select the scrolling direction.
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Show/Hide

Item Description
Show Display the numerical data display on the screen.
Hide Do not display the numerical data display on the screen.
Show/hide according to the condition The part is shown or hidden according to the specified conditions.

Click [Add] and set up a maximum of five conditions.
Condition Setting Click a condition number to configure a condition that must be satisfied for showing or 

hiding the part.
Bit Device Show the part if the bit device memory condition is satisfied and hide the part if the 

condition is not satisfied.
Word Device Show the part if the conditional expression of the specified word device memory is 

satisfied and hide the part if the expression is not satisfied.

Security Level This setting is available when using the security function.
Show or hide the part according to the security level of the user that is currently logged in.
For details, refer to “5 Security” in the Reference Manual 2.

AND/OR Setting When setting two or more conditions, set whether to perform AND or OR operations on 
the conditions.

Constant Display 
Type

Select the data type of the conditional expression.
[DEC+−] / [DEC] / [BCD] / [HEX]

Condition 
expression

Set an equal sign, value, and device memory address as the 
conditions for comparison.
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Detail

3.2.4 Notes
• A maximum of 4096 parts (including switches and slide switches) can be placed on one screen.
• Scrolling is performed in pixel units.
• If multiple scroll bars are placed that have the same ID and are not linked to other items, the scroll bar in the foreground 

takes effect.

3.3 Slider Switch
Slider switches are used in conjunction with numeric data entry.
For details on slider switches, refer to “6.1 Numerical Data Entry”.

Item Description
Coordinates Start X/Start Y Set the display position of the scroll bar using X and Y coordinates.

Width/Height Set the size of the scroll bar by specifying width and height.
Others Process Cycle Set a cycle for the V10/V9 series to read PLC data while the V10/V9 series is communicating with the PLC.

For details, refer to “1.2 Process Cycle”.
ID
(0 - 255)

Set the ID.
For details on IDs, refer to the Operation Manual.
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4.1 Overview
• The displayed patterns of lamps are switched in response to data changes in the lamp device memory.

There are lamps called “bit lamps” that are switched according to bit setting (ON) and resetting (OFF) and “word lamps” 
that are switched according to the values placed in device addresses.
- Bit lamp

Lamp device memory: M19

- Word lamp
Lamp device memory: D100

• Colors can be set on a pattern-by-pattern basis. For a [Draw Mode: REP] lamp, the text on the lamp can also be set for 
each pattern.

• Lamps can be set to light up when multiple conditions are satisfied. (N-state lamp)
Up to four conditions can be defined using AND and OR operators.

For example settings, refer to “Using Bit Lamps” page 4-3.

For example settings, refer to “Using Lamps with Conditions (N-State Lamp)” page 4-4.

PLC

M 0~15

M16~31

M32~47

.....
.....

LAMP

ON information

PLC device memory

PLC

D099

D100

D101

.....
.....

LAMP

3 (DEC)

PLC device memory

ONOFF

PLC

M 0~15

M16~31

M32~47

.....
.....

LAMP

PLC device 
memory

Condition 1  M0: ON
AND

Condition 2  M10: ON
AND

Condition 3  M20: ON
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• A single lamp can change between a maximum of 128 patterns.
This can be done using consecutive device memory addresses or by using any desired addresses (N-state lamp).

For an example on setting device memory addresses as desired, refer to “Creating a Three-Pattern 
Lamp (N-State Lamp)” page 4-5.
For an example on setting consecutive device memory addresses, refer to “Placing 128 Pattern Lamps” 
page 4-6.

(OFF) (ON) (P3) (P4) (P5) (P6)

(P128) (P127) (P8) (P7)

(   ): Bit lamp patterns

Pattern 0 Pattern 1 Pattern 2 Pattern 3 Pattern 4 Pattern 5

Pattern 6Pattern 7Pattern 126Pattern 127

Operation 
stop

Operation 
start Tank alarm Temperature 

increase
Temperature 

decrease
Water 

pressure drop

Voltage 
drop

Electric leak 
warning!

In 
preparation

Production 
discontinued!
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4.2 Setting Examples
Using Bit Lamps
When the M19 bit of the PLC device memory is ON, the lamp turns on, and when the M19 bit is OFF the lamp turns off.

Lamp device memory: M19

1. Click [Parts] → [Lamp] and place a lamp on the screen.

2. Double-click on the lamp to display the settings window.
Configure the following settings for [Style] and then click [Finish].

This completes the necessary settings.

PLC

M 0~15

M16~31

M32~47

.....
.....

LAMP

ON information

PLC device memory
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Using Lamps with Conditions (N-State Lamp)
Set a lamp that lights up when the M0, M10, and M20 bits of PLC device memory all turn ON.

Condition 1: M0 (ON)
Condition 2: M10 (ON)
Condition 3: M20 (ON)

1. Click [Parts] → [Lamp] and place a lamp on the screen.

2. Double-click on the lamp to display the settings window.
Configure the [N-state lamp] settings as shown below and then click [Finish].

This completes the necessary settings.

The lamp lights up when the M0, M10, and M20 bits all turn ON.

PLC

M 0~15

M16~31

M32~47

.....
.....

LAMP

PLC device memory



4.2    Setting Examples

4-5

1

2

3

4

5

6

7

8

9

10

Creating a Three-Pattern Lamp (N-State Lamp)
Set a lamp that shows the ON pattern when the M0 bit of the PLC device memory turns ON and the P3 pattern when the 
D100 value is between “1” and “50”.

1. Click [Parts] → [Lamp] and place a lamp on the screen.

2. Double-click on the lamp to display the settings window.
Set the [No. of Patterns] to “3” in the [Style] settings.

3. Configure the [N-state lamp] settings as shown below and then click [Finish].

This completes the necessary settings.

The V10/V9 series unit checks conditions in order starting from ON, P3, P4, and through to P128. The pattern for which 
conditions are determined to be satisfied the earliest is displayed.
If all conditions are not satisfied, the OFF pattern is displayed.

PLC

M 0~15

M16~31

D100

..
...

P3

...

40

PLC device memory

Conditions for showing ON pattern Conditions for showing P3 pattern
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Placing 128 Pattern Lamps
Set a 128 pattern lamp, like the one shown in the figure below.

Setting procedure
1. Click [Parts] → [Catalog] to display the catalog window.

Configure the following settings and drag and drop a lamp onto the screen.

2. Double-click on the lamp to display the settings window.
Configure the [Style] settings as shown below.
- Bit lamp

Lamp device memory: M0
(Used lamp device memory range: M0 to M126)

(OFF) (ON) (P3) (P4) (P5) (P6)

(P128) (P127) (P8) (P7)

(   ): Bit lamp patterns

Pattern 0 Pattern 1 Pattern 2 Pattern 3 Pattern 4 Pattern 5

Pattern 6Pattern 7Pattern 126Pattern 127

Operation 
stop

Operation 
start Tank alarm Temperature 

increase
Temperature 

decrease
Water 

pressure drop

Voltage 
drop

Electric leak 
warning!

In 
preparation

Production 
discontinued!

Drag and drop
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- Word lamp
Lamp device memory: D100

3. Configure the [Char. Prop.] settings as shown below.
Change between the [OFF] to [P128] tab and [0] to [127] tab to register text for each pattern and then click [Finish].
- Bit lamp

- Word lamp

This completes the necessary settings.
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Display example
• Bit lamp

* When multiple bits are set to ON, a pattern is displayed according to the most significant bit.

• Word lamp

* If a value outside the specified range is set for the lamp device memory, the lamp display is not changed.

Notes
• When placing multiple lamps, set up consecutive addresses for the lamp device memory to ensure high-speed 

processing.
• When placing multiple lamps that have a different number of screen patterns and the lamp device memory are allocated 

with consecutive addresses, be careful configuring the settings of the lamp device memory. The required number of bits 
varies depending on the number of patterns.

M000-015
M016-031

M112-127

M000-015
M016-031

M112-127

Operation 
stop

Water 
pressure drop

M4 is set to ON.

Set M4 in the PLC device memory to ON.
Pattern 5 (P6) is displayed.

When M0 to 126 is set to “OFF” in the PLC 
device memory, pattern 0 (OFF) is displayed.

Status monitor screen Status monitor screen

M000-015
M016-031

M112-127

Production 
discontinued!

Pattern 127 (P128) is displayed.

Status monitor screen

D100 3
D101

D100 0
D101

Operation 
stop

Temperature 
increase

Set “3” for D100.

Set “3” for D100 in the PLC device memory.
Pattern 3 is displayed.

When D100 is set to “0” in the PLC 
device memory, pattern 0 is displayed.

Status monitor screen Status monitor screen
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4.3 Detailed Settings
Style

*1 Multiple frame dimensions can be set at once by selecting the items to change via [Tool] → [Fix 3D parts frame].
*2 Notes on 3D type and 2D type parts

Part shapes differ depending on the selection made in the catalog.
• 3D type: Plain, Animation, Flat, Real, Sign, 3D, 3D_128, HA
• 2D type: 2D

Selection of an image file corresponds to the 3D type.
*3 When the [Use N-state lamp] checkbox is selected, the setting is hidden.

Item Description
No. of Patterns
(2 - 128)

Set the number of patterns that the lamp can display.

Area Setting Select from catalogs Select the part design.
After selecting the part, select the part color.

Select from image files Select a PNG file.
The PNG file can be set to all patterns by clicking [Apply to All Patterns].

Frame Type Select the frame type of the lamp. * Only available with 2D (Square2) parts.
Color Select the frame color of the lamp. * Only available with 2D (Square2) parts.

Detail Settings Fix the frame size *1 Zoom in and out while maintaining the dimensions specified for the top, bottom, left, and 
right of the frame.
Applicable parts: Only real type and square type parts with frames and 3D parts (excluding 

some parts)
Enable flash display function
(flashing with OFF pattern)

This item is available when a 3D pattern type *2 other than an OFF pattern (excluding “Sign” 
and “3D_128” parts) is selected.
Select this checkbox to flash the display between the selected pattern and the OFF pattern.

Other Settings Draw Mode
REP/XOR

REP: Display using the color set in [Area Setting].
XOR: When the lamp device memory is ON, the frame and text are displayed in the color 

resulting from an XOR operation.

For the difference between REP and XOR, refer to “4.4 Draw Mode” page 4-16.
Clear graphic displayed 
before switching 
(transparency function)

The previous graphic is not retained when the checkbox is selected.
For details, refer to “Notes on the transparency function” page 4-10.

Lamp Device *3 Device Designation Bit:
The lamp display is changed by setting (ON) and resetting (OFF) bits.
The required number of bits depends on the number of display patterns.
(127 bits maximum)

* When multiple bits are set (ON), the most significant bit has priority.

Word:
The lamp display is changed according to the value specified for the device memory address.
The range of setting values varies with the number of patterns.
(Range: 0 to 127)
If a value outside the specified range is set, the lamp display is not changed.

Input Type
(DEC/BCD)

Specify the input format of the device memory.
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Notes on the transparency function
The transparency function is used to create parts that are only displayed when ON or parts only consisting of characters.

The following shows how parts with transparency placed on the screen are displayed.

• Clear graphic displayed before switching (transparency function) Unselected
The previously displayed image remains.

• Clear graphic displayed before switching (transparency function) Selected
The previously displayed image does not remain. Parts can be displayed even with graphics placed in the background.

Notes
• Transparency cannot be set for [Lamp] → [Shape: 2D] → [Group: Square2] parts in the catalog window.

OFF ON
Part only displayed when 

ON
Hide

Only characters displayed

Custom parts
(Black: transparent color)

OFF ON

[OFF] [ON] [OFF]

[OFF] [ON] [OFF]
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Char. Prop.

*1 Cannot be set to transparent.

Item Description
[OFF] [ON] - [P128] When [Style] → [Other Settings] → [Draw Mode] is [XOR]:

Only [OFF] can be selected. Specify the text to be displayed.

Pattern No.
(0 - 127)

When [Style] → [Other Settings] → [Draw Mode] is [REP]:
Specify the text to be displayed on each pattern.

Text Enter text to be displayed on the lamp.
Up to 4 lines can be registered. Text properties can be set for each line.
Text can be justified within the lamp part.

String table Select this checkbox when using strings registered to the string table.
For details, refer to the Reference Manual 2.

Color
(text color, background color)

Set the color for text.
The background color can also be set if set as “no transparency” in the following [Style] setting.

Style Set the text style.
Character Size
(1 - 8)

Specify the enlargement factor for text.
* When [Bitmap font] is selected at [System Setting] → [Multi-language Setting] → [Font Type]

Point
(6 - 999)

Set the text size.
* When a font type other than [Bitmap font] is selected at [System Setting] → [Multi-language Setting] 

→ [Font Type]
Rotation + Direction Set the combination of text rotation and direction.

Four combinations are displayed in the drop-down menu.

When selecting an option other than the above, click the icon at the bottom.
The window that allows selection from all options is displayed.

Use Windows fonts Select this checkbox to use a Windows font.
Smooth Font *1 Smooth the edges of text. (Only settable for TrueType Windows fonts.)

Alignment Set the text alignment.

Text copy
Copy only characters

The text and its attributes for the current pattern (OFF, ON, P3) are copied to the other patterns.
Select the [Copy only characters] checkbox to copy text and coordinate information to all other patterns.
Note that the text properties will not be copied. If the destination for copy has no text, text properties will 
also be copied.

Set line spacing Set the pitch between lines.
Use the same style for all 
patterns

Select this checkbox to configure the same settings as the opened pattern attributes with respect to all 
lamp patterns (for each respective line if multiple lines are included).

Auto-adjust the size according 
to the style

Select this checkbox to automatically adjust the lamp size to the entered text.

Retain the coordinates when 
changing character string

Newly registered text is placed by centering. When any registered text is changed while this checkbox is 
selected, the coordinates remain the same.
When a line is added to the existing text while this checkbox is selected, the added line is aligned with the 
upper line.

4-Line Display Select this checkbox to divide the text entry area into four lines.
This allows different properties to be specified for each line when using Windows fonts.

Flush RightFlush Left
Center
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Function

*1 The following function is added when the [Display All] checkbox is selected.

Item Description
Function Set the type of operation to be performed by the lamp.

Standard Standard Use as a standalone part without any dependencies on other parts.
Display All Select this checkbox to display all of the available lamp functions. *1

Name Description Linked Part Refer to
Standard Mode Display a message on the lamp. Alarm

Message mode
page 8-1
page 12-1
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N-State Lamp

Precedence
The V10/V9 series unit checks conditions in order starting from ON, P3, P4, and through to P128. The pattern for which 
conditions are determined to be satisfied the earliest is displayed.

If all conditions are not satisfied, the OFF pattern is displayed.

Item Description
Use N-state lamp Select this checkbox to use the N-state lamp function.

Specify bit device memory or word device memory for each pattern.
Condition Setting Set the conditions for operating a lamp.

Click [Add] and set up a maximum of four conditions for lighting up the selected pattern.
Bit Device Light the lamp by setting the specified bit device memory to ON or OFF.
Word Device Light the lamp by setting a conditional expression for the specified word device memory.

Security Level This setting is available when using the security function.
Light the lamp according to the security level of the user that is currently logged in.
For details, refer to “5 Security” in the Reference Manual 2.

AND/OR Setting When setting two or more conditions, set whether to perform AND or OR operations on 
the conditions.

Pattern No. Precedence
ON High
P3
:

P128 Low

The number of patterns specified in 
the [Style] settings is displayed.

Constant Display 
Type

Select the data type of the conditional expression.
[DEC+−] / [DEC] / [BCD] / [HEX]

Condition 
expression

Set an equal sign, value, and device memory address as the 
conditions for comparison.
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Show/Hide

Item Description
Show Show the part on the screen.
Hide Do not show the part on the screen.
Show/hide according to the condition The part is shown or hidden according to the specified conditions.

Click [Add] and set up a maximum of five conditions.
Condition Setting Click a condition number to configure a condition that must be satisfied for showing or 

hiding the part.
Bit Device Show the part if the bit device memory condition is satisfied and hide the part if the 

condition is not satisfied.
Word Device Show the part if the conditional expression of the specified word device memory is 

satisfied and hide the part if the expression is not satisfied.

Security Level This setting is available when using the security function.
Show or hide the part according to the security level of the user that is currently logged in.
For details, refer to “5 Security” in the Reference Manual 2.

AND/OR Setting When setting two or more conditions, set whether to perform AND or OR operations on 
the conditions.

Constant Display 
Type

Select the data type of the conditional expression.
[DEC+−] / [DEC] / [BCD] / [HEX]

Condition 
expression

Set an equal sign, value, and device memory address as the 
conditions for comparison.
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Detail

Item Description
Coordinates Start X/Start Y Set the display position of the lamp using X and Y coordinates.

Width/Height Set the size of the lamp by specifying width and height.
Others Process Cycle Set a cycle for the V10/V9 series to read PLC data while the V10/V9 series is communicating with the PLC.

For details, refer to “1.2 Process Cycle”.
ID
(0 - 255)

Set the ID.
For details on IDs, refer to the Operation Manual.
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4.4 Draw Mode
XOR
Shape: 2D, group: square2

Text
When setting text on a lamp, the same text is displayed for both OFF and ON statuses.
Set text on the [OFF] tab of [Char. Prop.].

Color
• OFF frame color/ON color/OFF color

Set the lamp color via [Style] in the lamp settings window.
• OFF text color

Set the text color via [Char. Prop.] in the lamp settings window.
• ON frame color

The frame color to use when the lamp is ON cannot be set. It is automatically determined by an XOR operation as 
shown below.

• ON text color
The text color to use when the lamp is ON cannot be set. It is automatically determined by an XOR operation as shown 
below.
The text displayed when the lamp is ON is the same as that displayed when the lamp is OFF.

XOR = ON frame color
Frame color

OFF color

ON color
XOR

XOR = ON text color
Text color

OFF color

ON color
XOR
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Display example

For parts other than [Shape: 2D], [Group: Square2]
Text

When setting text on a lamp, the same text is displayed for both OFF and ON statuses.
Set text on the [OFF] tab of [Char. Prop.].

Color
• OFF color

Set the lamp color via [Style] in the lamp settings window.
• ON color

The color resulting from an XOR operation on the color specified for [Style] and the OFF color (explained above) is 
displayed.

• P3 to P128 color
As with the ON color, the color resulting from an XOR operation on the color specified in the settings window and the 
OFF color is displayed.

Notes
Draw mode: When an XOR operation is performed, the colors that can be used are the 16 colors displayed on [Custom Color] 
→ [Palette 1].
If a color other than the following 16 colors is selected, the XOR color may not be displayed correctly.

Bla Blu R Mag Gre C Y W

Bla Blu R Mag Gre C Y WBla

Blu Bla Mag R C Gre W YBlu

R Mag Bla Blu Y W Gre CR

Mag R Blu Bla W Y C GreMag

Gre C Y W Bla Blu R MagGre

C Gre W Y Blu Bla Mag RC

Y W Gre C R Mag Bla BluY

W Y C Gre Mag R Blu BlaW

A

C

B D

C

[OFF color: Yellow]
[ON color: Red]
[Frame color: White]  The frame color displayed when the lamp is ON
OFF color (yellow)   A
(setting)
OFF color (red)   B
(setting)
Frame color (white)   D
(setting)

XOR Purple = ON frame colorGreen C XOR

Bla Blu R Mag Gre C Y W

Bla Blu R Mag Gre C Y WBla

Blu Bla Mag R C Gre W YBlu

R Mag Bla Blu Y W Gre CR

Mag R Blu Bla W Y C GreMag

Gre C Y W Bla Blu R MagGre

C Gre W Y Blu Bla Mag RC

Y W Gre C R Mag Bla BluY

W Y C Gre Mag R Blu BlaW

A

C

BD

C

OFF color (yellow)   A
(setting)
OFF color (red)   B
(setting)
OFF color (blue)   D
(setting)

XOR

Light blue = ON text color
Green C XOR

[OFF color: Yellow]
[ON color: Red]
[Text color: Blue]  The text color displayed when the lamp is ON

[Palette 1]
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REP
Shape: 2D, group: square2
Text

When placing text on a lamp part in “REP” draw mode, the following two modes are available.
• When displaying different text when the lamp is ON and OFF:

OFF text
Set text on the [OFF] tab of [Char. Prop.].
ON text
Set text on the [ON] tab of [Char. Prop.].

• When displaying the same text when the lamp is ON and OFF:
OFF text
Set text on the [OFF] tab of [Char. Prop.].
ON text
Nothing is set for the text on the [OFF] tab of [Char. Prop.].
The text set in the character input box [OFF] is displayed when the lamp is ON.

Color
• ON frame color, OFF frame color, ON color, OFF color

Set the lamp color via [Style] in the lamp settings window.
The same frame color is used when the lamp is ON and OFF.

• OFF text color
Set color on the [OFF] tab of [Char. Prop.].

• ON text color
Set color on the [ON] tab of [Char. Prop.].
The part is displayed in the selected colors.

For parts other than [Shape: 2D], [Group: Square2]
This case is mostly the same as when [Group] is set to “Square2”. (Refer to page 4-18.)
Differences

• ON frame color, ON color
Set the lamp color via [Style] in the lamp settings window.
A color different from the OFF frame color can be set.

• For P3 to P128, the selected colors are shown.

Notes
• When the OFF text color and the ON color are the same, the text cannot be shown when the lamp is turned ON.

RunStop
When the lamp is OFF
[Style]: Normal

When the lamp is ON
[Style]: Bold

The text property can be set as shown.

Error Error
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4.5 Notes
Number of lamps
A maximum of 4096 lamp parts can be created on a single screen.
For details, refer to the Operation Manual.

Placing multiple lamp parts
When placing lamps overlaid, they are displayed as shown in the editor.
Take the following operations into consideration when creating screens.

XOR

XOR

XOR

XOR

M0=0

M1=0

M0=1

M1=0

XOR

XOR

M0=1

M1=1

XOR

XOR

M0=0

M1=1

REP

REP

M0=0

M1=0

M0=1

M1=0

REP

REP

M0=1

M1=1

REP

REP

M0=0

M1=1

REP

REP
M0=0

M1=1

REP

REP

M0

M1

M0

M1

M0

M1

M0

M1

M0

M1

* When M0 = 0 in the above cases, 
lamps are shown as below.

* XOR drawing is not performed 
when lamps are overlaid.
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5.1 Numerical Display
5.1.1 Overview

• Numerical data read from the PLC is displayed in real time on the screen in any of the following formats: DEC (w/o sign), 
DEC (with sign −), DEC (with sign +−), HEX (hexadecimal), OCT (octal), BIN (binary) and Real Number Type (decimal 
floating-point).

• Data read from the PLC can be shown on a 7 segment display and using * (asterisks).

• It is possible to show data in a different color when it exceeds or falls short of a specific range.
This setting can easily attract the operator’s attention to the situation.

• MONITOUCH can read data from the PLC, perform calculations, and display the result on the MONITOUCH screen.

• In addition to using numerical data displays ([Num. Display]) independently, they can also be linked to other parts.
For example, in order to indicate data as a percentage in the statistic graph as shown below, it is necessary to link [Num. 
Display] with [Statistic Graph].
This allows the percentage value to automatically reflect changes in the data of the statistic graph.

For example settings, refer to “Monitoring PLC Device Memory” page 5-4.

For details, refer to “9.5 Statistic Bar Graph” “9.6 Statistic Pie Graph”.

PLC

.................

12345
12345

PLC device memory

PLC

.................

1205

PLC device memory

7 segment display * display

100

80

100

150

Target 
value
Count Count

Target 
value

When the count 
exceeds the target, 
the color of the count 
number is changed.

PLC

.................

-211
789

MONITOUCH executes the following calculation 
on the read data of “789” and displays the result.
[-1000] + [789] × [1] = -211

PLC device memory

%
A      350    42.94%
B      209    25.64%
C      156    19.14%
D      100    12.26%

Linked

Numerical DisplayStatistic graph

Production 
Ratio

Result

Product
Product
Product
Product

Display
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• Device memory for offset value designation
A single numerical display part can be used to show different data by switching the device memory address assigned to 
the part. This can help to reduce the number of screens or parts used and facilitate screen maintenance.

D100 3

1000

980

12
D103 (D100 + 3)
D113 (D110 + 3)
D123 (D120 + 3)

1000

999

5

1

D102 (D100+ 2)
D112 (D110 + 2)
D122 (D120 + 2)

1000

998

10

D100 2

D100

D102

0

1000

998

D103

D112
D113

D122
D123

1000

10

980

12

D101 1000

999D111

5D121

D101 (D100+ 1)
D111 (D110 + 1)
D121 (D120 + 1)

Example: Displaying scheduled production volume, non-defective count, and defective count for a machine 
selected from No. 1 to 3

“2” written to D100 
(offset value 
designation)

Numerical Display
Machine number: D100 (device memory)
Scheduled production volume: D100 (base), D100 (offset value designation)
Non-defective count: D110 (base), D100 (offset value designation)
Defective count: D120 (base), D100 (offset value designation)

When D100 = 1, machine No. 1 data at 
D101, D111, and D121 are displayed.

“3” written to D100 
(offset value 
designation)

Scheduled
production volume

Non-defective count
Defective count

Production Result for One Day

Production Result for One Day Production Result for One Day

When D100 = 2, machine No. 2 data at 
D102, D112, and D122 are displayed.

When D100 = 3, machine No. 3 data at 
D103, D113, and D123 are displayed.

Machine number
(offset value 
designation device 
memory)
Scheduled 
production volume

Non-defective count

Defective count

Scheduled
production volume

Non-defective count
Defective count

Scheduled
production volume

Non-defective count
Defective count
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• Specifying attributes using device memory
The attributes (number of digits, decimal point, display type, or text color) of numerical display parts are easily 
changeable while MONITOUCH is in RUN mode.

31.5315

D100 315

0
D201
D202

0
D200

D100 315

D201
D202

D200

7

13B

D203 D2030 0

1
2
6

Example: Numerical data display D100 (no transparency)
Change the decimal place from 0 to 1, text color from black to red, and background 
color from white to yellow.

Room Temperature 
Check

D200 = 1
D201 = 2
D202 = 6

The display now 
includes one decimal 
place and shows 
red-colored text on 
yellow-colored 
background.

Device memory addresses for changing attributes
Decimal Point: D200
Text color: D201
Back Color: D202
Display Type: D203

D100

(White)
(Black)

(Yellow)
(Red)

Room Temperature 
Check

(1 decimal place)(No decimal point)

Room Temperature 
Check

D203 = 3

The display type is 
switched from DEC to 
HEX.
The setting for one 
decimal place (D200 
= 1) is invalid.

(DEC w/o sign) (DEC w/o sign)
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5.1.2 Setting Examples
Monitoring PLC Device Memory
This example explains monitoring of a PLC device memory D100.
The numerical data display is shown in red when the value is less than “100” and yellow when the value exceeds “1000”.

1. Click [Parts] → [Data Display] → [Num. Display] and place a numerical data display on the screen.

2. Double-click on the switch to display the settings window.
Configure the [Contents] settings as shown below.

3. Click [Other Settings] → [Operation/Alarm].
Configure the following settings for [Operation/Alarm] and then click [Finish].

This completes the necessary settings.
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5.1.3 Detailed Settings
Contents

Item Description
Device to 
Display

Device
(base device memory)

Specify the device memory address to use for numerical data display.

Use offset value 
designation device *1 *2

Set the device memory address and the code used for storing an offset value with respect to 
the value in the base device memory.

Data Length *3
1-Word/2-Word

Select the data length used for this part.

Text to Display Display Format Select the format of numbers to be displayed on the screen.
Designate by device *4 Select this checkbox to change the display format according to the value specified for the 

device memory address.
* This item cannot be used when “Real Number Type” is specified above for [Display 

Format].
Digits *5 Specify the number of digits for the numerical data display.
Designate by device *4 Select this checkbox to change the number of digits according to the value specified for the 

device memory address.
Decimal Point Specify the decimal place. The number of decimal places must be smaller than the number of 

digits.
When no decimal point is required, set “0”.

Designate by device *4 Select this checkbox to change the decimal point according to the value specified for the 
device memory address.

Auto-adjust the area 
according to the char. 
size

Select this checkbox to automatically adjust the item size based on the [Digits] and [Decimal 
Point] settings.

Code When a [Designate by device] checkbox is selected, set the code used when reading values 
from the device memory address.
This setting applies to [Display Format], [Digits], [Decimal Point], [Char. Color], and 
[Background].

Code Setting Range
DEC 0 - 65535
BCD 0 - 9999

Real Number Type (DEC) 0 - 65535
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*1 The device memory for offset value designation is read every cycle, regardless of the item processing cycle. Screen updates depend on 
the setting of the [Redraw the screen] checkbox in [Screen Setting] → [Screen Setting] → [Unhide] → [Unhide Items].
• Selected:

Update the screen when the value in the device memory for offset value designation changes.
Only update the items on the screen whose value changed in the device memory for offset value designation (the screen is not 
redrawn).

• Unselected:
The screen is updated at the following times.
Screen change/screen redraw/multi-overlap change (when there are parts placed on multi-overlap)

*2 Notes on using the device memory for offset value designation
• When the screen is updated, the device memory for offset value designation is read for the items placed on the screen. This means 

that for a screen that includes multiple addresses of the device memory for offset value designation, the updated screen is displayed 
upon completion of reading all of these device memory addresses. If screen updates are taking too long, use of the internal device 
memory is recommended.

• When setting offset values on a screen, the setting needs to be completed before the screen is changed to another screen. In a case 
where an offset value is designated in an OPEN macro, the offset value is not valid when the screen is open, but becomes valid when 
the screen is updated.

• An error occurs if a value set to the device memory for offset value designation is outside the permissible range. Observe the 
specified range for setting.

*3 Relationship between data length and display format

*4 For details on the method for specifying attributes using device memory, refer to “Specifying attributes using device memory” page 5-7.
*5 When a value exceeding the set number of digits is entered:

Code Format 1-word Display Range 2-word Display Range
DEC (w/o sign) 0 - 65535 0 - 4294967295
DEC (with sign −) −32768 - 32767 −2147483648 - 2147483647
DEC (with sign +−) −32768 - +32767 −2147483648 - +2147483647
HEX 0 - FFFF 0 - FFFFFFFF
OCT 0 - 177777 0 - 37777777777
BIN (Binary) 0 - 1111111111111111 0 - 11111111111111111111111111111111

Code Format DEC HEX/OCT/BIN
Display Overflow display Numbers from the right

E.g.: Data length: 1 word
Digits: 3
Entered value: 1010

− − − 010
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Specifying attributes using device memory
When a [Designate by device] checkbox in [Contents] → [Detail Settings] or a [Designate by device] checkbox in [Char. Prop.] 
→ [Detail Settings] is selected, the corresponding attribute can be changed by specifying a value using a device memory 
address.

Item Description
Contents Display Format Specify the display format for the numerical data display.

Set a value according to the following.

0: DEC (w/o sign)
1: DEC (w/ −sign)
2: DEC (w/ +−sign)
3: HEX
4: OCT
5: BIN
6: FLOAT*
7: BCD (w/o sign)
8: BCD (w/ −sign)
9: BCD (w/ +−sign)

* This setting is enabled when “2-Word” is set for [Contents] → [Data Length].
Digits When the numerical data display includes decimal places, specify the total number of digits 

including the number of decimal places.

* If a read value exceeds the limit specified for the number of digits, hyphens are 
displayed to indicate that an overflow occurred.

Decimal Point Specify the number of decimal places for the numerical data display.

* The number of decimal places must be smaller than the total number of digits. An 
overflow will occur if the number of decimal places is the same or more than the total 
number of digits.
When [Display Format] is set to “HEX”, “OCT”, or “BIN (Binary)”, the decimal point 
setting does not take effect.
Even if a value is set for [Decimal Point] in such a case, it is assumed to be zero.

Display Type Digits
DEC 1 - 10
HEX 1 - 8
OCT 1 - 11
BCD 1 - 8
BIN 1 - 32

FLOAT 1 - 32

Display Type Digits
DEC 0 - 9
BCD 0 - 7

FLOAT 0 - 31
HEX/OCT/BIN* -
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Notes on changing attributes using device memory
• The update timing depends on the setting of [Detail] → [Process Cycle] of each part.
• For parts with a frame, the frame size does not change according to the setting of [Digits], [Decimal Point], or [Display 

Format].
For this reason, the maximum number of digits in the screen program must be set in advance.

• When [Char. Prop.] → [Style] is set to “not transparent”, the drawing range of the background drawing area will be 
affected by changes to the settings of [Digits], [Decimal Point], and [Display Format]. This means that if the set number of 
digits decreases, the background color will remain on the screen.
For this reason, the maximum number of digits in the screen program must be set in advance. Alternatively, update the 
display by executing the “SYS (RESET_SCRN)” macro command or by changing the screen.

• If a displayed value has become higher than the maximum or lower than the minimum specified for alarm, the value is 
shown in the color specified for the alarm.

• The “CHG_DATA” macro command cannot be used with numerical data displays for which a [Designate by device] 
checkbox is selected.

• When “Entry Target” is set for [Function], the display is switched when the cursor is moved from the display field.

Char. Prop. Char. Color Set the color for text.

Bits 0 to 6: Color
Bit 7: Blinking (0: No, 1: Yes)

A color can be selected from the 128 colors (and blinking) on [Palette 1] in the [Custom Color] 
window.
Colors correspond to the following color codes.

Background Specify the background color of text.

Bits 0 to 6: Color
Bit 7: Blinking (0: No, 1: Yes)

A color can be selected from the 128 colors (and blinking) on [Palette 1] in the [Custom Color] 
window.
For details on color codes, refer to the “Char. Color” section.

* However, note that the background color setting does not take effect when [Char. Prop.] 
→ [Style] is set to “transparent”.

Item Description

31.5 Text color

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
0 to 127 colors

Text color

Blinking
0: No
1: Yes

n

[Palette 1]

00
16
32
48
64
80
96
112

15
31
47
63
79
95
111
127

0 1 2 3 4 5 6 7 8 9 A: B C D E F

31.5 Background color

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
0 to 127 colors

Background color

Blinking
0: No
1: Yes

n



5.1    Numerical Display

5-9

1

2

3

4

5

6

7

8

9

10

Style

Item Description
Area Setting Select from catalogs Select the part design.

After selecting the part, select the part color.
Select from image files Select a PNG file.
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Function

*1 The following function is added when the [Display All] checkbox is selected.

Item Description
Function Set the type of operation performed by the numerical data display.

Standard Num. 
Display

Display device memory values on the numerical data display in real time.

Entry Target Used in conjunction with the entry function.
For details, refer to “6.1 Numerical Data Entry”.

Display All Select this checkbox to display all of the available numerical data display functions. *1

Name Description Linked Part Refer to
Standard Entry Display Part Temporarily display values entered using a keypad. Entry page 6-1

Max. Value Display 
Part

Display the maximum value that can be entered using 
a keypad.

Min. Value Display 
Part

Display the minimum value that can be entered using 
a keypad.

Statistic Graph % 
Display

Display statistical data on the graph as a percentage. Statistic graph
Statistic pie graph

page 9-47
page 
9-53

Digital Switch Display a digital switch value. Switch page 3-25
Logging Logging Count 

Display
Display the number of logging entries or the number 
of the logged data within the trend data currently 
selected using the cursor.

Trend page 7-1

Logging Time 
Display

Display the last logging time or the logging time of 
the trend data currently selected using the cursor.

Mean Value Display Display the average value of all data stored in the 
logging block.

Max. Display Display the maximum value of all data stored in the 
logging block.

Min. Display Display the minimum value of all data stored in the 
logging block.

Total Display Display the total value of all data stored in the 
logging block.

Display start time Display the logging time of the oldest data on the 
currently displayed graph.

Display end time Display the logging time of the newest data on the 
currently displayed graph.

Currently Selected 
Value Display

Display the latest logging value or the cursor point 
value of each graph currently selected using the 
cursor.

Alarm Count Display Display the number of alarm logs or the No. of the 
sampled data within the log data currently selected 
using the cursor.

Alarm page 8-1

Time Display Display the last alarm log time or the sampling time 
of the log data currently selected using the cursor.
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Char. Prop.

*1 For details on the method for specifying attributes using device memory, refer to “Specifying attributes using device memory” page 5-7.
*2 Cannot be set to transparent.
*3 Featuring digital display fonts by Yourname, Inc.

Item Description
Alignment Set the text alignment.

Value to Display on Preview This item is available when the [Display for the editor] checkbox is selected on the [View] → [Display 
Environment] → [Display] tab.
Set the value to display using the editor.

Char. Color Set the color for text.
Designate by device *1 Select this checkbox to change the text color according to the value specified for the device memory 

address.
Background Set the background color of text.
Designate by device *1 Select this checkbox to change the background color according to the value specified for the device 

memory address.
Style Set the text style.
Character Size (1 - 8) Specify the enlargement factor for text.

* When [Bitmap font] is selected at [System Setting] → [Multi-language Setting] → [Font Type]
Point (6 - 999) Set the text size.

* When a font type other than [Bitmap font] is selected at [System Setting] → [Multi-language Setting] 
→ [Font Type]

Rotation + Direction Set the combination of text rotation and direction.
Four combinations are displayed in the drop-down menu.

When selecting an option other than the above, click the icon at the bottom.
The window that allows selection from all options is displayed.

Spacing Select this checkbox to specify the spacing between characters.
Zero Suppress Select this checkbox to use zero suppression.

When this checkbox is checked, select either [Flush Left] or [Flush right].

System Font
Windows Font
7-segment Font

Select the font to use for the numerical data display.
When “7-segment Font” is selected, select the [Display light-out segments] checkbox to display unlit 
segments.

Smooth Font *2 When “Windows Font” is selected, select this checkbox to smooth the edges of text.
(Only settable for TrueType Windows fonts.)

Display light-out 
segments *3

When “7-segment Font” is selected, select this checkbox to display unlit segments.

* Display Select this checkbox to display * (asterisks) instead of numbers.
Code When a [Designate by device] checkbox is selected, set the code used when reading values from the device 

memory.
This setting applies to [Display Format], [Digits], [Decimal Point], [Char. Color], and [Background].

Flush RightFlush Left
Center

[  Zero Suppress] (Flush Right) →       123
[  Zero Suppress] → 000123

Spaces

Flush Left → 123
Flush Right →      123
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Operation/Alarm

Item Description
Alarm Select this checkbox to display data in a different color when it exceeds or falls short of a 

specific range.
When “Entry Target” is selected for [Function], the range of values that can be entered 
using a keypad can be set.
For details on numerical value entry, refer to “6.1 Numerical Data Entry”.

Minimum Set the minimum value used to trigger an alarm.
Use offset value 
designation device

Set the device memory and code used for storing an offset value for the minimum value.

Char. Color Set the color for text.
Background Set the background color of text.

Maximum Set the maximum value used to trigger an alarm.
Use offset value 
designation device

Set the device memory and code used for storing an offset value for the maximum value.

Char. Color Set the color for text.
Background Set the background color of text.

Operation *1 Select this checkbox to perform an operation on the value of the device memory 
specified in [Contents].

Scaling *2 Select this checkbox to display data after automatically converting the data read from the 
PLC ([Range before Scaling]) to the specified range ([Range after Scaling]).
This eliminates the need for correction programs for data read from the PLC when 
displaying information such as temperature, rotation speed, etc.

Range before Scaling Specify the data to be read from the PLC.
Range after Scaling Specify the range of data to be shown on MONITOUCH.

Multiplier or divisor (constant)Offset value
(constant)

× or / (÷)

Device memory specified in [Contents]

4000

100

00

PLC MONITOUCH

(Range before scaling) (Range after scaling)
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*1 Operations
Example: Data read from PLC is “789”.
• When “BCD” is selected for [Input Type] and negative numbers are displayed

(Negative numbers do not exist in the BCD format.)
Select either [DEC (with sign −)] or [DEC (with sign +−)] for [Contents] → [Display Type].

[offset value] + (data) [×] [multiplier] = display data
[0] + (789) [×] [−1] = −789

Or [−1000] + (789) [×] [1] = −211

• Example of multiplication

[offset value] + (data) [×] [multiplier] = display data
[1000] + (789) [×] [1] = 1789
[0] + (789) [×] [100] = 78900

• Example of division with a decimal point
When “2” is entered for [Decimal Point] in [Contents], “7.89” is read into MONITOUCH.

[offset value] + (data) [÷] [divisor] = display data
[0] + (7.89) [÷] [100] = 0.0789

Data is rounded down to two decimal places to display “0.07”.

• Example of division without a decimal point

[offset value] + (data) [÷] [divisor] = display data
[0] + (789) [÷] [−100] = −7.89

Data is rounded to a whole number to display “−7”.

[offset value] + (data) [÷] [divisor] = display data
[200] + (789) [÷] [100] = 207.89

Data is rounded to a whole number to display “207”.

Example: When an operation is set for “Entry Target” (entry mode)
• The value entered using a keypad is displayed (= result of operation).

The value (i.e. data) stored in the device memory is the source value used in the operation.

[offset value] + (data) [×] [multiplier]
[0] + (A) [×] [100]

Input of “100” → 100 = (A) × 100 → (A) = 1
Input of “550” → 550 = (A) × 100 → (A) = 5 (remainder of 50 is ignored, “500” is displayed)
Input of “1340” → 1340 = (A) × 100 → (A) = 13 (remainder of 40 is ignored, “1300” is displayed)

[offset value] + (data) [÷] [divisor]
[0] + (A) [÷] [100]

Input of “100” → 100 = (A) / 100 → (A) = 10000
Input of “550” → 550 = (A) / 100 → (A) = 55000
Input of “1340” → 1340 = (A) / 100 → (A) = 2928 (A word exceeds 5 digit display)



5  Data Display

5-14

*2 Scaling
• If data in the PLC device memory multiplied by the maximum value specified for [Range after Scaling] is greater than a double-word, 

it cannot be displayed correctly.
• Example: Numerical data display

When data in the PLC device memory address D100 is “2000” with a range of 0 to 4000 specified for [Range before Scaling] and a 
range of 0 to 100 specified for [Range after Scaling], “50” is displayed on MONITOUCH.

• Example: When scaling is set for “Entry Target” (entry mode)
When “25” is entered using a keypad and a range of 0 to 4000 is specified for [Range before Scaling] and a range of 0 to 100 is 
specified for [Range after Scaling], “1,000” is written to the PLC device memory address D100.

• Notes on using entry targets (entry mode)
Errors may occur when using entry targets. The entered value will be displayed correctly if [Range before Scaling] is greater than 
[Range after Scaling].

When comparing [Range before Scaling] with [Range after Scaling], remove the decimal point from the display range.

Example: 0 to 10000 for [Range before Scaling] and 0.00 to 500.00 for [Range after Scaling]
The range after scaling is converted to 0 to 50000, which means [Range before Scaling] < [Range after Scaling] and the 
entered value is not displayed correctly.

4000

100

00

PLC

25

1000

MONITOUCH

(Range before scaling) (Range after scaling)

(Data entered on the keypad)
(Data stored)

100

0

1000010000

250

10000

100

00 0

PLC

100
2525

2500
200

2
0 0

PLC
Displayed on 
MONITOUCH

(Range before scaling) (Range after scaling)

Entered value = value displayed on MONITOUCH

Entry on 
MONITOUCH

Displayed on 
MONITOUCH

(Range before scaling) (Range after scaling)

Entered value ≠ value displayed on MONITOUCH

Entry on 
MONITOUCH

If [Range before Scaling] > [Range after Scaling], the entered 
value is displayed correctly.

If [Range before Scaling] < [Range after Scaling], the entered value 
is not displayed correctly.
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Interlock
This setting is only available when [Function] for a numerical data display is set to “Entry Target” and the [Display the 
keyboard] checkbox is selected.

Item Description
Use interlock Select this checkbox to add an interlock to the overlap display function of a 

numerical data display.
Click [Add] to set up to 5 conditions that must be satisfied for the interlock to 
activate.

Condition Setting Click a condition number to configure a condition that must be satisfied for the 
interlock to activate.

Bit device Set the interlock bit address.

Bit device “ON”: overlap display is allowed
When [Bit device] is OFF, overlap display is prohibited.
When [Bit device] is ON, overlap display is allowed.

Bit device “OFF”: overlap display is allowed
When [Bit device] is OFF, overlap display is allowed.
When [Bit device] is ON, overlap display is prohibited.

Word Device Set the comparison condition expression of the interlock device memory.

Data Length: Set the data length of the condition value.
1-Word/2-Word

Constant Display Type: Set the format of the comparison condition expression.
[DEC +−]/[DEC]/[BCD]/[HEX]

Comparison condition expression: Set a comparison sign, value, and device 
memory as the conditions for comparison.

Security Level Used in conjunction with the security function.
Allow users of levels higher than the set level to display overlaps.
For details on security functions, refer to “5 Security” in the Reference Manual 2.

AND/OR Setting When two or more conditions are set for activating the interlock, set whether to 
perform AND and OR operations on the conditions.

Detailed 
Settings

Sound an error 
buzzer when the 
condition is not met

Set whether an error buzzer sounds when the numerical display is pressed 
although conditions are not satisfied.

Deselected: A buzzer does not sound.

Selected: A buzzer will sound.
Display ladder diagram Select this checkbox to display the configured conditions for interlock activation 

as a ladder diagram.
Display setting details Select this checkbox to configure condition settings on the ladder diagram.
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Show/Hide

Item Description
Show Show the item on the screen.
Hide Do not show the item on the screen.
Show/hide according to the condition The part is shown or hidden according to the specified conditions.

Click [Add] and set up a maximum of five conditions.
Condition Setting Click a condition number to configure a condition that must be satisfied for showing or 

hiding the part.
Bit Device Show the part if the bit device memory condition is satisfied and hide the part if the 

condition is not satisfied.
Word Device Show the part if the conditional expression of the specified word device memory is 

satisfied and hide the part if the expression is not satisfied.

Security Level This setting is available when using the security function.
Show or hide the part according to the security level of the user that is currently logged in.
For details, refer to “5 Security” in the Reference Manual 2.

AND/OR Setting When setting two or more conditions, set whether to perform AND or OR operations on 
the conditions.

Constant Display 
Type

Select the data type of the conditional expression.
[DEC+−] / [DEC] / [BCD] / [HEX]

Condition 
expression

Set an equal sign, value, and device memory address as the 
conditions for comparison.
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Detail

*1 For details on real numbers (floating point data), refer to “5.1.4 Real Numbers (Floating Point Numbers)” page 5-18.

Item Description
Overlap Overlap ID

(0 - 9)
When the [Function] for a numerical data display is set to “Entry Target” and the [Display the keyboard] 
checkbox is selected, specify the overlap ID for displaying the keyboard.

Coordinates Start X/Start Y Set the display position of the numerical data display using X and Y coordinates.
Others Process Cycle Set a cycle for the V10/V9 series to read PLC data while the V10/V9 series is communicating with the PLC.

For details, refer to “1.2 Process Cycle”.
Input Type Select the code to use when reading data from the PLC device memory address.

BCD, DEC, Actual Number *1

1-Byte / 2-Byte Select one-byte or two-bytes for displaying numerical data.
Save an 
operation log

Used in conjunction with the operation log.
For details, refer to “4 Operation Log” in the Reference Manual 2.

ID
(0 - 255)

Set the ID.
For details on IDs, refer to the Operation Manual.
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5.1.4 Real Numbers (Floating Point Numbers)
MONITOUCH can handle real numbers specified by the IEEE 754 standard (32-bit single precision real number format).

Overview
IEEE 754 standard (32-bit single precision real number format)
32 bits are defined in the following format.

The above format expresses decimal floating-point data as shown below.

• Normalized numbers

• Denormalized numbers (e = 0)

Applicable range
−3.402823 × 10 38 ≤ n ≤ −1.401298 × 10 -45

1.401298 × 10 -45 ≤ n ≤ 3.402823 × 10 38

(Significant digits: approx. 7 (in decimal))

When the value satisfies the following conditions, it cannot be handled as a decimal floating-point number.
e = 255, f ≠ 0 (non-numerical)
e = 255, f = 0, s = 0 (+∞)
e = 255, f = 0, s = 1 (−∞)
e = (0)

Symbol Name Description
s Sign 0: Positive

1: Negative
e Exponent 0 - 255

* However, if “255” is specified, it cannot be regarded as a decimal 
floating-point number.
If “0” is specified, it is regarded as a denormalized number.

f Significand This is a binary fraction less than 1.
The final significand can be calculated using the following formula:
[1.f] = [1 + f × 2-23]

Symbol Name Description
s Sign 0: Positive

1: Negative
e Exponent Since e = 0, the exponent will be “-126”.
f Significand f ≠ 0

This is a binary fraction less than 1.
The final significand can be calculated using the following formula:
[0.f] = [f × 2-23]

022233031

s e f

s(-1) 2 (1.f)(e-127)

0 1-1

38-3.402823    10 3.402823    10 38-1.401298    10  -45 1.401298    10 -45
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MONITOUCH display range
−9.999999 × 10 31 ≤ n ≤ −1.000000 × 10 -31

1.000000 × 10 -31 ≤ n ≤ 9.999999 × 10 31

A: Overflow display (- - - -)
B: 0
C: −0

Decimal Floating-point Data Example
Example 1
When the following 32-bit data is displayed as decimal floating-point data, it is calculated as shown below.

As a result, a value of “-3.125” is shown on MONITOUCH.

Example 2
When the following 32-bit data is displayed as decimal floating-point data, it is calculated as shown below.

As a result, a value of “2.5” is shown on MONITOUCH.

0 1-1

38-3.402823    10 3.402823    10 38-1.401298    10  -45 1.401298    10 -45

31-9.999999   10 9.999999   10 31-1.000000   10-31 1.000000   10 -31

A C B A

1 1 0 0 0 0 0 0 0 1 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
022233031

s(-1) 2 (1.f)(e-127)

s e f

2 (128-127) 21 2
1(-1) -1

[1 + f    2   ]-23

[1 + (2  + 2  )   2   ]22 19 -23 [1 + (2     + 2     )]22-23 19-23

[1 + 2  + 2  ]-1 -4 [1 + 0.5 + 0.0625]
1.5625

-1 2 1.5625 -3.125

10000000(BIN) = 128(DEC)

[1 + (2   )   2   ]

0 1 0 0 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
022233031

s(-1) 2 (1.f)(e-127)

s e f

2 (128-127) 21 2
0(-1) 1

[1 + f    2   ]-23

21 -23 [1 + 2  ]-2

[1 + 0.25] 1.25

1 2 1.25 2.5

10000000(BIN) = 128(DEC)
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5.2 Character Display
5.2.1 Overview

• Data read from the PLC is displayed in the form of characters on the MONITOUCH screen in real time. ANK codes are 
assigned to one-byte characters and Shift-JIS codes are assigned to two-byte characters.

• Read data can also be displayed using * (asterisks). This can be used to hide passwords.

• In addition to using a character display ([Char. Display]) independently, it can also be linked with another part.
For example, when a character key set up in [Entry] mode is pressed, the character is entered in the [Char. Display] part 
specified as “entry target.” This is made possible by linking [Char. Display] with the [Entry] mode.

• Device memory for offset value designation
A single character display part can be used to show different data by switching the device memory address assigned to 
the part. This can help to reduce the number of screens or parts used and facilitate screen maintenance.

• Device memory for changing attributes
The attributes (number of bytes or text color) of character display parts are easily changeable while MONITOUCH is in 
RUN mode.

For details, refer to “6.2 Character Input”.

For details, refer to page 5-2.

For details, refer to page 5-3.

PLC

.................

PLC device memory

ABCDE
ABCDE

PLC

.................

PLC device memory

ABCDE

abcdefgh

ABCDEFGH

opqrstuv

OPQRSTUV

E J N S X & d
D I M R W % c
C H L Q V # c
B G K P U Z b

i n
r

ENTER CLEAR
h m

s
+BK -BK

g l q v z DEL BS
f k p u y UP DW

A F K O T Y a e j o t x <-- -->

w *

D

A
B
C

Linked

Character Display

Keyboard

Text Entry Screen
Product
Product
Product
Product
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5.2.2 Detailed Settings
Contents

*1 Code used for storing text of character display parts
• 1-byte characters: ANK code
• 2-byte characters: Shift-JIS code

*2 The device memory for offset value designation is read every cycle, regardless of the item processing cycle. Screen updates depend on 
the setting of the [Redraw the screen] checkbox in [Screen Setting] → [Screen Setting] → [Unhide] → [Unhide Items].
• Selected:

Update the screen when the value in the device memory for offset value designation changes.
Only update the items on the screen whose value changed in the device memory for offset value designation (the screen is not 
redrawn).

• Unselected:
The screen is updated at the following times.
Screen change/screen redraw/multi-overlap change (when there are parts placed on multi-overlap)

*3 Notes on using the device memory for offset value designation
• When the screen is updated, the device memory for offset value designation is read for the items placed on the screen. This means 

that for a screen that includes multiple addresses of the device memory for offset value designation, the updated screen is displayed 
upon completion of reading all of these device memory addresses. If screen updates are taking too long, use of the internal device 
memory is recommended.

• When setting offset values on a screen, the setting needs to be completed before the screen is changed to another screen. In a case 
where an offset value is designated in an OPEN macro, the offset value is not valid when the screen is open, but becomes valid when 
the screen is updated.

• An error occurs if a value set to the device memory for offset value designation is outside the permissible range. Observe the 
specified range for setting.
PLC device memory: Communication error Format
Internal device memory: Error: 46

*4 For details on the method for specifying attributes using device memory, refer to “Specifying attributes using device memory” page 5-22.

Item Description
Device to 
Display

Device *1
(base device memory)

Specify the device memory address to use for character display.

Use offset value 
designation device *2 *3

Set the device memory address and the code used for storing an offset value with respect to 
the value in the base device memory.

Text to Display No. of Bytes
(1 - 127)

Specify the number of bytes used by this part.

Designate by device *4 Select this checkbox to change the number of bytes according to the value specified for the 
device memory address.

Auto-adjust the area 
according to the char. 
size

Select this checkbox to automatically adjust the item size based on the [Digits] and [Decimal 
Point] settings.

Code When a [Designate by device] checkbox is selected, set the code used when reading values 
from the device.
This setting applies to [No. of Bytes], [Char. Color], and the [Background] color.

Code Setting Range
DEC 0 - 65535
BCD 0 - 9999

Real Number Type (DEC) 0 - 65535
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Specifying attributes using device memory
When a [Designate by device] checkbox in [Contents] → [Detail Settings] or a [Designate by device] checkbox in [Char. Prop.] 
→ [Detail Settings] is selected, the corresponding attribute can be changed by specifying a value using a device memory 
address.

Item Description
Contents No. of Bytes Specify the number of bytes of the character display.

No. of Bytes: 1 to 127
* Regardless of the setting for [No. of Bytes], 127 bytes (64 words) will always be 

read.
Char. Prop. Char. Color Set the color for text.

Bits 0 to 6: Color
Bit 7: Blinking (0: No, 1: Yes)

A color can be selected from the 128 colors (and blinking) on [Palette 1] in the [Custom Color] 
window.
Colors correspond to the following color codes.

Background Specify the background color of text.

Bits 0 to 6: Color
Bit 7: Blinking (0: No, 1: Yes)

A color can be selected from the 128 colors (and blinking) on [Palette 1] in the [Custom Color] 
window.
For details on color codes, refer to the “Char. Color” section.

* However, note that the background color setting does not take effect when [Char. 
Prop.] → [Style] is set to “transparent”.

abc Text color

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
0 to 127 colors

Text color

Blinking
0: No
1: Yes

n

[Palette 1]

00
16
32
48
64
80
96
112

15
31
47
63
79
95
111
127

0 1 2 3 4 5 6 7 8 9 A: B C D E F

abc Background color

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
0 to 127 colors

Background color

Blinking
0: No
1: Yes

n
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Notes on changing attributes using device memory
• The update timing depends on the setting of [Detail] → [Process Cycle] of each part.
• For parts with a frame, the frame size does not change according to the setting of [Digits], [Decimal Point], or [Display 

Format].
For this reason, the maximum number of bytes in the screen program must be set in advance.

• When [Char. Prop.] → [Style] is set to “not transparent”, the drawing range of the background color will be affected by 
changes to the number of bytes. This means that if the set number of bytes decreases, the background color will remain 
on the screen.
For this reason, the maximum number of bytes in the screen program must be set in advance. Alternatively, update the 
display by executing the “SYS (RESET_SCRN)” macro command or by changing the screen.

• The “CHG_DATA” macro command cannot be used with numerical data displays for which a [Designate by device] 
checkbox is selected.

• When “Entry Target” is set for [Function], the display is switched when the cursor is moved from the display field.

Style

Item Description
Area Setting Select from catalogs Select the part design.

After selecting the part, select the part color.
Select from image files Select a PNG file.
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Function

*1 The following function is added when the [Display All] checkbox is selected.

Item Description
Function Set the function of the character display.

Standard Char. Display Display device memory values on the character display in real time.
Entry Target Used in conjunction with the entry function.

For details, refer to “6.2 Character Input”.Password Input
Display All Select this checkbox to display all of the available character display functions. *1

Name Description Linked Part Refer to
Standard Entry Display Part Temporarily display values entered using character 

keys.
Entry page 6-22

Readings 
Registration

(Not used.)
* Register new words with a [Word Edit] switch.

Phrase Registration
Alarm Status Display Display the currently displayed status (ON/OFF, ON, 

or OFF).
Alarm page 8-1



5.2    Character Display

5-25

1

2

3

4

5

6

7

8

9

10

Char. Prop.

*1 For details on the method for specifying attributes using device memory, refer to “Specifying attributes using device memory” page 5-7.
*2 Cannot be set to transparent.
*3 For details on registering Windows fonts, refer to the Operation Manual.

Item Description
Alignment Set the text alignment.

Text to Display on Preview This item is available when the [Display for the editor] checkbox is selected on the [View] → [Display 
Environment] → [Display] tab.
Set the text to display using the editor.

Char. Color Set the color for text.
Designate by device *1 Select this checkbox to change the text color according to the value specified for the device memory 

address.
Background Set the background color of text.
Designate by device *1 Select this checkbox to change the background color according to the value specified for the device 

memory address.
Style Set the text style.
Character Size
(1 - 8)

Specify the enlargement factor for text.
* When [Bitmap font] is selected at [System Setting] → [Multi-language Setting] → [Font Type]

Point
(6 - 999)

Set the text size.
* When a font type other than [Bitmap font] is selected at [System Setting] → [Multi-language Setting] 

→ [Font Type]
Rotation + Direction Set the combination of text rotation and direction.

Four combinations are displayed in the drop-down menu.

When selecting an option other than the above, click the icon at the bottom.
The window that allows selection from all options is displayed.

Spacing Select this checkbox to specify the spacing between characters.
Character Position Select [Flush Left] or [Flush Right].

Use Windows fonts Select this checkbox to use a Windows font.
Smooth Font *2 When “Windows Font” is selected, select this checkbox to smooth the edges of text.

(Only settable for TrueType Windows fonts.)
Windows Font 
Registration *3

Register a Windows font to use to display text.

* Display Select this checkbox to display * (asterisks) instead of characters.
Code When a [Designate by device] checkbox is selected, set the code used when reading values from the device 

memory address.
This setting applies to [No. of Bytes], [Char. Color], and the [Background] color.

Flush RightFlush Left

Center

Flush-left →   ABC
Flush-right →          ABC
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Interlock
This setting is only available when [Function] for a character display part is set to “Entry Target” and the [Display the keyboard] 
checkbox is selected.

Item Description
Use interlock Select this checkbox to add an interlock to the overlap display function of a character display.

Click [Add] to set up to 5 conditions that must be satisfied for the interlock to activate.

For details on each item, refer to “Interlock” page 5-15.
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Show/Hide

Item Description
Show Show the item on the screen.
Hide Do not show the item on the screen.
Show/hide according to the condition The part is shown or hidden according to the specified conditions.

Click [Add] and set up a maximum of five conditions.
Condition Setting Click a condition number to configure a condition that must be satisfied for showing or 

hiding the part.
Bit Device Show the part if the bit device memory condition is satisfied and hide the part if the 

condition is not satisfied.
Word Device Show the part if the conditional expression of the specified word device memory is 

satisfied and hide the part if the expression is not satisfied.

Security Level This setting is available when using the security function.
Show or hide the part according to the security level of the user that is currently logged in.
For details, refer to “5 Security” in the Reference Manual 2.

AND/OR Setting When setting two or more conditions, set whether to perform AND or OR operations on 
the conditions.

Constant Display 
Type

Select the data type of the conditional expression.
[DEC+−] / [DEC] / [BCD] / [HEX]

Condition 
expression

Set an equal sign, value, and device memory address as the 
conditions for comparison.
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Detail

Item Description
Overlap Overlap ID

(0 - 9)
When the [Function] for a character display is set to “Entry Target” and the [Display the keyboard] 
checkbox is selected, specify the overlap ID for displaying the keyboard.

Coordinates Start X/Start Y Set the display position of the character display using X and Y coordinates.
Others Process Cycle Set a cycle for the V10/V9 series to read PLC data while the V10/V9 series is communicating with the PLC.

For details, refer to “1.2 Process Cycle”.
Text Process Set the order of the first and second bytes in words.

[LSB → MSB]

[MSB → LSB]

Save an 
operation log

Used in conjunction with the operation log.
For details, refer to “4 Operation Log” in the Reference Manual 2.

ID
(0 - 255)

Set the ID.
For details on IDs, refer to the Operation Manual.

MSB LSB
2nd byte     1st byte

15 0

LSB MSB
1st byte     2nd byte

15 0
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5.3 Message Display
5.3.1 Overview

• Use the message edit screen to register messages for display on the screen in advance. When a message registration 
number is specified for a device memory address, the corresponding message is displayed on the screen in real time.

• Single line message can be displayed at any position.

PLC

.................

AAAAAA
BBBBBB
CCCCCC
DDDDDD
EEEEEE
FFFFFF
GGGGGG
HHHHHH
IIIIII
JJJJJJ
KKKKKK

QQQQQQ

No. 0
No. 1
No. 2
No. 3
No. 4
No. 5
No. 6
No. 7
No. 8
No. 9
No. 10

No. 20

KKKKKK
10

PLC device memory

Message editing

AAAAAA

JJJJJJ

DDDDDD
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5.3.2 Detailed Settings
Device Memory

Style

Item Description
Device One word is used for device memory specification.

The message that corresponds to data contained at the specified device memory address is displayed on the 
screen.

* Specify a message number using its absolute address (range: 0 to 32767).
For details on absolute addresses, refer to the Operation Manual.

Message Edit Click [Open] to display the [Message Edit] window.
For details on editing messages, refer to the Operation Manual.

Item Description
Area Setting Select from catalogs Select the part design.

After selecting the part, select the part color.
Select from image files Select a PNG file.
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Char. Prop.

Item Description
Alignment Set the text alignment.

Message No. to Display on Preview This item is available when the [Display for the editor] checkbox is selected on the [View] 
→ [Display Environment] → [Display] tab.
Set the message to display using the editor.

Specify by absolute 
address

Unselected:
Specify the message using the group number and line number.
Selected:
Specify the message using the absolute address. 
(absolute address = (group number × 256) + line number)

Char. Color Set the color for text.
Background Set the background color of text.
Style Set the text style.
Character Size
(1 - 8)

Specify the enlargement factor for text.

Point
(6 - 999)

Set the text size.

Rotation + Direction Set the combination of text rotation and direction.
Four combinations are displayed in the drop-down menu.

When selecting an option other than the above, click the icon at the bottom.
The window that allows selection from all options is displayed.

Use Windows fonts Select this checkbox to use a Windows font.

Flush RightFlush Left

Center
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Show/Hide

Detail

Item Description
Show Show the item on the screen.
Hide Do not show the item on the screen.
Show/hide according to the condition The part is shown or hidden according to the specified conditions.

Click [Add] and set up a maximum of five conditions.
Condition Setting Click a condition number to configure a condition that must be satisfied for showing or 

hiding the part.
Bit Device Show the part if the bit device memory condition is satisfied and hide the part if the 

condition is not satisfied.
Word Device Show the part if the conditional expression of the specified word device memory is 

satisfied and hide the part if the expression is not satisfied.

Security Level This setting is available when using the security function.
Show or hide the part according to the security level of the user that is currently logged in.
For details, refer to “5 Security” in the Reference Manual 2.

AND/OR Setting When setting two or more conditions, set whether to perform AND or OR operations on 
the conditions.

Item Description
Coordinates Start X/Start Y Set the display position of the message display using X and Y coordinates.
Others Process Cycle Set a cycle for the V10/V9 series to read PLC data while the V10/V9 series is communicating with the PLC.

For details, refer to “1.2 Process Cycle”.
ID
(0 - 255)

Set the ID.
For details on IDs, refer to the Operation Manual.

Constant Display 
Type

Select the data type of the conditional expression.
[DEC+−] / [DEC] / [BCD] / [HEX]

Condition 
expression

Set an equal sign, value, and device memory address as the 
conditions for comparison.
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5.4 Table Data Display
5.4.1 Overview

• Sets of data can be displayed in tabular format with ease.
• Select from number display, character display, message display, or text for the data display part.
• The properties of multiple data display parts can be changed at once.
• Average, maximum, minimum, and total values can be displayed.
• Table data display parts can be set as an entry target for entry mode.

5.4.2 Table Data Settings
Lines and Columns

No.1 No.2 No.3 No.4 No.5 Average
1 100 150 120 130 200 140
2 120 100 180 190 200 158
3 130 120 160 100 150 132
4 50 60 40 150 20 64

Item Description
Number of 
Lines/Columns

Lines (1 to 20) Specify the number of lines.
Columns (1 to 25) Specify the number of columns.

Color Ruled Line Select this checkbox to display ruled lines.
The color of ruled lines can be specified when the checkbox is selected.

Background Select a background color for the table data.
Transparency Make the background color transparent.

Clear all Set all cells to blank with [cell format: Text].
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Style

Detail

Item Description
Area Setting Select from catalogs Select the part design.

Item Description
Input Cursor Movement Control 
Device

Select this checkbox when using the item selection function.
For details on the item selection function, refer to “6.3.1 Item Select Function”.

Coordinate Start X/Start Y Set the display position of the table data display using X and Y coordinates.
Others Process Cycle Set a cycle for the V10/V9 series to read PLC data while the V10/V9 series is communicating with the PLC.

For details, refer to “1.2 Process Cycle”.
Order INC
(0 - 255)

When the table data display contains multiple table data display parts for which [Function] is set to “Entry 
Target”, specify the order of precedence of each table data display part.

Cursor 
Direction
(RGT/DWN)

This setting is available when [Cursor Moved by] is set to “UP/DW Switch” in the entry mode and bit 14 
(cursor movement) of [Control Device] is set to ON.
This option determines the direction in which the cursor moves when the [Write] key is pressed.

ID
(0 - 255)

Set the ID.
For details on IDs, refer to the Operation Manual.
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5.4.3 Numerical Data Display Settings
Each data cell can be selected to display a settings window for the corresponding cell.
(For details on the editing procedure, refer to the Operation Manual.)
This section explains the case when [Num. Display] is selected for [Select Type].

Select Type

Contents

*1 Relationship between data length and display format

Item Description
Num. Display
Char. Display
Message Display
Text

Select [Num. Display].

Item Description
Device to 
Display

Device Specify the device memory address to use for numerical data display.
Data Length *1
1-Word/2-Word

Select the data length used for this part.

Incremental Direction *2 This setting is available when multiple data in the table are selected.
For details, refer to page 5-36.

Text to Display Display Format *1 Select the format of numbers to be displayed on the screen.
Digits *3 Specify the number of digits for the numerical data display.
Decimal Point Specify the decimal place. The number of decimal places must be smaller than the number of 

digits.
When no decimal point is required, set “0”.

Auto-adjust the area 
according to the char. size

Select this checkbox to automatically adjust the item size based on the [Digits] and [Decimal 
Point] settings.

Code Format 1-word Display Range 2-word Display Range
DEC (w/o sign) 0 to 65535 0 to 4294967295
DEC (with sign −) −32768 to 32767 −2147483648 to 2147483647
DEC (with sign +−) −32768 to +32767 −2147483648 to +2147483647
HEX 0 to FFFF 0 to FFFFFFFF
OCT 0 to 177777 0 to 37777777777
BIN (Binary) 0 to 1111111111111111 0 to 11111111111111111111111111111111
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*2 Incremental Direction

*3 Digits
For details, refer to page 5-6.

Function

*1 The following functions are added when the [Display All] checkbox is selected.

*2 Start X/Y, End X/Y

Item Description
Function Set the type of operation performed by the numerical data display.

Standard Numerical data display Display device memory values on the numerical data display in real time.
Entry Target Used in conjunction with the entry function.

For details, refer to “6.1 Numerical Data Entry”.
Display All Select this checkbox to display all of the available numerical data display functions. *1

Name Description
Standard Mean Value Display Start X/Y, End X/Y *2 Display the mean value of the selected data range.

Max. Value Display Part Start X/Y, End X/Y *2 Display the maximum value of the selected data range.
Min. Value Display Part Start X/Y, End X/Y *2 Display the minimum value of the selected data range.
Total Display Start X/Y, End X/Y *2 Display the total value of the selected data range.

12345 12345 12345
12345 12345 12345
12345 12345 12345
12345 12345 12345
12345 12345 12345

12345
12345
12345
12345
12345

12345 12345 12345
12345 D200 D203
12345 D201 D204
12345 D202 D205
12345 12345 12345

12345
12345
12345
12345
12345

The device memory addresses of the selected 
data display cells change as shown below.

Example:
Device memory: D200
[Incremental Direction] checkbox: selected (Down)

Select

12345 12345 12345
12345 12345 12345
12345 12345 12345
12345 12345 12345
12345 12345 12345

X:1,Y:1 X:2,Y:1 X:3,Y:1
X:1,Y:2 X:2,Y:2 X:3,Y:2
X:1,Y:3 X:2,Y:3 X:3,Y:3
X:1,Y:4 X:2,Y:4 X:3,Y:4
X:1,Y:5 X:2,Y:5 X:3,Y:5

This numerical data display shows the mean 
value of the selected data range.

Display Function: Mean Value Display
Start X: 2, Y: 1
End X: 2, Y: 4

Select
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Char. Prop.

*1 Cannot be set to transparent.
*2 Featuring digital display fonts by Yourname, Inc.

Item Description
Value to Display on Preview This item is available when the [Display for the editor] checkbox is selected on the [View] → [Display 

Environment] → [Display] tab.
Set the value to display using the editor.

Char. Color Set the color for text.
Background Set the background color of text.
Style Set the text style.
Character Size
(1 - 8)

Specify the enlargement factor for text.

Point
(6 - 999)

Set the text size.

Zero Suppress Select this checkbox to use zero suppression.

When this checkbox is selected, specify [Flush Left], [Center] or [Flush Right].

System Font
Windows Font
7-segment Font

Select the font to use for the numerical data display.
When “7-segment Font” is selected, select the [Display light-out segments] checkbox to display unlit 
segments.

Smooth Font *1 When “Windows Font” is selected, select this checkbox to smooth the edges of text.
(Only settable for TrueType Windows fonts.)

Display light-out 
segments *2

When “7-segment Font” is selected, select this checkbox to display unlit segments.

* Display Select this checkbox to display * (asterisks) instead of numbers.

[  Zero Suppress] (Flush Right) →        123
[  Zero Suppress] →  000123

Spaces

Flush Left →  123
Center →     123
Flush Right →       123
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Operation/Alarm

*1 For details on operations, refer to page 5-13.
*2 For details on scaling, refer to page 5-14.

Detail

Item Description
Alarm Select this checkbox to display data in a different color when it exceeds or falls short of a 

specific range.
When “Entry Target” is selected for [Function], the range of values that can be entered using a 
keypad can be set.
For details on numerical value entry, refer to “6.1 Numerical Data Entry”.

Minimum Set the minimum value used to trigger an alarm.
Char. Color Set the color for text.

Maximum Set the maximum value used to trigger an alarm.
Char. Color Set the color for text.

Operation *1 Select this checkbox to perform an operation on the value of the device memory address 
specified in [Contents].

Scaling *2 Select this checkbox to display data after automatically converting the data read from the PLC 
([Range before Scaling]) to the specified range ([Range after Scaling]).
This eliminates the need for correction programs for data read from the PLC when displaying 
information such as temperature, rotation speed, etc.

Range before Scaling Specify the data to be read from the PLC.
Range after Scaling Specify the range of data to be shown on MONITOUCH.

Item Description
Others Input Type Select the code to use when reading data from the PLC device memory address.

BCD/DEC
1-Byte / 2-Byte Select one-byte or two-bytes for displaying numerical data.
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5.4.4 Character Display Settings
Each data cell can be selected to display a settings window for the corresponding cell.
(For details on the editing procedure, refer to the Operation Manual.)
This section explains the case when [Char. Display] is selected for [Select Type].

Select Type

Contents

Function

Item Description
Num. Display
Char. Display
Message Display
Text

Select [Char. Display].

Item Description
Device to 
Display

Device Specify the device memory address to use for character display.
Incremental Direction This setting is available when multiple data in the table are selected.

For details, refer to page 5-36.
Text to Display No. of Bytes Specify the number of characters to be displayed.

Auto-adjust the area 
according to the char. size

Select this checkbox to automatically adjust the item size based on the [Digits] and [Decimal 
Point] settings.

Item Description
Function Set the function of the character display.

Standard Char. Display Display device memory values on the character display in real time.
Entry Target Used in conjunction with the entry function.

For details, refer to “6.2 Character Input”.



5  Data Display

5-40

Char. Prop.

*1 Cannot be set to transparent.
*2 For details on registering Windows fonts, refer to the Operation Manual.

Detail

Item Description
Text to Display on Preview This item is available when the [Display for the editor] checkbox is selected on the [View] → [Display 

Environment] → [Display] tab.
Set the text to display using the editor.

Char. Color Set the color for text.
Background Set the background color of text.
Style Set the text style.
Character Size
(1 - 8)

Specify the enlargement factor for text.

Point
(6 - 999)

Set the text size.

Character Position The character position in the cell can be selected.

Use Windows fonts Select this checkbox to use a Windows font.
Smooth Font *1 When “Windows Font” is selected, select this checkbox to smooth the edges of text.

(Only settable for TrueType Windows fonts.)
Windows Font 
Registration *2

Register a Windows font to use to display text.

* Display Select this checkbox to display * (asterisks) instead of characters.

Item Description
Others Text Process Set the order of the first and second bytes in words.

[LSB → MSB]

[MSB → LSB]

Flush Left →  123
Center →    123
Flush Right →       123

MSB LSB
2nd byte        1st byte

15 0

LSB MSB
1st byte         2nd byte

15 0
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5.4.5 Message Display Settings
Each data cell can be selected to display a settings window for the corresponding cell.
(For details on the editing procedure, refer to the Operation Manual.)
This section explains the case when [Message Display] is selected for [Select Type].

Select Type

Contents

Char. Prop.

Item Description
Num. Display
Char. Display
Message Display
Text

Select [Message Display].

Item Description
Device Specify the device memory address to use for message display.
Message Edit Click [Open] to display the [Message Edit] window.

For details on editing messages, refer to the Operation Manual.
Incremental Direction This setting is available when multiple data in the table are selected.

For details, refer to page 5-36.

Item Description
Message No. to Display on 
Preview

This item is available when the [Display for the editor] checkbox is selected on the [View] → [Display 
Environment] → [Display] tab.
Set the message to display using the editor.

Char. Color Set the color for text.
Background Set the background color of text.
Style Set the text style.
Character Size
(1 - 8)

Specify the enlargement factor for text.

Point
(6 - 999)

Set the text size.

Use Windows fonts Select this checkbox to use a Windows font.
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5.4.6 Text Settings
Each data cell can be selected to display a settings window for the corresponding cell.
(For details on the editing procedure, refer to the Operation Manual.)
This section explains the case when [Text] is selected for [Select Type].

Select Type

Char. Prop.

*1 Cannot be set to transparent.

Item Description
Num. Display
Char.Display
Message Display
Text

Select [Text].

Item Description
Text Enter the text for display.
Char. Color Set the color for text.
Background Set the background color of text.
Style Set the text style.
Character Size
(1 - 8)

Specify the enlargement factor for text.

Point
(6 - 999)

Set the text size.

Character Position The character position in the cell can be selected.

Use Windows fonts Select this checkbox to use a Windows font.
Smooth Font *1 When “Windows Font” is selected, smooth the edges of text.

(Only settable for TrueType Windows fonts.)

Flush Left →  123
Center →     123
Flush Right →       123



5.5    Notes

5-43

1

2

3

4

5

6

7

8

9

10

5.5 Notes
5.5.1 Placing Switches or Lamps Overlaying Other Switches or Lamps

Take the following points into consideration when placing parts.

Placing Numerical Data Displays, Character Displays, and Message Displays
Parts are displayed in the order that they are placed using the editor. This means that switch and lamp parts should be placed 
in the background and numerical data displays, character displays, and message displays should be placed in the foreground.

Placing Table Data (with Switches)
When [Text] is selected for the cell in the first column and first row of the table data, the entire first row is assigned the switch 
function.
Consequently, any switch part placed on the first row will not be recognized correctly because it is the same as placing a 
switch on a switch. (In this case, the switch function of the table data has priority.)

No. 1 1004 50
No. 2 1006 65
No. 3 999 45
No. 4 1005 55
No. 5 1008 41

888.9
100.7
434.0
123.2
770.8

Since [Text] is set for the cell in the first column 
and first row, the hidden switch parts on the first 
row are invalid.

Example:
If [Text] is selected for the first column and hidden 
switch parts are placed on other columns.
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6.1 Numerical Data Entry
6.1.1 Overview

Numerical data can be entered using keypads and slider switches and then written to specified device memory addresses.
If the target data display is a numerical data display when entering data using a keypad, enter numerical data.

Keypad
• Enter numerical data with respect to the entry target using a keypad placed on the screen.

The keypad display can be configured to show the value being entered and include allowable input ranges.
Entered values can be displayed as * (asterisks) if you need to hide the entered password.

• A keypad can be displayed when needed and numerical data can be entered with respect to the entry target. The keypad 
can remain hidden at other times.

• Cursor movement can be limited to certain entry targets.

Slider switch
Numerical data can be entered using slider switches.

For setting examples, refer to “Placing an Entry Target and Keypad on the Screen” page 6-2, “Specifying 
an Entry Range” page 6-6, and “Displaying Input Values Using * (Asterisks)” page 6-7.

For setting examples, refer to “Showing the Keypad Only When Necessary” page 6-4.

For details, refer to “6.3.1 Item Select Function” page 6-36.

For setting examples, refer to “Slider Switch” page 6-8.

9999

0

1250

0 . +/- ENT

1 2 3 CL

4 5 6 DW

7 8 9 UP

1250

Max.
Min.
Input

Entry Target

0 . +/- ENT

1 2 3 CL

4 5 6 DW

7 8 9 UP
D100

Password

1653 1653

0 . +/- ENT

1 2 3 CL

4 5 6 DW

7 8 9 UP

Entry Target

The system keyboard can 
also be used.

30.5

Move the slider switch while 
holding it down and release it to 
write the data change.
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6.1.2 Setting Examples
Placing an Entry Target and Keypad on the Screen
There are two methods for placing these parts: placement using an entry target or placement using a keypad. Each procedure 
is described below using an example.

Placement Using an Entry Target
1. Click [Parts] → [Data Display ] → [Num. Display] and place a numerical data display on the screen.

2. Display the settings window for the numerical data display and set the device memory for writing via [Contents] → 
[Device].

3. Set [Function] to “Entry Target”.

4. Click [Place Keypad] to place a keypad.

This completes the necessary settings.

9999

0

1250

0 . +/- ENT

1 2 3 CL

4 5 6 DW

7 8 9 UP

1250
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Placement Using a Keypad
1. Click [Parts] → [Entry ] → [Keypad] and place a keypad on the screen.

2. Display the settings window for the keypad, click the [Place Entry Target], and place an entry target.

3. Display the settings window for the entry target and set the device memory for writing via [Contents] → [Device].

This completes the necessary settings.

* An entry target can also be placed according to the following procedure.

1) Click [Parts] → [Data Display ] → [Num. Display] and place a numerical data display on the screen.
2) Display the settings window for the numerical data display and set the device memory for writing via [Contents] → 

[Device].

3) Set [Function] to “Entry Target”.
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Showing the Keypad Only When Necessary
This procedure is described below using an example. (The keypad disappears after entry.)

1. Click [Parts] → [Data Display ] → [Num. Display] and place a numerical data display on the screen.

2. Display the settings window for the numerical data display and set the device memory for writing via [Contents] → 
[Device].

3. Set [Function] to “Entry Target”.

4. Select the [Display the keyboard] checkbox and select a keypad.
When registering a new keypad, click [Register] and select a keypad.

5. Select the [Display Position] checkbox and set the display position of the keypad.
(The display position cannot be set when the system keyboard is selected.)

This completes the necessary settings.

This setting cannot be performed for table data display entry targets.

1653 1653

0 . +/- ENT

1 2 3 CL

4 5 6 DW

7 8 9 UP

Click for a new 
registration

When [System Keyboard] is selected
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Placing an Entry Display (Value Entry)
This procedure is described below using an example.

1. Double-click the keypad placed on the screen to display the settings window.

2. Select the [Entry Display Part (Num. Display)] checkbox in [Style] → [Additional Parts List].

3. Click [Adjust Position] to specify the position of the part.

This completes the necessary settings.

9999

0

1250

0 . +/- ENT

1 2 3 CL

4 5 6 DW

7 8 9 UP

1250Input

The selected parts are displayed in 
the preview window.
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Specifying an Entry Range
This procedure is described below using an example. Example: Entry range: 0 to 9999

1. Display the numerical data display settings window, click [Operation/Alarm] → [Alarm], and set “0” for the minimum value 
and “9999” for the maximum value.

2. Double-click the keypad placed on the screen to display the settings window.

3. Select the [Max. Value Display Part] and [Min. Value Display Part] checkboxes in [Style] → [Additional Parts List].

4. Click [Adjust Position] to specify the position of the part.

This completes the necessary settings.

9999

0

1250

0 . +/- ENT

1 2 3 CL

4 5 6 DW

7 8 9 UP

1250

Maximum
Minimum

The selected parts are 
displayed in the preview 
window.
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Displaying Input Values Using * (Asterisks)
This procedure is described below using an example.
Values are written to D100 using the keypad. The input values can be hidden on the V10/V9 unit by displaying them using * 
(asterisks).
OK/NG validation of input values is determined by a ladder or macro.

1. Click [Parts] → [Data Display ] → [Num. Display] and place a numerical data display on the screen.

2. Display the settings window for the numerical data display and set the device memory for writing via [Contents] → 
[Device].

3. Set [Function] to “Entry Target“.

4. Select the [* Display] checkbox in the [Char. Prop.] window.

5. Click [Place Keypad] to place a keypad.

This completes the necessary settings.

0 . +/- ENT

1 2 3 CL

4 5 6 DW

7 8 9 UP
D100

Password
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Slider Switch
This procedure is described below using an example.

1. Click [Parts] → [Others] → [Slider Switch] and place a slider switch on the screen.

2. Display the settings window for the slider switch and set the device memory for writing via [Output Setting] → [Device].

3. Click [Parts] → [Data Display ] → [Num. Display] and place a numerical data display on the screen.

4. Display the settings window for the numerical data display and set the same device memory as in step 2 for [Contents] → 
[Device].

This completes the necessary settings.

30.5

Move the slider switch while holding it down 
and release it to write the data change.
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6.1.3 Detailed Settings
Keypad
Operation Select

Item Description
Entry Target Data Display

Enter data with respect to an entry target placed on the screen or an overlap.
Control Device
(PLC → V series)

This device memory controls entry.
For details, refer to page 6-11.

Enable/disable the entry key (Bit 15) Select this checkbox to use the 15th bit of the control device memory to prohibit 
entry key writing.
For details, refer to page 6-11.

Cursor Moved by UP/DW Switch Perform entry target selection and cursor movement using [UP] and [DW] switches.
Write the input 
value when moving 
the cursor

Write the entry value to the corresponding device memory when moving the cursor 
to the next entry target.
For details, refer to page 6-10.

Moving the cursor 
when the entry key

The cursor automatically moves to the next item when the [ENT] key is pressed.
Bit 14 (cursor movement) of [Control Device] is invalid when this checkbox is 
selected.

Control Device Perform cursor movement and entry target selection by specifying a cursor 
movement order number for the control device memory. In this case, the [UP] and 
[DW] switches cannot be used.
For details, refer to page 6-11.
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Write the input value when moving the cursor
Selecting this option will write the entry value to the corresponding device memory and the cursor is moved to the next entry 
target using an up or down switch instead of the [ENT] key.

• List of applicable switches

• Note
When pressing an entry target to call a keypad, the keypad is not hidden after writing is set to occur in conjunction with 
cursor movement. However, the keypad is hidden after writing completes when the [ENT] key is pressed.

Function Description Function Description
↑ Move the cursor to the previous entry target.

(Cursor movement order number − 1)
Table Move + Move the cursor to the next table data display. 

(Cursor movement order number + 1)
↓ Move the cursor to the next entry target.

(Cursor movement order number + 1)
Table Move − Move the cursor to the previous table data 

display. (Cursor movement order number − 1)
Cursor Movement 
to Right

Move the cursor to the right in the table data 
display.

Cursor Movement 
to Left

Move the cursor to the left in the table data 
display.

5 0 0
1 5 0 0

7 9 UP8

4 6 DW5

1 3 +-2

0 CLR CR.

D100

D101

9 9
1 5 0 0

7 9 UP8

4 6 DW5

1 3 +-2

0 CLR CR.

D100

D101

99 1500D100   500
1500

D100  99
1500
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Control device memory
Control device memory controls entry. Consecutive addresses are used.
The method of control differs depending on the setting of [Operation Select] → [Cursor Moved by].

• [Cursor Moved by]: UP/DW Switch
Device Memory Description

n

Entry area selection Specify the cursor movement range for the entry target.

0: Disabled
The cursor moves between areas in the following order:
1) Screen
2) Overlap ID 0
3) Overlap ID 1
:

1: Enabled
Only move the cursor in the single specified range. The range is specified as “control device 
memory n + 1”.

Cursor movement This bit controls the cursor movement when the [ENT] key is pressed.
It can be used when [Cursor Moved by] is set to “UP/DW Switch”.
This bit is invalid if the [Moving the cursor when the entry key] checkbox is selected.
The cursor moves automatically at all times.

0: Manual
The cursor remains in the same position even when the [ENT] key is pressed. Use the [UP] and 
[DW] switches to move the cursor.

1: Auto
Press the [ENT] key to simultaneously write the entry value to the device memory and move the 
cursor to the next entry target.

Write 
enabled/disabled

This can be used when the [Enable/disable the entry key (Bit 15)] checkbox is selected.

0: Disabled
Operation of all entry switches is prohibited. If an entry key is pressed, an error beep sounds and 
no entry is possible. However, cursor movement can be performed with the [UP] and [DW] 
switches.

1: Enabled
Operation of entry switches is allowed.

n+1

The following are used when the value specified for entry area selection is “1” (enabled). Specify the range of cursor 
movement.

0: Screen
1: Overlap ID 0
2: Overlap ID 1
3: Overlap ID 2
4: Overlap ID 3
5: Overlap ID 4
6: Overlap ID 5
7: Overlap ID 6
8: Overlap ID 7
9: Overlap ID 8
10: Overlap ID 9

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0

Entry area selection
1: Enabled, 0: Disabled

Cursor movement
1: Automatic, 0: Manual

Write enabled/disabled*
1: Enabled, 0: Disabled

* The [Enable/disable the entry key (Bit 15)] checkbox must be selected.

Not used (always set to “0”)

MSB LSB
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• [Cursor Moved by]: Control Device
Device Memory Description

n Cursor movement 
order number

Specify the cursor movement order number for the data display (numerical display, character 
display) or table data display entry target. The following bits are used.

- For DEC specification:  Bits 0 to 7
- For BCD specification:  Bits 0 to 9

Entry target data 
selection

Select the type of data targeted for cursor movement.

0: Data display (numerical display, character display)
1: Table data display part

For lines and columns in the table, specify using “control device memory n + 2”.
Write 
enabled/disabled

This can be used when the [Enable/disable the entry key (Bit 15)] checkbox is selected.

0: Disabled
Operation of all entry switches is prohibited. If an entry key is pressed, an error beep sounds and 
no entry is possible.

1: Enabled
Operation of entry switches is allowed.

n+1

Specify the range of cursor movement.

0: Screen
1: Overlap ID 0
2: Overlap ID 1
3: Overlap ID 2
4: Overlap ID 3
5: Overlap ID 4
6: Overlap ID 5
7: Overlap ID 6
8: Overlap ID 7
9: Overlap ID 8
10: Overlap ID 9

n+2

The following are used when the value specified for entry target data selection is “1” (table data display part). Specify the 
line numbers and column numbers of the table.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0

Entry target data selection
0: Data display (numerical display, character display)
1: Table data display partWrite enabled/disabled*

1: Enabled, 0: Disabled
* The [Enable/disable the entry key (Bit 15)] checkbox must be selected.

Cursor movement order numbers 0 to 255

MSB LSB

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0

Line numbers: 1 to 20Column numbers: 1 to 25

MSB LSB
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Style

* The following switches can be used on keypads.

Item Description
Adjust Position Change the layout of the keypad and other added parts.
Select from catalogs Change the keypad part.
Additional Parts List * Select [For Keypad].

Use this list to add or remove entry-related parts.

Part Function Description
Switch Character Input Enter numerical values or character codes corresponding to the text on the switch.

Write Transfer the entered data to the specified device memory address. The screen can be 
changed after the execution of data writing.

Clear Clear the entered data.
Toggle Sign Invert the sign of the entered data.
Back Space *1 Delete the character to the left of the cursor.
DELETE *1 Delete the character at the current cursor position.
+1 Increment the number at the current cursor position by one.
-1 Decrement the number at the current cursor position by one.
Add Add the specified constant value. (Data is written when the [ENT] key is pressed.)
Subtraction Subtract the specified constant value. (Data is written when the [ENT] key is pressed.)
Cancel Restore the initially displayed value (the value prior to entry) during an entry operation.
LFT *1 Move the cursor left.
RGT *1 Move the cursor right.
UP *2 Move the cursor to the previous entry target. (Cursor movement order number −1)
DW*2 Move the cursor to the next entry target. (Cursor movement order number + 1)
Cursor Movement to Right *2 Move the cursor to the right in the table data display.
Cursor Movement to Left *2 Move the cursor to the left in the table data display.
Table Move + *2 Move the cursor to the next table data display. (Cursor movement order number + 1)
Table Move − *2 Move the cursor to the previous table data display. (Cursor movement order number − 1)
Max. Value Entry Press this switch for an entry target with an alarm setting to display the maximum value 

on the entry display.
Pressing the [ENT] key will write the maximum value to the entry target.

Min. Value Entry Press this switch for an entry target with an alarm setting to display the minimum value on 
the entry display.
Pressing the [ENT] key will write the minimum value to the entry target.

Numerical data 
display

Entry Display Part Temporarily display the entered value.
Max. Value Display Part Display the maximum value set for the entry target.
Min. Value Display Part Display the minimum value set for the entry target.
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*1 This setting is available when the [Allow to use Insert/DELETE keys when entering values] checkbox is selected in [System Setting] → [Unit 
Setting] → [General Setting].
This allows insertion by moving the cursor with the [LFT] and [RGT] function switches and deletion using the delete and backspace 
switches. This setting is enabled for keypads on all screens. However, take the following points into consideration.

- During entry operations, entered values are displayed in flush-right format with zero suppression regardless of the display format of the 
numerical data display. The display returns to the specified display format after value entry is complete.

- Insertion at the whole number part
Values are inserted to the right of the cursor. When values exist at all places, entering a new value 
deletes the most significant digit.
Additionally, entering a value at the most significant digit of the whole number part overwrites the 
current value.

- Insertion at the fractional part
Values are inserted to the left of the cursor. When values exist at all places, entering a new value 
deletes the least significant digit of the fractional part.
Additionally, entering a value at the least significant digit of the fractional part overwrites the current 
value.

*2 Cursor movement for table data display parts
- If there are multiple entry targets in a table data display part, move the cursor using the [DW] and [UP] function switches or [Cursor 

Movement to Right] and [Cursor Movement to Left] function switches.

- If there are multiple table data entry targets, move the cursor between the table data display parts using the [Table Move +] and [Table 
Move −] function switches.

- Special functions
Setting the cell on the first line of the first column (“No.” in the example below) of a table data display part that has entry targets to a 
text value will add switch functionality to the first line.
When the first line is pressed, the cursor moves to the first entry target cell in the table data display part.
(This works in the same way as the [Table Move +] and [Table Move −] function switches.)

This function is enabled when [Operation Select] → [Entry Target] is set to “Data Display” for the keypad.
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3

+/-
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ENTER0 .

CLEAR

DELETE

BackSpace+
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13

00013

123

123

00123
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Flush right with zero
suppression

Flush left with zero
suppression

Without zero suppression Flush right with 
zero suppression

Before entry During entry After entry

123.45
Whole

number part
Fractional part
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significant digit

Least 
significant digit

No.
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2

3
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644

151
170
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800
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0 . +/- ENT

1 2 3 CL
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7 8 9 UP

Current 
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Input
Press the [Cursor 
Movement to Right] 
switch to move the cursor 
to the entry target on the 
right.

No.

1

2

3

162

644

151

170

800

140

No.

1

2

A

10

52

B

425

754

10

0 . +/- ENT

1 2 3 CL

4 5 6 DW

7 8 9 UP

Current 
value

Target 
value

Table 
Move +
Table 

Move −

Press this switch to move 
the cursor to the top cell 
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Current 
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Input

Works in the 
same way as 
these switches

Press the first line in the 
table to move the cursor 
to the first entry target.
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Detail

Item Description
Graphic The text placed on the graphic library can be regarded as entry text.

Change between multiple graphic libraries using a switch that has [Function] set to 
“Graphic Library”.

Coordinates Set the placement position of the keypad.
Others Information Output Device

(V series → PLC)
This is the device memory that stores the entry state.
Processing differs depending on the setting of [Detail] → [Output row/column numbers in 
table data display to information output device].
For details, refer to page 6-16.

Write to Entry Target Device.
Data from the entry target is written to the specified device memory address.

Information Output Device
For numerical data entry → n+2, n+3
For text entry → n+2 onwards (number of bytes ÷ 2 = number of words used)

- Example: Text
Entering one-byte 10 characters into PLC device memory starting at D100: 
10 ÷ 2 = 5 words
D100 to D104 of the PLC device memory are used.

Highlight the entry target Highlight the display of the entry target selected with the cursor.
Clear the entry display Clear the data value on the entry display each time the [ENT] key is pressed.
Output row/column numbers in 
table data display to information 
output device

This setting is available when the entry target is a table data display part. Select this 
checkbox to store line and column numbers of table data in the device memory specified 
for [Information Output Device] n + 1.
For details, refer to page 6-16.

Show [Data Block], [Memory 
Card], [Recipe Item] and [Direct] 
under [Entry Target]

The number of types listed for [Operation Select] → [Entry Target] increases.

Data Block
Use when entering data into a data block area.

Memory Card
Use on a keypad to perform name editing in memory card mode.

Recipe Item
Use on a keypad to perform name editing in recipe mode.

Direct
Use when controlling all processing up to the data write operation using external 
commands.

Process Cycle Set a cycle for the V series to read the PLC data while it is communicating with the PLC. For 
details, refer to “1.2 Process Cycle”.

ID Set the ID.
For details on IDs, refer to the Operation Manual.
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Information output device memory
This is the device memory that stores the entry mode state. Consecutive addresses are used.
Processing differs depending on the setting of [Detail] → [Output row/column numbers in table data display to information 
output device].

• [Output row/column numbers in table data display to information output device]: Unselected

• [Output row/column numbers in table data display to information output device]: Selected

Device Memory Description

n
Cursor movement 
order number

The cursor movement order number of the currently selected entry target is stored. The following 
bits are used.

- For DEC specification:  Bits 0 to 7
- For BCD specification:  Bits 0 to 9

Entry operation If multiple keypad parts are displayed, the bit of the keypad in the foreground is set to “1” and the 
keypad becomes available for entry.
If only one keypad is displayed, it is always set to “1”.

Write status This bit shows whether the [ENT] key has been pressed or not.

0: Not written
Indicates that the [ENT] key has not been pressed.

1: Completed
Indicates that the [ENT] key was pressed and data was written to the device memory. Unless the 
cursor moves to another entry target, this bit remains set to “1”. It is recommended to clear this 
bit to “0” after confirmation.

n+1

The currently selected cursor movement range is stored.

0: Screen
1: Overlap ID 0
2: Overlap ID 1
3: Overlap ID 2
4: Overlap ID 3
5: Overlap ID 4
6: Overlap ID 5
7: Overlap ID 6
8: Overlap ID 7
9: Overlap ID 8
10: Overlap ID 9

n+2 When [Operation Select] → [Entry Target] is set to “Data Block”, the currently displayed data block number is stored.
No. 0 - 1023

n+3 - n+m
When [Detail] → [Write to] is set to “Information Output Device”, the entered value is stored.

Numerical value: 2 words maximum
Text: Number of bytes ÷ 2 words (if the number of bytes is odd, 1 byte is added.)

Device Memory Description
n This is the same as “[Output row/column numbers in table data display to information output device]: Unselected” page 

6-16.n+1

n+2

The line and column numbers of the selected table data cell are stored.

n+3 When [Operation Select] → [Entry Target] is set to “Data Block”, the currently displayed data block number is stored.
No. 0 - 1023

n+4 - n+m
When [Detail] → [Write to] is set to “Information Output Device”, the entered value is stored.

Numerical value: 2 words maximum
Text: Number of bytes ÷ 2 words (if the number of bytes is odd, 1 byte is added.)

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0

Entry operation
1: Enabled, 0: Disabled

Write status
1: Completed, 0: Not written

Cursor movement order numbers 0 to 255

MSB LSB

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0

Line selection (1 to 20)Column selection (1 to 25)

MSB LSB
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Entry Target
This section only explains the essential entry settings.

Numerical Data Display
Contents

Function

Item Description
Device Set the device memory for writing.

Item Description
Function Set the entry target.
Cursor movement order Set the cursor movement order. The cursor can be moved with the [UP] and [DW] switches or using a control 

device memory.
Use Item Select Select this checkbox to use the item select function.

The cursor moves to the entry target that is tapped.
For details on the operation and notes, refer to “Selecting by Tapping the Entry Target” page 6-36.

Display the keyboard Select a keypad. Click [Register] when registering a new keypad part.
Display Format Change the list view of the overlap library.
Display Position Unselected:

Display using the position of the keypad registered in the overlap library.
Selected:

Specify the keypad display position. The display coordinates can be set with the mouse by clicking 
[Specify with Mouse].
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Operation/Alarm

Interlock
This is used to control the calling of keypads.

Item Description
Alarm Set the entry range. Data can be entered within the range of the minimum and maximum values.

If data that exceeds the specified range is entered using an external command (other than a keypad), the 
entry target is displayed in the specified color.

For details, refer to “ Interlock” page 3-15.
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Table Data Display
General settings
Location of settings: Double-click on the table data display

• Detail

Table cells
Location of settings: Right-click on table cell → right-click menu → [Detail Setting]

• Select Type

Item Description
Input Cursor Movement 
Control Device

Perform cursor movement control. For details, refer to “6.3.1 Item Select Function” page 6-36.

Order INC When the table data display contains multiple table data display parts for which [Function] is set to “Entry 
Target”, this determines the order of precedence of each table data display part.

Cursor Direction Select the direction in which the cursor moves when the [ENT] key is pressed.
This setting is available when [Operation Select] → [Cursor Moved by] is set to “UP/DW Switch” for the 
keypad and bit 14 (cursor movement) of [Control Device] is set to ON.

ID Set an ID number.

Item Description
Select Type Set the display format to [Num. Display].
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• Contents

• Function

• Operation/Alarm

Item Description
Device Set the device memory for writing.

Item Description
Function Set the entry target.

Item Description
Alarm Set the entry range. Data can be entered within the range of the minimum and maximum values.

If data that exceeds the specified range is entered using an external command (other than a keypad), the 
entry target is displayed in the specified color.
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Slider Switch
Style

Output Setting

Item Description
Area Setting Set the part design.

Item Description
Device Set the device memory for writing data.
Data Length Set data length for the device memory. (1-Word/2-Word)
Direction Set the sliding direction.
Determine the number of 
divisions according to the 
item size

Select this checkbox to automatically define the number of divisions for the rail according to the size and 
scale value of the rail.

Divisions Set the number of rail divisions. (2 to 1024)
* If the rail size is smaller than the number of divisions, the rail is divided by the set number in the same 

manner as when the [Determine the number of divisions according to the item size] checkbox is 
selected.

Range Set the writable range of the slider switch. This range can be changed by switching to device memory 
specification.
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6.2 Character Input
6.2.1 Overview

A keyboard (or USB keyboard) or barcode reader can be used to enter text data (ASCII code data) to be written to the 
specified device memory address.
If the target data display is a character display when entering data using a keyboard, enter text data.

Keyboard
• Enter characters with respect to the entry target using a keyboard placed on the screen.

• A keyboard can be displayed when needed and character data can be entered with respect to the entry target. The 
keyboard can remain hidden at other times.

• Cursor movement can be limited to certain entry targets.

USB keyboard
• Text can be entered with respect to the entry target using a USB keyboard connected to the USB-A port.

* Supported keyboards
- Japanese keyboard (106 keyboard, 109 keyboard, etc.)
- US keyboard (101 keyboard, 104 keyboard, etc.)
- Keypad

For setting examples, refer to “Placing an Entry Target and Keyboard on the Screen” page 6-24.

For setting examples, refer to “Showing the Keyboard Only When Necessary” page 6-26.

For details, refer to “6.3.1 Item Select Function” page 6-36.

For setting examples, refer to “USB Keyboard Entry” page 6-27.

TEST

TEST

Z X C

A S D

Q W E

V B N

F G H

R T Y

M , .

J K L

U I O

SP ENTER

: BS ↓
P CLR ↑

Entry Target
Input

TEST TEST

Z X C
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Q W E

V B N
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R T Y

M , .

J K L

U I O

SP ENTER
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P CLR ↑Entry Target

The system keyboard can 
also be used.
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T-L-00B

T-L-00A
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Password
A password entry screen can be created using a character display.
There are two methods for handling passwords: displaying the input value using * (asterisks) and performing OK/NG 
validation using a ladder or macro (password input 1), and registering the correct password in advance and outputting the 
match/mismatch result to the specified address (password input 2).

Barcode reader
The V10/V9 series reads barcode data, converts the necessary data into ASCII code, and stores results in the specified PLC 
device memory address. This allows various types of information to be transferred immediately using barcodes.

For details on the setting procedure, refer to “Password Input 1 (* (Asterisks) Display)” page 6-29, and 
“Password Input 2 (Judgment Result Output)” page 6-30.

For details, refer to “17 Barcode”.

Enter “ABCD“.

• Device memory: 
D400

• Function: Entry Target
• Character property: 

* Display

Display on V10/V9: ****

Values stored on PLC:
D400 = 4241H
D401 = 4443H

• Password input 1

987

654

CLR321

ENT+/-.0

Enter “1999“.

Enter “1231“.

D300 = 0

D300 = 1

Enter “2000“. D300 = −1

• Device memory: 
D300

• Function: Password Input 
(Fixed)
- No. 0: 1999
- No. 1: 1231
- No. 2: (None)
- No. 3: (None)

Judgment result

If the input value matches the 
password, the password 
registration number is stored.
If the entered password does 
not match, “−1“ is stored.

• Password input 2

4902580302447

PI !

PLC

4902580302474
Code No. :

The V10/V9 series reads barcode data 
and transfers it to the PLC.

Barcode reader
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6.2.2 Setting Examples
Placing an Entry Target and Keyboard on the Screen
There are two methods for placing these parts: placement using an entry target or placement using a keyboard. Each 
procedure is described below using an example.

Placement Using an Entry Target
1. Click [Parts] → [Data Display ] → [Char. Display] and place a character display on the screen.

2. Display the settings window for the character display and set the [Contents] → [Device] and [No. of Bytes] settings.

3. Set [Function] to “Entry Target”.

4. Click [Place Keyboard] to place a keyboard.

This completes the necessary settings.

TEST

TEST
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Input
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Placement Using a Keyboard
1. Click [Parts] → [Entry ] → [Keyboard] and place a keyboard on the screen.

2. Display the settings window for the keyboard, click the [Place Entry Target], and place an entry target.

3. Display the settings window for the entry target (character display) and set the [Contents] → [Device] and [No. of Bytes] 
settings.

This completes the necessary settings.

* An entry target can also be placed according to the following procedure.
1) Click [Parts] → [Data Display ] → [Char. Display] and place a character display on the screen.
2) Display the settings window for the character display and set the device memory for writing via [Contents] → 

[Device].

3) Set [Function] to “Entry Target”.
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Showing the Keyboard Only When Necessary
This procedure is described below using an example. (The keyboard disappears after entry.)

1. Click [Parts] → [Data Display ] → [Char. Display] and place a character display on the screen.

2. Display the settings window for the character display and set the device memory for writing via [Contents] → [Device].

3. Set [Function] to “Entry Target”.
4. Select the [Display the keyboard] checkbox and select a keyboard.

When registering a new keyboard, click [Register] and select a keyboard.

5. Select the [Display Position] checkbox and set the display position of the keyboard.
(The display position cannot be set when the system keyboard is selected.)

This completes the necessary settings.

This setting cannot be performed for table data display entry targets.

TEST TEST

Z X C

A S D

Q W E

V B N

F G H

R T Y

M , .

J K L

U I O

SP ENTER

: BS ↓
P CLR ↑

Entry Target

Click for a new 
registration

When [System Keyboard] is selected
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USB Keyboard Entry
Text can be entered with respect to the entry target using a USB keyboard connected to the USB-A port.

Applicable USB Keyboards
• Japanese keyboard (106 keyboard, 109 keyboard, etc.)
• US keyboard (101 keyboard, 104 keyboard, etc.)

Settings on MONITOUCH
The [Keyboard] tab window on the Language Setting screen in Local mode allows you to select the type of keyboard to be 
connected to the USB-A (master) port.

V-SFT Settings
Settings must be made for a target character display with [Entry Target] selected for [Function] and [Entry] icon must be 
registered on the screen on which the keyboard will be used.

1. Click [Parts] → [Data Display ] → [Char. Display] and place a character display on the screen.

R-L-00A

1564

554

1653

T-L-00B

T-L-00A

Select a keyboard type 
and press the [Apply] 
switch to confirm the 
setting.
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2. Display the settings window for the character display and set the device memory for writing via [Contents] → [Device].

3. Set [Function] to “Entry Target” and click [Finish].

4. Click [Parts] → [Entry] → [Entry Mode] and place an icon on the screen.

This completes the necessary settings.

* The functions supported by USB keyboards are shown below.
- V10/V9 function switch assignment

- Other

USB keyboard V10/V9 USB keyboard V10/V9
F1 F1 F5 F5
F2 F2 F6 F6
F3 F3 F7 F7
F4 F4 F8 SYSTEM

USB keyboard Description USB keyboard Description
Character keys Character Input ← Move the cursor left
Enter Write → Move the cursor right
− (minus) Toggle Sign ↑ Move the cursor to the 

previous option (−1)
Space Space ↓ Move the cursor to the next 

option (+1)
Back Space Back Space Page Up Move to the next screen page 

(+1)
Delete Delete the character at the 

cursor position
Page Down Move to the previous screen 

page (−1)
Esc Restore the initial display 

state during entry operation.
Shift + Caps Lock Switching (Caps Lock)
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Password Input 1 (* (Asterisks) Display)
This procedure is described below using an example.
Characters are written to D400 on the password input screen. The input values can be hidden on the V10/V9 by displaying 
them using * (asterisks).
OK/NG validation of input values is determined by a ladder or macro.

1. Click [Parts] → [Data Display ▼] → [Char. Display] and place a character display on the screen.

2. Display the settings window for the character display and set the device memory for writing via [Contents] → [Device].

3. Set [Function] to “Entry Target“.

4. Select the [* Display] checkbox in the [Char. Prop.] window.

5. Click [Place Keyboard] and place a keyboard. A keypad can be placed when only numerical input is required.

This completes the necessary settings.

Enter “ABCD“.

• Device memory: D400
• Function: Entry Target
• Character property: 

* Display

Display on V10/V9: ****

Values stored on PLC:
D400 = 4241H
D401 = 4443H



6  Entry

6-30

Password Input 2 (Judgment Result Output)
This procedure is described below using an example.
Register the correct password to the character display in advance and output the match/mismatch result with the input value 
to the specified address.

1. Click [Parts] → [Entry ] → [Keypad] and place a keypad on the screen.

2. Display the settings window for the keypad, select the [Style] → [Additional Parts List] → [For Keyboard] → [Password 
Input] checkbox, and then click [Others].

3. Register a password in the settings window of the character display under [Function].

Fixed Register the number of passwords required using the four provided password fields numbered 0 to 3 (maximum 
of 32 one-byte alphanumeric characters).

Variable Select the checkboxes of the four provided passwords numbered 0 to 3 as required and store the password as an 
ASCII code at the specified device memory address.

987

654

CLR321

ENT+/-.0

Enter “1999”.

Enter “1231”.

D300 = 0

D300 = 1

Enter “2000”. D300 = −1

• Device: D300
• Function: Password Input 

(Fixed)
- No. 0: 1999
- No. 1: 1231
- No. 2: (None)
- No. 3: (None)

Judgment result

If the entered text matches the password, 
the password registration number is stored.
If the entered password does not match, 
“−1” is stored.

Password
registration

number

* One-byte and two-byte 
characters are treated differently.
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4. Set the device memory for outputting the password judgment result with [Contents] → [Device]. E.g. D300.

This completes the necessary settings.
The password judgment result is stored in D300.

- Password matches: When the password is accepted, No. 0 to 3 is stored.
- Password does not match: -1 (FFFF H) is stored.
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6.2.3 Detailed Settings
Keyboard
Operation Select / Detail
These are the same as for the keypad.

Style

* The following switches can be used on a keyboard.

For details, refer to “Operation Select” page 6-9 and “Detail” page 6-15.

Item Description
Adjust Position Change the layout of the keyboard and other added parts.
Select from catalogs Change the keyboard part.
Additional Parts List * Select [For Keyboard].

Use this list to add or remove entry-related parts.

Part Function Description
Switch Character Input Enter numerical values or character codes corresponding to the text on the switch.

Write Transfer the entered data to the specified device memory address. The screen can be changed 
after the execution of data writing.

Clear Clear the entered data.
Spaces One-byte space is entered.
Back Space Delete the character to the left of the cursor.
DELETE Delete the character at the current cursor position.
Cancel Restore the initially displayed value (the value prior to entry) during an entry operation.
LFT Move the cursor left.
RGT Move the cursor right.
UP Move the cursor to the previous entry target. (Cursor movement order number −1)
DW Move the cursor to the next entry target. (Cursor movement order number + 1)
Conversion of Kanji Enable kanji mode with conversion of one character at a time.

* JIS level-1 kanji set only
Cursor Movement to Right Move the cursor to the right in the table data display.

For details, refer to page 6-14.
Cursor Movement to Left Move the cursor to the left in the table data display.

For details, refer to page 6-14.
Table Move + Move the cursor to the next table data display. (Cursor movement order number + 1)
Table Move − Move the cursor to the previous table data display. (Cursor movement order number − 1)



6.2    Character Input

6-33

1

2

3

4

5

6

7

8

9

10

*1 Copying is not possible in the following situations. An error buzzer will sound.
- When converting Japanese characters
- When a character display part with [Function] set to [Password Input] is selected
- When a character display part with [Function] set to [Entry Target] is selected and the [*Display] checkbox is selected in the [Char. Prop.] 

settings
- When a range is selected (The buzzer does not sound.)
- When using the system keyboard
- When the [Enable/disable the entry key (Bit 15)] checkbox is selected and bit 15 is OFF

*2 Pasting is not possible in the following situations. An error buzzer will sound.
- When there are not enough bytes at the paste destination
- When line break, tab or control characters are included
- When an empty string is copied and pasted
- When converting Japanese characters
- When the language of the copied text differs from the paste destination (The buzzer does not sound.)
- When using the system keyboard
- When the [Enable/disable the entry key (Bit 15)] checkbox is selected and bit 15 is OFF

Switch Multi-char. Input Changeover the text for each pattern with the [Char. Switching (+)] and [Char. Switching (−)] 
switches.
Text on switches changeover according to the conversion modes of 1-byte/2-byte and caps 
lock.

Switching (Entry Mode 
Change)

-

Switching (1-byte/2-byte 
Char. Change)

-

Switching (Caps Lock) -
Direct Input -
Word Registration -
Char. Switching (+) Changeover the pattern and text of the [Multi-char. Input] switch in order from “OFF” to “P15.”
Char. Switching (−) Changeover the pattern and text of the [Multi-char. Input] switch in order from “P15” to “OFF.”
Copy Copies to the clipboard the text that is being input. *1

The information that is copied last is retained while in RUN mode.
Paste Inserts text from the clipboard to the left of the cursor. *2

Character 
display

Entry Target Temporarily display the entered value.
Password Input Displays input values as asterisks. This can be used for password inputs. For details, refer to 

page 6-29.

Part Function Description
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Entry Target
This section only explains the essential entry settings.

Character Display
Contents

Function

Interlock
These are the same as for the keypad.

Item Description
Device Set the device memory for writing.
No. of Bytes Specify the number of bytes (number of characters).

Item Description
Function Set the entry target.
Cursor movement order Set the cursor movement order. The cursor can be moved with the [UP] and [DW] switches or using a control 

device memory.
Use Item Select Select this checkbox to use the item select function.

The cursor moves to the entry target that is tapped.
For details on the operation and notes, refer to “Selecting by Tapping the Entry Target” page 6-36.

Display the keyboard Select a keyboard. Click [Register] when registering a new keyboard part.
Display Format Change the list view of the overlap library.
Display Position Unselected:

Display using the position of the keyboard registered in the overlap library.
Selected:

Specify the keyboard display position. The display coordinates can be set with the mouse by clicking 
[Specify with Mouse].

For details, refer to “Interlock” page 6-18.
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Table Data Display
General settings
Location of settings: Double-click on the table data display

• Detail

Table cells
• Select Type

• Contents

• Function

Item Description
Input Cursor Movement 
Control Device

Perform cursor movement control. For details, refer to “6.3.1 Item Select Function” page 6-36.

Order INC When the table data display contains multiple table data display parts for which [Function] is set to “Entry 
Target”, this determines the order of precedence of each table data display part.

Cursor Direction Select the direction in which the cursor moves when the [ENT] key is pressed.
This setting is available when [Operation Select] → [Cursor Moved by] is set to “UP/SW Switch” and bit 14 
(cursor movement) of [Control Device] is set to ON.

ID Set an ID number.

Item Description
Select Type Select [Char. Display].

Item Description
Device Set the device memory for writing.
No. of Bytes Specify the number of bytes (number of characters).

Item Description
Function Set the entry target.
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6.3 Convenient Functions
6.3.1 Item Select Function

Overview
The cursor can be moved to a specific entry target. This is called the “item select function.”
There are two methods for moving the cursor: tapping the entry target or using an external command from the device 
memory specified for [Input Cursor Movement Control Device] (page 6-37).

Selecting by Tapping the Entry Target
The cursor can be moved to a specific entry target by tapping the entry target.

Setting Procedure
When enabling the item select function for an entry target

Select the [Function] → [Use Item Select] checkbox of the data display part to be set as an entry target.

When placing a switch so that it overlaps an entry target
1. Set [Function] to “Item Select” for the switch.

2. Place the switch so that it overlaps an entry target.

9999

0
1250

300

7.23

11.02

TEST 0 . +/- CR

1 2 3 CL

4 5 6 DW

7 8 9 UP

1250DATA 1

DATA 2

DATA 3

DATA 4

NAME

Maximum
Minimum
Input

Entry to “DATA1” and 
“NAME” can be prohibited.

Cursor movement 
order number

0
1
2
3
4

50.00

0
1250

300

7.23

11.02

TEST 0 . +/- CR

1 2 3 CL

4 5 6 DW

7 8 9 UP

11.02DATA 1

DATA 2

DATA 3

DATA 4

NAME

Maximum
Minimum
Input

The cursor moves to the 
entry target that is tapped.
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Notes
• Place the switch set with “Item Select” for [Function] on the same editing layer (screen, overlap ID 0 to 9) as the keypad.
• For the keypad, set [Operation Select] → [Entry Target] to “Data Display” and [Cursor Moved by] to “UP/DW Switch”.

Item Select with [Input Cursor Movement Control Device]
Set a [Input Cursor Movement Control Device] at the position of the placed entry target. The cursor can be moved to the 
specific entry target by setting the relevant [Input Cursor Movement Control Device] bit either ON or OFF.

Location of Setting
The location of this setting differs depending on the placement location of the entry target. Specify the top device memory 
address for [Input Cursor Movement Control Device] at the location of this setting.

Details of the [Input Cursor Movement Control Device] Setting
The control method differs depending on whether the entry target is a numerical data display, character display, or table data 
display.
One bit is assigned to each entry target and cursor movement is controlled by the ON/OFF state of this bit.

When the entry target is a numerical number display or character display
[Input Cursor Movement Control Device] is associated with [Entry Target] and the [Cursor movement order] number in the 
following way.

0: Cursor movement prohibited
1: Cursor movement allowed

Entry Target
Location of the [Input Cursor Movement Control Device] Setting

Type Placement Location
Numerical Data 
Display
Character Display

Screen [Screen Setting] → [Screen Setting] → [Entry] → [Input Cursor Movement Control 
Device]

Normal overlap Normal overlap settings window → [Detail] → [Input Cursor Movement Control 
Device]

Multi-overlap Multi-overlap settings window → [Detail] → [Input Cursor Movement Control 
Device]

Call-overlap Call-overlap settings window → [Detail] → [Input Cursor Movement Control 
Device]

Global overlap Global overlap settings window → [Detail] → [Input Cursor Movement Control 
Device]

Data Block Area Data block area settings window → [Detail] → [Input Cursor Movement Control 
Device] under [Device Setting]

Table Data Display - Table data display settings window → [Detail] → [Input Cursor Movement Control 
Device]

9999

0
1250

300

7.23

11.02

TEST 0 . +/- CR

1 2 3 CL

4 5 6 DW

7 8 9 UP

1250DATA 1

DATA 2

DATA 3

DATA 4

NAME

Maximum
Minimum
Input

Entry to “DATA1” and 
“NAME” can be prohibited.

Cursor movement 
order number

0
1
2
3
4

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

MSB LSB
← Bit No.
← Cursor movement order No. 0 to 15

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
31 30 29 28 27 26 25 24 23 22 21 20 19 18 17 16

MSB LSB
← Bit No.
← Cursor movement order No. 16 to 31

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
255 254 253 252 251 250 249 248 247 246 245 244 243 242 241 240

MSB LSB
← Bit No.
← Cursor movement order No. 255 to 240

n

n+1

n+15
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When the entry target is a table data display
Assignment depends on the number of columns of the table data display part.

0: Cursor movement prohibited
1: Cursor movement allowed

• Table with 1 to 16 columns
For a table with 1 to 16 columns, one word is used for each line.
The total number of words used is the same as the number of lines.

• Table with 17 to 25 columns
For a table with 17 or more columns, 2 words are used for each line.
The total number of words used is “2 ÷ number of lines”.

Usage Example
An example of when a numerical data display or character display entry target and a keypad are placed on the screen is 
explained below.

1. Set [Screen Setting] → [Screen Setting] → [Entry] → [Input Cursor Movement Control Device]. Example: PLC device 
memory D200

2. Only the 0th, 2nd, and 3rd bits of the device memory for input cursor movement control are set to ON from the unit.

The cursor moves according to the cursor movement order numbers 0, 2, and 3.

Notes
In this case, the [Cursor movement order] number of each table data display is ignored.
The line and column numbers are also assigned to those consisting of text only.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
MSB LSB

← Bit No.
← Line 1

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
MSB LSB

← Bit No.
← Line 2

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
MSB LSB

← Bit No.
← Line 20

n

n+1

n+19

16 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 ← Column number

25 24 23 22 21 20 19 18 17
15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

MSB LSB

Column number
Bit No.
Line 1

Bit No.
Line 2

Bit No.
Line m

16 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1
15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00n + 1

LSB MSB

n

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00 15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00n + 3 n + 2

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00 15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00n + q n + p

D200 15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 1 1 0 1

MSB LSB
← Bit No.
← Cursor movement order No. 0 to 15



7 Trends

7.1 Overview

7.2 Historical Display

7.3 Real Time Display





1

7.1    Overview

7-1

2

3

4

5

6

7

8

9

10

7.1 Overview
There are two types of trend sampling: historical display (logging server) and real time display.

Historical Display
• The values of device memory addresses registered to a logging server can be saved as history. Logging can be performed 

at a fixed cycle or using a trigger bit (0 → 1).

• History data saved to a logging server using trend sampling parts can be displayed on a graph or as data.

Real Time Display
Values in consecutive device memory addresses can be expressed on a line graph.

For details, refer to “7.2 Historical Display” page 7-2.

For details, refer to the following references.
• “7.2.2 Graph Display” page 7-15
• “7.2.3 Data Display” page 7-25

For details, refer to “7.3 Real Time Display” page 7-32.

16:15:40
16:15:45
16:15:50
16:15:55
16:16:00
16:16:05
16:16:10
16:16:15
16:16:20
16:16:25
16:16:30
16:16:35

(D201)
80
40

290
120
190

75
200
120
280
120
115
120

(D200)
300
250
360
340
360
310
310
320
380
320
360
350

PLC

History data
Logging 
server

Graph display Data Display

0

D100

D101

D102 D103 D104 D105 D106 D107 D108

D109

D110 PLC

Example: Graph display of data in addresses D100 to D110
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7.2 Historical Display
7.2.1 Logging Server

• The area for saving logged data is referred to as the logging server. A maximum of 12 logging servers can be registered.
Logging is performed using a fixed cycle or a trigger bit (0 → 1) and device memory can be freely configured.

• CSV/backup output
- History data saved to a logging server can be output to a storage device as a CSV or backup file.

- The drive for outputting CSV and backup files can be set. CSV and backup files can be output with an SD card inserted 
in the SD card socket at all times or with a USB memory device, which can be connected only when needed.

• History data saved to a logging server using trend sampling parts can be displayed on a graph or as data.

For details, refer to “Outputting CSV/Backup Files” page 7-5.

For details, refer to the following references.
• “7.2.2 Graph Display” page 7-15
• “7.2.3 Data Display” page 7-25

No. 0

No. 2
No. 1

No. 3

No. 5
No. 4

No. 6

No. 8
No. 7

No. 9

No. 11
No. 10

Logging server Method: Fixed cycle at 1 second
Addresses: D200 to D209

Method: Trigger bit M0
Addresses: D10000 and D12225

Method: Fixed cycle at 5 seconds
Addresses: D0, D300, and D15000

Maximum of 12 registered logging servers

SD
No.0

.CSV

No. 0

No. 2
No. 1

No. 3

No. 5
No. 4

No. 6

No. 8
No. 7

No. 9

No. 11
No. 10 No.10

.CSV
No.3

.CSV

PLC

OFF ON

OFF ON

OFF ON

No. 0

No. 10
No. 3

No. 0

No. 3

No. 10Logging 
server

Internal storage 
(SRAM)

SD

No.0
.CSV

No.10
.CSV

No.3
.CSV

U
SB

flash drive

No.0
.BIN

No.10
.BIN

No.3
.BIN

20140401 20140402Backup
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Setting Example
Logging Methods
There are two logging methods: logging performed at a fixed cycle and logging performed upon triggering of a trigger bit (0 
→ 1).

Fixed cycle
This section explains logging with a fixed cycle using an example of logging data from device memory addresses D200 to 
D209 at 1 second intervals.

1. Display the [System Setting] → [Logging Server] window.

2. Click [Add] and set an unregistered number.

3. Set [Logging] to [Constant Cycle].

4. Configure the [Logging Data] tab window settings as shown below.

5. Set [Number of Data to Save] on the [Output Destination] tab window.

This completes the necessary settings.

Number of Data to Save Set the number of data entries to save in logging.
After Full Capacity Set the operation to perform when the value of [Number of Data to 

Save] is exceeded.

Erase old data entries and continue or stop logging.

To output logging data to a storage device, refer to “Outputting CSV/Backup Files” page 7-5.

To display logging data on a graph or as data, refer to the following references.
• “7.2.2 Graph Display” page 7-15
• “7.2.3 Data Display” page 7-25

• [Logging Time]: 1 sec
• [Number of Logging Data]: 10
• [Device]: D200 to D209
• [Type]: DEC
• [Decimal Point]: 0
• [Data Length]: 1-Word
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Trigger
This section explains logging with a trigger using an example of logging data from device memory addresses D10000 and 
D12225 when trigger bit M0 changes from 0 to 1.

1. Display the [System Setting] → [Logging Server] window.

2. Click [Add] and set an unregistered number.

3. Set [Logging] to [Trigger].

4. Configure the [Logging Data] tab window settings as shown below.

5. Set [Number of Data to Save] on the [Output Destination] tab window.

6. Set [Trigger Bit] on the [Control Device Setting] tab window.  M0

This completes the necessary settings.

Number of Data to Save Set the number of data entries to save in logging.
After Full Capacity Set the operation to perform when the value of [Number of Data to 

Save] is exceeded.

Erase old data entries and continue or stop logging.

To output logging data to a storage device, refer to “Outputting CSV/Backup Files” page 7-5.

To display logging data on a graph or as data, refer to the following references.
• “7.2.2 Graph Display” page 7-15
• “7.2.3 Data Display” page 7-25

• [Number of Logging Data]: 2
• [Device]: D10000 and D12225
• [Type]: DEC
• [Decimal Point]: 0
• [Data Length]: 1-Word
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Outputting CSV/Backup Files
Output logging data saved in SRAM (DRAM) to a storage device.

1. Display the [System Setting] → [Logging Server] window and specify a logging server number.

2. Set the settings under [CSV/Backup Setting] → [Output timing] on the [Output Destination] tab window.

3. Set the save target with [Drive for Output].

For an example on setting the logging method, refer to the following references.
• “Fixed cycle” page 7-3
• “Trigger” page 7-4

Output timing Storage Output Bit (0 → 1)
After Full Capacity
At power-on
Upon date change (AM00:00:00)
Upon change to local mode (when mode is changed from RUN to Local)
Upon storage removal (when storage removal switch is pressed)

Drive for Output Storage Setting: [System Setting] → [Other] → [Storage Setting]
C: Built-in Socket
D: USB-A port
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4. Double-click the format number on the [Format Setting] tab window and set the format of the CSV file.

This completes the necessary settings.
A CSV file/backup file is output at the timing set in step 2.

File Name Set the name of the CSV file.
Output Language Set the language used in the CSV file.

No Designation: Output using the displayed language.
Language 1 to 32

Title Setting Add a title to the first line of the CSV file. (Max. 10 lines)
Double-click a cell under [Message] and register text in the [Message Edit] 
window.

Items Not to Output
Items to Output
← →

Use the [←] and [→] buttons to set the items to output to the CSV file.

Logging Time
Time Display (msec)
Logging Data

* Logging time and time display are output separately.
Output Preview Display a preview of CSV file to be output.

For details on folder configuration, refer to “Storage output settings” page 7-10.

To only output a CSV file, select the [Others] → [Do not output backup files] checkbox.

Message editor (title)

Line 1
Line 2

Double-click

GNo. 127, No. 0

GNo. 127, No. 5

Double-click
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Detailed Settings
Location of settings: [System Setting] → [Logging Server]

Table

Item Description
Add Create a new logging server. A maximum of 12 logging servers can be registered.
Delete Delete the selected logging server.
Copy The following dialog box is displayed.

Paste The following dialog box is displayed.
The content copied using the [Copy] button is pasted to the specified number.

Table

Item Description
Copy source The specified block is copied.
Copy and paste 
simultaneously

When selected, copying and pasting are done simultaneously.
The paste destination is specified at [Destination].

* Be sure to deselect this checkbox when copying and pasting to 
a different file.

Destination This setting is valid when [Copy and paste simultaneously] is 
selected.
Specify the block number of the destination for pasting the copied 
content.
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Logging Data

Item Description
Logging Method Set the logging method.

Trigger
Perform logging when the [Trigger Bit] device memory changes from 0 to 1.
Location of setting:“Control Device Setting” page 7-12

Constant Cycle
Perform logging at the cycle set for [Logging Time].

Logging Time Set the logging frequency.   0 to 65535 (0 means every cycle)  Units: Seconds or 100 milliseconds
Number of Logging Data Set the total number of points to log.   Max. 256 points.
Device Set the logging device memory.

Type Set the data type.
Decimal Point Set the number of decimal places.
Data Length Set the data length of the set device memory.   1-Word/2-Word
Characters Set the number of characters (1 character = 1 byte).
Text Process Set the order of the first and second bytes within one word.   LSB → MSB, MSB → LSB
Conversion No

The value of the device memory address is logged as is.
Yes

The value of the device memory address after operation/scaling is logged.
Set Selected Batch copy the settings of the selected cell. For device memory addresses, automatic increment is 

performed.
Import Import logging device memory of the selected and subsequent numbers from a CSV file.

If the number of lines in the CSV file exceeds the number of logging entries, the device memory is not 
extended.

Export Export all logging device memory to a CSV file.
Up, Down Move the selected line.
Add Add a new line below the selected line.
Delete Delete the selected line.

0 : OFF

1 : ON

1 2 3 4 5

1 2 3 4 5
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Output Destination

Internal storage settings
Configure the settings for storing to SRAM (DRAM).

Item Description
Number of Data to Save Set the number of data entries to save in logging.
After Full Capacity Set the operation to perform when the value of [Number of Data to Save] is exceeded.

Erase old data entries and continue or stop logging.
Device Type Set the save destination for logging.

SRAM
Back up history data when power to the unit is OFF (on battery power) and when changing between RUN 
and Local mode.
The amount of free space and total used space can be checked via [SRAM/Clock Setting].

DRAM
All history data is cleared when power to the unit is turned OFF or when changing between RUN and Local 
mode.
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Storage output settings
Configure the settings for outputting to a storage device.

Item Description
Number of Data to Save Set the amount of data saved in the internal storage settings to save to a BIN file.

The timing of file output is as follows.
- When amount of saved internal storage settings data has reached its limit
- When switching the V10/V9 series unit from RUN to STOP, or when turning power ON (only when 

SRAM is selected)
- When the [Storage Removal] switch is pressed
- When a reset is performed (reset switch/reset bit ON)
- When the SAMPLE macro (V8 compatible) is executed

(To only output CSV and backup files, this setting is not required. Configure the CSV/backup settings.)
Drive for 
Outputs

Select the output target.

Storage settings: [System Setting] → [Other] → [Storage Setting] → [Storage Connection Target] 
C: Built-in Socket
D: USB-A port

The folder configuration on storage devices is as follows.
BIN file destination: (output drive)\access folder\LOGGING folder

*1 The folder name can be changed at [System Setting] → [Other] → [Storage Setting].
*2 Temporary file created during data update. This file is created temporarily only when the [System 

Setting] → [Unit Setting] → [General Setting] → [Output logging data in binary format] checkbox is 
unselected. (V9 only)

LOGGING

EXT0000

LOGGING00.BIN (LOGGING00.BIN-journal *2)

Logging server No. 00 to 11

Access folder (default) *1

LOGGING folder (fixed name)
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CSV/Backup Setting Output data saved in the internal storage settings to a CSV/backup file on the storage device.
Output timing Set the timing for outputting to the storage device.

Storage Output Bit (0 → 1) / After Full Capacity / At power-on / Upon date change (AM00:00:00) / 
Upon change to local mode / Upon storage removal

Drive for 
Output

Select the output target.

Storage settings: [System Setting] → [Other] → [Storage Setting] → [Storage Connection Target] 
C: Built-in Socket
D: USB-A port

The folder configuration on storage devices is as follows.
• CSV output destination

(output drive)\access folder\LOGGING folder
• Backup output destination

(output drive)\access folder\LOGGING\year/month folder\year/month/day folder

E.g.: Logging server number 0, CSV filename: power, output drive: USB-A port

*1 The folder name can be changed at [System Setting] → [Other] → [Storage Setting].
*2 For details on changing the filename, refer to “Format Setting” page 7-13.
*3 If a backup is not required, select the [Others] → [Do not output backup files] checkbox.

For details, refer to “Others” page 7-14.

Item Description

LOGGING

EXT0000

20140401

USB 
flash drive

201404

20140402

20140501

201405

20140502

power.CSV *2

power_20140401083000.CSV

(April 1, 2014 at 08:30:00)
LOGGING00_20140401083000.BIN

Year/month folder (backup) *3

Year/month/day folder

power_20140402083000.CSV

LOGGING00_20140402083000.BIN

Access folder (default) *1

LOGGING folder (fixed name)

Year, month, day, hour, minutes, seconds

Logging server
No. 00 - 11
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Control Device Setting

Control device

Confirmation device
This device memory stores the execution result of the control device memory.

Item Description
Trigger Bit Set the trigger bit to use when [Logging] is set to [Trigger]. Logging is performed when the trigger bit 

changes from 0 to 1.
0 → 1: Perform logging once.

Reset Bit Clear the history data.
1: Reset (logging is stopped while “1”)

Start Bit Control starting and stopping of logging.
0: Stop
1: Start

Storage Output Bit Display the storage output bit.

Change the device via [Output Destination] → [Storage Output Bit]. For details, refer to page 7-9.

Item Description
Trigger Bit Stores the trigger bit status.
Reset Bit This bit changes to “1” after a reset is complete.
Storage Output Bit This bit changes to “1” after the storage output is complete.

* If the storage output bit of the control device is turned off before the storage output is complete, it 
does not change to 1.

Data Presence Bit This bit changes to “1” when there is history data present at the saving destination.
Bit for capacity over 90% full This bit changes to “1” when the saving destination is 90% full with history data.
Bit for buffer full This bit changes to “1” when the saving destination is full.
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Format Setting
Format list

*1 While there are no restrictions on the number of rows and columns in the SMHxxxx.csv files, the maximum file size is 239 kbytes.
If there is a mistake in the settings or a SMHxxxx.csv file cannot be read, the logging block number is added to the title line.

Format window
Double-click a format number in the list to display this window.

Item Description
CSV Format Setting These settings are for saving history to CSV files.

Multiple CSV formats can be registered using the [Add] button.
Use CSV file for titles 
(V8 Compatible) *1

Add title lines using SMHxxxx.csv (xxxx: 0000 to 0011).
Place any CSV files into the “LOGGING“ folder on the storage device in advance.
The CSV format is only valid for No. 0 (V8 format).

Item Description
File Name Set the name of the CSV file.

Default: LOGGING_xx_yy.CSV (xx: logging server number, yy: format number)

* For details on file output destinations, refer to page 7-9.
Output Language Set the language used in the CSV file. 

Language 1 to 32
No Designation: Language displayed on the unit.

Display Type Switch to the V8 series (previous model) settings menu.



7  Trends

7-14

Others

Title Settings Add a title to the first line of the CSV file.
Click [Add] to register up to 10 lines of titles.
Double-click a cell under [Message] and register text in the [Message Edit] window. (GNo., No. designation)

Items Not to Output
Items to Output
← →

Use the [←] and [→] buttons to set the items to output to the CSV file.
Logging Data, Logging Time, Display Time (msec)

* Output all logging data.
Cells are divided into logging time and time display (msec).

Up, Down Set the item order in the CSV file. Select an item under [Items to Output] and use the [Up] and [Down] 
buttons to move it.
Items are displayed from the left in the file in the descending order of the list.

Output Preview Display a preview of CSV file to be output.

Item Description
Do not output backup files No backup folder or file is created when outputting to a storage device. For details on folder configuration, 

refer to page 7-10.
Use Calculation Operation Select this checkbox to display [Mean Value Display/Max. Display/Min. Display/Total Display] for a numerical 

data display for which [Function] is set to “Logging”.
Put msec information on 
logging time

This is a V8 compatible setting.
Select this checkbox to output the logging time in milliseconds when using a V8 sample macro.

Read Logging Device per 
cycle

Unselected (default)
Read the logging device memory at the frequency specified for [Logging Time].

Selected
Read the logging device memory according to the communication cycle.

Item Description
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7.2.2 Graph Display
• History data saved to a logging server can be displayed as a line graph or rectangular waves.

• A maximum of 16 graph lines can be displayed in one graph area.

• Backup files output to a storage device can be selected for display.

• Each graph line can be shown or hidden. Showing or hiding graphs can be easily changed as necessary, according to 
operating conditions.

• The display magnification of the X and Y axes of graphs can be increased or reduced (1/8 to 8 times).

History data

80.9

9.05

46.2

28.0

80.9

9.05

46.2

28.0

ON

ON

ON

ON

ON

ON

OFF

OFF

Temperature A
Temperature B
Temperature C
Temperature D

Trend sampling screen Trend sampling screen

Temperature A
Temperature B
Temperature C
Temperature D

X: 1 times, Y: 1 times X: 1 times, Y: 2 timesX: 1/2 times, Y: 1 times

Blank if there is no 
history to display.
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Location of Setting
Click [Parts] → [Trend] and place a graph on the screen.

Detailed Settings
Operation Select

Contents

Item Description
Display Mode Select [Historical Display].
Display Method Select [Graph].



1

7.2    Historical Display

7-17

2

3

4

5

6

7

8

9

10

Graph

Reference line

*1 When device memory is specified for a [Reference Line], the reference line is updated at the [High Speed] process cycle setting. However, 
if the [Show/hide graph data] checkbox is selected in the [Detail] settings, updating is dependent on the specified process cycle.

Item Description
Shape Set the graph shape.   Line/Rectangular
Display Mode Sequential

Draw the graph in the direction of movement.

Pen Recorder
Display a pen recorder type graph. Newest data is always on the right.

Direction Set the direction of graph lines.

Cursor Set the color and line type of the cursor.

Item Description
Reference Line 1
Reference Line 2
Reference Line 3
Reference Line 4

A maximum of four reference lines can be displayed at once. The line type is fixed to a dotted line. *1
The line color and the value where to display each reference line can be specified.

Min. Scale Value
Max. Scale Value *2

Set the scale values for calculating the position where the reference line should be drawn in the graph area. 
Negative values can also be specified.

To draw a reference line in the center of a trend graph:

Reference Line 1
- Min. Scale Value: 0
- Max. Scale Value: 2

Specifying “1” for reference line 1 will display 
a line at the center.

Data Length Set a data length when specifying device memory (other than [Constant]) for reference lines or the minimum 
and maximum scale values.
Set data length for the device memory.   1-Word/2-Word

Input Type Set the data type of the scale values.   DEC-/BCD *3/FLOAT *4

[Direction]: RGT, [Display Mode]: Sequential [Direction]: RGT, [Display Mode]: Pen Recorder

Newest data

Newest data

Y

Y

Y

Y

X X

X X

Graph 
origin

• RGT (right) • LFT (left) • UP (upward) • DW (downward)

X: Time axis
Y: Trend data

0 X

Y

Direction: 
RGT Reference Line 4

Reference Line 3

Reference Line 2

Reference Line 1

2

0

1

Reference Line

Max.

Min.
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*2 When device memory is specified for the minimum and maximum scale values and the values in the device memory is changed in RUN 
mode, the change will be updated to the graph when the graph is displayed or when the “TREND_REFRESH” macro command is 
executed. 

*3 When [DEC-/BCD] is selected, the setting at [System Setting] → [Hardware Setting] → [PLC Properties] → [Code] takes effect.
*4 If any specified value (non-numeric inclusive) is outside the range usable on the V10/V9 series unit, the line cannot be displayed.

Data Acquisition

Graph Setting

For details on the “TREND_REFRESH” macro command, refer to the Macro Reference Manual.

For details on the allowable range, refer to “5.1.4 Real Numbers (Floating Point Numbers)”.

Item Description
No. Set the number registered to the logging server.

The registration details are shown below.
Edit Edit the logging server.

For details, refer to “Detailed Settings” page 7-7.

Item Description
Points to Display *1 Set the number of plot points along the horizontal axis.

- For 1024 × 768, 1024 × 600 dots: 3 to 1024
- For 800 × 600, 800 × 480 dots: 3 to 800
- For 640 × 480 dots: 3 to 640

Number of Graphs Set the number of graph lines.   Max. 16
Set Selected Use this button to configure settings for all displayed graph lines at once when the data length, data type, 

minimum value, and maximum value are all the same.
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*1 Number of display points

*2 Example: When set to [Logging Server]→[Number of Logging Data: 8]
To display the logging data of the 3rd word in the logging server, specify “2” for [Logging Word No.].
Even if [Data Length] is different, the corresponding device memory is the same.

*3 When device memory is specified for the minimum and maximum graph values and the values at the device memory are changed in RUN 
mode, the changes will be updated to the graph when the graph is displayed or when the “TREND_REFRESH” macro command is 
executed.

Logging Word No. *2 Specify which word the data corresponds to in the number of logging data specified for the logging server.
Device Displays the logging device memory.

The device memory can be changed in the settings of the logging server set in the [Data Acquisition] 
settings.

Input Format Select the format for display on the screen. DEC-/BCD, Actual Number

DEC-/BCD
This is determined by the setting at [System Setting] → [Hardware Setting] → [PLC Properties] → [Code].

Actual Number
If any specified value (non-numeric inclusive) is outside the range usable on the V10/V9 series unit, it 
cannot be displayed.
For details on the allowable range, refer to “5.1.4 Real Numbers (Floating Point Numbers)”.

Data Length Set data length for the device memory.   1-Word/2-Word
Max., Min. *3 Set the minimum and maximum values of the graph.

* An error will occur if the same value is set. Make sure to set valid values.
Display Format Set the graph type.   Line Graph/Marker
Type Set the line type.
Color Set the line color.

If a value larger than the X size (dots) of the graph area is specified for [Points to Display], the graph will not be 
drawn correctly.

[Data Length]: 1-Word [Data Length]: 2-Word
Logging Word No. Logging Word No.

1st word 0 1st word
0

2nd word 1 2nd word
3rd word 2 3rd word

2
4th word 3 4th word
5th word 4 5th word

4
6th word 5 6th word
7th word 6 7th word

6
8th word 7 8th word

For details on the “TREND_REFRESH” macro command, refer to the Macro Reference Manual.

Item Description

Number of display points = Maximum number of points (11)

Plot Point Pitch

Number of plotted points: 6Direction: RGT

Graph origin

Graph area
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Style

• The additional parts are listed below.

Item Description
Adjust Position Change the layout of parts.
Select from catalogs Change the trend sampling parts.
Add Parts Add new parts. New parts are added to the [Addition Parts List].
Make display area transparent Make the display area transparent. (only when [Graph] is selected for [Display Method])

Function Description
Roll Up Move the cursor to the next point.
Roll Down Move the cursor to the previous point.
+ Block Display the next page.
− Block Display the previous page.
Graph Return Blinks while the cursor is displayed when a switch such as [+ Block] or [− Block] is pressed.

Press this switch when it is blinking to stop it from blinking and return to the latest display.
Reset Press once and the switch blinks. Press again within two seconds to clear the history and resume logging.

If not pressed again within 2 seconds, the switch is turned off and resetting is nullified.
Logging Time Display *1 Display the last logging time or selected logging time.
Logging Count Display Display the current history number or the count value of the selected history data.
Zoom in (X Direction) Increase the display magnification of the currently displayed graph in the X direction 

(1/8 → 1/4 → 1/2 → 1 → 2 → 4 → 8 times).
Zoom out (X Direction) Reduce the display magnification of the currently displayed graph in the X direction 

(8 → 4 → 2 → 1 → 1/2 → 1/4 → 1/8 times).
Zoom in (Y Direction) Increase the display magnification of the currently displayed graph in the Y direction 

(1/8 → 1/4 → 1/2 → 1 → 2 → 4 → 8 times).
Zoom out (Y Direction) Reduce the display magnification of the currently displayed graph in the Y direction 

(8 → 4 → 2 → 1 → 1/2 → 1/4 → 1/8 times).
Reset Display Magnification Reset the display magnification to actual size and reset the reference position to its initial state.
Display start time *1 Display the logging time of the oldest history data on the currently displayed graph.

Display end time *1 Display the logging time of the newest history data on the currently displayed graph.
Currently Selected Value 
Display *2

Display the latest history data or the selected history data.

File Select Select and display a backup file saved to a storage device.
Mean Value Display Display the average value of the history data of each graph.
Total Display Display the total value of the history data of each graph.
Max. Display Display the maximum value of the history data of each graph.
Min. Display Display the minimum value of the history data of each graph.
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*1 Up to the year, month, and day can be displayed if enough digits are specified.

*2 Only for monitoring. To store these values in device memory, use the “SAMPLE” macro command.

Less than 8 digits No display 18 digits Month, day, hour, minutes, seconds, and 
milliseconds

8 to 11 digits Hour, minutes, and seconds 19 to 22 digits Year Month Day Hour Minute Second
12 to 13 digits Hour, minutes, seconds, and milliseconds 23 digits or more Year, month, day, hour, minutes, seconds, 

and milliseconds
14 to 17 digits Month, day, hour, minutes, and seconds

For details, refer to the Macro Reference Manual.
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Scale Display

* If the minimum and maximum values are specified with device memory addresses (other than [Constant]) in the [Range Setting] window 
and these values are changed in RUN mode, the changes are updated at the following timings:
- When the screen is redrawn
- Upon execution of the “TREND_REFRESH” macro command 

Item Description
Axis Color Select the color of the major and minor tick marks, and axis lines of the scale.

This setting is common to all left, right, bottom, and top sides.Back Color
Display Minor scale Set the length of the minor tick marks of the scale. Range: 1 to 16

This setting is common to all left, right, bottom, and top sides. The thickness of the markings is fixed.
[Scale] in [Left], [Right], 
[Bottom], and [Top] tab 
windows

Displays the scale, grid line, and reference value settings for each side. Default: Selected on [Left] and 
[Bottom] tab windows

Small scale alignment Equal divide (unit based on [No. of divisions])
Minor tick marks are equally spaced according to the specified number of divisions along the axis line.

Equal interval (unit based on [Interval])
Minor tick marks are equally spaced according to the specified interval from the zero point along the axis 
line within the following range.

Display major tick marks Display major tick marks on the scale. (Unit: [Interval]) Length: Twice the minor tick marks  Thickness: Fixed
Grid Line Grid lines are drawn at the major and minor tick marks of the scale.

Color, Line Type Set the color and line type of grid lines.
Also apply to minor 
tick marks

This can be set when the [Display major tick marks] checkbox is selected. Set whether to display grid lines.
Selected: Display at both major and minor tick marks
Unselected: Only display at major tick marks

Reference Value Select this checkbox to display reference values at major and minor tick marks on the scale.
Property Set the number of digits or the color of reference values shown at tick marks.
Also apply to minor 
tick marks

This can be set when the [Display major tick marks] checkbox is selected. Set whether to display reference 
values.

Selected: Display at both major and minor tick marks
Unselected: Only display at major tick marks

Range Setting Use when [Small scale alignment] is set to [Equal divide] or when the [Reference Value] checkbox is selected.

Match with the specified graph
The range changes according to the following combinations.

Set Value
Specify the minimum and maximum values using constants or device memory addresses. *

Graph Direction Side Range
LFT/RGT Top/Bottom Number of horizontal axis points or scale of 

[Range Setting]DW/UP Left/Right
LFT/RGT Left/Right Scale of [Range Setting]
DW/UP Top/Bottom

Graph Direction Side Range
LFT/RGT Top/Bottom Number of horizontal axis points
DW/UP Left/Right
LFT/RGT Left/Right Maximum and minimum values specified 

for the selected graph number *DW/UP Top/Bottom
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Detail

*1 Notes on the [Show/hide graph data] setting
- Even if all the graph lines are hidden, the switches for [Roll Up], [Roll Down], [+ Block], [− Block] and [Graph Return] still work. The 

moved cursor point is also retained. (But the cursor is hidden.)
- When graph lines are shown or hidden, flickering associated with graph redrawing will occur momentarily.

*2 Notes on [Zoom In/Out]
- If zooming out results in a data interval less than one dot, thinning is employed to display the data.
- Zooming in and out in the Y direction is performed centered on the cursor value. If the cursor value is not a valid real number, zooming 

is performed based on the central value of the scale.
- If multiple graphs are displayed, zooming is performed based on the graph with the smallest graph number of those displayed.

If all graphs are hidden, zooming is performed based on the central value of the displayed scale.
- If the reference position shifts when returning to actual size, use a [Reset Display Magnification] switch to return to actual size.
- Pinch-to-zoom in and out is available on the V9 Advanced models. When zooming in and out with pinch-to-zoom, display at any 

magnification between 1/8 and 8 times is available based on the central value of the scale. However, note that zooming occurs at the 
same magnification for both the X and Y directions.

Item Description
Show/hide graph data Set the device memory used to show/hide graph line numbers 0 to 15. *1

Device
(word designation)

These bits control whether each graph is shown or hidden.

Process Cycle Set the cycle used to read the device memory.   High Speed, Low Speed, Refresh
Zoom In/Out Set the method for zooming in and out of graphs. The magnification can be specified for the X and Y 

directions respectively. *2

Switch Specify the display magnification using the switch function.
Zoom in: 1/8 → 1/4 → 1/2 → 1 → 2 → 4 → 8 times
Zoom out: 8 → 4 → 2 → 1 → 1/2 → 1/4 → 1/8 times

Device
X Device
Y Device

Set the display magnification using a device memory value.
0: 1 times
1: 2 times
2: 4 times
3: 8 times
4: 1/2 times
5: 1/4 times
6: 1/8 times

Coordinates Select a display position and size.
ID Set an ID number.
File Display Order Set the order for displaying files when using the [File Select] switch to display backup files.

Ascending Order: Display files in order from old to new.
Descending Order: Display files in order from new to old.

15 .. .. .. .. .. .. .. .. .. 04 03 02 01 00

Graph number 0

LSBMSB

Graph number 15
Graph number 1

Graph number 2
Graph number 3

1: Show
0: Hide
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Notes
Relationship Between Area and Plot Points
The V10/V9 series automatically calculates the plot point pitches for drawing graph lines as follows:

Formula: Point pitch (dots) = X size (dots) ÷ ([Points to Display] − 1)

Example: X size: 270 (dots), [Points to Display]: 10
270 ÷ (10 − 1) = 30
The plot point pitch is “30”.

Relationship between Graph Direction and X/Y Axes
The orientation of the X direction and Y direction changes depending on the setting of [Direction] in the [Contents] window.

When adjusting the size of an area after setting [Points to Display], it is automatically enlarged or reduced so 
that there will be no remainder left.
However, if the value for [Points to Display] is changed after the part is placed and adjusted in size, a remainder 
may result. The remainder dots will be shown as a blank area.

Example: X size: 278 (dots), [Points to Display]: 50
278 ÷ (50 − 1) = 5, remainder 33
The plot point pitch is 5 dots and the remainder (33 dots) becomes a blank area.

After setting the number of points for display, correct the X size of the display area to eliminate the blank area.

Graph Direction X Direction Y Direction Image
→ / ← Horizontal 

axis
Vertical 

axis

↑ / ↓ Vertical 
axis

Horizontal 
axis

A

B

C

D

E

F

X0

Y

Minimum plot point pitch: 1 dotX size

Y s
ize

Plot Point Pitch

Area

Number of display points = Maximum number of points (11)

0

Y
 

XX size

Y s
ize

Plot point pitch: 5 dots 

Blank area: 33 dots

Graph is not drawn

X

Y

X

Y

0 0
Direction: Direction:

Y

X Y

X0

0

Direction:
Direction:
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7.2.3 Data Display
• History data saved to a logging server can be displayed as numerical data or character data.

• A maximum of 16 entries of data can be displayed in a single display area.

• Backup files output to a storage device can be selected for display.

• History data saved to a logging server can be printed (log printing).

History data

07-20   16:15:43
07-20   16:15:51
07-20   16:15:52
07-20   16:21:12
07-20   16:21:54
07-20   16:21:55
07-20   17:05:02
07-20   17:06:31
07-20   18:08:01
07-20   18:08:01
07-20   19:21:30
07-20   19:22:45

80
40

290
120
190

75
200
120
280
120
115
120

300
250
360
340
360
310
310
320
380
320
360
350

07-20   16:15:43
07-20   16:15:51
07-20   16:15:52
07-20   16:21:12
07-20   16:21:54
07-20   16:21:55
07-20   17:05:02
07-20   17:06:31
07-20   18:08:01
07-20   18:08:01
07-20   19:21:30
07-20   19:22:45

No. 2
80
40

290
120
190

75
200
120
280
120
115
120

No. 1
300
250
360
340
360
310
310
320
380
320
360
350

1
2
3
4
5
6
7
8
9
10
11
12

PictBridge

Logging Data Printed result
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Location of Setting
Click [Parts] → [Trend] and place a graph on the screen.

Detailed Settings
Operation Select

Data Acquisition

Item Description
Display Mode Select [Historical Display].
Display Method Select [Data].

Item Description
No. Set the number registered to the logging server.

The registration details are shown below.
Edit Edit the logging server.

For details, refer to “ Detailed Settings” page 7-7.
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Data Setting

Item Description
Use Windows fonts Display history data using a Windows font.

Register all text to display via [Windows Font Registration].
Number of Columns Set the number of data entries to display.    Max. 16
Logging Word No. *1 Specify which word the data corresponds to in the number of logging data specified for the logging server.
Device Displays the logging device memory.

The device memory can be changed in the settings of the logging server set in the [Data Acquisition] 
settings.

Input Format Select the code type to use when reading data from the PLC device. The selection here also applies to 
[Alarm], [Operation], and [Scaling].   DEC/BCD/Actual Number *2

Data Length Set the data length.

Display Method Select the data display method. Numerical Display/Char. Display
Display Function No function

Display the logged data.

Logging No. Display
This display type is compatible with earlier MONITOUCH models.
For details, refer to the File Conversion manual.

Display Format Select the format for display on the screen.

DEC (w/o sign), DEC (with sign −), DEC (with sign +−), HEX, OCT, BIN (Binary)
Digits *3 Set the number of digits for numerical 

data display.

Decimal Point Set the number of decimal places. When no decimal point is required, set “0”.
Char. Color Set the text properties.
Back Color
Bold
Shadow
1/4
Italic
Transparent
Character Size

Code Format 1-word Display Range 2-word Display Range
DEC (w/o sign) 0 - 65535 0 - 4294967295
DEC (with sign −) −32768 - 32767 −2147483648 - 2147483647
DEC (with sign +−) −32768 - +32767 −2147483648 - +2147483647
HEX 0 - FFFF 0 - FFFFFFFF
OCT 0 - 177777 0 - 37777777777
BIN 0 - 1111111111111111 0 - 11111111111111111111111111111111

Display Format Digits Decimal Point
DEC 1 - 10 0 - 9
HEX 1 - 8 −

OCT 1 - 11 −

BIN 1 - 32 −
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*1 Example: When set to [Logging Server]→[Number of Logging Data: 8]
To display the logging data of the 3rd word in the logging server, specify “2” for [Logging Word No.].
Even if [Data Length] is different, the corresponding device memory is the same.

*2 If any value (non-numeric inclusive) specified is outside the range usable on MONITOUCH, the value cannot be displayed.

*3 Values entered that exceed the set number of digits are displayed as shown in the following table.

Style
Same as graph history display.

Zero Suppress Set the display method for numerical values that do not satisfy the specified digits condition.

Selected: Do not display zeros in front of the value
Unselected: Display zeros in front of the value

Char. Place Select either flush-left or flush-right for character display.
Text Process Set the order of the first and second bytes in words.

[Data Length]: 1-Word [Data Length]: 2-Word
Logging Word No. Logging Word No.

1st word 0 1st word
0

2nd word 1 2nd word
3rd word 2 3rd word

2
4th word 3 4th word
5th word 4 5th word

4
6th word 5 6th word
7th word 6 7th word

6
8th word 7 8th word

For details on the allowable range, refer to “5.1.4 Real Numbers (Floating Point Numbers)”.

For details, refer to “Style” page 7-20.

Item Description

Display Format DEC HEX/OCT/BIN
Display Overflow display Numbers from the right

[Data Length]: 1-Word
[Digits]: 3
Entered value: 1010

− − − 010
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Alarm/Operation

Detail

Item Description
Alarm If a value is outside the range of the maximum and minimum values, the color for display can be changed.
Operation Perform an operation on the value of the device memory.
Scaling Data (Range before Scaling) that the PLC has read is converted into the set range (Range after Scaling) that is 

set.

Item Description
Print Command Device Print the logged data. Set one word.

Print Message Specify the top number of the message registered with the layout and titles (text) for printing.
Click [Edit] to display the [Message Edit] window.
For details, refer to “Log Printing” page 7-30.

Preview Check a preview of the data for printing.
Coordinates Set the coordinates.
ID Set an ID number.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

0 → 1: Execute

Not used (always set to “0”)
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Log Printing
Overview
History data saved to a logging server can be printed.

Registering Print Messages
Location of registration
[Trend Graph] settings window → [Detail] → [Print Message]

Registration details
• The top line in the specified print message contains the title for printing.

To use two or more lines for titles, insert a one-byte “\” character at the end of the line. The next line will be recognized as 
a part of the title. Note that the “\” on the end of the line is not printed.

• On the line following the titles, specify the positions to indicate count, time, and logging data.
Use one-byte characters “C”, “T”, and “0” to “15”.

Alignment of C, T and 0 to 15 depends on the formats set for [Logging Count Display], [Logging Time Display] and [Trend] 
parts place on the screen.

• If [Zero Suppress] and [Flush Right] are selected for these parts, the values are printed with the lowest digit in alignment.
If [Zero Suppress] and [Flush Left] are selected for these parts, the values are printed with the highest digit in alignment. If 
[Zero Suppress] is not checked, the values are printed without zero suppression.

• The registered message is printed as the header at the top of each page.

For details on printing, such as printer compatibility and print setting procedures, refer to “16 Print”.

C: Sampling count print position
T: Sampling time print position
0 - 15: Print positions of data numbers 0 to 15 

Even when “C” (count) and “T” (time) are registered in the print message, the count and time are not printed if 
[Logging Count Display] and [Logging Time Display] parts are not placed on a screen.

07-20   16:15:43
07-20   16:15:51
07-20   16:15:52
07-20   16:21:12
07-20   16:21:54
07-20   16:21:55
07-20   17:05:02

80
40

290
120
190

75
200

300
250
360
340
360
310
310

07-20   16:15:43
07-20   16:15:51
07-20   16:15:52
07-20   16:21:12
07-20   16:21:54
07-20   16:21:55

No. 2
80
40

290
120
190

75

No. 1
300
250
360
340
360
310

1
2
3
4
5
6

PictBridge

Logging server Printed result

C

0

T

0

0

12345

1

12345

[Zero Suppress] checked
[Flush Left]
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Registration example

Execution Method
There are two methods for printing logging data.

• Switch function: [Logging] → [Print]

• Print Command Device

Item Description
Print Command Device Print the logged data. Set one word.

Title

Print position

[Print Message] Message GNo. 2 : No. 0
[Zero Suppress] unselected
[Flush Left]

Message GNo. 2 editing

1
2
3
4

50

06-04 13:14:20
06-04 13:34:20
06-04 13:54:20
06-04 13:74:20

06-04 15:14:20

1234
2457
1240
4563

9997

4562
2346
6548
7683

8764

 1111
 3464
 5648
 6713

 8127

  224
  456
  984
  777

  265

No. 1          No. 2         No. 3          No. 4
Logging 
count ---LINE1--- ---LINE2---

Printed result

Time

or

Switch Trend [Style]

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

0 → 1: Execute

Not used (always set to “0”)
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7.3 Real Time Display
• Values in consecutive device memory addresses can be expressed on a line graph.

Subsidiary lines can be drawn for easier recognition of data changes.

• A maximum of 16 trends (lines) can be displayed.
• Negative values can also be displayed on graphs.
• The interval between each point (point pitch) can be changed between equal pitch or an arbitrary pitch.

• Parent/child trends (overlay)
Asynchronous graphs can be displayed in the same graph area.

Refer to “7.3.1 Location of Settings” page 7-33.

Refer to “7.3.4 Display Method” page 7-43.

For details, refer to “Plot Point Pitch” page 7-39.

For details, refer to “Asynchronous Display of Multiple Trend Graphs” page 7-45.

0

D100

D101

D102 D103 D104 D105 D106 D107 D108

D109

D110 PLC

Example: Graph display of data in addresses D100 to D110

0

1

2

3

4 5

Graph origin

Pitch data

Example: When specifying the number of dots or the scale

Pitch data specified by number 
of dots or scale value

 Parent trend graph  Child trend graph

Overlaid
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7.3.1 Location of Settings
Click [Parts] → [Trend] and place a graph on the screen.

7.3.2 Detailed Settings
Operation Select

Contents

For details on the display method, refer to “7.3.4 Display Method” page 7-43.

Item Description
Display Mode Select [Real Time Display].
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Graph

Reference line

*1 When [DEC-/BCD] is selected, the setting at [System Setting] → [Hardware Setting] → [PLC Properties] → [Code] takes effect.
*2 If any specified value (non-numeric inclusive) is outside the range usable on the V10/V9 series unit, the line cannot be displayed.

Item Description
Shape Set the graph shape.   Line/Rectangular 
Direction Set the direction of graph lines.

Item Description
Reference Line Display a maximum of four horizontal reference lines on a graph.

Set the display position and color of each reference line. The line type is fixed to a dotted line.

When a device memory address (other than [Constant]) is set, reference lines are updated when the graph is 
displayed or when a “redraw” or a “redraw after clear” is commanded by the control device memory.

Min. Scale Value
Max. Scale Value

Set the scale values for calculating the position where the reference line should be drawn in the graph area. 
Negative values can also be specified.

To draw a reference line in the center of a trend graph:

Reference Line 1
- Min. Scale Value: 0
- Max. Scale Value: 2

Specifying “1” for reference line 1 will display 
a line at the center.

Data Length Set a data length when specifying device memory (other than [Constant]) for reference lines or the minimum 
and maximum scale values.
Set data length for the device memory.   1-Word/2-Word

Input Type Set the data type of the scale values.   DEC-/BCD *1/FLOAT *2

For details on the allowable range, refer to “5.1.4 Real Numbers (Floating Point Numbers)”.

Y

Y

Y

Y

X X

X X

Graph 
origin

• RGT (right) • LFT (left) • UP (upward) • DW (downward)

X: Time axis
Y: Trend data

0 X

Y

Direction: 
RGT (Reference Line 4)

(Reference Line 3)

(Reference Line 2)

(Reference Line 1)

X: Time axis
Y: Trend data

2

0

1

Reference Line

Max.

Min.
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Graph Setting

Item Description
Points to Display*1 Set the number of plot points along the horizontal axis.

- For 1024 × 768, 1024 × 600 dots: 3 to 1024
- For 800 × 600, 800 × 480 dots: 3 to 800
- 640 × 480 dots: 3 to 640

Always display A graph is displayed at all times for the number of points specified by the control device memory.
The update timing depends on the [Detail] → [Process Cycle] setting.

Control Device

* When the [Always display] checkbox is selected, the redraw and redraw after clear bits are invalid.

Points to display *1: 0 to 1024

Set the number of points to display.
The content of the device memory addresses set for numbers 0 to 15 is read for the specified number of 
points.

Redraw *2

The number of points to display are redrawn.   0 → 1
Drawing is performed over the previous graph without clearing the graph area. The previously displayed 
image remains.

Redraw after clear *2

The number of points to display are redrawn.   0 → 1
Drawing is performed after clearing the graph area. Only the latest graph is displayed.

Plot Point Pitch Equal pitch
Space all points equally.

Specify the scale range
Specify the interval between points using the scale range.

Specify the number of dots
Specify the interval between points with the number of dots.

For details, refer to “7.3.3 Plot Point Pitch” page 7-39.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0

Points to display0 → 1: Redraw *

0 → 1: Redraw after clear *
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*1 Number of display points

*2 “Redraw” and “redraw after clear”
When redrawing, select the “Redraw” or “Redraw after clear” bit.
If the interval between redrawing is too short, the graph may not be redrawn even at the leading edge.
Once displayed, data on the graph cannot be changed unless the redrawing command is given.

*3 When [DEC-/BCD] is selected, the setting for [System Setting] → [Hardware Setting] → [PLC Properties] → [Code] → [DEC/BCD] takes 
effect.

*4 If any value (non-numeric inclusive) specified is outside the range usable on MONITOUCH, the value cannot be displayed.

*5 Max., Min., Max. Scale, Min. Scale
Do not specify the same value for both maximum and minimum values. Doing so will result in an error when transferring data to the unit. 
Make sure to set valid values.

*6 When minimum and maximum values are set with a device memory address (other than [Constant]), these values are updated when the 
graph is displayed or when a “redraw” or a “redraw after clear” is commanded by the control device memory.

Detailed 
Settings

Number of Graphs Set the number of graph lines. Max. 16
Device The contents of this device memory address is read and displayed on the graph. The required number of 

addresses varies depending on the setting for [Points to Display] and [Data Length].
For details, refer to “7.3.3 Plot Point Pitch” page 7-39.

Use Range Point pitch: when specified with the number of dots
Input Format Set data format of device memory values.   DEC- / BCD *3 / Actual Number *4

The selection here also applies to minimum, maximum, and X axis scale values.
Data Length Select the data length for one plot point.   1-Word/2-Word
Min. *5 Set the graph display area. (PLC device memory *6 / internal device memory *6 / constant)
Max. *5

Min. Scale *5 Set when [Graph Setting] → [Plot Point Pitch] is set to [Specify the scale range].
For details, refer to “7.3.3 Plot Point Pitch” page 7-39.

Max. Scale *5

Display Format Set the graph type (line or marker) and color.
Type
Color

Item to Display Change the items displayed in the [Detail Settings] area.

If a value larger than the X size (dots) of the graph area is specified for [Points to Display], the graph will not be 
drawn correctly.

For details on the allowable range, refer to “5.1.4 Real Numbers (Floating Point Numbers)”.

Item Description

Number of display points = Maximum number of points (11)

Plot Point Pitch

Number of plotted points: 6Direction: RGT

Graph origin

Graph area
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Style

Scale Display

Item Description
Adjust Position Adjust the placement position.
Select from catalogs Change parts.
Make display area 
transparent

Make the display area transparent.

Item Description
Axis Color Select the color of the major and minor tick marks, and axis lines of the scale.

This setting is common to all left, right, bottom, and top sides.Back Color
Display Minor scale Set the length of the minor tick marks of the scale. Range: 1 to 16

This setting is common to all left, right, bottom, and top sides. The thickness of the markings is fixed.
[Scale] in [Left], [Right], 
[Bottom], and [Top] tab 
windows

Displays the scale, grid line, and reference value settings for each side. Default: Selected on [Left] and 
[Bottom] tab windows

Small scale alignment Equal divide (unit based on [No. of divisions])
Minor tick marks are equally spaced according to the specified number of divisions along the axis line.

Equal interval (unit based on [Interval])
Minor tick marks are equally spaced according to the specified interval from the zero point along the axis 
line within the following range.

Graph Direction Side Range
LFT/RGT Top/Bottom Number of horizontal axis points or scale of 

[Range Setting]UP/DW Left/Right
LFT/RGT Left/Right Scale of [Range Setting]
UP/DW Top/Bottom
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*1 If [Plot Point Pitch] is set to [Specify the scale range], use the minimum and maximum scale values.
*2 If the minimum and maximum values are specified with device memory addresses (other than [Constant]) in the [Range Setting] window 

and these values are changed in RUN mode, the changes are updated at the following timings:
- When the screen is redrawn
- The bit for “redraw” or “redraw after clear” in the control device memory is set to ON.

Detail

*1 This setting is invalid if the [Always display] checkbox is selected.

Display major tick marks Display major tick marks on the scale. (Unit: [Interval]) Length: Twice the minor tick marks  Thickness: Fixed
Grid Line Grid lines are drawn at the major and minor tick marks of the scale.

Color, Line Type Set the color and line type of grid lines.
Also apply to minor 
tick marks

This can be set when the [Display major tick marks] checkbox is selected. Set whether to display grid lines.
Selected: Display at both major and minor tick marks
Unselected: Only display at major tick marks

Reference Value Select this checkbox to display reference values at major and minor tick marks on the scale.
Style Setting Set the number of digits or the color of reference values shown at tick marks.
Also apply to minor 
tick marks

This can be set when the [Display major tick marks] checkbox is selected. Set whether to display reference 
values.

Selected: Display at both major and minor tick marks
Unselected: Only display at major tick marks

Range Setting Use when [Small scale alignment] is set to [Equal divide] or when the [Reference Value] checkbox is selected.

Match with the specified graph
The range changes according to the following combinations.

Set Value
Specify the minimum and maximum values using constants or devices. *2

Item Description
Coordinates Set a display position and size.
Process Cycle Set the cycle used to read the device memory. High Speed, Low Speed, Refresh
Overlap Select this checkbox to display multiple graphs asynchronously or 17 or more lines in one graph area.

For details, refer to “7.3.5 Asynchronous Display of Multiple Trend Graphs” page 7-45.
Use the background 
operation function *1

Update graphs in the background when other screens are displayed.
For details, refer to “7.3.6 Background Update” page 7-48.

ID Set an ID number.

Item Description

Graph Direction Side Range
LFT/RGT Top/Bottom Number of X-axis data points *1

UP/DW Left/Right
LFT/RGT Left/Right Minimum and maximum values specified 

for the selected graph number *2UP/DW Top/Bottom
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7.3.3 Plot Point Pitch
Select whether to place plot points along the X-axis of graphs at equal pitches (intervals) or at variable pitches.

Location of setting: [Graph Setting] → [Plot Point Pitch]
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Type
Equal pitch
Plot points are automatically set at an equal pitch. MONITOUCH calculates a pitch between plot points as shown below.
(MONITOUCH adjusts the data so that no remainder will result.)

Formula: Point pitch (dots) = X size of graph (dots) ÷ ([Points to Display] - 1)

Specify the number of dots
Pitch data (distance from the graph origin to each plot point) can be specified in units of dots.

Specify the scale range
Pitch data (distance from the graph origin to each plot point) can be specified using a scale value. The scale value is specified 
as the range in the [Graph Setting] settings. ([Max. Scale], [Min. Scale])

For details on device memory allocation, refer to “Equal pitch” page 7-41.

For details on device memory allocation, refer to “Specify the scale range, specify the number of dots” 
page 7-42.

For details on device memory allocation, refer to “Specify the scale range, specify the number of dots” 
page 7-42.

A

B

C

D

E

F

Plot point pitch: 30 dots

X size: 300 dots

Graph origin: 0

A

B

C

D

E

Graph origin: 0 30 dots

X size: 300 dots

60 dots
120 dots

210 dots
300 dots

A

B

C

D

E

Graph origin: 0 1

X size: 300 dots

2
4

7
10

[Specify the scale range]
• [Min. Scale]: 0
• [Max. Scale]: 10
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Device Memory Allocation
The allocation of device memory addresses differs depending on the [Points to Display] setting and the data length of each 
graph.

Equal pitch
Point data is stored consecutively from the set device memory address.

For example, allocation is performed as follows when 11 points are plotted on the X-axis and [Device] is D100.
• If the data length is 1 word, devices D100 to D110 are used.
• If the data length is 2 words, devices D100 to D121 are used.

Device memory address setting: n

Data length: word
n + 0 Point 0 data
n + 1 Point 1 data
n + 2 Point 2 data
n + 3 Point 3 data
n + 4 Point 4 data
n + 5 Point 5 data

:
:
:

n + m Point “m” data

Data length: double word
n + 0 Point 0 datan + 1
n + 2 Point 1 datan + 3
n + 4 Point 2 datan + 5

:
:
:
:
:

n + m Point “m” data

Device memory address setting: D100

Data length: word
D100 Point 0 data
D101 Point 1 data
D102 Point 2 data
D103 Point 3 data
D104 Point 4 data
D105 Point 5 data

:
:
:

D110 Point 10 data

Data length: double word
D100 Point 0 dataD101
D102 Point 1 dataD103
D104 Point 2 dataD105

:
:
:
:
:

D120 Point 10 dataD121
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Specify the scale range, specify the number of dots
Point data and pitch data (dot or scale value) from the set device memory address are stored one after the other.
A device for pitch data is allocated following the device memory for each point.

For example, allocation is performed as follows when 11 points are plotted on the X-axis and [Device] is D100.
• If the data length is 1 word, device memory addresses D100 to D121 are used.
• If the data length is 2 words, device memory addresses D100 to D141 are used.

Device memory address setting: n
Data length: word

n + 0 Point 0 data
n + 1 Point 0 pitch data
n + 2 Point 1 data
n + 3 Point 1 pitch data
n + 4 Point 2 data
n + 5 Point 2 pitch data

:
:

n + m Point “m” data
Point “m” pitch data

Data length: double word
n + 0 Point 0 datan + 1
n + 2 Point 0 pitch datan + 3
n + 4 Point 1 datan + 5
n + 6 Point 1 pitch datan + 7

:
:
:
:

n + m Point “m” data
Point “m” pitch data

Device memory address setting: D100
Data length: word

D100 Point 0 data
D101 Point 0 pitch data
D102 Point 1 data
D103 Point 1 pitch data
D104 Point 2 data
D105 Point 2 pitch data

:
:

D120 Point “m” data
D121 Point “m” pitch data

Data length: double word
D100 Point 0 dataD101
D102 Point 0 pitch dataD103
D104 Point 1 dataD105
D106 Point 1 pitch dataD107

:
:
:
:

D140 Point 10 data
D141 Point 10 pitch data
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7.3.4 Display Method
The display method differs depending on whether the [Graph Setting] → [Always display] checkbox is selected or not.

When [Always display] Checkbox is Selected
1. Check the graph control device memory. (Example: D1000)

Location of setting: [Trend Graph] settings window → [Graph Setting] → [Control Device]

2. Set the control device memory to “90”. (Points to Display)
Graphs are displayed with 90 points. Next, set the control device memory to “11” to display graphs with 11 points.

* The update timing depends on the [Detail] → [Process Cycle] setting. For details on the processing cycle, refer to “1.2 Process Cycle” page 
1-40.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0

0 to 1024: Points to Display
System reserved

D1000 = 90   90 points displayed D1000 = 11   11 points displayed
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When [Always display] Checkbox is Not Selected
1. Check the graph control device (e.g. D1000).

Location of setting: [Trend Graph] settings window → [Graph Setting] → [Control Device]

2. Set the control device to “11” (number of plotted points).

3. Change “redraw after clear” (bit 15) or “redraw” (bit 14) of the control device memory from 0 to 1.
• Redraw after clear (bit 15)

The previous graphs are cleared before displaying the latest graph.

• Redraw (bit 14)
The previous graphs are not cleared and the latest graph is displayed.

This completes the necessary settings.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0

0 to 1024: Points to Display0 → 1: Redraw

0 → 1: Redraw after clear

0

20

40

60

80

100

The graphs are 
displayed with the 11 
most recent points.

0

20

40

60

80

100

The latest graph with 
the 11 most recent 
points is displayed 
over the previous 
graph.
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7.3.5 Asynchronous Display of Multiple Trend Graphs
All the trend lines in the graph area are drawn at the same points and at the same timing because trend graphs have one 
word of control device memory. To draw multiple trend lines at different timings, two or more graphs must be overlaid and 
linked, thereby assigning priorities to respective control device memory.

Setting Procedure
This section explains drawing multiple graphs with an example of displaying two trend graphs asynchronously.

1. Place two trend graphs.

2. Set D120 to [Graph Setting] → [Control Device] in the [Trend] settings window.

3. Set “High Speed” for [Detail] → [Process Cycle] and “0” for [ID] (parent trend graph).

Refer to “7.3.1 Location of Settings” page 7-33.

Overlaying graphs

 Parent trend graph  Child trend graph
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4. In the [Trend] settings window of the other graph, set D140 to [Graph Setting] → [Control Device].

5. Set “High Speed” for [Detail] → [Process Cycle] and “0” for [Overlap] (child trend graph).

6. Place the parent trend graph under the child trend graph to overlap the two graphs.

This completes the necessary settings.
The graphs are drawn using the D120 control device memory (parent trend graph).

For details on display, refer to “7.3.4 Display Method” page 7-43.
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Display Method
This section explains how to draw two trend graphs based on the example in “Setting Procedure” page 7-45.

1. Set D120 to 9H (number of plotted points).

2. Set D140 to 9H (number of plotted points).

3. Set the D140 to 5H (number of plotted points) and set D120 to 8007H (“redraw after clear” and number of plotted points).

Notes on Setting
• When linking two or more trend graphs, regard one trend graph as a “parent” and the other trend graph as a “child.”

Select the [Detail] → [Overlap] checkbox for the child trend graph and set the ID of the parent trend graph.
Both the “redraw” and “redraw after clear” commands issued at the child trend graph are ignored and only the commands 
from the control device memory of the parent trend graph are accepted.

• Set [Process Cycle] to “High Speed” for all the trend graphs that are linked.
• Only the area property settings of the parent trend graph are available. The area property settings of the child trend 

graph are not displayed.
In addition, the reference lines set for the child trend graph area ignored.

• Place the child trend graph over the parent trend graph using the [Bring to Top] or [Send to Bottom] icon. If the parent 
trend graph is placed over the child trend graph, these two graphs will not be linked correctly.

• When the parent trend graph is set to be always displayed, both the parent and child trend graphs are displayed at all 
times.

The parent trend graph is drawn 
with up to 9 plot points.

The child trend graph is drawn with 
up to 9 plot points.

Change the number of plotted points to 5 
points in the child trend graph and send the 
“change” and “redraw after clear” commands 
from the parent trend graph at the same 
time.
The 5 points of the child trend graph are 
drawn for the first time.

Area property: Blue
(parent trend graph)

When the graphs are overlaid, the graph 
area is displayed in blue.

Area property: Light blue
(child trend graph)
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7.3.6 Background Update
Graphs can be updated even when displaying screens that do not contain trend graph parts.

Display example: [Number of Graphs]: 1
[Points to Display]: 9
[Control Device]: D100 (redraw command bit: 14th bit)

(1) Display graph on screen 1

D100 = 9H
(9 point display)

(2) Redraw graph on screen 1

D100 = 4009H
(Redraw 9 point)

(3) Display screen 10
Graph redraw command

D100 = 4009H
(Redraw 9 point)

Only update the latest state 
(latest single graph line only)

Display the graph updated by the command in 
step 2 (three graph lines)

* Previous graph lines remain until the redraw 
clear bit is turned ON.

Screen 1

Screen 1

Screen 10

Screen 1 Screen 1

(4) Display screen 1

• [Use the background operation function] 
checkbox unselected

• [Use the background operation function] 
checkbox selected
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Location of Settings
[Detail] → [Use the background operation function]

Notes on Setting
• The maximum number of trend parts using the background operation function that can be placed in one screen is 256.
• This function cannot be used with component parts.
• This setting is invalid if the [Always display] checkbox is selected.
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8.1 Overview
• Alarm server

The states of devices registered to an alarm server can be saved as alarm history. History data can be output to a CSV file 
on a storage device by turning the relevant bit ON for checking on a PC.

• Alarm parts
Placing alarm parts on the screen allows history data saved on an alarm server to be displayed in conjunction with certain 
times and messages. There are three alarm types to alarm parts.
- Alarm history

Alarm occurrence, reset, and acknowledged times are displayed on one line. The state of each alarm can be checked at 
a glance.

- Event history
Alarm occurrence, reset, and acknowledged times are each displayed on one line.

“Alarm Server” page 8-7

Alarm server

Block No. 0
Alarm history
Real time

Block No. 1
Event history

:

Temperature rise of 
Tank-A 
Lack of materials
Worker change
Abnormality of conveyor 
A-Line

05/10 08:12:40
05/10 15:15:43
05/10 17:00:00
05/10 19:59:15

05/10 08:15:30
05/10 15:30:25
**************
**************

05/10 09:30:40
**************
05/10 17:05:00
**************

Message Occurrence time Acknowledged time Reset timeTitle display

Temperature rise of 
Tank-A 
Temperature rise of 
Tank-A 
Temperature rise of 
Tank-A 
Lack of materials
Lack of materials
Worker change
Worker change
Abnormality of conveyor 
A-Line

Occurrence
Acknowledge
Cancel
Occurrence
Cancel
Occurrence
Cancel
Occurrence

05/10 08:12:40
05/10 08:15:30
05/10 08:15:40
05/10 15:15:43
05/10 15:30:25
05/10 17:00:00
05/10 17:05:00
05/10 19:59:15

Serious fault
Serious fault
Serious fault
Serious fault
Cancel
Minor fault
Minor fault
Serious fault

Message Event Name Time Group NameTitle display
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- Real time display
This screen will only display alarms that are currently occurring. Alarms that require resetting can be checked at a 
glance.

• Action when alarms occur
Six actions can be set to occur according to the alarm that occurred.
1) Scrolling messages

When an alarm occurs, an alarm message is automatically displayed at the bottom (or top) of the screen.
Displaying the scroll tool allows the display position to be changed or automatic scrolling to be paused.
Scrolling messages are displayed continually until the error is reset even if the screen is changed.

2) Audio playback
An audio file can be played when an alarm occurs. (V907xiW and V9 Lite model not supported)

“Scrolling Messages” page 8-21

“Playing Sounds” page 8-23

Lack of materials
Abnormality of conveyor 
A-Line

05/10 15:15:43
05/10 19:59:15

Serious fault
Serious fault

Message Occurrence time Group NameTitle display

08:12:40 Temperature rise of Tank-A 05/10 15:15:43 Material

Bottom Top

05/10 08:12:40 Temperature rise of Tank-A 

05/10 08:12:40 Temperature rise of Tank-A 

Scroll tool display

Paused

Monitor Screen Monitor Screen
Scrolling messages

08:12:40 Temperature rise of Tank-A 05/10 15:15:43 Material

A line A error 
occurred.Alarm bit

M100 = ON
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3) E-Mail
Send an e-mail when an alarm occurs or is reset. When using a multi-language screen, e-mails are sent in all 
languages.
A file can be attached to e-mail notifications.

4) Recording
Video can be saved to a video file (extension: .mp4) upon alarm occurrence and reset.
Use of the event recording function also allows video immediately before an alarm occurrence and reset to be saved, 
which facilitates cause analysis.

5) Operation Setting
Operations including output to a specified device memory address, display changeover, and macro execution can be 
performed when an alarm occurs.

“E-mail Notification” page 8-24

  Video Recording (Event Recording Function) page 8-25 

“Operation Setting” page 8-27

LAN

E-mail

Error

2014/04/10 18:55:04 <ON>
Apr/10/2014 18:55:04 <ON>
2014/04/10 18:55:04 <ON>
2014/04/10 18:55:04 <ON>
2014/04/10 18:55:04 <ON>

E-mail notification main body

* The mail server must reside on the network.

Mail server

EXT0000
ALARM

ALARM00_001_A_20190415113025.mp4
ALARM00_001_R_20190415114253.mp4

Error

0 2030
sec

0 2020

201904
20190415

sec

Error bit

Occurrence

Event recording function

USB

Reset

40 seconds before 
and after reset

Continuous recording

Video file saving 50 seconds before
and after occurrence

Alarm bit
M100 = ON

Monitor Screen Error 
occurrence!

Reset the error.

Screen changeover
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6) Parameter display
When an alarm occurs, the data (parameters) associated with the alarm can be saved/displayed together with an 
alarm message. Logging the history of such alarm-relevant parameters will make it easier to locate and investigate 
the causes of alarms.

7) Touch action
The screen can be changed by tapping the message on the alarm part.
More detailed alarm information can be displayed.

• Alarm part display/operation
- Title display/operation

A title can be added to each item in alarm parts.

“Parameters” page 8-29

“Touch Action” page 8-31

Touch!!

YAMADA SATO

MJ1

65.0

A B

Thermal error Material shortage
Worker change

Alarm bit ON
Temperature rise of Tank-A 65°C
Lack of materials 80 g
Worker change  Worker: Yamada → Sato
Abnormality of conveyor A-Line

14/05/10 08:12:40
14/05/10 15:15:43
14/05/10 17:00:00
14/05/10 19:59:15

Temperature rise of Tank-A 
Lack of materials
Abnormality of conveyor 
A-Line

Error Display

Insufficient materials.

Replenish xxxxx of yyy.

Error DetailsDisplay error details

Temperature rise of 
Tank-A 
Lack of materials
Worker change
Abnormality of conveyor 
A-Line

05/10 08:12:40
05/10 15:15:43
05/10 17:00:00
05/10 19:59:15

05/10 08:15:30
05/10 15:30:25
**************
**************

05/10 09:30:40
**************
05/10 17:05:00
**************

Message Occurrence time Acknowledged time Reset timeTitle display
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- Scrolling function
If the area width is insufficient to display all items, the screen can be scrolled by touch operation.

- Backup file display
Use the [File] switch to redisplay backup files (BIN) output to a storage device.

05/10 08:12:40
05/10 15:15:43
05/10 17:00:00
05/10 19:59:15

05/10 08:15:30
05/10 15:30:25
**************
**************

05/10 09:30:40
**************
05/10 17:05:00
**************

Occurrence time Acknowledged time Reset time
Serious fault
Serious fault
Serious fault
Serious fault

Group Name

Scroll

Temperature rise of 
Tank-A 
Lack of materials
Worker change
Abnormality of conveyor 
A-Line

05/10 08:12:40
05/10 15:15:43
05/10 17:00:00
05/10 19:59:15

05/10 08:15:30
05/10 15:30:25
**************
**************

05/10 09:30:40
**************
05/10 17:05:00
**************

Message Occurrence time Acknowledged time Reset time

Temperature rise of Tank-A 
Temperature rise of Tank-B
Temperature rise of Tank-C
Lack of materials
Lack of materials
Worker change
Abnormality of conveyor A-Line
Abnormality of conveyor B-Line
Worker change
Lack of materials
Worker change

03/01 07:50:40
03/01 07:50:43
03/01 07:50:50
03/01 12:05:10
03/01 15:15:25
03/02 17:00:00
03/02 19:59:15
03/02 21:18:00
03/02 22:00:00
03/02 22:03:15
03/03 05:00:00

03/01 08:15:30
03/01 08:15:30
03/01 08:15:30
03/01 12:10:35
03/01 15:30:25
**************
**************
**************
**************
**************
**************

03/01 08:15:30
03/01 08:15:30
03/01 08:15:30
03/01 12:10:35
03/01 15:30:25
03/02 17:00:02
03/02 21:20:02
03/02 21:20:02
03/02 22:10:02
03/02 22:10:02
03/03 05:00:10

Message Occurrence time Acknowledged time Reset time
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- Filter display
Use the [Filter] switch to select display in groups or display according to state (Occurrence, Reset, Check, Normal).

Example: Changing from display of all items to only occurring and acknowledged items.

Lack of materials
Abnormality of conveyor 
A-Line

05/10 15:15:43
05/10 19:59:15

Message Occurrence time
05/10 15:30:25
**************

**************
**************

Acknowledged time Reset time

Temperature rise of 
Tank-A 
Lack of materials
Worker change
Abnormality of conveyor 
A-Line

05/10 08:12:40
05/10 15:15:43
05/10 17:00:00
05/10 19:59:15

Message Occurrence time
05/10 08:15:30
05/10 15:30:25
**************
**************

05/10 09:30:40
**************
05/10 17:05:00
**************

Acknowledged time Reset time

Display all items

Displaying occurring and acknowledged items
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8.2 Alarm Server
8.2.1 Alarm Server

The area that stores the alarm history is referred to as an alarm server.
Set an alarm server via [System Setting] → [Alarm Server] or [View] → [Project] → [Project View] window.

Item Description
Alarm block list A list of registered alarm blocks is displayed.

Alarm block numbers 0 to 11 (total of 12) can be registered.

Screen program converted from V8 to V10/V9 is displayed as V8 compatible.
Add Add an alarm block.
Delete Delete an alarm block.
Copy The following dialog box is displayed.

Paste The following dialog box is displayed.
The content copied using the [Copy] button is pasted to the specified number.

or

Alarm block list

Alarm block settings

Item Description
Copy source The specified block is copied.
Copy and paste 
simultaneously

When selected, copying and pasting are done simultaneously.
The paste destination is specified at [Destination].

* Be sure to deselect this checkbox when copying and pasting to a 
different file.

Destination This setting is valid when [Copy and paste simultaneously] is selected.
Specify the block number of the destination for pasting the copied 
content.
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*1 Alarm blocks can also be configured from the [Monitoring Alarm] settings in the alarm part settings window.

Alarm block settings *1 Perform detailed configuration of the alarm block selected in the alarm block list.
Refer to“8.2.2 Alarm Block Settings” page 8-9

Item Description
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8.2.2 Alarm Block Settings
Alarm Device
Register alarm device memory and configure error conditions.

Item Description
Number of Monitoring Alarms Register a monitoring alarm using the [Add], [Insert], [Delete], [Delete All], and [Set Selected] 

buttons.
The number of registered alarms is displayed.

1 - 16384
Add Add an alarm device memory to the bottom of the list.

A device memory address is automatically allocated by adding “1” to the device memory address in 
the last row on the list.

Insert Insert an alarm device memory under the selected row.
A device memory address is automatically allocated by adding “1” to the device memory address in 
the selected row.

Delete Delete the selected alarm device memory.
Delete All Delete all registered alarm device memory.
Set Selected *1 Batch copy the settings of the selected cell to other cells.

Import*2 Import all alarm device memory settings from a CSV file.

Export*2 Export all alarm device memory settings to a CSV file.
Monitoring Intervals Set the monitoring frequency of the alarm device memory.

0: Every cycle
100 msec - 65535 sec

Record 
Parameters

Copy*3 Copy the parameters set for alarm device memory addresses.

Paste*3 The parameters copied using the [Copy] button are pasted to the specified alarm number.
Device Set the alarm device memory

Item Settings
Device Automatic device memory address increment
Error Condition Batch copy
Group
Message Automatic message number increment
Alarm types Alarm history

Event history
Real time

Batch copy

Actions Scrolling messages
Sound
E-Mail
Operation Setting
Parameters
Touch action
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*1 Batch setting of devices
1) Select a cell to set a device memory address.
2) With the cell in the selected state (highlighted in blue), click [Set Selected]. The [Set Selected] window is displayed.

Error Condition Set the error conditions of the device memory
Edge ON Bit OFF → ON: Error occurrence

Bit ON → OFF: Error reset
Edge OFF Bit ON → OFF: Error occurrence

Bit OFF → ON: Error reset
Range Designation Set the comparison condition expression for the value of the device memory address.

Data length: Set the data length of the condition value.
1-Word/2-Word

Constant Set the format of the comparison condition expression.
DEC+−/DEC/BCD

Group No.0 - 15 Set which alarm group the alarm device memory belongs to.
For details on alarm groups, refer to page 8-13.

Message Register an alarm message.
GNo.0 - 127
No.0 - 255

Set the group number and line number to which an alarm message is to be registered.
Display the [Message Edit] window by clicking the [Edit] button.

Message Lines Set the number of lines of the alarm message.
Alarm types Set the history type. Multiple types can be selected.

Match the [Display Mode] of alarm items when alarm messages are to be checked on MONITOUCH.

* When none are selected, the alarm is disabled even if [Error Condition] is satisfied. In this case, 
no history is recorded. This is useful when registering a device memory for future use.

Alarm History Alarm occurrence, reset, and acknowledged times are all displayed on one line.
The state of each alarm can be checked at a glance.

Event History Alarm occurrence, reset, and acknowledged*4 times are each displayed on one line.
Real Time This screen will only display alarms that are currently occurring. Alarms that require resetting can be 

checked at a glance.
Actions Set the action to perform when an alarm occurs.

Flowing Message An alarm message is automatically displayed at the bottom (or top) of the screen.
It is displayed continually until the error is reset even if the screen is changed.
Refer to page 8-21

Sound Play back an audio file. Refer to page 8-23.
E-Mail Send an e-mail. Refer to page 8-24.
Recording Record video before and after alarm occurrence and before and after alarm reset. Refer to

page 8-25.
Operation Setting Perform operations including writing to the specified device memory address (output setting), 

screen changeover / overlap control (function), and macro execution (macro). Refer to page 8-27.
Parameter When an alarm occurs, the data (parameters) associated with the alarm can be saved/displayed 

together with an alarm message. Refer to page 8-29.
Touch Action Change the screen by touching the alarm message.

The [Enable the touch-action function] checkbox must be selected at [Detail] → [Auxiliary Function] 
in the alarm part settings window. Refer to page 8-31.

Display Language Change the display language when using multi-language screens.
Display Page Each page displays 512 monitoring alarms.

Item Description



8.2    Alarm Server

8-11

1

2

3

4

5

6

7

8

9

10

3) Select the alarm range for batch setting and click [Run]. A confirmation message is displayed.

4) Check that the setting range is correct and click [Yes]. The device memory addresses of the specified range are 
changed.

*2 Importing and exporting alarm device memory settings
Settings such as device memory addresses, error conditions, and message numbers can be exported to a CSV file and 
also imported from a CSV file.

Example of CSV file output

Item Settings Remarks
Device Alarm device memory addresses

Setting examples
Internal device memory $u00100
PLC device memory (Fuji Electric SX (F mode) M10000 specified)
1:1 connection: PLCx[Mzz.000010000]

(x = PLC No., zz = CPU No.)
1:n connection: PLCx[yyy:Mzz.000010000]

(x = PLC No., yyy = Port No., zz = CPU No.)
Temperature control device memory (device memory of a Fuji 
Electric inverter specified)
1:1 connection: PLCx[#401799-00] (x = PLC No.)
1:n connection: PLCx[yyy:#401799-00] (x = PLC No., yyy = Port No.)

The “zz.” in the setting example of a Fuji 
Electric PLC device memory can be omitted if 
the CPU No. is “0”.

Error Condition Error conditions (Edge ON / Edge OFF / Range designation)
Setting value: Edge ON / Edge OFF / 1word / 2word

Constant Display
Type

Display type    Setting value: DEC+− / DEC / BCD This is used when the error condition is 
“1word” or “2word” (range designation).

Range Designation
(columns D to H)

Range settings
Column D: Constant or device memory
Column E: Condition expression
Column F: Constant or device memory
Column G: Condition expression
Column H: Constant or device memory

This is used when the error condition is 
“1word” or “2word” (range designation).

Group Specifies the alarm group.    Setting value: 0 to 15
Message Specifies the message number as an absolute address.

Setting value: 0 to 32767
Message Lines Specifies the number of lines of a message to display.

Setting value: 1 to 24

Header information: Do not change these items. If changed, settings cannot be imported.

Column 
D

Column 
E

Column 
F

Column 
G

Column 
H
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*1 Only specifies whether the function is used or not. Check and configure other detailed settings using V-SFT.
*2 Importing is possible only when the destination alarm is set to use parameters and “Enable” is specified.

*3 Copying and pasting parameters
1) Click the [Copy] button. The [Copy parameters] menu is displayed.

Set the copy range and click [OK].

2) Click the [Paste] button. The [Paste parameters] menu is displayed.
Set the paste range and click [OK].

3) The parameters are copied.

*4 When acknowledged time is used, check [Alarm History] or [Real Time] for the Alarm types.

Alarm History Specifies whether or not to use the alarm history function.
Setting value: ON / OFF

Event History Specifies whether or not to use the event history function.
Setting value: ON / OFF

Real Time Specifies whether or not to use the real time alarm function.
Setting value: ON / OFF

Flowing Message Specifies whether or not to use scrolling messages.
Setting value: Enable / None

*1

Sound Specifies whether or not to use audio output.
Setting value: Enable / None

*1

E-Mail Specifies whether or not to use E-mails.
Setting value: Enable / None

*1

Recording Specifies whether or not to use the video capture function.
Setting value: Enable / None

*1

Operation Setting Specifies whether or not to use operation settings.
Setting value: Enable / None

*1

Parameter Specifies whether or not to use parameters.
Setting value: Enable / None

*1, *2

Touch Action Specifies whether or not to use the touch action function.
Setting value: Enable / None

*1

Item Settings Remarks

The copied content is pasted to the specified 
number.

Pasting is repeated for the set number of times 
starting from number 0.
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Alarm Group
Set the color of alarm messages. Because up to 16 groups can be created, the color can be changed according to the severity 
of alarms.

Item Description
Alarm Group Create groups with the [Add] button.

0 - 15
Add Add a group.
Delete Delete a group.

There must be at least one group at all times. If all groups are deleted by the [Delete] or 
[Delete All] button, a new group is automatically created as No. 0.

Group settings Set the name and color of each group.
Specify Group Name Unselected

GROUPxx (xx: 00 to 15) is set automatically.

Selected
GNo. / No.
Register the group name in the message editor.
Display the [Message Edit] window by clicking the [Edit] button.

Color to Display Set the text color and background color of each alarm state.

Occurrence: Alarm occurring, unacknowledged
Cancellation: Alarm reset, unacknowledged
Acknowledgment: Alarm occurring, acknowledged
Normal: Alarm reset, acknowledged

Display Language When specifying a group name on a multi-language screen, group titles can be displayed 
according to the display language.
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Data Output Setting

Item Description
Internal Storage Setting Configure the settings for history stored in SRAM.

Number of Data to Save Set the number of alarms to save.
Occurrence, cancellation, and acknowledgment each count as one alarm entry.

1 - 65535
After Full Capacity Set the operation to perform when the value of [Number of Data to Save] is exceeded.

Clear old data and continue monitoring
Stop Monitoring

SRAM/Clock Setting Display the [SRAM/Clock Setting] window. The amount of free space and total used space in 
SRAM can be checked.

Detail 
Settings

Device Type Set the save destination.
SRAM: History is retained even when power is turned OFF or when switched to Local mode.
DRAM: All history is cleared when power is turned OFF or the screen is changed to local 

mode.
Memorize initial 
value

In the state where an alarm is occurring, set the operation to perform when power to the unit is 
turned ON or when switched from Local mode to RUN mode.

Selected
The error occurrence is not logged again because the latest state of the bit is recorded.
If the alarm is reset when power to the unit is turned OFF or while Local mode is displayed, the 
time that the V10/V9 series unit switches to RUN mode is saved as the reset time.

Unselected
The error occurrence is logged again. The time that RUN mode starts is saved as the time of 
occurrence.
The reset time of any alarms that were occurring is displayed as “-----”.

Specify the 
number of 
real-time alarms 
to display

Real time display
Set the number of errors to display when multiple errors occur at the same time.

Example: When the maximum display number is set to 50
If error number 51 occurs, only 50 error messages are displayed.

Storage Output Settings Output data saved in the internal storage settings to the storage device.

Output destination
(output drive)\access folder\ALARM folder

Filename (xx: block No.)
Alarm history: ALARMxx.BIN (ALARMxx.BIN-journal *1)
Event history: EVENTxx.BIN (EVENTxx.BIN-journal *1)

Output timing
• When the internal storage settings become full
• When the mode is switched from RUN to STOP
• When the [Storage Removal] switch is pressed
• At power-on (only when SRAM is selected)
• When a reset is performed (reset switch/reset bit ON)
• When the SAMPLE macro (V8 compatible) is executed

EXT0000

ALARM00.BIN (ALARM00.BIN-journal)

ALARM
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*1 Temporary file created during data update. This file is created temporarily only when the [System Setting] → [Unit Setting] → [General 
Setting] → [Output alarm data in binary format] checkbox is unselected. (V9 only)

*2 Match with the setting of [System Setting] → [Storage Setting] → [Storage Connection Target].
*3 If you do not want to create a backup folder, [Do not output backup files] can be selected on the [Others] tab.
*4 Refers to the operation of a switch for which [Function] is set to [Storage Removal] or [Storage Removal] on the system menu.

Number of Data to Save Set the amount of data to save to the storage device.
Occurrence, reset, and acknowledgement are each counted as a single data entry.
If this setting is not configured, a BIN file is not created in the ALARM folder.
SRAM history data is output to the backup folder.

Drive for Output Set the output destination for the ALARMxx.BIN/EVENTxx.BIN files.
Storage Setting *2
C: Built-in Socket
D: USB-A Port

CSV/Backup Setting Output a CSV file and backup file (BIN/CSV) to the storage device. *3

CSV output
Output destination

(output drive)\access folder\ALARM

CSV Filename
Set at [Format Setting] → [CSV Format Setting] → [File Name].
ALARM_00_00.CSV (default)

Backup file output
Output destination

(output drive)\access folder\ALARM\year/month folder\year/month/day folder

BIN filename (xx: block No.)
Alarm history: ALARMxx_yyyymmddhhmmss.BIN
Event history: EVENTxx_yyyymmddhhmmss.BIN

CSV Filename
Set at [Format Setting] → [CSV Format Setting] → [File Name].
ALARM_00_00_yyyymmddhhmmss.CSV (default)

Drive for Output Set the output destination.
Storage Setting *2
C: Built-in Socket
D: USB-A Port

Output timing Set the output timing.
Storage Output Bit: Output when the relevant bit turns ON.
After Full Capacity
At power-on
Upon date change (AM00:00:00)
Upon change to local mode
Upon storage removal *4

Item Description

EXT0000

201404

20140411

ALARM_00_00.CSV

ALARM

ALARM00_20140411130020.BIN

ALARM_00_00_20140411130030.CSV

Year/month folder

Year/month/day folder
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Example of storage output
1. Alarm block number 0, alarm history, output drive (built-in socket), CSV/backup output drive (built-in socket)

2. Alarm block number 0, alarm history, output drive (built-in socket), CSV/backup output drive (USB-A)

EXT0000

201404

201405

20140410

20140503

20140504

20140411

ALARM00.BIN (ALARM00.BIN-journal)

ALARM_00_00.CSV

ALARM

ALARM00_20140410130020.BIN

ALARM_00_00_20140410130030.CSV

ALARM00_20140411130020.BIN

ALARM_00_00_20140411130030.CSV

Access folder (default)

Year/month/day folder

SD card

Time (year/month/day/hour/minute/seconds)
CSV filename (default)

Block number

Filename (default)

Year/month folder

EXT0000

201404

201405

20140410

20140503

20140504

20140411

ALARM_00_00.CSV

ALARM

ALARM00_20140410130020.BIN

ALARM_00_00_20140410130030.CSV

ALARM00_20140411130020.BIN

ALARM_00_00_20140411130030.CSV

EXT0000

ALARM00.BIN (ALARM00.BIN-journal)

ALARM

Access folder (default)

Year/month folder

Time (year/month/day/hour/minute/seconds)
CSV filename (default)

Block number

Filename (default)

Access folder (default)

SD card

USB flash drive

Year/month/day folder
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Control Device Setting

Item Description
Control Device Execute resets and storage output using a control device memory.

Reset Bit Bit OFF → ON: Clears the history data. While bit is ON, saving of history is halted.
Acknowledgment Bit Bit OFF → ON: Sets an unacknowledged alarm as acknowledged.

When multiple V10/V9 series units are connected to a single PLC, using this acknowledgment 
bit allows the acknowledged state to be updated to all V10/V9 series units.

Storage Output Bit Bit OFF → ON: Outputs history data to CSV file.
The bit device memory setting is configured on the [Data Output Setting] tab window.

Monitoring Bit Control the start and end of history saving.
Bit OFF → ON: Starts monitoring. History is saved when the alarm bit turns ON.
Bit ON → OFF: Stops monitoring. History is not saved even if the alarm bit turns ON.

If this bit is not used, history is saved when the alarm bit turns ON/OFF.
Normal Operation Bit This bit controls the alarm history.

While the alarm bit is OFF, this bit is ON. As soon as the alarm bit turns ON, this bit turns OFF.
The first error bit that is turned ON while this bit is OFF is recognized as the “primary cause” 
error, and can be distinguished from the other errors.

Confirmation 
Device

Output the execution result of the control device memory and other information.

Reset Bit When the reset bit of the control device memory is ON and reset is completed, this bit turns 
ON.

Acknowledgment Bit When the acknowledgment bit of the control device memory changes to 1, this bit turns ON.
Storage Output Bit When the storage output bit of the control device memory changes to 1 and the storage 

output is complete, this bit turns ON.
* If the storage output bit of the control device is turned off before the storage output is 

complete, it does not change to 1.
Alarm History This bit turns ON according to the amount of alarm history save data.

Data Presence Bit: Turns ON when history data exists.
Bit for over 90% full capacity: Turns ON when history data takes up 90% of the storage 

capacity.
Bit for buffer full: Turns ON when the storage device is full.

Event History This bit turns ON according to the amount of event history save data.

Data Presence Bit: Turns ON when history data exists.
Bit for over 90% full capacity: Turns ON when history data takes up 90% of the storage 

capacity.
Bit for buffer full: Turns ON when the storage device is full.
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Format Setting

*1 While there are no restrictions on the number of rows and columns in the SMHxxxx.csv files, the maximum file size is 239 kbytes.
If there is a mistake in the settings or a SMHxxxx.csv file cannot be read, the alarm block number is added to the title line.

CSV format setting
• V10/V9 format

Item Description
CSV Format Setting These settings are for saving alarm and event history to CSV files.

Multiple CSV formats can be registered using the [Add] button.
Use CSV file for titles (V8 
Compatible) *1

Add title lines using SMHxxxx.csv (xxxx: 0000 to 0011).
Place any CSV files into the “ALARM“ folder on the storage device in advance.
The CSV format is only valid for No. 0 (V8 format).

Event History Setting Specify Event Name Set the message to use for the status display area of the event history part.
Display the [Message Edit] window by clicking the [Edit] button.
GNo. No.

Item Description
Type Select the alarm type.

Alarm/Event
File Name Set the name of the CSV file. 1 to 64 one-byte alphanumeric characters

Default
ALARM_xx_aa.CSV (xx: block number, aa: format number)

Output Language Set the language used in the CSV file.
No Designation: Output the CSV file using the language displayed on the unit.
Language 1 to 32
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• V8 format
Select when saving CSV files in the same format as the V8 series.

Display Type Set the items and format for CSV file output.

V8 Format: Select this checkbox to output the CSV file in the same format as the V8 series.
Title Setting Add a title to each item. 

Click [Add] to register up to 10 lines.
Double-click a cell under [Message] and register text in the [Message Edit] window. (GNo., No. 
designation)

Items Not to Output
Items to Output
>
<

Use the [>] and [<] switches to select the items for CSV file output.

Items Not to Output: Not output to CSV file
Items to Output: Output to CSV file

Items to Output
Up
Down

Set the display order in the CSV file using the [Up] and [Down] buttons.

Items are displayed in left to right order in the CSV file.
Calendar Condition Set the output condition of the selected items.

Date Only/Time Only/Date and Time

Date/Time Display Format Setting
Set the date and time display format. Refer to page 8-32.

Output Preview Check a preview of the CSV file output.

Item Description
Type Select the alarm type.

Alarm: V8 alarm display format
Event: V8 bit sampling format

File Name Set the name of the CSV file.   1 to 64 one-byte alphanumeric characters

Default
ALARM_xx_aa.CSV (xx: block number, aa: format number)

Output Language Set the language used in the CSV file.
No Designation: Output the CSV file using the language displayed on the unit.
Language 1 to 32

Display Type (V8 Format) Set the items and format for CSV file output.

V8 Format: Select this checkbox to output the CSV file in the same format as the V8 series.
Title Setting Add a title to each item. 

Click [Add] to register up to 10 lines.
Double-click a cell under [Message] and register text in the [Message Edit] window. (GNo., No. 
designation)

History Display Select the history data for CSV file output.
[Time of Occurrence]/[Occurrence/Cancellation Time]/[Occurrence/Confirmation Time]/
[Occurrence/Cancellation/Confirmation Time]/[Time Lag Display]/
[Total Frequency of Occurrence Display]/[Total Time of Occurrence Display]/
[Time of Occurrence Display]

Calendar Condition Set the output condition of items shown in [History Display].
Date Only/Time Only/Date and Time

Date/Time Display Format Setting
Set the date and time display format. Refer to page 8-32.

Display the primary cause only Only output history data of primary causes to the CSV file.

Item Description

Alarm Event
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Others

*1 If the setting at [Alarm Server] → [Data Output Setting] → [Storage Output Settings] → [Number of Data to Save] is not configured, 
ALARMxx.BIN/EVENTxx.BIN files are not created. A CSV file is created from the data saved in the internal storage settings.

*2 The filename can be changed via [Format Setting] → [File Name].
*3 SRAM requires formatting because the SRAM usage changes. After changing this setting, any history data recorded prior to the change 

cannot be displayed.
*4 The display content differs depending on the number of displayable digits of the numerical display part.

Add a (*) mark to the primary cause Add an asterisk (*) to the left of the primary cause error.
Output Information Select the status for output to the CSV file.

ON-OFF: Output occurrence/cancellation history.
ON: Output occurrence history.
OFF: Output cancellation history.
ON-OFF-CHK: Output occurrence/cancellation/acknowledgment history.

Activate Status Display Select the status of output information.
Display ON/OFF/CHK: Output the bit status as ON/OFF/CHK.
Specify Message No.: Output the bit status using a message.

Item Description
Do not output backup files No backup folder or file is created.

Unselected
Create a backup folder.

Selected
Do not create a backup folder.
The files ALARMxx.BIN/EVENTxx.BIN *1 and ALARM_xx_aa.CSV *2 are created in the ALARM 
folder.

Put msec information on time *3 *4 When using an alarm part with [Display Mode] set to [Event History], display the date and time 
down to milliseconds.
Select the [Event History] checkbox in the [Alarm Server] settings window and place a numerical 
display part with [Function] set to [Alarm Time Display].

* The time displayed within an alarm part and the time output to a CSV file is in seconds.
Read Monitoring Device per cycle Selected

Read the alarm device memory according to the communication cycle.

Unselected
Read the alarm device memory according to [Monitoring Intervals].

Less than 8 digits No display 18 digits Month, day, hour, minutes, seconds, and 
milliseconds

8 to 11 digits Hour, minutes, and seconds 19 to 22 digits Year, month, day, hour, minutes, and 
seconds

12 to 13 digits Hour, minutes, seconds, and milliseconds 23 digits or more Year, month, day, hour, minutes, seconds, 
and milliseconds

14 to 17 digits Month, day, hour, minutes, and seconds

Item Description
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8.2.3 Action When Alarms Occur
In addition to saving history to an alarm server when an alarm occurs, other actions such as displaying a scrolling message or 
sending e-mails can be added. This section describes the required settings for each action.

Scrolling Messages
An alarm message is automatically displayed at the bottom (or top) of the screen. It is displayed continually until the error is 
reset even if the screen is changed over. Once all messages have been scrolled through, the first message is displayed.

* If two or more lines are set for [Alarm Device] → [Message Lines], the multiple lines are merged into one line for display in the scrolling 
message.
However, note that only the first line is displayed when V9 Series system version is 1.360 or earlier and when Windows fonts are used.

Settings
• Alarm block settings

Select [Enable] for [Alarm Block] → [Alarm Device] → [Slide Message] → [Setting].

• Flowing (scrolling) message settings
Click the [Edit] button or [System Setting] → [Other] → [Flowing Message].
Configure the following settings.

08:12:40 Temperature rise of Tank-A 05/10 15:15:43 Material

Bottom Top

05/10 08:12:40 Temperature rise of Tank-A 

05/10 08:12:40 Temperature rise of Tank-A 

Scroll tool display

Paused

Monitor Screen Monitor Screen
Scrolling messages

08:12:40 Temperature rise of Tank-A 05/10 15:15:43 Material
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*1 The time of scrolling messages is referenced from the internal clock of the V10/V9 series unit and not the history time on the alarm server. 
If power to the V10/V9 series unit is turned off and on again or the screen is switched to Local mode while a scrolling message is 
displayed, the time is updated to when switched to RUN mode.

*2 Only [Windows Font] properties in the [Char. Prop.] window accessible from the [Message Edit] window are available. The other 
[Color]/[Point] settings are unavailable.

Item Description
Operation 
Setting

Flow Speed Set the message speed.
1 - 255 pixel/100ms

Message Interval Set the interval between multiple scrolling messages.
Position Set the display position of messages.

Lower End / Upper End
* Scrolling messages can be moved between the top/bottom of the screen in RUN 

mode by using the “scroll tool”.
Flow Direction Set the direction of message scrolling.

Left ← Right / Left → Right
Scroll Tool Display the scroll tool when the message area is tapped.

The scroll tool can be used to change the display position and speed.

Display Setting Date Display Display the date of alarm occurrence. *1

Time Display Display the time of alarm occurrence. *1

Char. Prop. Use Windows Font Displays with the [Windows Font] setting set in the [Char. Prop.] window accessible in 
the [Message Edit] window. *2

Char. Color
Background
Style
Point

Set the text color, background color, style, and point size of scrolling messages.

Area Setting Transparency
Area Color

Set the area color. The area can be made transparent.

Display Frame
Frame Color

Add a frame to the area. The frame color can also be set.

Moves the display position.

Scrolling occurs at double speed while the switch is pressed.

Stop scrolling. Tap a stopped message to manually scroll left or right.

Available
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Playing Sounds
Play back an audio file. Audio can be played back continuously while an alarm is occurring.

Supported models

Settings
• Double-click [Alarm Block] → [Alarm Device] → [Sound].

Configure the following settings.

*1 Audio priority
When multiple errors occur, the WAV file with the highest priority is played.
If multiple errors with the same priority occur, the audio file of the last error to occur is played.

Model Connection Port Other
V10 Standard All Audio output connector Connection to both an amplifier and external 

speaker is required.V9 Standard
V9 Advanced V910xiWRLD

V910xiWLD

Item Description
Setting Enabled
Play a sound while the bit is ON Continuously play back the audio file.
WAV File No. Set the WAV file number from number 0000 to 1023.

The names of audio files that can be played are formatted as “WAxxxx.wav” (xxxx: 0000 to 
1023).
For details on file formats, refer to “2 Sound” in the Reference Manual 2.

Sound Priority No. *1 Set the priority of the WAV file.

A line A error 
occurred.

Alarm bit
M100 = ON
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E-mail Notification
Send an e-mail notification when an error occurs. Files can be attached to e-mails. When using a multi-language screen, 
e-mails are sent in all languages.

Settings
• Double-click [Alarm Block] → [Alarm Device] → [E-Mail].

Configure the following settings.

• E-mail settings
Configure the mail server settings. There are two ways to configure mail server settings: using the V-SFT editor or on the 
V10/V9 series unit.

Item Description
Setting Enabled
Send when the alarm occurs Send an e-mail notification when an error occurs.
Attach the specified file Select this checkbox to attach a file. Press the [Edit] button to select a file.

For details, refer to “6.8 E-mail Notification“ in the Reference Manual 2.
Send when the alarm is reset Send an e-mail notification when the system recovers from an error.
Send to Select the recipient mail addresses.

* When creating screens and the recipients of e-mail notification is yet to be determined, 
dummy recipients from numbers 0 to 8 can be used instead. The actual recipient addresses can 
be registered later on the V10/V9 series unit in the [E-Mail Setting] in Local mode.

Refer to “6.8 E-mail Notification” in the Reference Manual 2.

LAN

E-mail

Error

2014/04/10 18:55:04 <ON>
Apr/10/2014 18:55:04 <ON>
2014/04/10 18:55:04 <ON>
2014/04/10 18:55:04 <ON>
2014/04/10 18:55:04 <ON>

E-mail notification main body

* The mail server must reside on the network.

Mail server

Dummy settings
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Video Recording (Event Recording Function)
• Video can be saved to a video file (extension: .mp4) upon error occurrence and reset by using the USB camera display and 

alarm function.
• The event recording function allows video to be recorded continuously regardless of whether alarms occur. Video can be 

saved immediately after an error occurrence and reset, which facilitates cause analysis.
If the event recording function is not used, video is saved immediately after an error occurrence and reset.

• Video files of up to 180 seconds (up to 90 seconds before and 90 seconds afterwards) can be saved.

Settings
• Hardware settings

Click [System Setting] → [Hardware Setting] → [Other Devices] → [USB Camera].
Set the USB camera settings in the [USB Camera Properties] window.

Item Description
Recording/display 
setting

Drive for Output Set the destination for storing video files.
Storage Setting

Video files are saved on the drive selected at [System Setting] → [Other] → [Storage 
Setting] → [Storage Connection Target].

Camera Resolution Set the resolution of the USB camera.
320 × 240
640 × 480

Timestamp Set the time stamp settings.
A time stamp is added to the video so that the date and time of the video recording is 
superimposed on the video when the video file is played back.
The system font is used for the time stamp.

Use Info Output Device Store the camera status.
Alarm Settings Use Event Record 

Function
Select to use this function in conjunction with the alarm function when recording video 
immediately before an error occurrence and immediately before resetting an error.
Alarm server recording settings must also be configured.
In RUN mode, video is recorded continuously regardless of whether alarms occur.

Refer to “1.2 USB Camera Display” in the Reference Manual 2.

EXT0000
ALARM

ALARM00_001_A_20190415113025.mp4
ALARM00_001_R_20190415114253.mp4

Error

0 2030
sec

0 2020

201904
20190415

sec

Error bit

Occurrence Reset

Video 50 seconds before
 and after occurrence

Video 40 seconds before 
and after reset

Continuous recordingEvent recording function

Video file saving
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• Alarm block settings
Double-click [Alarm Block] → [Alarm Device] → [Recording]. Configure the following settings.

*1 This setting is only available when “Yes” is selected for [Use Event Record Function] at [System Setting] → [Hardware Setting] → [USB 
Camera Properties].
To play back video using the video player, stop recording video by using the “USBCAM_REC STOP” macro command.

*2 In the following cases, video is recorded to a single file. This means that there are cases when the duration of video recording is extended. 
However, note that since the maximum duration of video recording is 180 seconds, video recording ends upon reaching 180 seconds.

- When both occurrence and resetting are set, the end of video recording for occurrence overlaps with the start time of video recording 
for resetting.

- Multiple alarms occur at once.

Item Description
Setting Enabled
Record occurrence

Before *1
After

Select this checkbox to record video when an alarm occurs. Set the duration of video recording immediately 
before and immediately after an alarm occurs.
A total of 180 seconds of video can be saved. *2

0 to 90 sec
Record resetting

Before *1
After

Select this checkbox to record video when an alarm is reset. Set the duration of video recording immediately 
before and immediately after an alarm is reset.
A total of 180 seconds of video can be saved. *2

0 to 90 sec

• Event recording function: Yes • Event recording function: None
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Operation Setting
Double-click [Alarm Block] → [Alarm Device] → [Operation Setting].
Perform operations including writing to the specified device memory address (output setting), screen changeover / overlap 
control (function), and macro execution (macro).

Output setting
Turn the output device ON or OFF or write data when an alarm occurs or is canceled.

Item Description
Output device to 
edit

Occurrence 
operation

Set the output operation to perform when an alarm occurs.

Cancellation 
operation

Set the output operation to perform when an alarm is canceled.

Number of Outputs 0 No output operation
1 - 16 Output operation performed

Set the required items according to the output operation.

Alarm bit
M100 = ON

Monitor Screen Error 
occurrence!

Reset the error.

Screen changeover

Output Action Output Target 
Device Inversion Time Data Length

Write Value
Set
Reset
Alternate

Output bit

- -

Momentary (ON)
Momentary (OFF)

100 ms - 3 s
Bit returns to 
original value after 
inversion time 
elapses.

-

Writing in Words Output device - 1-Word/2-Word
Value to write
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Function
Perform screen changeover / overlap control when an alarm occurs or is canceled.

Macro
Execute a macro when an error occurs or is canceled.

Item Description
Function to Edit Occurrence operation Set the function used when an alarm occurs.

Cancellation operation Set the function used when an alarm is canceled.
Function None No function

Screen Changeover Perform screen changeover automatically.
Set [Switch to] and [List View] or [Thumbnail].

Overlap Control Display a global overlap.
Set [Global Overlap ID] and [Overlap Library No.].

Item Description
Macro to Edit Occurrence operation Set the macro to execute when an alarm occurs.

Cancellation operation Set the macro to execute when an alarm is canceled.
Setting Use Alarm macros Register a macro via the [Edit] button.

Specify the macro block number Specify the macro block number.
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Parameters
When an alarm occurs, the data (parameters) associated with the alarm can be saved/displayed together with an alarm 
message. Logging the history of such alarm-relevant parameters will make it easier to locate and investigate the causes of 
alarms.

Settings
• Double-click [Alarm Block] → [Alarm Device] → [Parameter].

Configure the following settings.

Parameter table

Item Description
Parameter table number 0 to 31 Create parameters with the [Add] button.

Up to 32 parameters can be registered per alarm device memory address.
Add Add a new parameter.
Delete Delete the selected parameter.
Up/Down Change the order of parameters.

Device Set the parameter device memory address.

Touch!!

YAMADA SATO

MJ1

65.0

A B

Thermal error Material shortage
Worker change

Alarm bit ON
Temperature rise of Tank-A 65°C
Lack of materials 80 g
Worker change  Worker: Yamada → Sato
Abnormality of conveyor A-Line

14/05/10 08:12:40
14/05/10 15:15:43
14/05/10 17:00:00
14/05/10 19:59:15
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• Editing messages
Register parameter numbers into alarm messages.

Display Type Set the display type of the parameter and other related items.
Numerical Data Save/display the data value of the device memory. The following settings are required.

Text Save/display text set at the device memory address. The following settings are required.

Message No. Specify a message number (absolute address) for the device memory address and 
save/display the corresponding message.
The following settings are required.

Bit In the bit state when an error occurs, save/display the corresponding message.
Bit ON: Save the message of [Message G No.] and [Message No.].
Bit OFF: Save the message of [Message G No.] and [Message No. + 1].
The following settings are required.

Windows fonts are not supported. If Windows fonts are used, parameter symbols (%PxxS) are displayed instead 
of the relevant parameter.

Item Description

Item Setting Value
Data Length 1-Word/2-Word
Input Format DEC/BCD/FLOAT
Display Format DEC (w/o sign)/DEC (with sign −)

DEC (with sign +−)/HEX/OCT/ BIN (binary)
Digits 1 - 32
Decimal Point 0 - 31
Zero Suppress Yes/None
Char. Place Flush Right/Flush Left

Item Setting Value
Data Length 1-Word/2-Word
Characters 1 - 127
Text Process LSB → MSB / MSB → LSB

Item Setting Value
Data Length 1-Word/2-Word
Input Format DEC / BCD

Item Setting Value
Message G No. 0 - 127
Message No. 0 - 255

%PxxS
0 - 31
Specify parameter numbers registered in the [Parameter Table] window.
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Touch Action
Tap the message on the alarm part to changeover the screen. This displays more detailed alarm information.

Settings
• Double-click [Alarm Block] → [Alarm Device] → [Touch Action].

Configure the following settings.

• Alarm part settings window → [Detail]

Item Description
Action Type Screen changeover
Screen No. Set a screen number from 0 to 9999.

Item Description
Auxiliary 
Function

Enable the touch-action 
function

Unselected: Tapping a message does not changeover the screen.
Selected: Tapping a message changes over the screen.

Temperature rise of Tank-A 
Lack of materials
Abnormality of conveyor 
A-Line

Error Display

Insufficient materials.

Replenish xxxxx of yyy.

Error DetailsDisplay error details
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8.3 Date and Time Display Setting
Set the date and time format used by alarm parts, alarm CSV output, scrolling messages, and e-mail.
When using multi-language screens, a format for each language can be set.

Configure settings at [System Setting] → [Setting] → [Date and Time Display Setting].

*1 Default values for month format display (MMM)

Item Description
Display Language Select a language.

Language 1 to 32
Date Format Set the date format.

To use a format other than those provided, enter the format directly.

Time Format Set the time format.
To use a format other than those provided, enter the format directly.

Display format for noon Set the noon display format.
PM: PM12:00
AM: AM12:00

Customize Format Customize the format of month (MMM), weekday (DDD), and AM/PM.
Representation of 
Months

Set when using characters instead of numbers for the month display. *1

Representation of 
Days of the Week

Set when displaying days of the week. *2

Representation of 
AM/PM

Set when changing the AM/PM display. *3

Month English
Baltic Japanese Simplified Chinese

Traditional Chinese Korean Central 
Europe Cyrillic Greek Turkish

Jan Jan янв Ίαν Oca
Feb Feb февр Φεβρ Şub
Mar Mar март Μάρτ Mar
Apr Apr апр Άπρ Nis
May May май Μάϊος May
Jun Jun июнь Ίούν Haz

Year
YYYY 4 digits
YY 2 digits (00 to 99)

Month
MM 01 - 12
M 1 - 12
MMM Customized format *1

Day
DD 01 - 31
D 1 - 31

Day of the week DDD Customized format *2

Hour

hh 00 - 12
h 0 - 12
HH 00 - 23
H 0 - 23

Minute
mm 00 - 59
m 0 - 59

Second
ss 00 - 59
s 0 - 59

AM/PM AP AM/PM *3
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*2 Default values for days of the week display (DDD)

*3 Default values for AM/PM display

Setting example
• Date Format

Jul Jul июль Ίούλ Tem
Aug Aug авг Αύγ Ağu
Sep Sep сент Σεπτ Eyl
Oct Oct окт Όκτ Eki
Nov Nov ноябрь Νοέμ Kas
Dec Dec дек Δεκ Ara

Day of the 
week

English
Baltic Japanese Simplified Chinese

Traditional Chinese Korean Central 
Europe Cyrillic Greek Turkish

Mon Mon 月 星期一 월요일 Mon пн Δευ Ptesi
Tue Tue 火 星期二 화요일 Tue вт Τρι Salı
Wed Wed 水 星期三 수요일 Wed ср Τετ  ar
Thu Thu 木 星期四 목요일 Thu чт Πεμ Per
Fri Fri 金 星期五 금요일 Fri пт Παρ Cuma

Saturday Sat 土 星期六 토요일 Sat сб Σαβ C.tesi
Sunday Sun 日 星期日 일요일 Sun вс Κυρ Paz

AM/PM English
Baltic Japanese Simplified Chinese

Traditional Chinese Korean Central 
Europe Cyrillic Greek Turkish

AM AM 午前 上午 오전 AM AM am AM
PM PM 午後 下午 오후 PM PM pm PM

Date Format Customize Format Display on MONITOUCH
MMM DD YYYY [Representation of Months] selected 

(default)
May 15 2014

DDD, MMM DD YYYY [Representation of Months] selected 
(default)
[Representation of Days of the Week] 
selected (default)

Thu, May 15 2014

Month English
Baltic Japanese Simplified Chinese

Traditional Chinese Korean Central 
Europe Cyrillic Greek Turkish
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8.4 Alarm Parts
Place an alarm part for checking history saved to an alarm server on MONITOUCH.
An alarm part can be placed by clicking [Parts] → [Alarm].

8.4.1 Detailed Settings
Operation Select

Item Description
Display Mode Display history data stored on an alarm server on MONITOUCH.

The display on MONITOUCH differs depending on the display mode.
Alarm History Display alarm occurrence, cancellation, and acknowledgment times on one line.

The state of each alarm can be checked at a glance.
Event History Alarm occurrence, reset, and acknowledged times are each displayed on one 

line.
Real Time Only display alarms that are currently occurring.

Alarms that require canceling can be checked at a glance.
Alarm Tracking (V8) This is selected when using a screen program converted from the V8 series.

The menu changes to a V8-compatible parts menu.

These options are displayed when the [Display All] checkbox is selected.
Alarm Logging (V8)
Time Order Alarming (V8)
Bit Order Alarming (V8)

 Display Order of Date/Time Set the display order of error messages.
Ascending Order Display in the order of old errors → new errors.
Descending Order Display in the order of new errors → old errors.
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Contents

*1 When [Use Windows Font] is checked, also check [System Setting] → [Unit Setting] → [General Setting] → [Use the point size specified in 
the message edit window for alarm parts using Windows fonts]. (Default: checked)
In this case, the text size set in [Contents] → [Point] in the alarm settings window above is invalid, and displayed using the size set at [Edit] 
(or right-click menu) → [Char. Prop.] → [Point] in the message editor.

*2 The [System Setting] → [Unit Setting] → [General Setting] → [Activate auto-scroll display of the alarm] checkbox must be selected.
(Default: selected)

Item Description
Common 
Setting

Ruled Line Display Display ruled lines in the display area. The color of ruled lines can also be set.
Use Windows Font Display alarm messages using a Windows font. *1

Title Setting Display a title Display a title for each item in the display area.
Edit Titles can be edited by opening the [Message Edit] window.

Use the same number of consecutive lines as the number of items to display.
Detail Setting Set the number of points, display position, and color of titles.

Display Setting Items Not to Display
Items to Display
>
<

Use the [>] and [<] switches to select the items for display on MONITOUCH.

Items Not to Display: Not displayed on MONITOUCH.
Items to Display: Displayed on MONITOUCH.

Items to Display
Up, Down

Set the display order of items on MONITOUCH using the [Up] and [Down] switches.

Items are displayed from left to right on MONITOUCH.
Point Set the text size.
Select 
Option

Display 
Width

Set the display width of the items selected for display.
When a message is longer than the display area width, automatic scrolling is performed while 
the message is selected by the cursor so that the entire message can be displayed. *2

Place Set the display position of the items selected for display.
Calendar 
Condition

Set the display state of the items selected for display.
Date Only/Time Only/Date and Time

Date/Time Display Format Setting
Set the date and time display format. Refer to page 8-32.

Preview Check a preview of the display on MONITOUCH.
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Monitoring Alarm

Filter

Item Description
Reference Alarm Block No. Set the alarm block number for displaying history data.

The editing window for alarm blocks can be displayed using the [Edit] button.
Settings The settings of the selected alarm block can be checked in this area.

Item Description
Filter Setting Set the display state immediately following screen switching.

Filter settings are not required when displaying all history information.
When [Real Time] is selected in the [Operation Select] window, configure the filter settings and 
select the [Occurrence] checkbox.

* Filter settings can be changed on MONITOUCH in RUN mode.
Group No. 0 to 15
Occurrence
Reset
Acknowledge
Normal

Selected: Display on MONITOUCH.
Unselected: Do not display on MONITOUCH.
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Style

Item Description
Additional Parts List Displays a list of alarm-related parts.

Selected: Displayed on MONITOUCH.
Unselected: Not displayed on MONITOUCH.
Parts can be added to the list by clicking [Add Parts].

Roll Up Move the cursor to the next item.
Roll Down Move the cursor to the previous item.
+ Block Scrolls the display up by one page.
− Block Scrolls the display down by one page.
Delete Delete the selected message.

* The message is only erased from display on MONITOUCH and it remains in the 
history data.

Reset Clear the history data on the alarm server.
Press this switch once to activate it and press it again within 2 seconds to clear the 
data. If the switch is not pressed again within two seconds, the switch s lamp turns off 
and resetting is nullified.

Graph Return This switch blinks when a message is selected using [+ Block] or [− Block] buttons.
Press the switch when it is blinking to deselect the message and return to the latest 
alarm display.

Change Display Order Change the message display order between [Ascending Order] and [Descending 
Order].

Display Change-over Change the date and time display format between [Date Only] and [Time Only].
Acknowledge Acknowledge the selected unacknowledged messages.
Acknowledge All Acknowledge all unacknowledged messages.
Filter Display Change the information to display.

Select the information to display from group, occurrence, cancellation, 
acknowledgment, and normal.

File Select Display a backup file (CSV) saved to a storage device.
Count Display *2 Display the number of event history entries or the count value of the selected 

message.
Time Display *1 *2 Display the latest time of the event history or the time of the selected message.
Status Display Display the event history status.

Occurrence/cancellation/acknowledgment/normal
Mode (Switch) Display relay (V8) or relay sampling (V8) mode messages on a switch.
Mode (Lamp) Display relay (V8) or relay sampling (V8) mode messages on a lamp.

Adjust Position Display the window for adjusting the placement position of each part. Part size can 
also be changed.

Select from catalogs Set the part design from the catalog.
Parts Design Set the design and color of the part selected in the [Additional Parts List] or preview 

pane.
Edit Selected Parts Set the part selected in the [Additional Parts List] or preview pane.
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*1 Display differs depending on the number of specified digits. 
Select the [Put msec information on time] checkbox at [Alarm Block] → [Others] to display and record down to milliseconds.

*2 When converting data from an older model, this corresponds to the [Function] setting of “Logging Time Display” or “Logging Count 
Display”.
Enable millisecond display by changing [Function] to “Alarm Time Display” or “Alarm Count Display”. 

Logging Time Display

Show/Hide
Set the show and hide settings of alarm parts.

Detail

Less than 8 digits No display 18 digits Month, day, hour, minutes, 
seconds, and milliseconds

8 to 11 digits Hour, minutes, and seconds 19 to 22 digits Year, month, day, hour, minute, 
and second

12 to 13 digits Hour, minutes, seconds, and 
milliseconds

23 digits or more Year, month, day, hour, minutes, 
seconds, and milliseconds

14 to 17 digits Month, day, hour, minutes, and 
seconds

Less than 8 digits No display 14 to 17 digits Month, day, hour, minutes, and 
seconds

8 to 11 digits Hour, minutes, and seconds 19 to 22 digits Year, month, day, hour, minute, 
and second

For details, refer to “14 Item Show/Hide Function”

Item Description
Auxiliary 
Function

Enable the touch-action 
function

Changeover the screen by tapping the displayed alarm message.
* Enable [Touch Action] on the alarm server.

Info. Output 
Device

Output the selected 
alarm No.

Store the alarm number selected (cursor display) on MONITOUCH into the specified device 
memory address.
Use this setting to display detailed alarm information.

Coordinate Start X / Start Y Set the placement position and size of the display area.
Width/Height

Others ID Set the ID of the alarm part.
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9.1 Bar Graph
9.1.1 Overview

• Data in a device memory address can be expressed on a bar graph.

• When data in a device memory address exceeds or falls short of the range specified, the graph color can be changed. This 
helps the operator to recognize the situation easily and correctly.

• As shown below, it is possible to display a bar graph in several colors.

• A reference point can be set and then data from the reference point to the specified data in a device memory address can 
be expressed on a graph (deviation display).

For setting examples, refer to “Displaying Current Values (Standard Display)” page 9-2.

For setting examples, refer to “Displaying Current Values (Standard Display)” page 9-2.

For setting examples, refer to “Displaying Current Values (Standard Display)” page 9-2.

For setting examples, refer to “Displaying Deviation from a Reference Value to the Current Value 
(Deviation Display)” page 9-4.

.................

7000

0 100%50

0 10050
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9.1.2 Setting Examples
Displaying Current Values (Standard Display)
The current value of a device memory address within the range of the minimum and maximum values can be displayed 
(standard display).

1. Click [Parts] → [Graph] → [Bar Graph] and place a bar graph on the screen.

2. Double-click on the bar-graph to display the settings window.
Configure the [Contents] settings as shown below.
• Set the device memory address to display on the graph with [Current Value] → [Device].
• Select [Standard] for [Type].
• Specify the graph display area using [Range].

.................

7000

0 100%50
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3. Configure the following settings for [Style] and then click [Finish].
To change the graph color depending on the value, proceed to step 4.

4. Configure the [Alarm] settings to change the graph color depending on the value.
In this case, color settings set for [Style] are disabled.

5. Set the following to display the graph using the different colors for different value ranges.

This completes the necessary settings.
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Displaying Deviation from a Reference Value to the Current Value 
(Deviation Display)
A reference point can be set and then data from the reference point to the specified device memory address can be 
expressed on a graph.

1. Click [Parts] → [Graph] → [Bar Graph] and place a bar graph on the screen.

2. Double-click on the bar-graph to display the settings window.
Configure the [Contents] settings as shown below.
• Set the device memory address to display on the graph with [Current Value] → [Device].
• Select [Deviation] for [Type].
• Specify the value or device memory address to be used as the reference for [Standard].
• Specify the graph display area.

0 10050
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3. Configure the following settings for [Style] and then click [Finish].
To change the graph color depending on the value, proceed to step 4.

4. Configure the [Alarm] settings to change the graph color depending on the value.
In this case, color settings set for [Style] are disabled.

5. Set the following to display the graph using the different colors for different value ranges.

This completes the necessary settings.
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9.1.3 Detailed Settings
Displayed Information

Item Description

Current 
Value

Device Specify the device memory address to monitor as a graph.
Input Type
(DEC- / BCD, Real Number)

Select the data format of device memory values.
The selection here also applies to the values of [Target Value], [Standard Value], [Range], and 
[Alarm].

* When [DEC-/BCD] is selected, the setting at [Code: DEC/BCD] under [Communication 
Setting] in the [PLC Properties] window accessible via [System Setting] → [Hardware 
Setting] takes effect.

Data Length
(1-Word, 2-Word)

Select data length of the device memory.

Display 
Setting

Type
(Standard, Deviation)

Standard
Display the device memory value between the minimum and maximum values on a graph.

Deviation
Set a reference value and display deviation from the reference value to the current value.

Direction
(UP, DW, LFT, RGT)

Set the direction to draw graph lines.
Vertical bar graph: UP / DW
Horizontal bar graph: LFT / RGT

Target Value, Standard Target Value
Set this when [Standard] is selected for [Type].
Display a line at the position of the target value on the graph.

* If a value less than the minimum value of the range is set, a line is not displayed.
Standard

Set this when [Deviation] is selected for [Type].
Specify the reference value of the graph.

* If [Alarm] is configured, the [Standard] or [Target Value] setting is disabled.
Range
(Minimum/Maximum)

Specify the minimum and maximum values for the display range of the graph.
If the display range is variable, select a device memory. If the display range is fixed, specify a 
constant.

Display the scale according to 
the display range

This is only available for parts that correspond to a numerical display.
An optimal scale is displayed according to the minimum and maximum of the value in the 
range.

* This setting is only available when the minimum and maximum values are specified with 
constants.

0 100

0 100

Standard Value Current Value
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Style

Item Description
Select from catalogs Type

Set the part design.
Color

Set the part color.
Select from image files Load an image file.
Data Color When [Standard] is selected for [Type]:

Set the graph color from the minimum value to the device memory value.
When [Deviation] is selected for [Type]:

Set the graph color from the reference value to the device memory value.
* If [Alarm] is configured, this is disabled.

Target Value Color When [Standard] is selected for [Type]:
Set the color of the target value line displayed on the graph.

* If [Alarm] is configured, this is disabled.
Display Area Color Set the color inside the graph area.
Display a frame around the 
display area

Display a frame around the graph area.
When this checkbox is selected, the frame color can be set.
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Alarm

Item Description
Use alarm display Change the colors of the graph according to the device memory value.

Area Setting

When [Standard] is selected for 
[Type]:
Upper Limit2/Upper 
Value/Area within the 
Range/Lower Value/Lower 
Limit2

Set the ranges for alarm display and each corresponding color.

When [Deviation] is selected 
for [Type]:
Upper Limit+/Standard 
Value/Lower Limit−

Set the ranges for alarm display and each corresponding color.

Display 
Setting

Add marks to upper and lower 
limit values

Display  marks at the alarm range positions of the graph.

Position Specify the position of the  marks.
Vertical bar graph: Left/Right
Horizontal bar graph: Top/Bottom

Mark Color Specify the color of the  marks.
Display in separate colors Display each alarm color separately on a single graph.

• Type: Standard

• Type: Deviation
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Examples of graphs with alarm settings
When [Standard] is selected for [Type]

When [Deviation] is selected for [Type]

50 150 250 350 450

50 150 250 350 450

50 150 250 350 450

50 150 250 350 45050 150 250 350 450

50 150 250 350 450

50 150 250 350 450

Lower 
limit 
color

Within 
range 
color

Upper 
limit 
color

Area 
color

[Direction] set to RGT

Current 
value

Lower limit 
value

Upper limit 
value

Current 
value

Lower limit 
value

Upper limit 
value

Current 
value Lower limit 

value
Upper limit 

value

Current 
value

Lower limit 
value

Upper limit 
value

Current 
value

Lower limit 
value

Upper limit 
value

Current 
value

Lower limit 
value

Upper limit 
value

Current 
value

Lower limit 
value

Upper limit 
value

• Single color use • Separate color use • With marks

50 150 250 350 450

50 150 250 350 450

50 150 250 350 450

50 150 250 350 450

50 150 250 350 450

50 150 250 350 450

50 150 250 350 450

A AA A

A AA A

A AA A

A A

Lower 
limit 
color

Within 
range 
color

Upper 
limit 
color

Area 
color

[Direction] set to RGT

Current value Standard value

A: Range value

Current value Standard value
Lower limit value Upper limit value

Current value Standard valueCurrent value Standard value

Current valueStandard value Current valueStandard value

• Single color use • Separate color use • With marks
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Detail

Item Description
Coordinates Start X/Start Y Specify the placement coordinates.

(Coordinates at top left of part)
Width/Height Specify the width and height of the part.

Others Process Cycle Specify the process cycle of the part.
Add animation effect to 
area/indicator

Draw changes in the graph display over the 
time specified for [Animation Interval].

Example: Animation interval: 200 msec
Current value changes from 
20 to 80Animation Interval Set the drawing speed of changes in the 

graph display.

ID Set the ID.

0 10020 80

Increase on graph occurs over 
200 msec
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9.2 Pie Graph
9.2.1 Overview

• Data in the specified device memory address can be expressed clockwise on a pie graph.

• When data in a device memory exceeds or falls short of the range specified, the graph color can be changed. This helps 
the operator to recognize the situation easily and correctly.

• As shown below, it is possible to display a bar graph in several colors.

• A reference point can be set and then data from the reference point to the specified data in a device memory can be 
expressed on a graph (deviation display).

For setting examples, refer to “Displaying Current Values (Standard Display)” page 9-12.

For setting examples, refer to “Displaying Current Values (Standard Display)” page 9-12.

For setting examples, refer to “Displaying Current Values (Standard Display)” page 9-12.

For setting examples, refer to “Displaying Deviation from a Reference Value to the Current Value 
(Deviation Display)” page 9-14.

Reference point
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9.2.2 Setting Examples
Displaying Current Values (Standard Display)
The current value of a device memory within the range of the minimum and maximum values can be displayed (standard 
display).

1. Click [Parts] → [Graph] → [Pie Graph] and place a pie graph on the screen.

2. Double-click on the pie graph to display the settings window.
Configure the [Contents] settings as shown below.
• Set the device memory address to display on the graph with [Current Value] → [Device].
• Select [Standard] for [Type].
• Specify the graph display area using [Range].

.................
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3. Configure the following settings for [Style] and then click [Finish].
To change the graph color depending on the value, proceed to step 4.

4. Configure the [Alarm] settings to change the graph color depending on the value.
In this case, color settings set for [Style] are disabled.

5. Set the following to display the graph using the different colors for different value ranges.

This completes the necessary settings.
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Displaying Deviation from a Reference Value to the Current Value 
(Deviation Display)
A reference point can be set and then data from the reference point to the specified device memory address can be 
expressed on a graph.

1. Click [Parts] → [Graph] → [Pie Graph] and place a pie graph on the screen.

2. Double-click on the pie graph to display the settings window.
Configure the [Contents] settings as shown below.
• Set the device memory address to display on the graph with [Current Value] → [Device].
• Select [Deviation] for [Type].
• Specify the value or device memory address to be used as the reference for [Standard].
• Specify the graph display area.

Reference point
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3. Configure the following settings for [Style] and then click [Finish].
To change the graph color depending on the value, proceed to step 4.

4. Configure the [Alarm] settings to change the graph color depending on the value.
In this case, color settings set for [Style] are disabled.

5. Set the following to display the graph using different colors for different value ranges.

This completes the necessary settings.



9  Graph Display

9-16

9.2.3 Detailed Settings
Displayed Information

Item Description

Current 
Value

Device Specify the device memory address to monitor as a graph.
Input Type
(DEC- / BCD, Real Number)

Select the data format of device memory values.
The selection here also applies to the values of [Target Value], [Standard Value], [Range], and 
[Alarm].

* When [DEC-/BCD] is selected, the setting at [Code: DEC/BCD] under [Communication 
Setting] in the [PLC Properties] window accessible via [System Setting] → [Hardware 
Setting] takes effect.

Data Length
(1-Word, 2-Word)

Select data length of the device memory.

Display 
Setting

Type
(Standard, Deviation)

Standard
Display the device memory value between the minimum and maximum values on a graph.

Deviation
Set a reference value and display deviation from the reference value to the current value.

Target Value, Standard Target Value
Set this when [Standard] is selected for [Type].
Display a line at the position of the target value on the graph.

* If a value less than the minimum value of the range is set, a line is not displayed.
Standard

Set this when [Deviation] is selected for [Type].
Specify the reference value of the graph.

* If [Alarm] is configured, the [Standard] or [Target Value] setting is disabled.
Range
(Minimum/Maximum)

Specify the minimum and maximum values for the display range of the graph.
If the display range is variable, select a device memory. If the display range is fixed, specify a 
constant.

Display the scale according to 
the display range

This is only available for parts that correspond to a numerical display.
An optimal scale is displayed according to the minimum and maximum of the value in the 
range.

* This setting is only available when the minimum and maximum values are specified with 
constants.

Standard Value
Current Value
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Style

Item Description
Select from catalogs Type

Set the part design.
Color

Set the part color.
Select from image files Load an image file.
Data Color When [Standard] is selected for [Type]:

Set the graph color from the minimum value to the device memory value.
When [Deviation] is selected for [Type]:

Set the graph color from the reference value to the device memory value.
* If [Alarm] is configured, this is disabled.

Target Value Color When [Standard] is selected for [Type]:
Set the color of the target value line displayed on the graph.

* If [Alarm] is configured, this is disabled.
Display Area Color Set the color inside the graph area.
Display a frame around the 
display area

Display a frame around the graph area.
When this checkbox is selected, the frame color can be set.

Display a doughnut-shaped 
graph

Display a doughnut-shaped pie graph.
Select this checkbox to set the hole radius.

Hole

Hole radius
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Alarm

Item Description
Use alarm display Change the colors of the graph according to the device memory value.

The color settings are implemented in the area settings.

Area Setting

When [Standard] is selected for 
[Type]:
Upper Value/Area within the 
Range/Lower Value

Set the range for alarm display and each corresponding color.

When [Deviation] is selected 
for [Type]:
Upper Limit+/Standard 
Value/Lower Limit−

Set the reference value as well as the range for alarm display and each corresponding 
color.

Display Setting

Add marks to upper and lower 
limit values

Display  marks at the alarm range positions of the graph.

Mark Color Specify the color of the  marks.
Display in separate colors Display each alarm color separately on a single graph.

• Type: Standard

• Type: Deviation
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Examples of graphs with alarm settings
When [Standard] is selected for [Type]

When [Deviation] is selected for [Type]

Lower 
limit 
color

Within 
range 
color

Upper 
limit 
color

Area 
color

Lower limit 
value

• Single color use

• Separate color use

• With marks

Upper limit 
value

Current 
value

Upper 
limit value Current 

value
Lower limit 

value

Current 
value

Upper limit 
value

Lower limit 
value Upper limit 

value
Lower limit 

value

Current value

Upper limit 
value

Lower limit 
value

Current 
value

Upper 
limit value Current 

value
Lower limit 

value

Current 
value

Upper limit 
value

Lower limit 
value

A A

A A

A A

A A

A A

A A

A A

Lower 
limit 
color

Within 
range 
color

Upper 
limit 
color

Area 
color A: Range value

• Single color use

• Separate color use

• With marks

Lower 
limit 
value

Upper limit 
value

Current 
value

Upper limit 
value

Lower 
limit 
valueCurrent 

value

Upper 
limit 
value

Lower limit 
value

Current 
value

Upper limit 
value

Lower limit 
value

Current value

Lower 
limit 
value

Upper limit 
value

Current 
value

Upper limit 
value

Lower 
limit 
valueCurrent 

value

Upper 
limit 
value

Lower limit 
value

Current 
value

Standard 
value

Standard 
Value

Standard 
value

Standard 
value

Standard 
value

Standard 
value

Standard 
value
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Detail

Item Description

Coordinates
Start X/Start Y Specify the placement coordinates.

(Coordinates at top left of part)
Width/Height Specify the width and height of the part.

Others

Process Cycle Specify the process cycle of the part.
Add animation effect to 
area/indicator

Draw changes in the graph display over the 
time specified for [Animation Interval].

Example: Animation interval: 200 msec
Current value changes from 
20 to 80Animation Interval Set the drawing speed of changes in the 

graph display.

ID Set the ID.

0

2080

Increase on graph occurs over 
200 msec
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9.3 Closed Area Graphs
9.3.1 Overview

• Changes to data in a closed area, such as a tank, can be expressed on a closed area graph.

• When data in a device memory exceeds or falls short of the range specified, the graph color can be changed.

• As shown below, it is possible to display a bar graph in several colors.

For setting examples, refer to “Displaying Current Values” page 9-22.

For setting examples, refer to “Displaying Current Values” page 9-22.

For setting examples, refer to “Displaying Current Values” page 9-22.

1234
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9.3.2 Setting Examples
Displaying Current Values
The current value of a device memory within the range of the minimum and maximum values can be displayed.

1. Click [Parts] → [Graph] → [Closed Area Graph] and place a closed area graph on the screen.

2. Double-click on the closed area graph to display the settings window.
Configure the [Contents] settings as shown below.
• Set the device memory address to display on the graph with [Current Value] → [Device].
• Specify the graph display area using [Display Range].

.................
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3. Configure the following settings for [Style] and then click [Finish].
To change the graph color depending on the value, proceed to step 4.

4. Configure the [Alarm] settings to change the graph color depending on the value.
In this case, color settings set for [Style] are disabled.

5. Set the following to display the graph using the different colors for different value ranges.

This completes the necessary settings.
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9.3.3 Detailed Settings
Displayed Information

Style

Item Description

Current 
Value

Device Specify the device memory address to monitor as a graph.
Input Type
(DEC- / BCD, Real 
Number)

Select the data format of device memory values.
The selection here also applies to the values of [Display Range] and [Alarm].

* When [DEC-/BCD] is selected, the setting at [Code: DEC/BCD] under [Communication Setting] in 
the [PLC Properties] window accessible via [System Setting] → [Hardware Setting] takes effect.

Data Length
(1-Word, 2-Word)

Select data length of the device memory.

Display 
Range

Direction
(UP, DW, LFT, RGT)

Set the direction to draw graph lines.

Minimum/Maximum Specify the minimum and maximum values for the range of the graph.
If the display range is variable, select a device memory. If the display range is fixed, specify a constant.

Item Description
Select from catalogs Type

Set the part design.
Color

Set the part color.
Select from image files Load a PNG file.
Data Color Set the graph color from the minimum value to the device memory value.

* If [Alarm] is configured, this is disabled.
Display Area Color Set the color inside the graph area.
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Alarm

Examples of graphs with alarm settings

Item Description
Use alarm display Change the colors of the graph according to the device memory value.

The color settings are implemented in the area settings.

Area Setting Upper Limit/Area within the 
Range/Lower Limit

Set the range for alarm display and each corresponding color.

Display Setting Display in separate colors Display each alarm color separately on a single graph.

Lower 
limit 
color

Current 
value

Lower 
limit value

Upper 
limit value

Within 
range 
color

Upper 
limit 
color

Area 
color

[Direction] set to UP

• Single color use

• Separate color use

Upper 
limit value
Current 
value
Lower 
limit value

Upper limit value
Current value

Lower limit value

Current 
value

Lower 
limit value

Upper 
limit value

Upper 
limit value
Current 
value
Lower 
limit value

Upper limit value
Current value

Lower limit value
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Detail

Item Description

Coordinates
Start X/Start Y Specify the placement coordinates.

(Coordinates at top left of part)
Width/Height Specify the width and height of the part.

Others
Process Cycle Specify the process cycle of the part.
ID Set the ID.
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9.4 Panel Meter
9.4.1 Overview

• Data in a device memory can be expressed in the form of an analog meter.
The indicator can be selected to move in either the clockwise or counterclockwise direction.

• Alarm display
- Location used for alarms: indicator

When data in the device memory exceeds or falls short of the range specified, the indicator 
color changes to show the status.

- Location used for alarms: Area
When divisions are made in the alarm range, these divisions can be colored separately. Division into a maximum of 16 
sections is allowed.
Note that the color of the indicator does not change according to the alarm condition.

Example: No. of divisions: 3

• Extended indicator/scale settings
The design of the scale or indicator can be changed using a PNG file prepared by the user.

• Numerical data display
The current data can be displayed on the panel meter in numerical format.

Example: When “8” is set in the device memory address D100

For setting examples, refer to “Displaying Current Values” page 9-28.

For setting examples, refer to “Displaying Current Values” page 9-28.

For setting examples, refer to “Displaying Current Values” page 9-28.

For setting examples, refer to “Using Image Files for the Indicator and Scale” page 9-43.
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9.4.2 Setting Examples
Displaying Current Values
The current value of a device memory within the range of the minimum and maximum values can be displayed.

1. Click [Parts] → [Graph] → [Panel Meter] and place a panel meter on the screen.

2. Double-click on the panel meter to display the settings window.
Configure the [Contents] settings as shown below.
• Set the device memory address to display on the panel meter with [Current Value] → [Device].
• Select the direction of indicator movement with [Operation Setting] → [Progress Direction].
• Specify the graph display area using [Display Setting] → [Range].

.................
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3. Configure the following settings for [Style] and then click [Finish].
• Set the meter shape and color on the [Design] → [Meter] tab.
• Set the indicator shape and color on the [Design] → [Indicator] tab.
• Set the scale shape and color on the [Design] → [Scale] tab.
To change the panel meter color depending on the value, proceed to step 4.

4. Configure the [Alarm] settings to change the indicator and meter color depending on the value.
- When [Indicator] is selected for [Alarm Setting] → [Alarm Color Target]

Set the three colors of the indicator, two colors of the meter area, and range. In this case, color settings set on the 
[Meter] and [Indicator] tabs in the [Style] settings are disabled.
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- When [Area] is selected for [Alarm Setting] → [Alarm Color Target]
Set the color of the meter area and the range. (Up to 16 divisions)
In this case, color settings set on the [Meter] tab in the [Style] settings are disabled.

This completes the necessary settings.
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9.4.3 Detailed Settings
Contents

Item Description

Current 
Value

Device Specify the device memory address to monitor.
Input Type
(DEC- / BCD, Real Number)

Select the data format of device memory values.
The selection here also applies to the values of [Range] and [Alarm].

* When [DEC-/BCD] is selected, the setting at [Code: DEC/BCD] under [Communication 
Setting] in the [PLC Properties] window accessible via [System Setting] → [Hardware 
Setting] takes effect.

Data Length
(1-Word, 2-Word)

Select data length of the device memory.

Operation 
Setting

Progress Direction
(Clockwise, 
Counterclockwise)

Select the direction of indicator movement.

Display 
Setting

Target Value Display a line at the position of the target value on the panel meter.
* If the minimum value of the range is set, a line is not displayed.
* If [Alarm] is configured, the [Standard Value] or [Target Value] setting is disabled.

Range
(Maximum, Minimum)

Specify the minimum and maximum values for the display range of the panel meter.
If the display range is variable, select a device memory. If the display range is fixed, specify a 
constant.
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Style

Item Description

Design

Select from catalogs Type
Set the part design.

Color
Set the part color.

Select from image files Load an image file.
Meter Set the color and size of the meter. For details, refer to “Meter” page 9-33.
Indicator Set the color and size of the indicator. For details, refer to “Indicator” page 9-34.
Scaling Set the color, size, and number of divisions for the scale. For details, refer to “Scaling” 

page 9-35.
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Meter

Item Description
Full, Quarter, Half Select the shape of the meter.
Color Set the color of the meter.
Target Value Set the color of the line displayed for the target value.

* If [Alarm] is configured, this is disabled.
Display a frame around Select this checkbox to display a frame around the 

meter.
When this checkbox is selected, the frame color can 
be set.

Frame Set the frame color for the meter.
Customize the size Set the meter to an arbitrary size.

Start Angle Set the start position of the meter. Example: [Start Angle]: 180, [End Angle]: 0
End Angle Set the end position of the meter.

Outer Radius The meter comprises the area between the outside 
and inside circles.
The meter width can be adjusted with the outside 
circle and inside circle radii.

Inner Radius

Meter
Target Value

Frame

* The panel meter area is the area circularly 
enclosed from the start angle to the end angle 
in the clockwise direction.

Hole
Outer circle

Hole radius
Outer circle

radius
* The inner circle must be set.

The minimum radius of the inner circle is 10 
pixels. The minimum difference between the 
radii of the outer and inner circles is 3 pixels.
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Indicator

Item Description
Color Set the indicator color.

* If [Alarm Color Target] is set to [Indicator] in the [Alarm] settings, this is disabled.
Enable indicator extended settings Select this checkbox to specify the indicator’s design.
Select an image file Select this checkbox to use an image file as the indicator.

Select Select an image file to display as the indicator.
Size Setting Width Change the width of the image file.

Height Change the height of the image file.
Fix aspect ratio Enlarge/reduce the image file with the width and height bound to a fixed aspect ratio.

Position 
Setting

Base Point X Adjust the horizontal position of the 
indicator image.

* The indicator rotates around the 
point specified for [Panel Meter 
Center Point].

Base Point Y Adjust the vertical position of the indicator 
image.

Panel Meter 
Center Point

Displays the coordinates of the panel meter 
center point.

Default Restore the base position of the indicator 
image (center bottom edge of the image file) 
to the center coordinates of the panel meter.

Length Set the length of the indicator in pixels.
(Maximum: Radius of the panel meter; 
Minimum : 1)

Top Select the shape of the indicator tip.

End Select the shape of the indicator base.

Base point

Top End

Indicator length
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Scaling

Item Description
Display the scale Select this checkbox to display a scale on the panel meter.
Select from image files Select this checkbox to use an image file as the scale.

Select Select an image file to display as the scale.
Size Setting Width Change the width of the image file.

Height Change the height of the image file.
Fix aspect ratio Enlarge/reduce the image file with the width and height bound to a fixed aspect ratio.

Position 
Setting

Base Point X Adjust the horizontal position of the scale 
image.

Base Point Y Adjust the vertical position of the scale 
image.

Panel Meter 
Center Point

Displays the coordinates of the panel meter 
center point.

Default Restore the base position of the scale image 
(center of the image file) to the center 
coordinates of the panel meter.

Color Set the scale color.
Radius Set the scale size.

Display the scale primary axis Select this checkbox to display the primary axis on the scale.

Base point

Scaling

Scale radius

No primary axisWith primary axis
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Direction Outside Display tick marks on the outside of the 
primary axis.

Inside Display tick marks on the inside of the 
primary axis.

Major 
scale

Divisions
 (1 - 255)

Set the number of divisions on the major 
scale across the entire scale.

Example: Major scale divisions: 8
Minor scale divisions: 5

 

Length
 (1 - 16)

Set the length of the major scale.
* If using the minor scale, the length 

increases and decreases by 2.
Minor scale Select this checkbox to divide the major 

scale by the minor scale.
* The length of the minor scale is half of 

the major scale.
Divisions
 (1 - 16)

Set the number of divisions across the major 
scale.

Display the scale according to the display 
range

This is only available for parts that correspond to a numerical display.
An optimal scale is displayed according to the minimum and maximum of the value in the 
range.

This setting is only available when the minimum and maximum values are specified with 
constants. Display numerical values on the scale according to the display range of the panel 
meter.

Item Description

Minor scale

Number of 
divisions for 
minor scale

Major scale



9.4    Panel Meter

9-37

1

2

3

4

5

6

7

8

9

10

Alarm
Alarm color target: indicator

Item Description
Use alarm display Select this checkbox to use the alarm function.
Alarm 
Setting

Alarm Color 
Target

Indicator The indicator color is displayed using three alarm colors according to the upper and 
lower limit values.
The meter is displayed using the two colors for within the range of the upper and lower 
limits, and outside of the range.

Area The meter color can be divided into a maximum of 16 colors according to the [Alarm 
Area] settings.
The indicator color is fixed.
For details on settings, refer to “Alarm color target: area” page 9-38.

Area Setting Upper Value Set the color of the meter for the upper limit value and outside the range of the upper 
and lower limits of the alarm display.

Area within the Range Set the within range color.
Lower Value Set the color of the meter for the lower limit value and outside the range of the upper 

and lower limits of the alarm display.
Indicator Color 
Setting

Upper Limit 
Area

Set the indicator color when the current value exceeds the upper limit value.

Area within the 
Range

Set the indicator color when the current value is within the range of the upper and lower 
limits.

Lower Limit 
Area

Set the indicator color when the current value is less than the lower limit value.
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Alarm color target: area

Item Description
Use alarm display Select this checkbox to use the alarm function.
Alarm 
Setting

Alarm Color 
Target

Indicator The indicator color is displayed using three alarm colors according to the upper and lower 
limit values.
The meter is displayed using the two colors for within the range of the upper and lower limits, 
and outside of the range.
For details on settings, refer to “Alarm color target: indicator” page 9-37.

Area The meter color can be divided into a maximum of 16 colors according to the [Alarm Area] 
settings.
The indicator color is fixed.

Normal Area Area within the Range Specify the color of the area not included 
in the alarm range in the display range of 
the panel meter.

Alarm Area Division Set the number of alarm areas.
No. 0 - 15 Lower 

Value
Set the lower limit value of the alarm area.

Upper 
Value

Set the upper limit value of the alarm 
area.

Color Set the display color of the alarm area.
* Drawing is performed in order from “Data 0 

property” to “Data 15 property”. 
When a range overlaps with another when 
drawn, the color of the data property with 
the higher number is displayed in the 
foreground.

Alarm Area
No. 1

Alarm Area
No. 0

Alarm Area
No. 2

Alarm Area
No. 3

Example: Divisions: 4, clockwise
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Num. Display
A panel meter can be set with a numerical data display to show the current value.

Contents

Item Description
Use a numerical data display Select this checkbox to display a numerical data display within the panel meter.

Contents Specify the display format, number of digits, and number of decimal places for the numerical data display. 
For details, refer to “Contents” page 9-39.

Style Specify the design of the numerical data display. For details, refer to “Style” page 9-40.
Char. Prop. Set a text color and size for the numeric data display. For details, refer to “Char. prop.” page 9-41.
Display 
Position

Specify the display position of the numerical data display. For details, refer to “Position” page 9-41.

Item Description
Display Set the numerical value format.
Digit Set the number of digits for the numerical data display.
Decimal Point Set the number of decimal places. When no decimal point is required, set “0”.
Auto-adjust the area 
according to the number of 
digits

Select this checkbox to automatically adjust the item size based on the [Digit] and [Decimal Point] settings.
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Style

Item Description
Area Setting Select from catalogs Select the design of the numerical data display part to use from the parts catalog.

Type
Select the design of the numerical data display part.

Color
Set the color of the numerical data display part.

Select from image files Select the design of the numerical data display part from an image file.
Select Select the image file to use.
Width Change the width of the image file.
Height Change the height of the image file.
Fix aspect ratio Enlarge/reduce the image file with the width and height bound to a fixed aspect 

ratio.
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Char. prop.

Position

Item Description
Color Set the text color.
Background Set the background color of the numerical data display area.
Style Set the text style.
Character Size Set the text size.

* This changes to point specification when using a Windows font or 7-segment font.
Rotation + Set the orientation of text.

* This cannot be set when using a Windows font.
Spacing To set a text spacing, select this checkbox and specify a spacing.

* This cannot be set when using a Windows font.
Zero Suppress To set zero suppression, select this checkbox and select flush left or flush right.
System Font
Windows Font
7-segment Font

Select the font of the numerical data display.

Display light-out segments This setting is available when [7-segment Font] is selected.
Select this checkbox to display unlit segments.

Item Description
Base X Adjust the horizontal position of the numerical data display.
Base Y Adjust the vertical position of the numerical data display.
Panel Meter Center Point Displays the coordinates of the panel meter center point.
Default Restore the base position of the numerical data display (center 

of the item) to the center coordinates of the panel meter.

1234
Base point
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Detail

Item Description

Coordinates
Start X/Start Y Specify the placement coordinates.

(Coordinates at top left of part)
Width/Height Specify the width and height of the part.

Others

Process Cycle Specify the process cycle of the part.
Add animation effect to 
area/indicator

Draw changes in the graph display over the 
time specified for [Animation Interval].

Example: Animation interval: 200 msec
Current value changes from 
100 to 300.Animation Interval Set the drawing speed of changes in the graph 

display.

ID Set the ID.

50

100

150

200
250

300

350

400

450
Indicator movement occurs over 
200 msec.
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Using Image Files for the Indicator and Scale
An image file created by the user can be used for the part design (background, indicator, and scale).

[Style]

Item Description
Select from images files
(background/indicator/scale)

Select a PNG file from the desired folder.
The selected PNG file is stored at “.\MONITOUCH\User\Parts”.

Width, Height Change the width and height of the imported PNG file.
Fix aspect ratio Select this checkbox to use a fixed width-to-height ratio when changing the size of the PNG file.
Panel Meter Center Point Displays the coordinate values of the panel meter (circle) center point.

Base Point X/Base Point Y Specify the X and Y coordinate values of the base point in pixels to adjust the position of the indicator or 
scale.
The indicator rotates around the [Panel Meter Center Point].

Default Restore the X and Y coordinate values of the base point to those specified for [Panel Meter Center Point].

ScalingBackground / Indicator

Background

Indicator

N

S

EW

(0, 0)

Panel meter center point

Indicator

Base point

Scaling
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Setting procedure
This section explains the procedure for importing a PNG file into the panel meter.

1. Place a panel meter on the screen.

2. Import a background image for the panel meter.
Select the [Style] → [Design] → [Select from image files] radio button in the settings window and click the [Select] button 
to select an image file (e.g. back_A.png).

ScalingBackground of the panel meter Indicator

scale_A.pngback_A.png pin_A.png

Background of the panel meter
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3. Select the [Style] → [Meter] → [Detail Settings] in the settings window to enlarge or reduce the size using the [Outer 
Radius] and [Inner Radius] values.

4. Import a PNG image for the indicator.
Select the [Style] → [Indicator] → [Select an image file] checkbox in the settings window and click the [Select] button to 
select an image file (e.g. pin_A.png).

* The PNG image of the indicator is imported while it is pointing upward with reference to the panel meter center 
point. The indicator cannot be rotated on the editor.

5. Move the indicator part downward by specifying values for [Base Point X] and [Base Point Y] on the [Style] → [Indicator] 
tab.
The indicator can be enlarged or reduced by specifying values for [Width] and [Height].

* The indicator rotates around the panel meter center point.

Graph area

Indicator

Indicator base point X and Y (panel meter center coordinates)

Indicator base point X, Y

Panel Meter Center Point
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6. Import a PNG image of the scale.
Select the [Style] → [Scale] → [Display the scale] → [Select an image file] checkbox in the settings window and click the 
[Select] button to select an image file (e.g. scale_A.png).

7. Specify values for [Width] and [Height] on the [Style] → [Scale] tab to reduce the size of the scale.
The position of the scale can be moved by specifying values for [Base Point X] and [Base Point Y].

This completes the necessary settings.

Restrictions
• The order of drawing is shown below. Drawing is performed in ascending order.

* When a draw item edited in the [Modify Part] window is placed on a 3D panel meter part, the item is placed over the 
panel meter.

• The numerical data display is displayed even when a value falls outside the range specified for [Scale] (specified at 
[Contents] → [Range]).
However, if the number of digits exceeds the specified value, “---” is displayed.

Scaling

0

5

10

15
20

25

30

35

40

8

1. Part area *

3. Scale

2. Alarm

4. Indicator

5. Numerical data display

Panel meter structure
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9.5 Statistic Bar Graph
9.5.1 Overview

• Percentages of data contained in consecutive device memory addresses can be expressed on a graph.
One statistic bar graph can be divided into a maximum of eight sections.

• It is also possible to indicate percentages as numerical values for the statistic bar graph.
In this case, the statistic bar graph must be linked to a numerical data display.

For setting examples, refer to “Displaying a Bar Graph of the Ratio of D100 to D104 Values” page 9-48.

For setting examples, refer to “Displaying a Numerical Data Display of the Ratio of D100 to D104 
Values” page 9-49.

15%
25%
20%
10%
30%

% display

Statistic bar graph Numerical data display
Linked



9  Graph Display

9-48

9.5.2 Setting Examples
Displaying a Bar Graph of the Ratio of D100 to D104 Values
The following example shows how to display the ratio between the values of five device memory addresses on a bar graph.

1. Click [Parts] → [Graph] → [Statistic Bar Graph] and place a statistic bar graph on the screen.

2. Double-click on the statistic bar-graph to display the settings window.
Configure the [Contents] settings as shown below.
• Set the top device memory address to display on the graph with [Top Data] → [Device].
• Set the number of device memory addresses to display on the graph with [Display Setting] → [Number of Data to 

Display].
• Set the color of each device memory on the graph display with [Display Setting] → [Color Setting for Data].

This completes the necessary settings.

.....

3500
500
2000
3000
1000

D100
D101
D102
D103
D104

.....

D104

D103

D102
D101

D100
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Displaying a Numerical Data Display of the Ratio of D100 to D104 
Values
The following example shows how to display the ratio between the device memory addresses displayed on the statistic bar 
graph on a numerical data display.

1. Click [Parts] → [Graph] → [Statistic Bar Graph] and place a statistic bar graph on the screen.

2. Double-click on the statistic bar-graph to display the settings window.
Select [Num. Display] under [Add Parts] in the [Style] settings.

D104

D103

D102
D101

D100

10
30
20
5

35

%
%
%
%
%

Ratio display
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3. The settings window for the numerical data display is displayed. Select [Statistic Graph % Display] for [Function] and 
specify a value for [Statistic Graph No.]. Click [Finish] to close the settings window of the numerical data display.

4. Repeat steps 2. and 3. to place multiple numerical data displays.

This completes the necessary settings.
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9.5.3 Detailed Settings
Contents

Style

Item Description

Data 
Setting

Top Data Device Set the top device memory address to display on the statistic graph.
The required device memory are automatically allocated to the statistic graph.

* The data format relies on the setting at [Code: DEC/BCD] under [Communication 
Setting] in the [PLC Properties] window accessible via [System Setting] → 
[Hardware Setting].

Data Length
(1-Word, 2-Word)

Select data length of the device memory.

Display 
Setting

Number of Data to 
Display

Set the number of device memory to display on the statistic graph.

Color Setting for 
Data

Set the color for each data memory displayed on the statistic graph.

Item Description
Select from catalogs Type

Set the part design.
Color

Set the part color.
Select an image file Load an image file.
Frame Color Set the color of the frame around the graph area.
Additional Parts List Statistic Graph % Display Add [Statistic Graph % Display].
Add Parts Num. Display Add a numerical data display part.
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Detail

Item Description

Coordinates
Start X/Start Y Specify the placement coordinates.

(Coordinates at top left of part)
Width/Height Specify the width and height of the part.

Others
Process Cycle Specify the process cycle of the part.
ID Set the ID.
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9.6 Statistic Pie Graph
9.6.1 Overview

• Percentages of data contained in consecutive device memory addresses can be expressed on a graph.
One statistic pie graph can be divided into a maximum of eight sections.

• It is also possible to indicate percentages as numerical values for the statistic pie graph.
In this case, the statistic pie graph must be linked to a numerical data display.

For setting examples, refer to “Displaying a Pie Graph of the Ratio of D100 to D103 Values” page 9-54.

For setting examples, refer to “Displaying a Numerical Data Display of the Ratio of D100 to D103 
Values” page 9-55.

25%
12%
50%
13%

% display

Statistic pie graph Numerical data display
Linked
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9.6.2 Setting Examples
Displaying a Pie Graph of the Ratio of D100 to D103 Values
The following example shows how to display the ratio between the values of four device memory addresses on a pie graph.

1. Click [Parts] → [Graph] → [Statistic Pie Graph] and place a statistic pie graph on the screen.

2. Double-click on the statistic pie graph to display the settings window.
Configure the [Contents] settings as shown below.
• Set the top device memory address to display on the graph with [Top Data] → [Device].
• Set the number of device memory addresses to display on the graph with [Display Setting] → [Number of Data to 

Display].
• Set the color of each device memory address on the graph display with [Display Setting] → [Color Setting for Data].

This completes the necessary settings.

.....

2500
1250
5000
1250

D100
D101
D102
D103

..........

D103

D102

D101

D100
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Displaying a Numerical Data Display of the Ratio of D100 to D103 
Values
The following example shows how to display the ratio between the device memory addresses displayed on the statistic pie 
graph on a numerical data display.

1. Click [Parts] → [Graph] → [Statistic Pie Graph] and place a statistic pie graph on the screen.

2. Double-click on the statistic pie graph to display the settings window.
Select [Num. Display] under [Add Parts] in the [Style] settings.

25
15
50
15

%
%
%
%

D103

D102

D101

D100
Ratio display
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3. The settings window for the numerical data display is displayed. Select [Statistic Graph % Display] for [Function] and 
specify a value for [Statistic Graph No.]. Click [Finish] to close the settings window of the numerical data display.

4. Repeat steps 2. and 3. to place multiple numerical data displays.

This completes the necessary settings.
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9.6.3 Detailed Settings
Contents

Style

Item Description

Data 
Setting

Top Data Device Set the top device memory address to display on the statistic graph.
The required device memory are automatically allocated to the statistic graph.

* The data format relies on the setting at [Code: DEC/BCD] under [Communication 
Setting] in the [PLC Properties] window accessible via [System Setting] → 
[Hardware Setting].

Data Length
(1-Word, 2-Word)

Select data length of the device memory.

Display 
Setting

Number of Data to 
Display

Set the number of devices to display on the statistic graph.

Color Setting for 
Data

Set the color for each data displayed on the statistic graph.

Item Description
Select from catalogs Type

Set the part design.
Color

Set the part color.
Select an image file Load an image file.
Frame Color Set the color of the frame around the graph area.
Additional Parts List Statistic Graph % Display Add [Statistic Graph % Display].
Add Parts Num. Display Add a numerical data display part.
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Detail

Item Description

Coordinates
Start X/Start Y Specify the placement coordinates.

(Coordinates at top left of part)
Width/Height Specify the width and height of the part.

Others
Process Cycle Specify the process cycle of the part.
ID Set the ID.



10 Calendar

10.1 Overview

10.2 Time Display

10.3 Calendar

10.4 Calendar Data Correction





10.1    Overview

10-1

11

2

3

4

5

6

7

8

9

10

10.1 Overview
• The calendar part is used to show the year, month, day, hour, minute, second, and day of the week on the screen.

• The calendar range of V10/V9 is as follows.

* When the power is turned on immediately after purchase (before communication with a PLC with a calendar function and 
before using the built-in calendar of the V10/V9 series).

• Depending on the calendar data to be used, the setting and correction methods vary. Refer to the following table.

*1 PLC calendar: Calendar that the PLC retains in the CPU
Because a maximum of 8-way communication is possible on the V10/V9 series, the PLC calendar data to be read must be determined.
This can be configured using the [Calendar] setting at [System Setting] → [Hardware Setting] → [Control Area]. When [PLC Selection] is 
set to [PLC1], the calendar of PLC1 is read; when [PLC Selection] is set to [PLC3], the calendar of PLC3 is read.
However, if the PLC specified for [PLC Selection] is not equipped with a built-in calendar, it is regarded as “no calendar”.

*2 V10/V9 series calendar: Calendar on the V10/V9 series unit
*3 User format: Calendar in the user-defined format created in the PLC

Immediately after 
purchase * Displayable calendar range during RUN Local Mode calendar setting range

V10 2023/4/1  9:00:00 2012/1/1  00:00:00 to 2111/12/31  23:59:59 2012/1/1 00:00:00 to 2111/12/31 23:59:59
V9 2014/4/1  9:00:00 1970/1/1 00:00:00 to 2038/1/18 23:59:59 2012/1/1 00:00:00 to 2038/1/18 23:59:59

PLC Calendar *1 V10/V9 Series Calendar *2 User Format *3

Part • Time display
• Calendar

• Time display
• Calendar

• Time display

Required Settings Connected device settings *1
[Calendar]

and
SRAM/clock settings *4
Built-in clock not used

SRAM/clock settings *4 Time display format setting

At Power ON
or
Local → RUN

The PLC calendar *1 is automatically 
read and displayed.

The V10/V9 series calendar is 
displayed.

Data in the device memory set for the 
time display part is read and 
displayed.

RUN Mode V10/V9 series CPU clock V10/V9 series CPU clock
Auto Correction The PLC calendar *1 is automatically 

read at 1:23:45 a.m *6. − −

Correction Calendar read device memory bit ON
or

Macro:
SET_CLND ............... PLC1
PLC_CLND *5 .......... PLC2 - 8

Local mode screen 
or

Macro: SET_SYS_CLND −

Backup at Power 
OFF

2023/4/21  10:15:20
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*4 SRAM/Clock Setting
Always set this option when using the built-in calendar in the V10/V9 series unit.

• Select [System Setting] → [Unit Setting] → [SRAM/Clock] and select the [Use SRAM Calendar] checkbox.
• Always install a backup battery.

*5 In the case of PLC2 to PLC8, calendar correction is performed by the execution of macro commands “PLC_CLND” and “SYS 
(SET_SYS_CLND)”.
When the bit of the device set for calendar reading is turned ON, the calendar data of the PLC specified for [Calendar] will be read as 
explained in *1.

*6 The calendar data is automatically loaded once a day when the date changes. MONITOUCH recognizes the date change (00:00:00 AM), 
and then reads calendar data at 01:23:45 AM. However, if MONITOUCH reads calendar data by using the calendar read device memory or 
macro commands between 00:00:00 AM and 01:23:44 AM, MONITOUCH does not read the calendar data at 01:23:45 AM.
Upon date change (AM00:00:00) when the V9 Series system version is 1.160 or earlier.

For details on batteries, refer to the Hardware Specifications Manual.

For details, refer to the Macro Reference Manual.
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10.2 Time Display
10.2.1 Overview

• Displays the PLC clock.

• Displays the V10/V9 series unit clock.

• Displays the values of consecutive device memory addresses as the time.

• Displays the seconds data stored in device memory in timer format.

For setting examples, refer to “Displaying the PLC Calendar” page 10-4.

For setting examples, refer to “Displaying the Built-in V10/V9 Series Calendar” page 10-6.

For setting examples, refer to “Display Using the Time Display Format Setting” page 10-8.

For setting examples, refer to “Displaying Seconds Data Stored in Device Memory in Timer Format” 
page 10-10.

2014/ 4/21
10:15:20

2014/ 4/21 10:15:20

2014/ 4/21 10:15:20

2014/ 4/21
10:15:20

Built-in V10/V9 
series calendar

Show

2014/ 4/21 10:15:20

...

14
4

21
10
15

D100
D101
D102
D103
D104

.........

20D105

1:20:50

.................

4250
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10.2.2 Setting Examples
Displaying the PLC Calendar
Display the PLC’s built-in calendar on the V10/V9 series unit.

1. Click [System Setting] → [Hardware Setting] → [Control Area].

2. Set the PLC to use at [PLC Selection] under [Calendar Setting].

2014/ 4/21
10:15:20

2014/ 4/21 10:15:20
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3. Click [System Setting] → [Unit Setting] → [SRAM/Clock] and deselect the [Use SRAM Calendar] checkbox.

4. Click [Parts] → [Time Display] → [Time Display] and place a time display part.

5. Double-click on the time display part to display the settings window.
Configure the [Contents] settings as shown below.
• Select [Type] → [Display the system calendar].
• Specify the format of the date and time under [Display Format].

This completes the necessary settings.
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Displaying the Built-in V10/V9 Series Calendar
The following example shows how to display the built-in V10/V9 series calendar.

1. Click [System Setting] → [Unit Setting] → [SRAM/Clock] and select the [Use SRAM Calendar] checkbox.

2. Click [Parts] → [Time Display] → [Time Display] and place a time display part.

2014/ 4/21 10:15:20

2014/ 4/21
10:15:20

Built-in V10/V9 
series calendar

Show
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3. Double-click on the time display part to display the settings window.
Configure the [Contents] settings as shown below.
• Select [Type] → [Display the system calendar].
• Specify the format of the date and time under [Display Format].

This completes the necessary settings.
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Display Using the Time Display Format Setting

1. Click [Parts] → [Time Display] → [Time Display] and place a time display part.

2. Double-click on the time display part to display the settings window.
Configure the [Contents] settings as shown below.
• Select [Type] → [Display the value of the designated device].
• Select [Display Mode] → [Time Display].
• Specify the top device memory address to use for time display with [Device Designation].
• Specify the display format of the date and time under [Display Format].

2014/ 4/21 10:15:20

...

14
4

21
10
15

D100
D101
D102
D103
D104

.........

20D105
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3. Specify the format of the data to read with [Time Display Format Setting].
Example 1: Read Word Count: 6

Data Unit: Word
Code Type: BCD
0000: Year
0001: Month
0002: Day
0003: Hour
0004: Minute
0005: Sec

Example 2: Read Word Count: 3
Data Unit: Byte
Code Type: BCD
0000: Year Month
0001: Day Hour
0002: Minute Sec

This completes the necessary settings.

2014/ 4/21 10:15:20

...

14
4

21
10
15

D100
D101
D102
D103
D104

.........
20D105

2014/ 4/21 10:15:20

...
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Displaying Seconds Data Stored in Device Memory in Timer Format
The following example shows how to display the seconds data stored in device memory in timer format on a V10/V9 series 
unit.

1. Click [Parts] → [Time Display] → [Time Display] and place a time display part.

2. Double-click on the time display part to display the settings window.
Configure the [Contents] settings as shown below.
• Select [Type] → [Display the value of the designated device].
• Select [Display Mode] → [Timer Display].
• Specify the device memory address for storing the seconds data with [Device Designation].
• Specify the display format of the time under [Display Format].

This completes the necessary settings.

1:20:50

.................

4250
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10.2.3 Detailed Settings
Contents

Item Description

Data to 
Display

Type
Display the system calendar

Use data from the PLC calendar, V10/V9 series calendar, or calendar device 
memory. The display format can be set freely and the character size enlarged 
or reduced easily.

Display the value of the 
designated device

Use a user-formatted calendar.
Display the values of consecutive device memory addresses as the calendar.

Display 
Mode

Time Display
This setting is available when “Display the value of the designated device” is 
selected for [Type].
Display the values of consecutive device memory addresses as the calendar.

Timer Display
This setting is available when “Display the value of the designated device” is 
selected for [Type].
Display the seconds data stored in device memory in timer format.

Device Designation
This setting is available when “Display the value of the designated device” is 
selected for [Type].
Specify the top address of the device memory for reading.

Time display format setting
This setting is available when “Display the value of the designated device” is 
selected for [Type].
Set the calendar data format.
For details, refer to “Time display format setting” page 10-12.

Display 
Format

Date Select this checkbox to display the date.
Set the date display format.

Year Digits Set the number of digits used to express the year.
Zero Suppress for Year Specify whether to use zero suppression for the year.
Zero Suppress for Month-Day Specify whether to use zero suppression for the month and day.

Time Select this checkbox to display the time.
Set the time display format.
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Time display format setting

*1 Device memory allocation for each data unit
• Word

• Byte

Item Description

Specify Format Select this checkbox if [Data Display] → [Type] → [Display the value of the designated device] is 
selected and [Display Mode] is set to [Time Display].

Read Word Count
(1 - 6)

Data for the number of words to be read starting at [Device Designation] are read as the calendar 
data.

Data Unit *1
(Word, Byte)

Select [Word] or [Byte] for data unit when reading data from the PLC.

Code Type
(BCD/DEC)

Select the code to be used at the time of reading data from the PLC.

0000 - 0005 Specify the contents of data for each device memory address.

0000
0005

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

− − − − − −

Year (00 to 99)
Month (1 to 12)
Day (1 to 31)
Hour (0 to 23)
Minute (0 to 59)
Second (0 to 59)

0000
0005

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

Year (00 to 99)
Month (1 to 12)
Day (1 to 31)
Hour (0 to 23)
Minute (0 to 59)
Second (0 to 59)
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Character Properties

Detail

Item Description
Color Set the text color and area background color.
Style Set the text style.

Character Size Set the text size.
This changes to point specification when using a Windows font or 7-segment font.

1-byte / 2-byte Select one-byte or two-byte display.

Rotation + Direction Set the orientation of text.
This cannot be set when using a Windows font.

Spacing To set a text spacing, select this checkbox and specify a spacing.
This cannot be set when using a Windows font.

System Font
Windows Font
7-segment Font

Select the font of the numerical data display.

Display light-out segments This setting is available when [7-segment Font] is selected.
Select this checkbox to display unlit segments.

Item Description

Coordinates Start X/Start Y Specify the placement coordinates.
(Coordinates at bottom left of part)

Others
Process Cycle Set the process cycle.
ID Set the ID.
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10.3 Calendar
10.3.1 Detailed Settings

Style

Contents

Item Description

Area Setting
Select from catalogs

Type
Set the part design.

Color
Set the part color.

Select from image files Load an image file.

Item Description

Display 
Format

Item to 
Display

Set the items to display on the calendar.
The year in Western calendar format and the hour (0 to 24) are displayed.

Year Month Day Hour Minute Second
Year Month Day
Hour Minute Second
User format

Select the checkbox of the items to display from year, month, day, hour, minute, and second.

Year
Select either two digits or four digits to indicate the year.
Display example:
Two digits indicate the year 2014 as “14”, and four digits as “2014”.

Display days of the week Register the display names of each day of the week.
A maximum 13 one-byte characters (6 two-byte characters) can be used.
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Character Properties
When [Batch edit date/time] is selected
The character properties of the year, month, day, hour, minute, and second can be set at once.

Item Description
Color Set the text color and area background color.
Style Set the text style.

Character Size Set the text size.
This changes to point specification when using a Windows font or 7-segment font.

Rotation + Direction Set the orientation of text.
This cannot be set when using a Windows font.

Spacing To set a text spacing, select this checkbox and specify a spacing.
This cannot be set when using a Windows font.

Zero Suppress Select this checkbox to use zero suppression.
1-byte / 2-byte Select one-byte or two-byte display.
System Font
Windows Font
7-segment Font

Select the font of the numerical data display.

Display light-out segments This setting is available when [7-segment Font] is selected.
Select this checkbox to display unlit segments.
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When [Edit Date/Time Individually] is selected
The character properties of the year, month, day, hour, minute, and second can be set individually.

Item Description

Year/Month/
Day/Hour/
Minute/sec

Color Set the text color and area background color.
Style Set the text style.

Rotation + Direction Set the orientation of text.
This cannot be set when using a Windows font.

Spacing To set a text spacing, select this checkbox and specify a spacing.
This cannot be set when using a Windows font.

Zero Suppress Select this checkbox to use zero suppression.
1-byte / 2-byte Select one-byte or two-byte display.

Character Size Set the text size.
This changes to point specification when using a Windows font or 7-segment font.

System Font
Windows Font
7-segment Font

Select the font of the numerical data display.

Display light-out segments This setting is available when [7-segment Font] is selected.
Select this checkbox to display unlit segments.
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Detail

Notes
• Calendar parts consist of “hour, minute, and second” parts and “year, month, and day” parts as well as two-level displays. 

Additionally, there are parts for punctuation marks like “:” and “-”.
• Calendar data is displayed in the following format on the computer.

Item Description

Coordinates
Start X/Start Y Specify the placement coordinates.

(Coordinates at top left of part)
Width/Height Specify the width and height of the part.

Others ID Set the ID.

YY or YYYY MM DD hh mm ss SUN

Year Month Day Hour Minute Second Weekday
(Displayed as registered)
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10.4 Calendar Data Correction
Calendar data that no longer displays the actual time can be corrected.
The setting method varies depending on the part selected.
Check the table of correction fields on “Overview” page 10-1 and correct the data as needed.

10.4.1 Correcting in the Control Area

PLC with Calendar Function
1. Refer to the PLC manual and correct time data in the calendar device memory of the PLC.
2. Set “0” to “1” for [Calendar Read Device] of [Control Area] set in [Hardware Setting].

The V10/V9 series will read the calendar data from the PLC.

PLC without Calendar Function
1. Set the correct calendar data for [Calendar Device] set at [Control Area] → [Other Settings].
2. Set “0” to “1” for [Calendar Read Device] of [Control Area].

The set calendar data will be read.

<Operation Example>

D4

01.04.14
9:00:002014

      4
    20
    12
    30
      0

D100
D101
D102
D103
D104
D105

20.04.14
12:30:002014

      4
    20
    12
    30
      0

D100
D101
D102
D103
D104
D105

[Calendar Device]: D100 to 106
[Calendar Read Device]: D4-0

(1) Setting data in BCD.
D100 = 2014
D101 = 4
D102 = 20
D103 = 12
D104 = 30
D105 = 0

(2) Set the D4-0 bit of the device memory set 
for calendar to ON.

Calendar readout
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10.4.2 Correcting Using a Macro
The calendar data in PLC 1 can be corrected by executing the macro command “SYS (SET_CLND)”.
1. According to the macro format, set data for “year, month, day, hour, minute, and second” correctly at the relevant device 

memory.
2. Execute the “SYS(SET_CLND)” macro command as the ON macro of a switch, etc.

The calendar data is written to PLC1.
The corrected calendar data will be read.

<Operation Example>

10.4.3 Correcting in Local Mode
Calendar data can be set on the [SRAM/Clock] screen that can be displayed in Local mode.

* Correction can only be performed when using the built-in clock.

01.04.14
10:40:00$u0

$u1
$u2
$u3
$u4
$u5

0
0
0
0
0
0

01.04.14
10:40:00$u0

$u1
$u2
$u3
$u4
$u5

2014
      4
    20
    12
      0
      0

01.04.14
10:40:00$u0

$u1
$u2
$u3
$u4
$u5

2014
      4
    20
    12
      0
      0

$u0
$u1
$u2
$u3
$u4
$u5

2014
      4
    20
    12
      0
      0

20.04.14
12:00:00

Rewrite the PLC calendar.

Calendar readout

Calendar
01.04.14
10:40:00

20.04.14
12:00:00

Macro commands “PLC_CLND” and 
“SYS(SET_SYS_CLND)” are used to correct the 
calendar data in PLC2 to PLC8.
For details, refer to the Macro Reference Manual.

(1) Set the data.
Set 20.04.14, 12:00:00.
$u0000 = 2014 (W) ← or 14(W)
$u0001 = 4 (W)
$u0002 = 20 (W)
$u0003 = 12 (W)
$u0004 = 0 (W)
$u0005 = 0 (W)

(2) Execute the macro command.
Set the calendar of PLC1, port 1 to 20.04.14 
12:00:00.

[ON Macro Edit]
SYS(SET_CLND) $u0000

For details on settings, refer to the following manuals.
- V10 Series Unit Operation / Local Mode / Error Screen Manual
- V9 Series Troubleshooting/Maintenance Manual
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11 Graphics and Animation

11.1 Graphics

11.2 Animation
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11.1 Graphics
11.1.1 Overview

A variety of pre-registered graphics can be displayed on the screen or changed based on bit activation and the graphic 
number.

The graphic display method differs depending on the [Operation Select] setting.
• Switch

Switches can be used to display or change between graphics and text registered in the graphic library.
In this case, the displayed graphics cannot be moved or transformed.

• Device (No. Designation)
A graphic number can be specified for display using the [Device (No. Designation)] setting.

The displayed graphics can be moved or transformed.
To animate or transform graphics or text, set up parameters for these items in the graphic library.
When parameters are set, the required device memory addresses are allocated for animation and transformation.
For details on the procedure for setting parameters, refer to “11.1.4 Graphic Library (Parameter Settings)” page 11-14.

Press the [- Block] 
switch.

Graphic No. 6 is displayed.Graphic No. 4 is displayed.

Press the [+ Block] 
switch.

Graphic No. 5 Graphic No. 6Graphic No. 4

D200 5

Specify “5” for D200. Graphic No. 5 is displayed.

Graphic No. 5

D201 0
0

100

D200

D202
D201

0D200

D202

The graphic moves 100 
pixels in the Y direction.

D200 = “0”
Graphic No. 0 is displayed.

Specify “100” for D202 of the 
Y coordinate device memory.

100 pixelsX coordinate
Y coordinate
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• Device (Bit Designation)
The graphics or text registered in the graphic library can be shown or hidden according to bit activation.
There are two display types.

- Type: 1-Graphic
When the bit is set to ON, the corresponding graphic is shown, and when the bit is set to OFF, the graphic is hidden.

- Type: 2-Graphic
Two graphics are assigned to one bit. When the bit is set to OFF, the OFF graphic is displayed, and when the bit is set to 
ON, the ON graphic is displayed.

• It is possible to move or transform the graphics or text set for [1-Graphic] and [2-Graphic].
To animate or transform graphics or text, set up parameters for these items in the graphic library.
When parameters are set, the required device memory addresses are allocated for animation and transformation.
For details on the procedure for setting parameters, refer to “11.1.4 Graphic Library (Parameter Settings)” page 11-14.

* The graphic mode display is possible without placing a display area part. For details, refer to page 11-7.

D200

Screen

When bit 1 of D200 is activated ...

The picture corresponding to 
bit 1 is displayed on the screen.

D200D200

Changes to the ON graphic.OFF graphic is displayed on the screen.

Screen

Bit 1 of D200 is deactivated. Bit 1 of D200 is activated.

D200 D200
D201 100

Bit 1 of D200 is activated and 
Graphic No. 0 is displayed.

The graphic moves 100 pixels in the X direction.

Specify “100” for D201 of the X 
coordinate device memory.

For the X coordinate
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11.1.2 Detailed Settings
Operation Select: Switch
Graphic Select

Style

Item Description
Min. Graphic Set the graphic with the lowest number among those to be displayed on the screen.
Max. Graphic Set the graphic with the highest number among those to be displayed on the screen.
Initial Graphic Set the initial graphic to show when the screen is displayed.

Select an initial graphic number between the minimum and maximum graphic numbers.

Item Description
Additional Parts List Select an operation switch.

Parts can be added to the list using the [Add Parts] button.
+ Block Switches to the next graphic.
− Block Switches to the previous graphic.
Block Call Switches to the specified graphic number.

The graphic number is specified via [Edit Selected Parts] → [Others].
Parts Design Set the design and color of parts.
Edit Selected Parts Configure the part selected in the [Additional Parts List] or preview pane. Part size can also be 

changed.
Adjust Position Displays the window for adjusting the placement position of each part.
Select from catalogs Set the part design from the catalog.
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Display area
The size of the display area must be changed to accommodate the graphic for display.
The position of the “OFF” mark (offset mark) of the graphic library corresponds to the upper left corner of the display area 
part on the screen. Take this position into consideration when determining the size of the display area part.

Show/Hide
Set the show and hide settings of graphic items.

Detail

For details, refer to “14 Item Show/Hide Function”.

Item Description
Coordinates Start X/Start Y Specify the coordinates of the display area.

Width/Height Set the size of the display area.
Others Process Cycle Set the cycle for the V10/V9 series to read PLC data.

ID Set an ID number.

OFF

OFF

Graphic library editing Screen editing

Display area

Offset position at the upper left 
corner of the display area
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Operation Select: Device (No. Designation)
Graphic Select

Item Description
Device Designation Specify the device memory addresses used for specifying a graphic number.

Consecutive device memory addresses are used when a parameter is specified. *1

Graphic G No. Designation Selected
Specify 0 to 9 for the graphic group number.
The graphics that can be displayed on the screen are limited to those (0 to 255) of the specified group 
number.

Unselected
All graphics corresponding to graphic group numbers 0 to 9 can be displayed.
Specify the graphic numbers using absolute addresses (0 to 2559).

No. of Parameter *1 This is required when moving or changing graphics.
Set the maximum parameter value of items registered in the graphic library.
The valid parameter number determines the number of words secured for the specified device memory 
address.
For details on parameter settings, refer to “11.1.4 Graphic Library (Parameter Settings)” page 11-14.

Device Memory Description Remarks
n Graphic No.

n+1 Parameter 1 Only with parameter specification.
n+2 Parameter 2

: :
n+63 Parameter 63

With Group No. Specification Without Group No. Specification 
(Absolute Address)

Group No. Graphic No. Group No. Graphic No.
0 0000 - 0255 (None) 0000 - 0255
1 0000 - 0255 0256 - 0511
2 0000 - 0255 0512 - 0767
3 0000 - 0255 0768 - 1023
4 0000 - 0255 1024 - 1279
5 0000 - 0255 1280 - 1535
6 0000 - 0255 1536 - 1791
7 0000 - 0255 1792 - 2047
8 0000 - 0255 2048 - 2303
9 0000 - 0255 2304 - 2559
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*1 Example of using parameters
The table below shows device memory assignment and contents when the following settings are configured.

Style

Device Memory Description Remarks
D300 Device Device memory for graphic number 

specification
D301 Parameter 1 Device memory for Center X 

coordinate specification
[Valid parameter No.] is set to “2” so two words 
are secured for use.

D302 Parameter 2 Device memory for Center Y 
coordinate specification

Item Description
Display Graphic Select the area for displaying graphics.

Display area/Base screen
Adjust Position Displays the window for adjusting the placement position of each part. Part size can also be changed.
Select from catalogs Set the part design from the catalog.

Graphics Graphics library
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Display area
• When [Display Graphic] is set to [Display area]

The offset position of the graphic library corresponds to the upper left corner of the display area part. Take this position 
into consideration when determining the size of the display area part. Refer to page 11-4.

• When [Display Graphic] is set to [Base screen]
The offset position of the graphic library corresponds to the upper left corner of the screen.

• If [Base area] for [Display Graphic] is selected and there is no display area, the previous picture may remain on the screen 
when the picture is changed.

Show/Hide
Set the show and hide settings of graphic items.

Detail

For details, refer to “14 Item Show/Hide Function”.

Item Description
Coordinates Start X/Start Y Specify the coordinates of the display area.

Width/Height Set the size of the display area.
Others Process Cycle Set the cycle for the V10/V9 series to read PLC data.

ID Set an ID number.

OFF

OFF

OFF

Graphics library Screen No. 0 Screen No. 6

Display area

OFF OFF

Graphics library Screen No. 1
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Operation Select: Device (Bit Designation)
Graphic Select

*1 Display example:
[Device Designation]: D200, [Start Graphic]: GNo. 0, No. 0, [No. of Bits to Monitor]: 12

- Type: 1-Graphic

- Type: 2-Graphic

Item Description
No. of Bits to Monitor *1 Set the total number of bits used for displaying graphics.

1 - 512
Device Designation *1 Set the device memory used for displaying graphics. Consecutive bits are used for the number of 

monitored bits.
Type *1 Select the graphic display method.

1-Graphic A graphic is displayed when the bit is set to ON.
OFF: Graphic hidden
ON: Graphic shown

2-Graphic A graphic is displayed when the bit is set to either ON or OFF.
OFF: OFF graphic shown
ON: ON graphic shown

Mode *3 Specify the display state when changing between graphics.
This setting is available when [Type] is set to [2-Graphic].
When [Type] is set to [1-Graphic], the mode is fixed to [XOR].

XOR Bit OFF: OFF graphic is displayed.
Bit OFF → ON: OFF graphic is cleared and ON graphic is displayed.
Bit ON → OFF: ON graphic is cleared and OFF graphic is displayed.

REP Bit OFF: OFF graphic is displayed.
Bit OFF → ON: ON graphic is displayed over the OFF graphic.
Bit ON → OFF: OFF graphic is displayed over the ON graphic.
The graphics are not XORed with the base screen and are instead displayed in their original colors.

Start Graphic *1 Set the starting graphic group number and graphic number of the graphic to display.
Valid parameter No. *2 This is required when moving or transforming the graphics. Specify the total number of parameters 

set for each graphic.
The number of words for the device memory and allocation is determined from this total and the 
parameter numbers.
(For details on the parameter setting, refer to the Operation Manual.)

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
11 10 9 8 7 6 5 4 3 2 1 0

MSB LSB

Graphic No. 0 graphic No.
(Bit ON)

Because [No. of Bits to Monitor] is 12, 12 graphics can be assigned to these bits 
(bit 0 to bit 11).

D200 bit No.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
22 20 18 16 14 12 10 8 6 4 2 0
23 21 19 17 15 13 11 9 7 5 3 1

MSB LSB

Graphic No. 0 graphic No.
(Bit ON)

Because [No. of Bits to Monitor] is 12, 24 graphics can be assigned to these bits 
(bit 0 to bit 11).

D200 bit No.

(Bit OFF)
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*2 Display example:
[Device Designation]: D200, [Type]: 1-Graphic, [Start Graphic]: GNo. 1, No. 4, [No. of Bits to Monitor]: 20, [Valid parameter No.]: 4

*3 Display example:
- Mode: XOR

In XOR mode, the graphic color is XORed with the colors of the base screen (display area). Therefore, the graphic is displayed in the 
color XORed with the base color (= XORed color), rather than the color specified during editing. For details on XORed color, refer to 
page 11-12.

- Mode: REP

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
19 18 17 16 15 14 13 12 11 10 9 8 7 6 5 4

MSB LSB

Graphic No. 1 graphic No.
(Bit ON)

16 bits for monitoring

Because [No. of Bits to Monitor] is 20, 20 graphics are assigned 
to 16 bits in D200 and 4 bits in D201.

D200 For graphic relay operation (16 relays)
D201 For graphic relay operation (4 relays)
D202 For parameter No. 1
D203 For parameter No. 2
D204 For parameter No. 3
D205 For parameter No. 4

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
23 22 21 20

Bit No. of D201
Graphic No. 1 graphic No.

(Bit ON)

4 bits for monitoring

Total of 20 
= [No. of Bits to Monitor]

D200 bit No.

Bit: OFF
OFF graphic is displayed.

Bit: ON
OFF graphic is cleared and 
ON graphic is displayed.

Bit: OFF
ON graphic is cleared and 
OFF graphic is displayed.

When displayed on the screen (background: blue):Graphic library editing

Ellipse in solid color
Foreground color: yellow

Yellow ellipse is XORed into white by 
blue screen.

Bit: OFF
OFF graphic is displayed.

Bit: ON
ON graphic is displayed 
over the OFF graphic.

Bit: OFF
OFF graphic is displayed 
over the ON graphic.
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Style

Display area
• Offset

- When [Display Graphic] is set to [Display area]
The offset position of the graphic library corresponds to the upper left corner of the display area part. Take this position 
into consideration when determining the size of the display area part.

- When [Display Graphic] is set to [Base screen]
The offset position of the graphic library corresponds to the upper left corner of the screen.

Item Description
Display Graphic Select the area for displaying graphics.

Display area/Base screen
Adjust Position Displays the window for adjusting the placement position of each part. Part size can also be changed.
Select from catalogs Set the part design from the catalog.

OFF

OFF

OFF

Graphics library Screen No. 0 Screen No. 6

Display area

OFF OFF

Graphics library Screen No. 1
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• Transparency
Select the [Transparent] checkbox for the display area part to add transparency to the display area part properties. Select 
this checkbox to avoid a situation where graphics under the display area part are hidden. For details on part changes, 
refer to the Operation Manual.

- Example with transparent setting

Show/Hide
Set the show and hide settings of graphic items.

Detail

For details, refer to “14 Item Show/Hide Function”.

Item Description
Coordinates Start X/Start Y Specify the coordinates of the display area.

Width, Height Set the size of the display area.
Others Process Cycle Set the cycle for the V10/V9 series to read PLC data.

ID Set an ID number.

• Not transparent • Transparent
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11.1.3 Graphic Display Color
Display Modes
When graphics are displayed on the screen, there are two types of display modes.

• XOR: Graphic colors are XORed with the colors of the base screen.
• REP: Original graphic colors are shown.

Whether XOR or REP is used for the display state is determined by the mode and parameter settings. Refer to the following 
table.

* When the graphic to be displayed is a “Paint” graphic, it cannot be displayed in XORed colors.
* When a pattern with a [Transparent Color Setting] is used, the graphic can be displayed with the original colors even if [Mode] is set to 

[XOR]. For details, refer to page 11-13.

XORed Colors
When [XOR] is selected, graphic colors are XORed with the colors of the base screen (display area). The resulting color is called 
“XORed color.” The basic eight XORed colors are shown below.

XOR operations
Each of the basic eight colors has an identification code as given below:

When a color is XORed with another color, it means that the two color codes are XORed to obtain another code.

Graphic Registration Parameter
Graphic Switching Method Type Action: Replace Action: Animation
Switch REP XOR
Device (No. Designation) REP XOR
Device (Bit Designation) 1-Graphic XOR XOR

2-Graphic Mode: XOR XOR XOR
Mode: REP REP XOR

Overlaid picture colors (basic eight colors)
Black Blue Red Magenta Green Cyan Yellow White

Base screen picture colors
(basic eight colors)

Black Black Blue Red Magenta Green Cyan Yellow White
Blue Blue Black Magenta Red Cyan Green White Yellow
Red Red Magenta Black Blue Yellow White Green Cyan

Magenta Magenta Red Blue Black White Yellow Cyan Green
Green Green Cyan Yellow White Black Blue Red Magenta
Cyan Cyan Green White Yellow Blue Black Magenta Red

Yellow Yellow White Green Cyan Red Magenta Black Blue
White White Yellow Cyan Green Magenta Red Blue Black

64k-color 32k-color
Color Code HEX Color Code HEX
Black 0000 Black 0000
Blue 001F Blue 001F
Red F800 Red 7C00

Magenta F81F Magenta 7C1F
Green 07E0 Green 03E0
Cyan 07FF Cyan 03FF

Yellow FFE0 Yellow 7FE0
White FFFF White 7FFF

64k-color  XORed color of blue and white 32k-color  XORed color of blue and white
Blue 0000 0000 0001 1111 (001F) 0000 0000 0001 1111 (001F)

White 1111 1111 1111 1111 (FFFF) 0111 1111 1111 1111 (7FFF)
XOR ↓ XOR ↓

Yellow 1111 1111 1110 0000 (FFE0) 0111 1111 1110 0000 (7FE0)
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XOR Display Transparency (Pattern Transparency)
Because animation on a graphic display is always XORed, it is impossible to display the same colors on the screen as initially 
set for the background color (other than black).
Additionally, because the XORed color is affected by the base color, when animation is performed on multiple background 
colors, the color changes whenever the background does.

When a transparent pattern is used for animation, colors can be displayed just as they were originally created.

* Always select the [With Transparent] checkbox for the pattern when using this function.

Pattern editing
• Set the color not to show on the screen for the [Transparent Color Setting] in the [Pattern Edit] window.
• Only one transparent color can be set per pattern.
• For a pattern like the one below, the perimeter color (red) is set as the transparent color. Consequently, when this pattern 

is displayed on the screen, the red area becomes transparent and the background color is displayed.

For details on pattern editing, refer to the Operation Manual.

CHECKER

Original pattern

The original color is 
affected by the 
background color.

The original color is
affected by the

background color.

CHECKER

Displayed without 
being affected by the 
background.

Displayed without being affected 
by the background.

Original pattern

Transparent color

Red Black Greenish brown

Transparent color: red

Background

Display on the screen
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11.1.4 Graphic Library (Parameter Settings)
Configure parameter settings to move, transform, and change graphics registered in the graphic library.

Parameter Targets and Settings
The following drawing items can be set using parameters.

*1 Paint is not drawn correctly if operation of the graph is set to animation in the parameter settings.

Continuous line (point 0 (to n) coordinates)
If a continuous line is drawn as shown below, there are seven points at which parameters can be set.

Parallelogram

Graphics Item Specified by Parameter Refer to
Straight line Start point, end point
Continuous line Point 0 (to n) coordinates page 11-14
Rectangle Start point, end point
Parallelogram Start point, PX2, PY2, PX3, PY3 page 11-14
Polygon Center coordinates, radius, start angle, number of corners
Circle Center coordinates, radius
Arc, sector Center coordinates, radius, start angle, end angle
Ellipse, elliptical arc, elliptical sector Center coordinates, X radius, Y radius
Text Start point (coordinates at the bottom left of the first character)
Pattern Start point (coordinates of the top left corner), (pattern) No. page 11-15
Paint *1 Start point page 11-15
Graphic call Start point (library) No.
Pixel Start point
Data display Start point (coordinates of the bottom left of the first digit), No. page 11-15

0

1

2

3

4

5

6

• PX2

• PY2

• PX3

• PY3
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Pattern
• Start point

The start point is the top left corner of the pattern, as shown below.

• Pattern No.
Set the parameters for the numbers to change the picture by specifying a number.

Paint (start point)
The coordinates of the paint start point can be changed using a parameter device memory.
Note that drawing is performed using REP instead of XOR so the previous paint display (e.g. circle) will remain.

Data display
The position of the data display can be moved.

Parameter No. 1

Parameter No. 2

Wine Beer Soda Water Vodka

No. 0 No. 1 No. 2 No. 3 No. 4

Wine

No. 0

Soda

No. 2

Water

No. 3Pattern Pattern

34263426 3426
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Parameter Settings
Set parameters in the graphic editing window of each graphic.

Item Description
Operation Select whether to overwrite the previous state or erase the previous state before drawing anew.

Replace Overwrite the previous state. The previous state will remain.

* This setting is available when there is no display area and the [System Setting] → [Unit Setting] → 
[General Setting] → [General Settings] tab → [Retain previous picture in graphic mode (V8 
compatible)] checkbox is selected.

Animation Always draw the latest state.

Set Set the parameter of each setting item using the [Set] button.
No Setting Do not secure a device memory for the parameter.
Absolute Input Specify the parameter value using absolute coordinates.

When specifying coordinates
The following shows an example when target coordinate values are specified in a device memory 
where the coordinates of the top left corner of the screen are [0, 0] and the coordinates of the bottom 
right corner are [639, 479] (or [319,239]/[799, 599]/[1023, 767]).

When specifying numbers (pattern, graphic call)
The following shows an example when a registered pattern number or graphic library graphic 
number is specified directly.

[0, 0]

[639, 479]

[300, 200]

A circle specified at X = 300 and Y = 200 is displayed at the following location.

No. 3 No. 4 No. 5 No. 6 No. 7 No. 8

If “3” is specified for the parameter device 
memory, pattern number 3 is displayed.
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Incremental + 
Input

Specify the input parameter value using relative coordinates in the positive direction.

When specifying coordinates
The following shows how the graphic moves in the positive direction when a positive value is 
specified to the device memory and in the negative direction when a negative value is specified to 
the device memory where the placement position of the graphic is [0, 0].

When specifying numbers (pattern, graphic call)
The following shows how a number higher than the placed one is called when a positive value is 
specified to the device memory and a number lower than the placed one is called when a negative 
value is specified to the device memory where “0” is set for the number of the placed pattern or 
graphic.

Incremental − 
Input

Specify the input parameter value using relative coordinates in the negative direction.

When specifying coordinates
The following shows how the graphic moves in the negative direction when a positive value is 
specified to the device memory and in the positive direction when a negative value is specified to the 
device memory where the placement position of the graphic is [0, 0].

When specifying numbers (pattern, graphic call)
The following shows how a number lower than the placed one is called when a positive value is 
specified to the device memory and a number higher than the placed one is called when a negative 
value is specified to the device memory where “0” is set for the number of the placed pattern or 
graphic.

Item Description

300

200

Positive direction

Po
sit

ive
 d

ire
cti

on

The circle set at [300, 200] moves from 
its initial position as shown below.

Initial position
[0, 0]

No. 3 No. 4 No. 5 No. 6 No. 7 No. 8

When the initial pattern number is “4” and “2” is 
specified for the parameter device memory, pattern 
number 6 is displayed.

Pattern

Initial pattern

200

200

Negative direction

Ne
ga

tiv
e d

ire
cti

on

The circle set at [200, 200] moves from 
its initial position as shown below.

Initial position at [0, 0]

No. 3 No. 4 No. 5 No. 6 No. 7 No. 8

When the initial pattern number is “8” and “3” is 
specified for the parameter device memory, 
pattern number 5 is displayed.

Initial pattern

Pattern
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11.2 Animation
11.2.1 Overview

• When the configured bit is set to ON, the picture is displayed. When the bit is set to OFF, the picture is cleared.
Movement can be easily set by switching pictures in a position or by moving a picture.

• Graphics can be created with pixels in the “Frame Edit” area. Bitmap data can be imported and used for animation easily.
• An animation image can be made opaque to the background color and display a picture exactly as registered (when 

transparent color is set). In this case, even if animation pictures overlap each other, the image will not be corrupted or 
change color.

• It is not necessary to create a complicated program on the PLC for animation. Because animation can be created easily 
using the settings on the V10/V9 series, interesting screens such as screen savers or logo displays can be created with 
minimal effort.

• Using the scale function, screens can be created in synchronization with the PLC, which reflect the field conditions in real 
time.

Bit is ON Bit is OFF

1 frame

This image does not
react with the

background color.

No problem even when 
animation images overlap 
each other.

Animation can be performed by 
synchronizing with the value in the PLC, 
such as data from an encoder.

Use the scale function for these motions.

Use the scale function for these motions.
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11.2.2 Setting Example
Using an Animation Table
Create the following animation using an animation table.

1. Registering animation
1) Click [Home] → [Registration Item] → [Animation]. The [Animation] tab window is displayed.

2) Right-click on [Animation], select [Add], and set the [Animation VIEW] settings.

3) Register frame numbers 0 and 1.

4) In the same manner, create a new animation (animation number 1) and frame numbers 2 and 3.

(0 , 50) (500 , 50)

(500 , 600)

Display when bit 0 of D100 is set to ON

Animation No. 1
(Move vertically in 8 seconds)

Animation No. 0
(Move horizontally in 10 seconds)

Animation No. 0

No. 0 No. 1Frame

Double-click

 No. 2  No. 3Frame

Double-click
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2. Setting animation on the screen
Click [View] → [Function Item] → [Animation Setting] → [New] and configure the animation settings.

3. Unit Operation
Set bit 0 of D100 to ON. The animation is displayed.

Item Setting
Table Setting Selected

Table 0 Animation No. 0
Move: Continuous Line Move

Movement Pattern: None
Movement Points: 2
Seconds to Move: 100* 100 msec
Animation Replay Coordinates

X0:Y0  0,50
X1:Y1  500,50

No sound
Table 1 Animation No. 1

Move: Continuous Line Move
Movement Pattern: None
Movement Points: 2
Seconds to Move: 80* 100 msec
Animation Replay Coordinates

X0:Y0  500,50
X1:Y1  500,600

No sound
Continuous replay None
Display Command Device D100
Control the moving range by the scale 
value

None
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Using Scaling (With Movement)
Create the following animation using scaling. Animation movement is controlled by the change in the scaling value.

1. Registering animation
1) Click [Home] → [Registration Item] → [Animation]. The [Animation] tab window is displayed.

2) Right-click on [Animation], select [Add], and set the [Animation VIEW] settings.

3) Register frame number 3.

2. Setting animation on the screen
Click [View] → [Function Item] → [Animation Setting] → [New] and configure the animation settings.

: Animation No. 3

(Movement range)

Scaling value: 0

The movement of the animation playback coordinates 
set for the table is controlled by the scaling value.

Scaling value: 50

Scaling value: 100

Animation No. 3

Frame No. 3
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3. Unit Operation
1) Set bit 0 of D200 to ON. The animation is displayed.
2) Set the scaling value of D201 to move the animation.

Using Scaling (Without Movement)
Create the following animation. The timing to switch the animation number can be specified using a scaling value.

1. Registering animation
1) Click [Home] → [Registration Item] → [Animation]. The [Animation] tab window is displayed.

2) Right-click on [Animation], select [Add], and set the [Animation VIEW] settings.

Item Setting
Table Setting Selected

Table 0 Animation No. 3
Move: Continuous Line Move

Movement Pattern: None
Movement Points: 2
Animation Replay Coordinates

X0:Y0  0,50
X1:Y1  500,50

Scale values 0 to 100
No sound

Continuous replay None
Display Command Device D200
Control the moving range by the scale value Selected

Scale Device Designation D201

0   32

33   65

66   100

Animation No. 5

Animation No. 5

Animation No. 6

Animation No. 7

Depending on the scaling value, the 
corresponding animation is shown.

When showing scaling values on a bar 
graph, it is possible to use animation 
in synchronization with the graph.

(Frame No. 5)

(Frame No. 6)
(Frame No. 7)

Scale valuesNo. 6    No. 7

Animation No. 5
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3) Register frame number 5.

4) In the same manner, register animation number 6 (frame number 6) and animation number 7 (frame number 7).

2. Setting animation on the screen
1) Click [View] → [Function Item] → [Animation Setting] → [New] and configure the animation settings.

3. Unit Operation
1) Set bit 0 of D500 to ON. The animation is displayed.
2) Set the scaling value of D501 to change the animation number.

Item Setting
Table Setting Selected

Table 0 Animation No. 5
No movement Animation playback coordinates

X, Y  100, 100
Scale values 0 to 32
No sound

Table 1 Animation No. 6
No movement Animation playback coordinates

X, Y  100, 100
Scale values 33 to 65
No sound

Table 2 Animation No. 7
No movement Animation playback coordinates

X, Y  100, 100
Scale values 66 to 100
No sound

Continuous replay None
Display Command Device D500
Control the moving range by the scale value Selected

Scale Device Designation D501

Frame No. 5

Frame No. 6

Frame No. 7
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11.2.3 Detailed Settings
Registering Animation
Animations are defined and registered in the [Animation] tab window.

Opening the Registration Window
Click [Home] → [Registration Item] → [Animation] to display the [Animation] tab window.
Configure settings in the [Animation VIEW] window and perform frame editing in this window.

The menu items on the right-click menu differ depending on the folder that was right-clicked, [Animation], 
[Animation No. xxxx] or [Frame No. xxxx].

• [Animation] folder

• [Animation No. xxxx] folder

• [Frame No. xxxx] folder

Refer to“Animation VIEW Window” page 11-25

Refer to“Animation VIEW Window” page 11-25

Refer to“Frame Editing” page 11-25
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Animation VIEW Window

*1 A “frame” refers to a single image used in animation. Drawing is performed on a pixel unit basis.

*2 Display example
Start Frame No.: 5
End Frame No.: 9
Seconds to Replay: 30 × 100 msec
Animation is performed as shown below.

Frame Editing
• For details on frame editing and registration, refer to the Operation Manual.
• A maximum of 1023 frames can be registered (0 to 1022).

Item Description
Use When this checkbox is selected, an animation number is set. To clear the setting, deselect this checkbox.
Animation No. Displays the animation number currently being edited.

The animation number can be changed by clicking the up/down arrow buttons. Values can also be entered 
directly without using the up/down buttons.
Setting range: 0 to 1023

Start Frame No.
- End Frame No.

Set the range (number) of frames *1 to be used for animation.
Setting range: 0 to 1022

Seconds to Replay 
(× 100 msec) *2

Set the cycle (speed) for changing the frames specified for [Start Frame No.] and [End Frame No.].

TEST When the frames have been registered, the actual motion of the animation can be checked.

PLAY The set frame is displayed within the time set for [Seconds to Replay].
PAUSE Pause playback.
STOP Stop playback.
Repeat Playback Normally playback is only performed once when the [PLAY] button is clicked.

Select this checkbox to enable continuous playback.

No. 0 No. 1  No. 2  No. 3Frame

 No.5  No.6 No.7  No.8  No.9Frame

30 × 100 msec = Switches frames within 3 seconds

In the case of continuous playback, animation repeats 
after 3 seconds elapse.
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Animation Settings
Display Settings
[Table Setting]: Unselected
Specify one animation number for playback. Specifying a device memory address allows changing the animation number and 
display position.

Item Description
Animation No. Set the animation number specification method.

Unselected: Set one animation number.
Selected: Set the animation number using a device memory.

Coordinate Set the display position of the animation.
Unselected: Set the X and Y coordinates.
Selected: Set the X and Y coordinates using a device memory.

Play Setting Do Not Erase End 
Frame *1

Set the operation to perform when animation playback ends.
Unselected

On completion of playback, the image disappears even if the command bit remains ON.

Selected
The end frame is shown even after completion of replay while the command bit remains ON. 
When the command bit is set to OFF, the end frame disappears.

Continuous replay Set the number of times to play back the animation.
Unselected: The animation is played back only once.
Selected: The animation is played back continuously.

Display Command 
Device

This is the device memory to be used for displaying the animation on the screen.

(1) Show/hide animation (bit 0)
[1] (ON): Show the corresponding animation number.
[0] (OFF): Hide the currently displayed animation.

(2) Pause/resume playback (bit 1)
[1] (ON): Pause the currently playing animation.
[0] (OFF): Resume playback of the paused animation.

Continued

(1) Show/hide animation

System reserved (“0” setting)
(2) Pause/resume playback

(3) Pause/resume movement

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

Playing

Frames are switched in accordance 
with the animation setting.

Set bit 1 to ON.

Paused

The animation pauses with the frame 
displayed when bit 1 is set to ON.
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*1 Do Not Erase End Frame
- Checkbox unselected

- Checkbox selected
Animation can be shown or hidden according to the status of the command device memory, which facilitates display control from an 
external device.

*2 Pause/resume movement (bit 2)
- When movement is selected on the animation table ([Table Setting]: selected), movement is resumed from the position where it was 

paused.

- When movement occurs using the coordinates specified by a device memory address, movement resumes according to the value 
specified for [Display Command Device].

Play Setting Display Command 
Device

(3) Pause/resume movement (bit 2) *2
[1] (ON): Pause the currently moving animation.
[0] (OFF): Resume movement of the animation.

Item Description

Animation is played back when the command bit is set to ON.

On completion of playback, it 
disappears even if the command bit 
remains ON.

Animation is played back when the command bit is set to ON.

The end frame is shown even 
after completion of playback 
while the command bit remains 
ON.

When the command bit is set 
to OFF, the end frame 
disappears.

Set bit 2 to OFF. Bit 2 ON 
= stop movement

Moving
Bit 2 OFF 

= resume movement

Set bit 2 to OFF. Bit 2 ON 
= stop movement

Moving

Movement resumes from the coordinate position specified in 
the device memory when the bit changes to OFF.

Set bit 2 to OFF.

Movement resumes
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[Table Setting]: selected
The multiple animations registered in the table are played back in order.

*1 For details, refer to “Display Settings” page 11-26.

Item Description
Table Register animation numbers to play back using the [Add] button. Refer to “Table 0 to 15” page 11-29.
Continuous replay Set the number of times to play back the animation.

Unselected: The animation is played back only once.
Selected: The animation is played back continuously.

Display Command Device This is the device memory to be used for displaying the animation on the screen.

(1) Show/hide animation (bit 0)
[1] (ON): Show the corresponding animation number.
[0] (OFF): Hide the currently displayed animation.

(2) Pause/resume playback (bit 1)
[1] (ON): Pause the currently playing animation.
[0] (OFF): Resume playback of the paused animation.

(3) Pause/resume movement (bit 2) *1
[1] (ON): Pause the currently moving animation.
[0] (OFF): Resume movement of the animation.

Control the moving range by 
the scaling value

Use a scaling value. The settings for scaling values are available when this checkbox is selected. Refer to 
“Scaling” page 11-32.

Table

(1) Show/hide animation

System reserved (“0” setting)
(2) Pause/resume playback

(3) Pause/resume movement

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

Playing

Frames are switched in accordance 
with the animation setting.

Set bit 1 to ON.

Paused

The animation pauses with the frame 
displayed when bit 1 is set to ON.
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Table 0 to 15
Register up to 16 animations to play back in sequence.

Item Description
Animation No. Set the animation number to play back.
Move Set whether or not to move the animation.

Unselected: No movement
Selected: Move

No movement Configure the following settings.

Move Set the following items for straight line path.

Set the following items for circular and arc-like paths.

Use WAV Set whether or not to play an audio file.

Unselected: No playback.
Selected: Play back an audio file. The following movement settings become available when 

this checkbox is selected.
Continuous Replay Continuously play back an audio file.
WAV File No. Set the audio file number.

Start Frame Display *3 Baton pass animation can be performed. This setting is available for tables other than table 
number 0.

Do Not Erase End Frame *4 Set the operation to perform when animation playback ends.

Unselected
On completion of playback, the image disappears even if the command bit remains ON.

Selected
The end frame is shown even after completion of replay while the command bit remains ON. 
When the command bit is set to OFF, the end frame disappears.

Animation Replay 
Coordinates

Set the display position of the animation.

Seconds to Move 
(× 100 msec)

Set the playback time for the set animation number.

Movement Pattern *1 None
Movement Points Specify the number of movement points.

Range: 2 to 32
Animation Replay 
Coordinates

Specify the coordinates of the movement points.
These can be specified with direct input or by using the 
mouse.

New *2
Specify with Mouse

Specify the coordinates of the movement points using 
the mouse.

Not set: Selected
Already set: Unselected

Seconds to Move 
(× 100 msec)

Set the movement time for the set animation number.

Movement Pattern *1 Circle (Clockwise)
Circle (Counterclockwise)

No. of Divisions *1 Specify the number of divisions of the circumference.
Range: 2 to 31

Animation Replay 
Coordinates

Specify the coordinates of the movement points.
These can be specified with direct input or by using the 
mouse.

New *2
Specify with Mouse

Specify the coordinates of the movement points using 
the mouse.

Not set: Selected
Already set: Unselected

Full Circle *2 Select this checkbox when a full circle is used for the path.
Seconds to Move 
(× 100 msec)

Set the movement time for the set animation number.
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*1 Movement Pattern/Movement Points/No. of Divisions

*2 [Specify with Mouse]/[New]
- When [Movement Pattern] is set to “None”, click the desired points on the screen in the same way as drawing a continuous straight line. 

The coordinates are defined in order. Double-click to accept the points and display the window again. The number of clicks is 
automatically set for [Movement Points]. Specifying with mouse is automatically finished when 32 points are set.

- When [Movement Pattern] is set to “Circle (Clockwise/Counterclockwise)” with [Full Circle], specify the start and end points.

- When [Movement Pattern] is set to “Circle (Clockwise/Counterclockwise)” with [Arc], specify the start and end points.

A configured path can be modified by clicking [Specify with Mouse] when the [New] checkbox is unselected.
To show the path on the editing screen, select the [Display Animation Paths] checkbox in the [Display Environment] window.
A straight line, continuous straight line, circle, or arc created by drawing is displayed in the editing window.

1

2
3

4 5

6

1
2

3

4

5

6

7
8

91011
12

13

14

15

16

17
18

19 20

Example: Straight line
[Movement Points]: 6

Example: Circle
[No. of Divisions]: 20

4th point

3rd point End point
Click Double-click

Start point
Click Click Click

2nd point

: Start point End point

: Start point

Clockwise

Counter-clockwise

Right-click to return to the [Animation] window.
: End point

Path for animation
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*3 Start Frame Display

*4 For details, refer to “Display Settings” page 11-26.

：Animation table No. 0
：Animation table No. 1, with start frame display
：Animation table No. 2, with start frame display
：Animation table No. 3, with start frame display

When the command bit is set to ON, the start frames 
of all animation tables are displayed.

When animations are played continuously, the same action is repeated.

When playback of all tables is finished, 
the animation disappears.
(if the end frame is set to disappear)

Table No. 0

No. 3

No. 2

• The start frame disappears when the animation of each table is started.

No. 1
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Scaling

*1 Difference between using and not using scaling values
- When scaling values are not used:

- When scaling values are used:

*2 Setting example
When assigning scaling values equally in the range from 0 to 3000 using animation tables No. 0 to No. 2 :

Item Description
Control the moving range by 
the scaling value *1

Use a scaling value. The following setting items for scaling values become active.

Scale Device Designation Set the device memory that specifies the scaling value.
Min. Scale Set the minimum scaling value of the animation table.
Max. Scale Set the maximum scaling value of the animation table.
Equal-assign Scale Values *2 Equally assign scaling values to the animation in the table.

50

50

50150

:Graphics to be moved
Coordinates (50, 50) must be 
specified from the PLC.

To move the graphics “+100” 
horizontally, “X150” must be 
specified from the PLC.

100

Define the graphic start position as 
(0, 0) on the screen. When “100” is specified from the 

PLC, the graphics move “100” from 
the start position.
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Detail

Item Description
Output the end bit after 
animation is finished

This is the device memory to be used for checking the status of animation.
• In the case of device memory designation, the end bit is output when the animation playback time 

(seconds) has elapsed.
• In the case of using an animation table, the end bit is output when all of the animations in the 

animation table have been played back.
• If the animation is finished halfway through playback, the end bit is not output.
• The end bit is not output when using scaling.

Process Cycle Set a cycle for the V10/V9 series to read the PLC data while it is communicating with the PLC.
For details, refer to “1.2 Process Cycle”.

ID Set the ID.

End of animationSystem reserved (“0” setting)

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB
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11.2.4 Notes
Animation Setting Position
An animation can be set only on a base screen. Note that you cannot register it on an overlap screen.

Transparency
A part of a picture (frame) in the registered animation can be hidden.

Transparent color setting for frame
1. Fill out the non-display area of each frame using a color different from the color of the display area in the [Frame Edit] tab 

window.

2. Click [Transparent Color Setting] on the [Edit] menu. Select the [With Transparent] checkbox and select the red color used 
in step 1.

This makes the color in the non-display area transparent. When displaying the frame on the screen, the background can 
be seen though the non-display area.

The background can be seen 
through the frame.

The background can be seen
through the frame.

Example:
Fill the part not to be shown in red.
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Structure of Layers
Animations are displayed behind overlaps on the V10/V9 series unit.

Restrictions
• Frame size limit

The maximum capacity per frame is 1 MB.
In the case of capturing a bitmap or JPEG file larger than 1 MB, the file will be automatically divided into 1 MB segments 
so that the bitmap or JPEG can be captured. (Files with a resolution of up to 1920 × 1080 can be captured.)

• Maximum number of movements
Up to 256 animation settings can be configured for each screen. However, the maximum number of animations that can 
be displayed simultaneously is 64.
Even if the bit is set to ON, the 65th and subsequent animations will not be displayed.

CancelOK

Will start operation?

(1) Base ... bottom layer

(3) Overlap

(2) Animation

(4) Message box ... top layer
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12.1 Message Mode
12.1.1 Overview

This function displays messages on the screen by specifying the line number of a message previously registered in the 
message registration area (message editing) or by grouping these messages into blocks and specifying the block number(s).
The message mode has four kinds of display configurations as shown below.

Other message display methods are described in “5.3 Message Display” page 5-29 and “8 Alarm”.

Display line by line. How 
do you configure display?

Display in blocks. What 
block type?

[Operation Select]: 
Direct Block

[Operation Select]: 
Page Block

How do you display 
message(s)?

Direct blockPage block

Refer to (A) on page 12-2. Refer to (B) on page 12-2.

[Operation Select]: 
Direct Message

[Operation Select]: 
Page Message

Display the registered 
message separately.

Display the registered 
message continuously.

Refer to (C) on page 12-3. Refer to (D) on page 12-3.
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How to Specify Block Numbers
If [Operation Select] is set to [Page Block] or [Direct Block] in the message mode, specify the [Page Block] or [Direct Block] 
number to which the message to display is registered.

A [Operation Select]: Page block
Register the message that was previously registered in the message editing area as [Page Block].
The corresponding “page block” is displayed on the screen.
To display a page block on the screen, there are two ways: changeover with a switch or changeover with respect to data in 
a device memory address.

B [Operation Select]: Direct block
Register the message that was previously registered in the message editing area as [Direct Block].
The corresponding “direct blocks” are displayed on the screen.
To display a direct block on the screen, there are two ways: changeover with a switch or changeover with respect to data 
in a device memory address.

For setting examples, refer to “Displaying Messages (Page Blocks)” page 12-4.

No. 0
No. 1
No. 2
No. 3
No. 4
No. 5
No. 6
No. 7
No. 8
No. 9
No.10
No.11

D100 0

Control panel side emergency stop

The EMERGENCY STOP button on 
the control panel is pressed.
Reset the button.

Operation box side emergency stop

The EMERGENCY STOP button on the 
operation box is pressed.
Reset the button.

Control panel side emergency stop

The EMERGENCY STOP button on 
the control panel is pressed.
Reset the button.

The EMERGENCY STOP button 
on the operation box is pressed.
Reset the button.

Message group No. 3
Page block No. 0

Set “0” for D100. Page block No. 0

Control panel side emergency stop

The EMERGENCY STOP button on 
the control panel is pressed.
Reset the button.

D100 0

No. 0
No. 1
No. 2
No. 3
No. 4
No. 5
No. 6
No. 7
No. 8
No. 9

No.21
No.22

No. 1
No. 9
No. 6
No.22
No. 5

MONITOUCH
General Specifications

Item
Description

Hardware Specifications
Input voltage    85 to 235 AC

Display color    16 colors
Display area    640 x 480 pixels

FUNC switch    8 points
Switch    H24 x W40

Printer port    1 port
Baud rate   RS232C/RS422

General Specifications
Switch    H24 x W40

Display color    16 colors
Baud rate   RS232C/RS422

Input voltage    85 to 235 AC

Message group No. 2

Direct block No. 0
Direct block No. 1

Direct block No. 2

Set “0” for D100. Direct block No. 0

General Specifications
Switch    H24 x W40

Display color    16 colors
Baud rate   RS232C/RS422

Input voltage    85 to 235 AC
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How to Specify Message Numbers
If [Operation Select] is set to [Page Message] or [Direct Message] in the message mode, always specify the number of the 
message to display.

C [Operation Select]: Page message
Specify the line number of the top message to display. Several lines of the message, of the number specified, are 
continuously displayed within the display area on the screen.

D [Operation Select]: Direct message
One device memory address is automatically assigned to each line in the message display area. Specify the message 
number to display based on the assigned device memory address.
A message specified by the device memory address is displayed on the screen.

= No. 3
= No. 4
= No. 5
= No. 6

D100 3

No. 0
No. 1
No. 2
No. 3
No. 4
No. 5
No. 6
No. 7
No. 8

Four lines from message No. 3 (to 
message No. 6) are displayed in order 
on the screen.

Control Panel Emergency Stop
Operation box emergency stop
Direction change count
Count stop
Pusher error
Intermediate stopper error
Saddle raise stopped
Saddle final raise stopped
Carry roller start

Message editor

4 lines

Y size
4 lines

Set “3” for D100.

Count stop
Pusher error
Intermediate stopper error
Saddle raise stopped

D100

D101

D102

D100

D101

D102

= No. 2

= No. 8

= No. 4

D101 8
2

4

D100

D102

No. 0
No. 1
No. 2
No. 3
No. 4
No. 5
No. 6
No. 7
No. 8

Device memory addresses, each of which 
specifies a message number, are assigned 
consecutively for 3 lines.

Control Panel Emergency Stop
Operation box emergency stop
Direction change count
Count stop
Pusher error
Intermediate stopper error
Saddle raise stopped
Saddle final raise stopped
Carry roller start

Message editor

Size
3 lines

Line 1 device
Line 2 device
Line 3 device

Direction change count
Carry roller start
Pusher error
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12.1.2 Setting Examples
Displaying Messages (Page Blocks)
Register a message to a page block and display the message by changing the block number using a switch.

1. Click [Parts] → [Message] → [Message] and place a message mode part on the screen.

2. Double-click on the message mode part to display the settings window.
Configure the [Operation Select] settings as shown below.

No. 0
No. 1
No. 2
No. 3
No. 4
No. 5
No. 6
No. 7
No. 8
No. 9
No.10
No.11

Control panel side emergency stop

The EMERGENCY STOP button on 
the control panel is pressed.
Reset the button.

Operation box side emergency stop

The EMERGENCY STOP button on the 
operation box is pressed.
Reset the button.

Control panel side emergency stop

The EMERGENCY STOP button on 
the control panel is pressed.
Reset the button.

The EMERGENCY STOP button 
on the operation box is pressed.
Reset the button.

Message group No. 3
Page block No. 0

Page block No. 0

Control panel side emergency stop

The EMERGENCY STOP button on 
the control panel is pressed.
Reset the button.
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3. Click [Contents] and configure the settings as shown below.
Click [Edit] to register a message for display.

4. Click [Edit] in the [Page Block Edit] window to display the [Message Edit] window.

5. Register the following message and then close the [Message Edit] window.
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6. Register the message registered in the [Message Edit] window to page block number 0 as shown below.

7. In the same manner, register the message again to page block number 1 as shown below and click [Registration 
Complete].

8. Configure the settings as shown below and click [Finish].

This completes the necessary settings.
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12.1.3 Detailed Settings
Operation Select

Item Description
Message Editing Method Select the display method for message mode.

Page Block Page blocks are displayed on the screen.
There are two methods for changing the display: switches and device memory addresses

Direct Block Direct blocks are displayed on the screen.
There are two methods for changing the display: switches and device memory addresses.

Page Message Specify the line number of the top message to display using [Message No. Designation 
Device] (described later).
Several lines of the message, of the number specified, are continuously displayed within 
the area at the top of the screen.

Direct Message One device memory address is automatically assigned to each line in the message display 
area.
Specify the message number to display for the assigned device memory address.
A message specified by the device memory address is displayed on the screen.
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Displayed information
[Operation Select]: Page block/direct block

[Operation Select]: Page message/direct message

Item Description
Display Switching Method Select how to call up blocks.

Switch:
Change the block number to display using a switch placed on the screen.

Device:
Directly specify the block number using [Block No. Setting Device] (described later) to display the 
corresponding block.

Min. Block Set the lowest block number for the page blocks or direct blocks to display.
The page block or direct block can be edited by clicking [Edit].

Max. Block Set the highest block number for the page blocks or direct blocks to display.
The page block or direct block can be edited by clicking [Edit].

Initial Block Set the initial block number to show when the screen is displayed.
The page block or direct block can be edited by clicking [Edit].

Block No. Setting Device Specify the block number to display on the screen.
The page block or direct block can be edited by clicking [Block Edit].

Item Description
Message No. Designation Device Specify the message number to display on the screen.

One device memory address is automatically assigned to each line for direct messages.
Device memory addresses are allocated sequentially from the first device memory 
address specified for [Message No. Designation Device].
The number of words to use is based on the display area’s Y size divided by the character 
enlargement factor value.

Messages to Display Specify by line numbers 
(No. 0 to 255) in the 
specified group

Set a group number.
The message displayed on the screen is limited to a message within the specified group 
number. Specify a message number (0 to 255) in a single group for [Message No. 
Designation Device].

Specify by absolute 
address

Specify the message number to be displayed as an absolute address.
Messages from more than one group can be specified.
Specify a message number (0 to 32767) among all groups for [Message No. Designation 
Device].
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Char. Prop.

Item Description
Color Set the message color.
Background Set the background color.
Style Set the message style.
Character Size
(1 - 8)

Set the character enlargement factor value of the message.
When [Switch] or [Lamp] is selected for [Others] → [Action Area] (described later), the enlargement factor 
values for X and Y are fixed to “1”.

* When [Bitmap font] is selected at [System Setting] → [Multi-language Setting] → [Font Type]
Point
(6 - 999)

Set the text size.
When [Switch] or [Lamp] is selected for [Others] → [Action Area] (described later), the point size is fixed to 
“12”.

* When a font type other than [Bitmap font] is selected at [System Setting] → [Multi-language Setting] 
→ [Font Type]

Use Windows fonts Select this checkbox to use a Windows font.
Message character properties are configured in the [Message Edit] window.
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Style

Item Description
Adjust Position Adjust the position and size of parts.
Select from catalogs Select the part design.
Additional Parts List Add and delete switch parts used in message mode.

Each switch is used for page blocks or direct blocks.
+ Block Changes to the next message block.
− Block Changes to the previous message block.
Roll Up Scrolls up through messages.
Roll Down Scrolls down through messages.
Block Call Changes to the specified block number.
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Editing parts
Select a part in the preview pane to change the part’s style settings.

Item Description
Parts Design Area Setting Select from catalogs Select the part design.

After selecting the part, select the part color.
Select an image file Select a PNG file.

Edit Selected Parts Text Enter the text to be displayed on the switch.
(Up to 4 lines can be registered. Text properties can be set for each line.)
Text can be justified within the switch part.

Char. Prop. Set the text properties and style.
Others Edit switch settings other than those related to text and style.

For details on switch settings, refer to “3.1 Switch” page 3-1.
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Checking the display area size
Whether messages are displayed as intended in display areas can be checked on the screen.

With messages registered, click [View] → [Display Environment] → [Display] tab and select the [Display Message] checkbox.

The registered messages are displayed on the screen.

To adjust the size and other settings, perform adjustments via the [Adjust Position] button described in “Style” page 12-10.
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Show/Hide

Item Description
Show Show the item on the screen.
Hide Do not show the item on the screen.
Show/hide according to the condition The part is shown or hidden according to the specified conditions.

Click [Add] and set up a maximum of five conditions.
Condition Setting Click a condition number to configure a condition that must be satisfied for showing or 

hiding the part.
Bit Device Show the part if the bit device memory condition is satisfied and hide the part if the 

condition is not satisfied.
Word Device Show the part if the conditional expression of the specified word device memory is 

satisfied and hide the part if the expression is not satisfied.

Security Level This setting is available when using the security function.
Show or hide the part according to the security level of the user that is currently logged in.
For details, refer to “5 Security” in the Reference Manual 2.

AND/OR Setting When setting two or more conditions, set whether to perform AND or OR operations on 
the conditions.

Constant Display 
Type

Select the data type of the conditional expression.
[DEC+−] / [DEC] / [BCD] / [HEX]

Condition 
expression

Set an equal sign, value, and device memory address as the 
conditions for comparison.
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Detail

Item Description
Coordinates Start X/Start Y Set the display position of the message mode part using X and Y coordinates.

Width/Height Set the size of the message mode part by specifying width and height.
Others Action Area Set the position to display the message on the screen.

Display area:
Display on provided display area parts.

Switch:
Display on provided switch parts.
Switches are automatically set to “Mode” for [Function]. Each switch has [Display Order] (0 to 23) as an 
auxiliary setting where the message to display on each switch can be specified. When [Display Order] 
settings are all the same, messages are displayed in the same order that switches were placed.

* One switch part shows one message line.

Lamp:
Display on provided lamp parts.
Lamps are automatically set to “Mode” for [Function]. As with switch parts, each lamp has [Display Order] 
(0 to 23) as an auxiliary setting.

* One lamp part shows one message line.
Process Cycle Set a cycle for the V10/V9 series to read PLC data while the V10/V9 series is communicating with the PLC.

For details, refer to “1.2 Process Cycle”.
ID
(0 - 255)

Set the ID.
For details on IDs, refer to the Operation Manual.
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12.1.4 Registering Messages
There are two ways of registering messages.

• [Message] settings window → [Contents] → [Edit]

* When [Operation Select] is set to [Page Block] or [Direct Block], the [Message Edit] window cannot be displayed using 
this method.

* When a message group number is specified, the cursor appears at the start line of the group.

• [Home] → [Registration Item] → [Message] → (specify group number)

In the [Message Edit] window, line numbers denote absolute addresses as default.
When a message group number is specified, deselect [Display] menu → [Display Absolute Address as Line Number] 
before commencing editing.

For details on the editing procedure in the [Message Edit] window, refer to the Operation Manual.
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12.1.5 Registering Page Blocks
There are two ways of registering page blocks.

• [Message] settings window → [Contents] → [Edit]

• [Home] → [Registration Item] → [Page Block] → (specify block number)

For details on the editing procedure in the [Page Block Edit] window, refer to the Operation Manual.
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12.1.6 Registering Direct Blocks
There are two ways of registering direct blocks.

• [Message] settings window → [Contents] → [Edit]

• [Home] → [Registration Item] → [Direct Block] → (specify block number)

For details on the editing procedure in the [Direct Block Edit] window, refer to the Operation Manual.
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12.2 Displaying Comments
12.2.1 Overview

Register comments in advance and display them using bit designation or number designation.
A maximum of 32,767 comments can be registered. Character properties, such as color or size, can be set for each comment.
One comment can include multiple lines.

Bit Designation
Display the comment that corresponds to bit ON of the assigned device memory address.

When multiple bits are set to ON, the least significant bit has priority.

=No.2

D100D100

No.1

No.2

No.3

No.4

D100-00=

D100-01=

D100-02=

D100-03=

Error 2

When D100 = 0 Set bit 1 of D100.

No comment is 
displayed.

Comment No. 2 is 
displayed.

Error 1
Error 2
Error 3
Solution:
Perform XX.
Error 4

Comment editing

=No.1

D100

No.1

No.2

No.3

No.4

D100-00=

D100-01=

D100-02=

D100-03=

Comment editing

When bit 0 and bit 3 of 
D100 are set to ON:

Comment No. 1 is displayed since 
the least significant bit has priority.

Error 1

Error 1
Error 2
Error 3
Solution:
Perform XX.
Error 4
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Number Designation
Set the comment number to the assigned device memory address and display the comment.

For setting examples, refer to “Displaying Comments (Number Designation)” page 12-20.

No.1

No.2

No.3

No.4

=No.3

D100 3D100 0

Error 1
Error 2
Error 3
Solution:
Perform XX.
Error 4

Comment editing

When D100 = 0 Set “3” for D100.

No comment is 
displayed.

Comment No. 3 is 
displayed.

Error 3
Solution:
Perform XX.
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12.2.2 Setting Examples
Displaying Comments (Number Designation)
Register the comment to display in advance and specify the comment number to D100.

1. Click [Parts] → [Message] → [Comment] and place a comment display on the screen.

2. Double-click on the comment display to display the settings window.
Configure the following settings for [Contents] and then click [Finish].

No.1

No.2

No.3

No.4

=No.3

D100 3D100 0

Error 1
Error 2
Error 3
Solution:
Perform XX.
Error 4

Comment editing

When D100 = 0 Set “3” for D100.

No comment is 
displayed.

Comment No. 3 is 
displayed.

Error 3
Solution:
Perform XX.
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3. Click [Home] → [Registration Item] → [Comment] → [OK] with group number 0.

4. Register a comment as shown below.
Press the [Alt] and [Enter] keys together to enter a new line.

5. Select the comment line for setting character properties, right-click, and click [Char. Prop.].
Set the following character properties and then close the [Comment Edit] window.

This completes the necessary settings.
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12.2.3 Detailed Settings
Operation Select

Item Description
Comment Designation Select the comment display method.

Bit Designation
Select this option to display the comment using bit activation.
No. Designation
Select this option to display the comment by specifying the comment number.

Device Designation Specify the command device memory address to use for displaying comments on the screen.
The setting should vary depending on which of [Bit Designation] or [No. Designation] was selected.

Bit Designation:
Set the device memory address (1 bit) to display the comment set for [Top Line No.].
When multiple bits are set to ON, the least significant bit has priority.
No. Designation:
Set the device memory address (1 word) for specifying the comment number.
When “0” is specified, no comment is displayed.
When “1 to 32767” is specified, the corresponding comment is displayed.
However, if the BCD code is used on the PLC, the available range is limited to “0 to 9999”.

Bits to Use
(1 - 512)

Set the number of bits to use for comment display (total number of comments to be displayed).
From the bit set for [Device Designation], as many bits as set for [Bits to Use] are consecutively 
allocated to the comment specified for [Top Line No.] and later.

Top Line No.
(1 - 32767)

Specify the top comment number for display by activation of the bit set for [Device Designation].
Click [Edit] to display the [Comment Edit] window.
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Style

Item Description
Area Select from catalogs Select the part design.

After selecting the part, select the part color.
Select an image file Select a PNG file.
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Show/Hide

Item Description
Show Show the item on the screen.
Hide Do not show the item on the screen.
Show/hide according to the condition The part is shown or hidden according to the specified conditions.

Click [Add] and set up a maximum of five conditions.
Condition Setting Click a condition number to configure a condition that must be satisfied for showing or 

hiding the part.
Bit Device Show the part if the bit device memory condition is satisfied and hide the part if the 

condition is not satisfied.
Word Device Show the part if the conditional expression of the specified word device memory is 

satisfied and hide the part if the expression is not satisfied.

Security Level This setting is available when using the security function.
Show or hide the part according to the security level of the user that is currently logged in.
For details, refer to “5 Security” in the Reference Manual 2.

AND/OR Setting When setting two or more conditions, set whether to perform AND or OR operations on 
the conditions.

Constant Display 
Type

Select the data type of the conditional expression.
[DEC+−] / [DEC] / [BCD] / [HEX]

Condition 
expression

Set an equal sign, value, and device memory address as the 
conditions for comparison.
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Detail

Checking the display area size
Whether comments are displayed as intended in display areas can be checked on the screen.
The procedure is the same as described for the message mode. Refer to page 12-12.

Item Description
Coordinates Start X/Start Y Set the display position of the comment display using X and Y coordinates.

Width/Height Set the size of the comment display by specifying width and height.
Others Process Cycle Set a cycle for the V10/V9 series to read PLC data while the V10/V9 series is communicating with the PLC.

For details, refer to “1.2 Process Cycle”.
ID
(0 - 255)

Set the ID.
For details on IDs, refer to the Operation Manual.
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12.2.4 Registering Comments
There are two ways of registering comments.

• [Comment] settings window → [Contents] → [Edit]

* When [No. Designation] is selected, the window for comment registration will not be displayed in this way.
* The cursor is displayed at the start line of the group that includes the line number specified for [Top Line No.].

• [Home] → [Registration Item] → [Comment] → (specify group number)

For details on the editing procedure in the [Comment Edit] window, refer to the Operation Manual.
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13.1 Memo Pad
13.1.1 Overview

• Message board function
The message board function is available for leaving daily messages in a workshop, etc.
This is particularly useful for exchanging messages among operators working in shifts.

• Pen input
Message entry is made simple by writing on the screen directly with a special pen.

• A maximum of eight memo pad areas
Memo pad areas are common to every screen. Up to 8 memo pad areas can be registered.

• Saved in the SRAM area
When a memo pad area is secured in the built-in or separate SRAM area, the data is retained even after the power is 
turned off.

• Also, it is possible to use a storage device to save memo pad data without using the SRAM area.

• The memo pad can be displayed on screen by specifying the page number of the memo pad.
• Linking with the data sheet function is possible. A signature input using the memo pad can be output to a data sheet to 

create a file with an electronic signature.

Only one memo pad function can be used on one screen.

For details on data sheets, refer to “16.3 Printing Data Sheets”.

1-dot 2-dot Line Delete
Area

Delete
All

Blue Red Pink Green Pale
Blue Yellow White Navy Sky

Blue Brown

Message Board

name

1
2
3
4
5
6
7

100
200
300

40
50

600
770

aaaa
bbbb
cccc
dddd
eeee
gggg
hhhh

SD

PDF

name

123
123
123
123
123
123
123

1234
1234
1234
1234
1234
1234
1234

ABCD
ABCD
ABCD
ABCD
ABCD
ABCD
ABCD

memo

Daily report Daily report

Expanded data sheet

Memo pad

PDF
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13.1.2 Usage Example
Suppose that the following screen is created.

1. When the screen is first opened, the following settings are set as default.
Pen size: 1 pixel
Pen color: White
Pen state: Free
To change the setting, press the corresponding switch and set the desired option.

2. Write a message within the memo pad area.

Use the dedicated pen when writing messages.

3. When deleting the message, press the [Delete All] switch.
4. When deleting part of the message, press the [Delete Area] switch (ON display), and enclose the desired data.

The enclosed data is deleted.
On completion, press the [Delete Area] switch (OFF display).

5. When drawing a straight line, press the [Straight line] switch (ON display).
Moving the pen on the memo pad area draws a straight line.
To cancel the function that draws straight lines, press the [Straight line] switch again (OFF display).

6. Pressing the [+] switch brings up a new memo pad area (up to 8 areas).
Pressing the [−] switch brings up the previous memo pad area.

1 pixel 2 pixels Straight 
line

Delete 
Area

Delete 
All

Blue Red Violet Green Light 
blue Yellow
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13.1.3 Detailed Settings
Style

Item Description
Additional Parts 
List

Pen Size (1 dot) Add a [Pen Size (1 dot)] switch.

Selects the pen thickness.
Pen Size (2 × 2 dots) Add a [Pen Size (2 × 2 dots)] switch.

Selects the pen thickness.
Line Add a [Line] switch.

Select the pen state. This is an alternate switch.
ON: Line
OFF: Free

Delete Area Add a [Delete Area] switch.

This switch deletes the selected memo pad area.
This is an alternate switch.
ON: Delete the rectangular area selected on the display area.
OFF: Deletion is not possible.

Delete All Add a [Delete All] switch.

This switch deletes data from the displayed memo pad area.
+ Block Add a [+ Block] switch.

Brings up the next memo pad area (up to 8).
− Block Add a [− Block] switch.

Brings up the previous memo pad area (up to 8).
Pen Color Add a [Pen Color] switch.

This switch is used to select the pen color.
Block Call Add a [Block Call] switch.

Brings up the memo pad area of the specified number.
Add Parts Switch Add a switch.
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Detail

Item Description
SRAM/Clock Setting Configure the settings to save memo pad data to the SRAM area.

For details, refer to “13.1.4 Memo Pad Data Storage” page 13-5.
Coordinate Set the Start X/Start Y (top left coordinates).
ID Set the ID.
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13.1.4 Memo Pad Data Storage
Memo pad data can be saved to the built-in RAM, SRAM, or a storage device.
Data saved to RAM is cleared when MONITOUCH is turned off or when the local mode screen is displayed.
To retain data even when the power is turned off, save data to SRAM or a storage device.

Memo Pad Storage Area Size

* This is the maximum capacity available provided that the entire SRAM area is used for the memo pad function.

Saving to RAM
No settings are required.

Saving to SRAM
To save data to the SRAM area, settings must be configured in the [SRAM/Clock Setting] window.

[SRAM/Clock Setting] window
• Storage area for memo pad

Set the storage area size for the memo pad function in the SRAM area.
Refer to the list shown above to set an appropriate size.

Saving to a Storage Device
No settings are required. Insert the storage device into MONITOUCH.
Note that when the memo pad area is configured in the [SRAM/Clock Setting] window, data is stored in the SRAM area even 
if a storage device is inserted.

• Filename: MEMxxxx.png (xxxx=0000 to 0007)

Storage Target Capacity (Words)
RAM 32,000

SRAM * 262,000
Storage device 262,000

For details of the procedure for dividing the SRAM area, etc., refer to “1.1 System Settings”.

For details on other settings, refer to “1.1 System Settings”.
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Timing for Saving Data
The memo pad data is saved to the memo pad area at the following timing.

• When switching pages using the [Function: + Block, − Block] switches
• When changing the screen
• When switching from RUN mode to Local mode (only for SRAM)

If data cannot be saved due to insufficient memory, the memo pad display area flashes and the unit beeps. Reduce the memo 
pad data.
The remaining space of the memo pad data storage area when saving to SRAM is stored in system device memory $s108 and 
109.

* Notes on SRAM usage
• If the power is shut down before data is saved, the data is lost.
• If the power is shut down while data is being saved, all the data may be lost.

The data save status is stored in system device memory $s720.

System Device Memory
Memo pad data is stored in system device memory $s.

*1 Usage example
When “8002HEX” is stored in $s106 and a screen with a memo pad is displayed, page No. 2 is cleared before the screen is displayed.
Once the screen is displayed, the value stored in $s106 changes to “0002HEX”.

*2 Codes of the 128 colors

Address ($s) Description Device Type
106

→ V
← VPage number Stores the number of the currently displayed memo pad.

The number to display when a screen change occurs can be specified.
Delete Select the operation to perform when a screen change occurs.

0: Displays the data saved for the specified number.
1: Displays the specified number after clearing the saved data (turns OFF 

automatically after clearing). *1

107

← V

108
109 Remaining space of memo pad data storage area when saving to SRAM (unit: bytes)

719 Pen color (128 colors) *2
Specify the color of the pen when the screen is displayed. If a color other than the 128 colors is 
specified, the color turns white.
When the color of the pen is changed using a switch, the selected color code is stored. If a color 
other than the 128 colors is selected, “−1” (FFFF  Hex) is stored.

0: Black, 1: Blue, 2: Red, 3: Purple, 4: Green, 5: Light blue, 6: Yellow, 7: White (default) *2

→ V
← V

720 Result of saving to SRAM area
0: Successfully saved
1: Error in data. The previous data is cleared. ← V

727 0: Save possible
1: Save impossible due to insufficient memory

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

Not used Page number 0 to 7Delete

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
Page 7 Page 0

Page 6 Page 1
Page 5 Page 2

0: Data not registered Page 4 Page 3
1: Data registered

0 1 2 3 4 5 6 7 8 9 A B C D E F

0F
1F
2F
3F
4F
5F
6F
7F

00
10
20
30
40
50
60
70
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14.1 Overview
• The switch or numerical data display parts registered on the screen can be shown or hidden according to its operating 

status.
The “show/hide” attribute can be set using methods including device memory bit activation in the PLC, bit/word 
designation, or commands.

• Registered items can be set with the show/hide attribute even if they will not be actually used. For example, if future 
additions of items are planned, the items to be added can be registered in advance and set with the hide attribute, which 
will make future programming easier.

• Items which were placed overlapping will be displayed in the same order that they were placed even if they are hidden 
and shown again.

Applicable items

Locations for registration
Screen, overlap, screen library, data block

Refer to “14.2 Setting Examples” page 14-2

Switch
Lamp
Data display Numerical data display, character display, message display
Graph Graphs, statistical graphs, closed area graphs
Linked parts Keypads, character keys, trend parts, alarm parts, video/RGB display, USB camera display, JPEG display, 

network camera display, remote desktop display, graphic parts, message parts, comment parts, recipes, data 
blocks, and memo pads

Grouped items Including graphic items

PLC

10.23

9.89

7.23

11.02

12.03

A B C D E

No. 1

No. 2

No. 3

No. 4

No. 5

10.23

9.89

7.23

11.02

12.03

849

988

489

156

484

A B C D E

No. 6

No. 7

No. 8

No. 9

No. 10

No. 1

No. 2

No. 3

No. 4

No. 5

M200 = ON

The numerical data display group on the right side 
is only displayed when M200 is ON in the PLC.

MENU

MENU

Operation 1 Operation 2 Setting 1 Setting 2

Setting 3 Error 
Monitor Monitor 1 Monitor 2

Maintenance 
1

Maintenance 
2

Trouble 
Monitor 1

Trouble 
Monitor 2

Operation 1 Operation 2 Setting 1 Setting 2

Setting 3 Error 
Monitor Monitor 1 Monitor 2

The switches with [Hide] set 
will not be displayed.
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14.2 Setting Examples
14.2.1 Displaying Items when the Corresponding Bit Turns ON

Screen Creation
1. Place a numerical data display and character display on the screen.
2. Configure the [Bit device] settings via [Show/Hide].

Unit Operation
1. When M100 is set to ON via the PLC, the numerical data display is shown.

2. When M200 is set to ON via the PLC, the character display is shown.

3. When M100 and M200 are set to OFF, the numerical data display and character display are hidden.

PLC

M100 = ON

M100 = ON
M200 = OFF

M100 = OFF
M200 = OFF

PLC

M200 = ON

M100 = ON
M200 = ON

M100 = ON
M200 = OFF
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14.2.2 Displaying Items Using Device Memory Values
Screen Creation
1. Place a switch.
2. Configure the [Word Device] settings via [Show/Hide].

Unit Operation
1. When D100 is set to “1234” via the PLC, switch A on the left is shown.

2. When D100 is left as “1234” and D200 is set to “9999” via the PLC, switch B on the right is shown.

3. When D100 and D200 are both set to “0”, the switches are hidden.

PLC

D100 = 1234

D100 = 1234
D200 =       0

D100 =       0
D200 =       0

PLC

D200 = 9999

D100 = 1234
D200 = 9999

D100 = 1234
D200 =       0
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14.2.3 Displaying Items Using the Level of the Security Function
Screen Creation
1. Place a switch that initiates operation.
2. Set the level of [Security Level] to “2” via [Show/Hide].

* Always turn on the security function. Items with security levels will not be displayed if the security function is not turned 
on.

Unit Operation
1. A lamp is displayed on the screen (security level 0).

2. Enter the ID and password for level 2 on the login screen of the security function.
The login level changes to level 2 and the operation switch is displayed.

3. Users with a login level of 2 to 15 can operate the operation switch.

4. When a user logs off, the login level changes to 0 and the operation switch becomes hidden.

Lamp (no security level (always displayed)
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14.3 Detailed Settings
Show/Hide
Configure the [Show/Hide] settings for each item.

Screen Settings
Set the timing of item drawing via [Screen Setting] → [Screen Setting] → [Unhide].

Item Description
Show Show the part on the screen.
Hide Do not show the part on the screen.
Show/hide according to the condition The part is shown or hidden according to the specified conditions.

Click [Add] and set up a maximum of five conditions.
Condition Setting Click a condition number to configure a condition that must be satisfied for showing or 

hiding the part.
Bit Device Show the part if the bit device memory condition is satisfied and hide the part if the 

condition is not satisfied.
Word Device Show the part if the conditional expression of the specified word device memory is 

satisfied and hide the part if the expression is not satisfied.

Security Level This setting is available when using the security function.
Show or hide the part according to the security level of the user that is currently logged in.
For details, refer to “5 Security” in the Reference Manual 2.

AND/OR Setting When setting two or more conditions, set whether to perform AND or OR operations on 
the conditions.

Item Description
Unhide items Selected

Perform item redisplay when the state of [Show/Hide] for an item changes.

Unselected
Perform redisplay immediately after changing screens or only when executing the “SYS (RESET_SCRN)” 
macro.

Apply to all screens Apply the above settings to all screens.

Constant Display 
Type

Select the data type of the conditional expression.
[DEC+−] / [DEC] / [BCD] / [HEX]

Condition 
expression

Set an equal sign, value, and device memory address as the 
conditions for comparison.
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14.4 Checking Settings
Use the following method to check the [Show/Hide] settings of items.

Item List
Display the [Item List] window from the [View] menu.
Items with [Show/Hide] settings are shown in green, yellow or light blue. Uncolored items correspond to items for which 
[Show] is selected.

Display Environment Settings
Select [View] → [Display Environment].

* The same settings can be made via the right-click menu on the screen.

Item Description
Hide Items not displayed Items with [Show/Hide] settings are not displayed on the screen.
Display a hidden item symbol Display a hidden item symbol for items with [Show/Hide] settings.

Yellow: security level

Light blue: hidden

Green: device memory 
designation

Symbol Setting
None Show

Light blue Hide

Green Show/hide according to the condition

Yellow Security Level
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15.1 Overview
15.1.1 Recipes

In manufacturing, the conditions and data that are critical for making products are collectively referred to as a “recipe”.
For example, when beverages are produced on the factory floor of a beverage manufacturer, the conditions for producing 
apple juice and orange juice differ with respect to ingredients and production processes for each type of beverage.

In order to produce and deliver products at a constant quality, the use of recipe information specific to each product is very 
important.
Recipes for products to be made on a particular day are managed on the factory floor, and smoothly changing between 
recipes according to the production conditions results in efficient production of higher quality products.

Ingredients
Fruit juice
Sugar
Flavoring
Acidulant

xxx  g
xx g
xx g
x g

Apple juice
Process

Agitation
Sterilization
Cooling

xxx  min
xxx  min
xxx  min

Production control

9:00 to 11:00
11:00 to 15:00
15:00 to 18:00

xxxxx
xxxxx
xxxxx

Ingredients
Fruit juice
Sugar
Flavoring
Acidulant

xxx  g
xx g
xx g
x g

Orange juice
Process

Agitation
Sterilization
Cooling

xxx  min
xxx  min
xxx  min

Production control

9:00 to 11:00
11:00 to 15:00
15:00 to 18:00

xxxxx
xxxxx
xxxxx

The required data is managed for each 
product type and applied during 
production.

Production control

9:00 to 11:00
11:00 to 15:00
15:00 to 18:00

xxxxx
xxxxx
xxxxx

Process
Agitation
Sterilization
Cooling

xxx  min
xxx  min
xxx  min

Production control

9:00 to 11:00
11:00 to 15:00
15:00 to 18:00

xxxxx
xxxxx
xxxxx

Process
Agitation
Sterilization
Cooling

xxx  min
xxx  min
xxx  min

Apple juice Orange juice

Change to the 
apple juice recipe!
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15.1.2 Recipe Function
Precise and easy management of recipes, as described in the previous section, on the factory floor is a requirement.
Recipes comprise different information depending on product type and may undergo modification on the factory floor.
Recipe data can be managed without stress by managers on the factory floor if data on a PLC can be substituted or changed 
according to circumstance.
The advantages of using the recipe function of the V10/V9 series unit can be realized in various situations.

Structure

• Recipe data is stored in the CSV or BIN file format and can be read or written by the V10/V9 series unit.
An external storage device (i.e. SD card) is required to store files.

• Data can be read and written in units of files or records.

• Not only can data on an SD card be read or written, additions to data and new data can also be created.

• CSV and BIN files can be easily created and edited using the screen configuration software.
• Settings including the format of each file and bits for commanding transfer are specified in the recipe settings in the 

screen configuration software.

SD
Store CSV files (or BIN files) 
on an SD card.

Charge
Contents
Size
Net
Gross

60
60
50
40

1100

110
110
85
60

1200

4200
4500
800

5000
1000

A B Data GAPPLE
ORANGE
GRAPE
LEMON
Type D

60
60
50
40

2200

110
110
85
60

1500

10
8

11
15
8

A B 3APPLE
ORANGE
GRAPE
LEMON
PEACH

60
60
50
40
80

110
110
85
60

120

250
220
240
220
240

A B C

Records

Files

150
180
140
110
100

30
40
80

100
90

10
10
30
50
45

5
5
5
5
5

PRODUCT.BIN

SD

100
160

80
70

20
50

5
5

100 80 20 5

160 70 50 5

(1) Addition of one record of data from the PLC

(2) Addition of one record of data from the PLC

(1) added
(2) added
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Operations
The recipe function performs the following operations.

• Reading and writing of files (CSV/BIN)
For details on these operations, refer to “15.3 Reading Recipes in Units of Files When the PLC Bit Turns ON” and “15.4 
Reading Recipes in Units of Files with Switch Operations”.

• Reading and writing of records
For details on these operations, refer to “15.5 Reading Recipes in Units of Records” and “15.6 Writing Recipes in Units of 
Records”.

There are two types of control modes in which operation execution commands can be issued. “Global control” allows 
commands to be executed regardless of the display state of MONITOUCH, and “local control” only accepts commands when a 
specific screen is displayed.
These modes are described below.

Global Control
Recipe operations can be performed when any screen is displayed using commands from a PLC because reading and writing 
of data is performed according to a control bit from the PLC, as specified in the recipe settings.

Local Control
Recipe operations are only possible using switches placed on a screen for executing the relevant recipe operations.

SD SD

M100 = ON

Recipe operation is 
executed.

The trigger bit for recipe 
loading turns ON on the PLC.

SD SD

Press the switch for loading recipes 
placed on the screen.

Recipe operation is 
executed.
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15.2 Creating Recipe Data (BIN/CSV Files)
15.2.1 Using the Screen Configuration Software

This section explains the procedure for creating BIN files such as the above two as an example.

Setting Procedure
File Format/Format Settings
1. Because two BIN files of different formats are being created, recipe registration is separated into number 0 and number 1.

The creation procedure for number 0, PRODUCT.BIN, is explained first.
Click [System Setting] → [Recipe] and select “0” for [No.]. The [Recipe [0]] window is displayed.

2. On the [Standard Operation] tab window, select [File-based transfer] for [Data to Transfer].
Configure the other settings as shown below.

3. Next, select the [File Format] tab window.
Configure the following settings.

APPLE
ORANGE
GRAPE
LEMON
PEACH

150
180
140
110
100

30
40
80

100
90

10
10
30
50
45

5
5
5
5
5

PRODUCT.BIN

APPLE
ORANGE
GRAPE
LEMON
PEACH

60
60
50
40
80

110
110
85
60

120

250
220
240
220
240

WORK.BIN

Fruit juice

Agitation time

Create

Create

Sugar Flavoring Acidulant

Sterilization 
time Cooling time

Storage Target Folder (Blank = directly under the “RECIPE” folder)
File Type BIN
Storage Target File File Name Designation
Filename PRODUCT (bin)

Add record name Selected
Add title to data Selected
Number of Records 5
Number of Data 4
Record Name: Characters 8
Record Name: Text Process LSB->MSB
Data Type DEC
Data Length 1-Word
Decimal Point 0
Transfer Target Data
Device Designation Specify consecutively
Top device D100
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Creating BIN Files
1. Select the [Recipe Data] tab window. Click [Create File].

[PRODUCT.bin (New)] is shown as the title of the creation area on the right and a creation menu is displayed.
2. First, enter title names. Double-click each title name to enter text.
3. Next, enter record names. Double-click each record in the same manner to enter text.
4. Edit each entry of recipe data.
5. After editing the required number of entries, click [Save As] and save the file.

Creating Recipe No. 1
1. Create recipe number 1 in the same manner as recipe number 0.

Click [System Setting] → [Recipe] and select “1” for [No.].
The [Recipe [1]] window is displayed.

2. Create a file in the same manner as number 0.
However, set “3” for [Number of Data] because WORK.BIN has three columns in this example.

Storing on an SD Card
1. Connect the SD card to the PC and click [File] → [Storage Manager].

2. The [Storage Drive Select] window is displayed.

3. Specify the drive of the SD card connected in step 1 and click [OK].
The [Storage Manager] window is displayed.
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4. Click the [Write to Storage] button on the [Storage Setting] menu.

5. In the [Write to storage] window, check that the [Write Data Being Edited] checkbox is selected and click [OK].
6. An access folder is created on the SD card drive in the [Storage Manager] window. Check that a “RECIPE” folder is created 

along with some other folders on the SD card drive and then close the [Storage Manager] window.
7. Next, save the created BIN files to the “Recipe” folder that was confirmed to exist in step 6.

Either use Windows Explorer to copy the files or click the [Save As] button on the [Recipe Data] tab window in the recipe 
settings to save the files directly to the “Recipe” folder.
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15.2.2 Creating Recipes Using Excel (CSV Files Only)
Setting Procedure
File Format/Format Settings
1. Configure the [Standard Operation] and [File Format] tab windows with the same settings as the BIN files in the previous 

section.

• [Standard Operation] tab window

• [File Format] tab window

Creating CSV Files
1. Start Excel.

Edit the data in Excel in the intended format.
2. Save the data. Click [File] → [Save As].
3. Select “CSV (Comma delimited) (*.csv)” for [Save as type], specify a filename, and save the file.

Storing on an SD Card
1. Connect the SD card to the PC and click [File] → [Storage Manager].

2. The [Storage Drive Select] window is displayed.

Storage Target Folder Any location on the SD card
File Type CSV
Storage Target File File Name Designation
Filename PRODUCT (csv)

Add record name Selected
Add title to data Selected
Number of Records 5
Number of Data 4
Record Name: Characters 8
Record Name: Text Process LSB->MSB
Data Type DEC
Data Length 1-Word
Decimal Point 0
Transfer Target Data
Device Designation Specify consecutively
Top device D100
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3. Specify the drive of the SD card connected in step 1. and click [OK].
The [Storage Manager] window is displayed.

4. Click the [Write to Storage] button on the [Storage Setting] menu.

5. In the [Write to storage] window, check that the [Write Data Being Edited] checkbox is selected and click [OK].
6. An access folder is created on the SD card drive in the [Storage Manager] window. Check that a “RECIPE” folder is created 

along with some other folders on the SD card drive and then close the [Storage Manager] window.
7. Next, save the created CSV file to the “RECIPE” folder that was confirmed to exist in step 6.

Copy the file using Windows Explorer.
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15.3 Reading Recipes in Units of Files When the PLC Bit Turns ON
15.3.1 Conceptual Operation

* PLC data can also be written to files. PLC data is written to a BIN file when the relevant bit turns ON.
If a BIN file does not exist, a new BIN file is created automatically.

15.3.2 Setting Procedure
1. Click [System Setting] → [Recipe] and select “0” for [No.]. The [Recipe [0]] window is displayed.
2. On the [Standard Operation] tab window, select [File-based transfer] for [Data to Transfer].
3. Select [File Name Designation] for [Storage Target File] and define the name of the file for reading (e.g. PRODUCT.bin).

* Select the [Designate by device] checkbox under the filename to allow reading by a specified device memory address such as of a PLC.
A fixed file is targeted in this example.

4. Display the [File Format] tab window.
5. Select [Specify consecutively] for [Device Designation] under [Transfer Device Setting] and specify the top device memory 

address (e.g. D100).
6. Display the [Transfer Command] tab window.
7. Select the [MONITOUCH → PLC] checkbox under [Add Transfer Condition].

Define the PLC bit (e.g. M100) for [Device].
Select [Transfer when bit [ON]] for [Trigger Select].

This completes the necessary settings. The screen program can be transferred to MONITOUCH.

15.3.3 Operating Procedure
1. With the recipe file stored on an SD card, the relevant bit (e.g. M100) on the PLC turns ON.
2. The data of the file defined in step 3 of the previous section is read out sequentially to the reading destination starting 

from the top device memory address (e.g. D100).

SD

150
180
140
110
100

30
40
80

100
90

10
10
30
50
45

5
5
5
5
5

PRODUCT.BIN
D100
D101
D102
D103
D104
D105
D106

D118
D119

150
30
10
5

180
40
10

45
5

M100 = ONPLC bit turns ON

PLC reads recipe
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15.4 Reading Recipes in Units of Files with Switch Operations
15.4.1 Conceptual Operation

* PLC data can also be written to files. Pressing the switch writes the PLC data to the selected file. If a file does not exist, a 
new file is created automatically.

15.4.2 Setting Procedure
1. Click [System Setting] → [Recipe] and select “0” for [No.]. The [Recipe [0]] window is displayed.
2. On the [Standard Operation] tab window, select [File-based transfer] for [Data to Transfer].
3. Display the [File Format] tab window.
4. Select [Specify consecutively] for [Device Designation] under [Transfer Device Setting] and specify the top device memory 

address (e.g. D100).
5. Next, configure the switch settings.

In the switch settings window, change “Standard” to “Recipe” under [Function] in the [Function] settings and then select 
“Recipe Data Load”.

6. Select [0], which was specified in step 1, for [Recipe]. The switch settings differ depending on the selection made here.
7. Select the [Select at the time of execution] checkbox for [File Selection].

(When there is only one file, specify a value for [Specify the number] or [Specify the name].)

This completes the necessary settings. The screen program can be transferred to MONITOUCH.

15.4.3 Operating Procedure
1. With the recipe file stored on an SD card, press the switch (set with “Recipe Data Load” for [Function]) on the screen.

A list window for automatic file selection is displayed.

2. Select a file and press the [Load] button to sequentially read out to the reading destination starting from the top device 
memory address (e.g. D100). When there are files that cannot be viewed in the window at once, either scroll or perform 
filtering to bring them into view. For more information on filtering, refer to the next page.

SD

D100
D101
D102
D103
D104
D105
D106

D118
D119

150
30
10
5

180
40
10

45
5

Press the switch and select a file 
from the displayed list.

PLC reads recipe

Load

Load

Scroll the list to bring hidden 
files into view.
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Reading Out by Searching for Filenames (Filtering)
When there are many files, searching for filenames (filtering) can be used to find files.

* Searching for record names (filtering) is also possible.

1. With the recipe file stored on an SD card, press the switch (set with “Recipe Data Load” for [Function]) on the screen.
A list window for automatic file selection is displayed.

2. Press the [Filter] button to display the following filtering window.
Enter the first few characters of the filename.

* Press the text field to automatically display the system keyboard. Use this keyboard to enter text.

3. Press [OK] to display a list of files with filenames that contain the entered text.
When there are files that cannot be viewed in the window at once, the entire list can be checked by scrolling.

Load
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4. Find the target file, select it, and press [Load]. The target file is read out sequentially to the reading destination starting 
from the top device memory address (e.g. D100).

The recipe data of the file is 
read into the PLC.
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15.5 Reading Recipes in Units of Records
15.5.1 Specifying Record Numbers for Reading

Conceptual Operation

Setting Procedure
1. Click [System Setting] → [Recipe] and select “0” for [No.]. The [Recipe [0]] window is displayed.
2. On the [Standard Operation] tab window, select [Record-based transfer] for [Data to Transfer].
3. Select [File Name Designation] for [Storage Target File] and define the name of the file for reading (e.g. PRODUCT.bin).
4. For the [Transfer Record] settings, select the [Designate by device] checkbox next to [Record Number Designation].

Define the device memory address for record number designation (e.g. D500).
5. Display the [File Format] tab window.
6. Select [Data] for [Transfer Target] under [Transfer Device Setting] and specify the top device memory address (e.g. D100).
7. Display the [Transfer Command] tab window.
8. Select the [MONITOUCH → PLC] checkbox under [Add Transfer Condition].

Define the PLC bit (e.g. M100) for [Device].
Select [Transfer when bit [ON]] for [Trigger Select].

This completes the necessary settings. The screen program can be transferred to MONITOUCH.

Operating Procedure
1. With the recipe file stored on an SD card, specify “3” for the device memory address (e.g. D500) on the PLC.
2. In addition, set the relevant bit (e.g. M100) to ON.
3. The data of record number 3 in the file defined in step 3 of the previous section is read out sequentially to the reading 

destination starting from the top device memory address (e.g. D100).

SD

150
180
140
110
100

30
40
80

100
90

10
10
30
50
45

5
5
5
5
5

PRODUCT.BIN
D100
D101
D102
D103
D104
D105
D106

140
80
30
5

No. 1
No. 2
No. 3
No. 4
No. 5

D500 = 3 (record number)
M100 = ON (transfer command bit)

PLC bit turns ON

Recipe at record number 3 
is read to the PLC
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15.6 Writing Recipes in Units of Records
15.6.1 Specifying Record Names for Writing

Conceptual Operation

Setting Procedure
1. Click [System Setting] → [Recipe] and select “0” for [No.]. The [Recipe [0]] window is displayed.
2. On the [Standard Operation] tab window, select [Record-based transfer] for [Data to Transfer].
3. Select [File Name Designation] for [Storage Target File] and define the name of the file for reading (e.g. PRODUCT.bin).
4. For the [Transfer Record] settings, select the [Designate by device] checkbox next to [Record Name Designation].

Define the device memory address for record name designation (e.g. D500).
5. Display the [File Format] tab window.
6. Select [Data] for [Transfer Target] under [Transfer Device Setting] and specify the top device memory address (e.g. D100).
7. Display the [Transfer Command] tab window.
8. Select the [PLC → MONITOUCH] checkbox under [Add Transfer Condition].

Define the PLC bit (e.g. M100) for [Device].
Select [Transfer when bit [ON]] for [Trigger Select].

This completes the necessary settings. The screen program can be transferred to MONITOUCH.

Operating Procedure
1. With the recipe file stored on an SD card, specify the record name (e.g. “APPLE”) to the device memory address (e.g. 

D500) on the PLC using ASCII code characters.
2. In addition, set the relevant bit (e.g. M100) to ON.
3. The data stored in the transfer device memory (e.g. D100) is written sequentially starting from the top address to the 

“APPLE” record in the file defined in step 3 of the previous section.

SD

170
180
140
110
100

50
40
80

100
90

20
10
30
50
45

8
5
5
5
5

PRODUCT.BIN
D100
D101
D102
D103
D104
D105
D106

170
50
20
8

APPLE
ORANGE

GRAPE
LEMON
PEACH

D500 onwards = APPLE (record name)
M100 = ON (transfer command bit)

PLC bit turns ON

PLC value written to recipe 
of record “APPLE”
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15.6.2 Creating New Records
New records can be created by defining record numbers or records names that do not currently exist and executing writing.

* Files can also be created in the same manner.

Conceptual Operation

Setting Procedure
1. Click [System Setting] → [Recipe] and select “0” for [No.]. The [Recipe [0]] window is displayed.
2. On the [Standard Operation] tab window, select [Record-based transfer] for [Data to Transfer].
3. Select [File Name Designation] for [Storage Target File] and define the name of the file for reading (e.g. PRODUCT.bin).
4. For the [Transfer Record] settings, select the [Designate by device] checkbox next to [Record Name Designation].

Define the device memory address for record name designation (e.g. D500).
5. Display the [File Format] tab window.
6. Select [Data] for [Transfer Target] under [Transfer Device Setting] and specify the top device memory address (e.g. D100).
7. Display the [Transfer Command] tab window.
8. Select the [PLC → MONITOUCH] checkbox under [Add Transfer Condition].

Define the PLC bit (e.g. M100) for [Device].
Select [Transfer when bit [ON]] for [Trigger Select].

This completes the necessary settings. The screen program can be transferred to MONITOUCH.

Operating Procedure
1. With the recipe file stored on an SD card, specify the record name (e.g. “BANANA”) to the device memory address (e.g. 

D500) on the PLC using ASCII code characters.
2. In addition, set the relevant bit (e.g. M100) to ON.
3. Because the record name “BANANA” does not exist in the file defined in step 3 of the previous section, the data in the 

transfer device memory (e.g. D100) is written sequentially starting from the top address to a newly added record named 
“BANANA”.

SD

150
180
140
110
100

30
40
80

100
90

10
10
30
50
45

5
5
5
5
5

PRODUCT.BIN
D100
D101
D102
D103
D104
D105
D106

170
50
20
8

APPLE
ORANGE

GRAPE
LEMON
PEACH

150
180
140
110
100
170

30
40
80

100
90
50

10
10
30
50
45
20

5
5
5
5
5
8

APPLE
ORANGE

GRAPE
LEMON
PEACH

BANANA

D500 onwards = BANANA (record name)
M100 = ON (transfer command bit)

PLC bit turns ON

Because the record name “BANANA” does not exist, a new 
record name “BANANA” is added to the recipe.
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Difference in Operation Between Record Name Designation and 
Record Number Designation
When creating in units of records, operation differs between creating a new record name and creating a record number.

• Record name
When a new record name is created that did not previously exist, records are added by inserting a line at the end of the 
relevant file.

• Record number
When a new record number is created that did not previously exist, a new record is created with the specified record 
number. If there is a gap between the end number and the new number, empty lines are registered.

APPLE
GRAPE
LEMON
PEACH

60
50
40
80

110
85
60

120

250
240
220
240

APPLE
GRAPE
LEMON
PEACH
ORANGE

60
50
40
80
60

110
85
60

120
110

250
240
220
240
220

No. 1
No. 2
No. 3

60
50
40

110
85
60

250
240
220

No. 1
No. 2
No. 3
No. 4
No. 5
No. 6
No. 7
No. 8

60
50
40
0
0
0
0

60

110
85
60
0
0
0
0

110

250
240
220

0
0
0
0

220
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15.7 Checking that the Recipe Function is Operating Correctly
15.7.1 Conceptual Operation

15.7.2 Setting Procedure
1. Click [System Setting] → [Recipe] and select “0” for [No.]. The [Recipe [0]] window is displayed.
2. On the [Standard Operation] tab window, select [File-based transfer] for [Data to Transfer].
3. Select [File Name Designation] for [Storage Target File] and define the name of the file for reading (e.g. PRODUCT.bin).

* Select the [Designate by device] checkbox under the filename to allow reading by a specified device memory address such as of a PLC.
A fixed file is targeted in this example.

4. Display the [File Format] tab window.
5. Select [Specify consecutively] for [Device Designation] under [Transfer Device Setting] and specify the top device memory 

address (e.g. D100).
6. Display the [Transfer Command] tab window.
7. Select the [MONITOUCH → PLC] checkbox under [Add Transfer Condition].

Define the PLC bit (e.g. M100) for [Device].
Select [Transfer when bit [ON]] for [Trigger Select].

8. Select the [Use Info Output Device] checkbox under [Device Setting] and specify a device memory address (e.g. D400).
This completes the necessary settings. The screen program can be transferred to MONITOUCH.

15.7.3 Checking Procedure
1. With the recipe file stored on an SD card, the relevant bit (e.g. M100) on the PLC turns ON.
2. The data of the file defined in step 3 of the previous section is read out sequentially to the reading destination starting 

from the top device memory address (e.g. D100).
3. Check the D400 setting. If transfer was completed successfully, the 14th bit turns ON (D400 = H4000).

* The content of the information output device memory is shown below. For details, refer to page 15-21.

SD

150
180
140
110
100

30
40
80

100
90

10
10
30
50
45

5
5
5
5
5

PRODUCT.BIN
D100
D101
D102
D103
D104
D105
D106

D118
D119

150
30
10
5

180
40
10

45
5

3) Information 
declaring that the 
operation 
successfully 
completed is output 
to the PLC.

4) D400 = H4000 is output

M100 = ON1) PLC bit turns ON

2) PLC reads recipe

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Information output device memory
(e.g. D400)

System reserved

Transfer error

PLC → MONITOUCH transfer complete
MONITOUCH → PLC transfer complete

PLC → MONITOUCH transfer in progress

MONITOUCH → PLC transfer in progress
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15.8 Detailed Settings
15.8.1 Location of Settings

Click [System Setting] → [Recipe].
A window for specifying the recipe number is displayed. Select a number and click [OK].
The [Recipe] settings window is displayed.

15.8.2 Recipe Settings (0 to 255)
The recipe settings area is used to newly register information when there are differences in the settings required for recipe 
management, such as the format of files that store recipe data and execution start bits etc. First, a number is set to the recipe 
setting.

[Standard Operation] Tab Window

*1 BIN files result in faster processing speed on MONITOUCH than CSV files.
However, checking and editing of BIN file content requires Hakko Electronics’ “V-SFT” software.

*2 The applicable filenames when specifying by file number are “RECxxxx.CSV” and “RECxxxx.BIN”. (xxxx: 0000 to 9999)

Item Description
Data to Transfer Record-based transfer Select this option to read and write recipe data in units of records (rows or columns).

File-based transfer Select this option to read and write recipe data in units of files.
Storage Target Folder Define the storage target folder for files on the SD card. Define one folder per recipe 

setting.
File Type CSV/BIN *1 Select the file format of the data to store.

Add This checkbox is enabled when [Transfer Data] is set to [File-based transfer] and [File 
Type] is set to [CSV].
When a “PLC → MONITOUCH“ transfer is executed, data is added to the end of the 
CSV file.
Max. 32767 lines

Storage Target File File Number Designation *2
(0 to 9999)

Set the file number of the storage target.
When the [  Designate by device] checkbox is selected, the storage target can be 
defined by specifying a number to a device memory address.

File Name Designation Set the filename of the storage target.   Max. 64 characters (one-byte) 
When the [  Designate by device] checkbox is selected, the storage target can be 
defined by specifying a name to a device memory address.

Transfer Record Record Number Designation
(0 to 32767)

Set the record number of the storage target.
When the [  Designate by device] checkbox is selected, the storage target can be 
defined by specifying a number to a device memory address.

Record Name Designation Set the record name of the storage target.   Max. 64 characters (one-byte) 
When the [  Designate by device] checkbox is selected, the storage target can be 
defined by specifying a name to a device memory address.
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[File Format] Tab Window
Item Description

Line/Column Contents Line: Record, Column: Data

Line: Data, Column: Record *1

Add record name Set how to handle the first column (or first line) in the CSV/BIN file.
• Unselected

The first column is handled as data.

• Selected
The first column is handled as a record name (2 to 255).

Add title to data Set how to handle the first line (or first column) in the CSV file.
• Unselected

The first line is handled as data.

• Selected
The first line is handled as the title.

Reading the title name Read the CSV file created in advance that contains the title. 
The read title is registered to [Title Name].

Interface Language Select the display language of the title name.
Delimiter (Comma, Tab, Period *2, Semicolon) This setting is only available when [CSV] is selected for [File Type] on 

the [Standard Operation] tab window. Select the character for 
delimiting data.

Number of Records (1 to 32767) This setting is only available when [File-based transfer] is selected 
for [Data to Transfer] on the [Standard Operation] tab window. Set 
the number of records per file.

Number of Data (1 to 4096) Set the number of data entries on the first line (or first column) (per 
record) in the CSV/BIN file.

APPLE
ORANGE
GRAPE
LEMON
PEACH

60
60
50
40
80

110
110
85
60

120

250
220
240
220
240

Records

Data

APPLE   ORANGE   GRAPE   LEMON   PEACH
60

110
250

60
110
220

50
85

240

40
60

220

80
120
240

Records

Data

60
60
50
40
80

110
110
85
60

120

250
220
240
220
240

APPLE
ORANGE
GRAPE
LEMON
PEACH

60
60
50
40
80

110
110
85
60

120

250
220
240
220
240

APPLE
ORANGE
GRAPE
LEMON
PEACH

60
60
50
40
80

110
110
85
60

120

250
220
240
220
240

APPLE
ORANGE
GRAPE
LEMON
PEACH

60
60
50
40
80

110
110
85
60

120

250
220
240
220
240

Agitation time Sterilization 
time Cooling time
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*1 This setting is only available when [CSV] is selected for [File Type] on the [Standard Operation] tab window. The size of the file is 1MB or 
less.

*2 The decimal point is indicated using a comma for German, Italian, French and other relevant languages. For this reason, a period character 
may be used as the delimiter in CSV files. Note that when editing this data in Excel, the relevant option must be changed for the display 
format. 

*3 The title name is read when creating a new recipe file. This cannot be used when reading an existing recipe file.

[Recipe Data] Tab Window

Format Title Name (max. 255 bytes) *3 This setting is only available when the [Add title to data] checkbox is 
selected. Register a title.
There are two methods to register a title, directly editing the cell or 
reading from a CSV file using [Reading the title name].

Data Type 
(DEC/DEC-/HEX/OCT/BIN/CHAR/
BCD/FLOAT)

Set the data format.

Data Length (1-Word/2-Word)
Decimal Point (0 to 32)
Characters (2 to 255)
Text Process (LSB → MSB)

Transfer Target This setting is only available when the [Add record name] checkbox 
is selected.

Data Only transfer data.
Record Name + Data Transfer record names and data.

Device Designation This setting is only available when [File-based transfer] is selected 
for [Data to Transfer] on the [Standard Operation] tab window.

Specify consecutively Specify the top device memory address only.
The number of bits required for the data is assigned consecutively.

Individually specify the top of the 
record

A top device memory address for each record in the file can be 
specified.

Specify individually Specify all device memory addresses individually.
V8 Compatible Setting The automatically converted settings when a V8 recipe screen is 

converted.

Item Description
Create File Select when creating a new CSV or BIN file.

Overwrite Save the created file to an existing file.
Save As Save the created file using a different filename. The save destination is not limited to the 

storage device drive and can be changed to any location on the PC.
Page Switch the screen for editing.
Interface Language Switch the language for editing.

File Editing Select when loading an existing CSV or BIN file.
Storage Drive Select Select the drive of the SD card/USB flash drive connected to the PC.
Storage Target Folder The folder specified on the [Standard Operation] tab window is displayed automatically.
File List The files in the specified folder are displayed.
Edit Select a CSV/BIN file displayed under [File List] and click the [Edit] button. The file is 

loaded into the editing window on the right.
Copy Select a CSV/BIN file displayed under [File List] and click the [Copy] button. This makes a 

copy of the file.
Delete Select a CSV/BIN file displayed under [File List] and click the [Delete] button. This deletes 

the file.
Rename Select the CSV/BIN file displayed under [File List] and click the [Rename] button. The file 

name can be changed.

Item Description
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[Transfer Command] Tab Window

* Operation when MONITOUCH is starting up
Transfer is executed when the trigger bit is ON or OFF during startup.

Edit a file in another folder Edit a file in a folder other than the storage target folder. Click to display a window for 
specifying the folder.

Newest File Select when loading an existing CSV or BIN file that was used recently.

Item Description
Add Transfer 
Condition

Specify the operation to perform and trigger bit to use when transferring the 
recipe.

PLC → MONITOUCH/MONITOUCH 
→ PLC

Select [PLC → MONITOUCH] to store the data on the PLC onto an SD card.
Select [MONITOUCH → PLC] to transfer the data on an SD card to the PLC.

Device Specify the trigger bit used for outputting transfer commands.
Trigger Select * The timing of the transfer command trigger can be selected.

• Transfer when bit ON
• Transfer when bit OFF

Device Setting Use command device Select this checkbox to prohibit recipe transfer operations.
Turning this bit ON prevents execution of transfer even if a recipe is selected 
and a transfer command is issued.

Use Info Output Device Select this checkbox to check the state of recipe transfer operations on the 
specified device memory address. Information is divided across different bit 
numbers.
Refer to the following table for details.

Output Transfer File No. This setting is only available when [File-based transfer] is selected for [Data to 
Transfer] and [File Number Designation] is selected for [Storage Target File] on 
the [Standard Operation] tab window.
Select this checkbox to specify a device memory address. The transferred file 
number can be output.

Output Transfer File Name This setting is only available when [File-based transfer] is selected for [Data to 
Transfer] and [File Name Designation] is selected for [Storage Target File] on the 
[Standard Operation] tab window.
Select this checkbox to specify a device memory address. The transferred file 
name can be output using the relevant number of characters.
Max. 64 characters (one-byte)

Output Transfer Record No. This setting is only available when [Record-based transfer] is selected for [Data 
to Transfer] and [Record Number Designation] is selected for [Storage Target 
File] on the [Standard Operation] tab window.
Select this checkbox to specify a device memory address. The transferred 
record number can be output.

Output Transfer Record Name This setting is only available when [Record-based transfer] is selected for [Data 
to Transfer] and [Record Name Designation] is selected for [Storage Target File] 
on the [Standard Operation] tab window.
Select this checkbox to specify a device memory address. The transferred 
record name can be output using the relevant number of characters.
Max. 64 characters (one-byte)

Item Description

Device Bit No. State
n 0 Transfer error

0: No error
1: Transfer error

12 MONITOUCH → PLC transfer in progress
1: Transferring

(changes to 0 when transfer is complete)
13 PLC → MONITOUCH transfer in progress

1: Transferring
(changes to 0 when transfer is complete)

14 MONITOUCH → PLC transfer complete
1: Transfer complete

(must be cleared manually after checking)
15 PLC → MONITOUCH transfer complete

1: Transfer complete
(must be cleared manually after checking)

n+1 - External media error
4: Media disconnected
12: Writing error
16: Reading error
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15.9 Switch Operated Functions
15.9.1 Switch Types

*1 Entire lines are deleted when the [Shift subsequent record numbers of recipe data by one after a record is deleted.] checkbox is selected 
in the [System Setting] → [Unit Setting] → [General Settings] tab window.

*2 When [File-based transfer] is selected in the recipe settings and the [Select at the time of execution] checkbox is selected for [File 
Selection] in the switch function settings, [Created on] and [Updated on] can be displayed in the recipe window of the V10/V9 series unit.
When the [Always display the filename] checkbox is selected but the entire filename is not displayed in [File Name] column, the width of 
the column can be adjusted to display the entire filename.

Operation Switch Function Attached Setting Details of Operation
Filter Recipe Data Save

Recipe Data Load
Recipe Data Delete

Select the [Select at the time of 
execution] checkbox for [File 
Selection]/[Record Selection].

Filter and display filenames or record names for when 
selecting a recipe.

New Recipe Data Save Select the [Select at the time of 
execution] checkbox for [File 
Selection]/[Record Selection].

Create new recipe data by naming a file or record and 
save to an SD card.

Save Recipe Data Save Select the [Select at the time of 
execution] checkbox for [File 
Selection]/[Record Selection]. *2

Write data on a PLC to the recipe on an SD card.
(Filter and display filenames or record names for 
when selecting a recipe.)

Recipe Data Save Select [Specify the number] or 
[Specify the name] for [File 
Selection]/[Record Selection].

Write data on a PLC to the recipe (file/record 
specified with the switch) on an SD card.

Load Recipe Data Load Select the [Select at the time of 
execution] checkbox for [File 
Selection]/[Record Selection]. *2

Load recipe data on an SD card to a PLC.
(Filter and display filenames or record names for 
when selecting a recipe.)

Recipe Data Load Select [Specify the number] or 
[Specify the name] for [File 
Selection]/[Record Selection].

Load recipe data (file/record specified with the 
switch) on an SD card to a PLC.

Delete Recipe Data Delete
(file-based)

Select the [Select at the time of 
execution] checkbox for [File 
Selection]. *2

Delete the recipe file on an SD card.
(Filter and display filenames or record names for 
when selecting a recipe.)

Select [Specify the number] or 
[Specify the name] for [File Selection].

Delete the specified recipe file on an SD card.

Recipe Data Delete
(record-based)

Select the [Select at the time of 
execution] checkbox for [Record 
Selection].

[Transfer Target: Data]
Delete the specified record data on the SD card. *1
(Filter and display record names for when selecting a 
recipe.)
[Transfer Target: Record Name + Data]
Delete the record name and record data on the SD 
card. *1
(Filter and display record names for when selecting a 
recipe.)

Select [Specify the number] or 
[Specify the name] for [Record 
Selection].

[Transfer Target: Data]
Delete the specified record data on the SD card. *1

[Transfer Target: Record Name + Data]
Delete the specified record name and record data on 
the SD card. *1
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Filter
Target/Conditions

* Not case-sensitive for file name targets.
Case-sensitive for record names.

Operating Procedure
The operating procedure is explained using the example of pressing a [Recipe Save Data] switch.

1. Set the recipe number in the editor and transfer a [Recipe Data Save] switch with the [Select at the time of execution] 
checkbox selected for [File Selection]/[Record Selection] to the V10/V9 series unit in advance.

2. Press the [Recipe Save Data] switch on the V10/V9 series unit. The following list window is displayed.

3. Press the [Filter] button to display the following text filtering window.
Enter the first few characters of the filename or record name.

* Press the text field to automatically display the system keyboard. Use this keyboard to enter text.

Filter target Filenames and record names
Filter length Max. 64 characters (both two-byte and one-byte)
Filter conditions * Equal to/Not equal to/Begin with/Not begin with/End with/Not end with/Include/Not include
Location of execution Executable by pressing switches with [Function] set to [Recipe Data Save], [Recipe Data Load], or [Recipe Data 

Delete].

Save
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4. Selecting the [Include] filter condition and pressing the [OK] button displays a list of files or records with names that 
contain the entered text. (When the entire list cannot be viewed in the window at once, hidden items can be checked by 
scrolling.)

5. Find the target file or record, select it, and press [Save]. The following confirmation message is displayed.
Press [Yes] to overwrite.
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New
File-Based Targets
1. Set the recipe number in the editor and transfer a [Recipe Save Data] switch with the [Select at the time of execution] 

checkbox selected for [File Selection] to the V10/V9 series unit in advance.
2. Press the [Recipe Save Data] switch on the V10/V9 series unit. The window shown below is displayed.

3. Click the [New File] button. The window for entering a new recipe name is displayed.

4. Press the text field to automatically display the system keyboard. Use this keyboard to enter the name of the new file to 
create.

Save

A file list is displayed.

Press the text field to display the system keyboard.
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5. Press the [Save] button to create a new file.
Press the [Recipe Load Data] switch to display a list that contains the newly created file.

Record-Based Targets
When the target is a record, select [Record Name Designation] for [Transfer Record] in the recipe settings in advance.

1. Set the recipe number in the editor and transfer a switch with the [Select at the time of execution] checkbox selected for 
[Record Selection] to the V10/V9 series unit in advance.

2. Press the [Recipe Save Data] switch on the V10/V9 series unit. The window shown below is displayed.

3. Click the [New File] button. The window for entering a new recipe name is displayed.

Save
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4. Press the text field to automatically display the system keyboard. Use this keyboard to enter the name of the new record 
to create.

5. Press the [Save] button to create a new record.

Press the text field to display the system keyboard.
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15.10 Specifications

*1 Check how many recipes are currently registered by clicking [Tool] → [List of Memory Use] or [View] → [Project].
Delete registered recipes by first displaying the [Project] view window via [View] → [Project], and then clicking [Recipe] 
via [Add/Delete Other Settings] under [System Setting]. Double-click on [Recipe] to display the current recipes in the list. 
Select the recipes for deletion and click the [Delete] button.

*2 Not case-sensitive for one-byte characters.
*3 Note that if 4096 words is exceeded, transfer processing is executed by internally dividing the number of records into 

units of 4096 words.
*4 Execution of a fifth recipe does not generate an error. The data of the fifth recipe is put on standby until the execution of 

any one of the four recipes is completed, and the recipe data on standby is executed.
*5 The maximum number of files available when specifying file numbers is 10,000. Applicable filenames are “RECxxxx.CSV” 

and “RECxxxx.BIN”. (xxxx: 0000 to 9999)

Notes
• Global operations and local operations cannot be executed at the same time on the same recipe number.
• When the screen is changed during recipe operation:

Global: Not affected.
Local: Screen is changed after transfer processing is complete.

• When record data is deleted, the record data is written as empty data.
• If the data format is a character string (including the record name), the recipe data cannot be read or written correctly if 

the language in the file (character code) and the language set on MONITOUCH do not match.

Recipe Parts
• Click [Parts] → [Others] → [Recipe] to place a recipe part on the screen.

This part is a replacement for the recipe display used by the V8 series. Converting a V8 series screen program with recipe 
display parts on the screen to a V10/V9 series screen program will automatically convert it to this item.

• Compatibility is maintained with recipe settings for this recipe part with the [V8 Compatible Setting] at [System Setting] 
→ [Recipe] (No.) → [File Format].

Number of recipes 256 *1

Number of files No limit (up to the capacity of the target storage device) *5

File size Depends on the setting of [File Format]
[Line: Record, Column: Data]: No limit (up to the capacity of the target storage device) 
[Line: Data, Column: Record]: 1MB or less.

Number of records per file 32767
Number of data entries per record 4096 (number of words per record: 65535)
Number of folder name characters Maximum of 255 characters (one-byte) for the full path name *2

Number of filename characters Maximum of 64 characters (one-byte) or 32 characters (two-byte) *2 *5

Number of record name characters Maximum of 255 characters (one-byte) *2

Number of transferable words No limitation *3

Number of recipes executable at the 
same time

Maximum of 4 recipes *4

Number of files transferable at the 
same time

1

Number of records transferable at the 
same time

When [Record-based transfer] is set for [Data to Transfer]: 2
When [File-based transfer] is set for [Data to Transfer]: Number set for [Number of Records] on the 
[File Format] tab window (max. 32767 records).
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16.1 Overview
When the V10/V9 series is operating in RUN mode, the displayed screen and the internal buffer information can be printed 
from a connected printer.

• Hard copy
Print the displayed screen.

• Printing logs
Print collected log data.

• Data sheet print
- Print data registered as a data sheet.

- Data registered as a data sheet is output to a storage device in PDF file format.

For details, refer to “16.2 Hard Copy” page 16-16.

For details, refer to “Log Printing” page 7-30.

For details, refer to “16.3 Printing Data Sheets” page 16-18.

copy PictBridge

Copy

PictBridge

No.1 No.2
1 08-20 13:25:40 300 80
2 08-20 14:05:13 250 40
3 08-24 16:59:54 360 290
4 08-24 17:01:05 340 75
5 08-24 17:01:05 310 120
6 08-24 17:01:05 310 115

A

B

C

D

E

F

PictBridge

A

B

C

D

E

F

SDPDF
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16.1.1 Compatible Printers
The following printers can be connected to the V10/V9 series.

*1 Depending on the model of the printer, the version may need to be updated. Use the latest version.
*2 Supported by V9 unit hardware versions “f” and later.

If a screen program that uses Hewlett-Packard HPLIP is transferred to a unit with a hardware version between “a” and “e”, 
error 315 occurs.

*3 If a screen program that uses Hewlett-Packard HPLIP is transferred to a unit with V9 unit operating system version lower 
than 3.90, error 314 occurs.
Update the V9 unit operating system.

List of compatible printers

Printable Items
The table below shows the items printable by each printer.

*1 A color or monochrome hard copy can be designated with the system device memory ($s1007).

Settings on the Editor Applicable Models
V10/V9 

Connection 
Port

V9 Unit Version *1

EPSON ESC/P-R EPSON printers that support “ESC/P-R” control codes
USB-A
LAN
LAN2
WLAN

Program Ver. 1.250 or later
OS Ver. 2.60 or later

HP HPLIP *2 Hewlett-Packard printers that support “HP Linux Imaging and 
Printing (HPLIP)” Ver. 3.18.6 or lower

Program Ver. 2.200 or later
OS Ver. 4.00 or later *3

OKI COREFIDO LED printer “B432dnw” by OKI Program Ver. 2.400 or later
OS Ver. 4.20 or later 

PictBridge PictBridge-compatible printers USB-B Supported by all versions
PR201 Monochrome PC-PR201 series models with which printing from MS-DOS is 

possible

MJ1
MJ2
USB-A

Program Ver. 1.060 or later
OS Ver. 1.40 or later

PR201 Color
ESC-P Monochrome MS-DOS-compatible printer models ESC/P24-J84, ESC/P-J84, 

and ESC/P SuperESC-P Color

CBM292 / 293 Citizen Systems
Line thermal printer

SK1-41/31/32/21/22/24 Sanei Electric
Thermal printer

Program Ver. 1.430 or later
OS Ver. 1.40 or later

MR - 400 Sato MR-400 series barcode printer Program Ver. 1.060 or later
OS Ver. 1.40 or later

*4 For a list of compatible printer models, visit our website (www.monitouch.com).

Printable Items
ESC/P-R
HP HPLIP

OKI COREFIDO
PictBridge PR201

ESC-P CBM292/293 SK1-41/31/
32/21/22/24 MR-400

Screen hard copy  *1  *1  *3

Printing logs

Data sheet print  *2

Data sheet print (expanded)

Printing using the “OUT_PR” macro 
command
Printing using the “MR_REG”/”MR_OUT” 
macro command

$s1007 Hard copy
0 Color (32-k colors)
1 Grayscale
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*2 Landscape printing on A4/15-inch paper is not supported.
Data is printed in portrait orientation regardless of the paper setting.

*3 When PR201 Color or ESC-P Color is selected, printing is performed using 16 colors.

A

Paper feed direction

A
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16.1.2 Printers that Support EPSON “ESC/P-R” and Hewlett-Packard 
“HPLIP”, and OKI “COREFIDO”

• EPSON printers that support “ESC/P-R” control codes can be connected to a V10/V9 series unit.
• Hewlett-Packard printers that support “HP Linux Imaging and Printing (HPLIP)” version 3.18.6 or lower can be connected 

to a V10/V9 series unit.
• The LED printer “B432dnw” by OKI can be connected to a V10/V9 series unit.

Connection
USB-A port connection

• Connect the USB-A port of the V10/V9 series unit to the USB port of the printer with a commercially available USB cable.

LAN connection (LAN/LAN2/WLAN)
• Connect the LAN/LAN2/WLAN port of the V10/V9 series unit to the LAN port of the printer via Ethernet.

Hardware Settings
Configure settings at [System Setting] → [Hardware Setting] → [Printer].
Printer model

For information on connectable models, visit our website at “www.monitouch.com”.

Item Description

Model
Select the printer to connect.

EPSON ESC/P-R
HP HPLIP
OKI COREFIDO

Target Port No.

Select the port to connect the printer.
USB-A

Connect a printer using a commercially available USB cable.

Network
Connect a printer via Ethernet. The printer is connected to all LAN ports (LAN/LAN2/WLAN).

USB-A USB-B
PrinterUSB cable

PrinterEthernet
LAN
LAN2
WLAN
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Printer properties

Item Description
Network printer IP address setting
(available with network connection only)

Set the method for specifying the IP address of the network printer.
Manual (fixed)

IP Address
(available with network connection only)

Set the IP address of the printer.

Printer Control Device
(Yes/None)

When using a device memory for printer control, printing of screen hard copies and 
data sheets can be performed by setting the bit from “0” to “1”.

Printer Info Output Device
(Yes/None)

When using a device memory for outputting printer information, the printer state is 
output to the specified address.

Always Output Status Bit
(Yes/None)

When the V10/V9 series receives a print command, “0 → 1” is output at the start of 
data transmission and “1 → 0” is output at the end of transmission. However, if the 
print data is minimal, the signal may not be output.
Set to “Yes” when bit output is required regardless of the data size.
The output area is shown below.

• Bit 1 of the device memory for outputting printer information
• Bit 0 of internal device memory $s16

Hard Copy

Orientation
(Horizontal, Vertical)

Select the orientation of the screenshot image printed on paper.
* This setting is disabled and horizontal output is performed for models whose 

resolution is SVGA (800 × 600 pixels) or higher.
• Hard copy example

Reversed Image
(Reversed, Normal)

Reversed: White and black are reversed for printing.
Normal: The screenshot image is printed out as displayed on MONITOUCH.

Color adjustment
(Yes/None)

Enabled when [Reversed] is selected.
Enabling color adjustment also adjusts colors other than black and white (dark → light, 
light → dark).
Enable color adjustment when using TTF fonts.

Data Sheet Data Sheet Setting Configure settings for data sheet printing. For details, refer to page 16-18.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

0 → 1: Data sheet output
0 →1: Screen hard copy

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

0: Not busy state
1: Busy state

0: End (standby)
1: Transferring data for printing

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB
$s16

0: End (standby)
1: Transferring data for printing

A A

Vertical Horizontal Vertical Horizontal

AA

For ESC/P-R and HPLIP For OKI COREFIDO
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Print Size
The print size varies depending on the item to be printed and the paper setting.

Screen hard copy
• The paper size is fixed to “A4”.
• The print start position and print size cannot be changed.

Printing logs
• Printing is fixed to “A4 vertical (portrait)”. If a line cannot be held within the paper width, the remaining section will be 

printed while wrapping around and going down to the next line.
• The print start position and print size cannot be changed.

Data sheet print
• Output is fixed to “A4”.
• Set the paper size from [Home] → [Registration Item] → [Data Sheet] → [Data Sheet Edit] → [Data Sheet Setting] → 

[Paper Size], or from [System Setting] → [Hardware Setting] → [Printer] → [Printer Properties] → [Data Sheet Setting] → 
[Paper Size]. If the specified paper size is larger than A4, the data sheet size will be reduced and printed to fit on the 
paper.

• The print start position and print size cannot be changed.

Data sheet print (expanded)
• The print size is A4 only. Use a printer that handles A4 paper. If A4 paper is fed in landscape orientation or a selected 

paper size is different from the paper size set for the printer, printing cannot be performed correctly. (Data outside the 
printing area is not printed.)

• The print start position and print size cannot be changed. Note that margins will vary slightly between different printer 
models.

• For parts placed on an expanded data sheet screen, the [Show/Hide] setting takes effect.
When a part should always be printed, select [Show] for the [Show/Hide] setting.

Status Output (Network Printer)
The status of the connection between the V10/V9 series unit and a network printer is output to the internal device memory 
$s1068.

* The error may be output as “−1” (printer error related to hardware) depending on the printer used.

Notes
• Color printing is performed.
• Error handling varies depending on the printer model. For details, refer to the instruction manual for the printer.

Value Description Cause and Remedy

0 The network printer is not connected or it is 
in the normal state. -

1 Printing is in progress. -
−1 Printer error (hardware related) Check if the printer is out of order.

−2 Printer error (paper related)
The printer ran out of paper. Add paper.
The type of paper is not correct. Set the correct type of paper.

−3 Printer error (ink related)*
The ink is not set. Install an ink cartridge.
The ink level is low. Install a new ink cartridge.

−4 Printer error (network related) A connection with the network printer cannot be established. Check the network 
connection settings of the V10/V9 series unit and the printer.
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16.1.3 PictBridge Printers
A PictBridge-compatible printer can be connected.

Connection
USB-B port connection
Connect the USB-B port of the V10/V9 series unit to the USB-A port of the printer with a commercially available USB cable.

* When transferring screen programs via the USB-B port, change the cable connection.

Hardware Settings
Configure the [System Setting] → [Hardware Setting] → [Printer] settings.

Printer model

For information on compatible models, visit our website (www.monitouch.com).

Item Description
Model PictBridge

Target Port No. USB-B (automatically set when “PictBridge” is selected for [Model])

PictBridge

USB-AUSB-miniB

Printer

USB cable
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Printer properties

Item Description
Printer Control Device
(Yes/None)

When using a device memory for printer control, printing of screen hard copies and 
data sheets can be performed by setting the bit from “0” to “1”.

Printer Info Output Device
(Yes/None)

When using a device memory for outputting printer information, the printer state is 
output to the specified address.

Always Output Status Bit
(Yes/None)

When the V10/V9 series receives a print command, “0 → 1” is output at the start of 
data transmission and “1 → 0” is output at the end of transmission. However, if the 
print data is minimal, the signal may not be output.
Set to “Yes” when bit output is required regardless of the data size.
The output area is shown below.

• Bit 1 of the device memory for outputting printer information
• Bit 0 of internal device memory $s16

Hard Copy

Orientation
(Horizontal, Vertical)

Select the orientation of the screenshot image printed on paper.
* This setting is disabled and horizontal output is performed for models whose 

resolution is SVGA (800 × 600 pixels) or higher.
• Hard copy example

Reversed Image
(Reversed, Normal)

Reversed: White and black are reversed for printing.
Normal: The screenshot image is printed out as displayed on MONITOUCH.

Color adjustment
(Yes/None)

Enabled when [Reversed] is selected.
Enabling color adjustment also adjusts colors other than black and white (dark → light, 
light → dark).
Enable color adjustment when using TTF fonts.

Data Sheet Data Sheet Setting Configure settings for data sheet printing. For details, refer to page 16-18.
Use PictBridge only on USB-B port
(Yes/None)

Select “Yes” when using the USB-B port to connect to a PictBridge printer during 
operation in RUN mode.
When transferring screen programs via the USB-B port, switch to Local mode.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

0 → 1: Data sheet output
0 →1: Screen hard copy

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

0: Not busy state
1: Busy state

0: End (standby)
1: Transferring data for printing

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB
$s16

0: End (standby)
1: Transferring data for printing

A A

HorizontalVertical
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Print Size
The print size varies depending on the item to be printed and the paper setting.

Screen hard copy
• The paper size is fixed to “A4”.
• The print start position and print size cannot be changed. 

Printing logs
• Printing is fixed to “A4 vertical (portrait)”. If a line cannot be held within the paper width, the remaining section will be 

printed while wrapping around and going down to the next line.
• The print start position and print size cannot be changed. 

Data sheet print
• Output is fixed to “A4”.
• Set the paper size from [Home] → [Registration Item] → [Data Sheet] → [Data Sheet Edit] → [Data Sheet Setting] → 

[Paper Size], or from [System Setting] → [Hardware Setting] → [Printer] → [Printer Properties] → [Data Sheet Setting] → 
[Paper Size]. If the specified paper size is larger than A4, the data sheet size will be reduced and printed to fit on the 
paper.

• The print start position and print size cannot be changed. 

Data sheet print (expanded)
• The print size is A4 only. Use a printer that handles A4 paper. If A4 paper is fed in landscape orientation or a selected 

paper size is different from the paper size set for the printer, printing cannot be performed correctly. (Data outside the 
printing area is not printed.)

• The print start position and print size cannot be changed. Note that margins will vary slightly between different printer 
models.

• For parts placed on an expanded data sheet screen, the [Show/Hide] setting takes effect. 
When a part should always be printed, select [Show] for the [Show/Hide] setting.

Status Output
The status of the connection between the V10/V9 series unit and a PictBridge printer is output to the internal device memory 
$s1066.

* The error may be output as “−1” (printer error related to hardware) depending on the printer used.

Notes
• Color printing is performed.
• Error handling varies depending on the printer model. For details, refer to the instruction manual for the printer.

Value Description Cause and Remedy

0 The PictBridge printer is not connected or 
it is in the normal state. -

1 Printing in process using the PictBridge 
printer.

-

-1 Printer error (hardware related)
The cable is not connected. Check the USB cable connection.
Check if the printer is out of order.

-2 Printer error (paper related)
The printer ran out of paper. Add paper.
Paper is not correct. Set correct paper.

-3
Printer error (ink related) *

The ink is not set. Install an ink cartridge.
-4 The ink level is low. Install a new ink cartridge.
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16.1.4 PR201 and ESC-P Printers
The V10/V9 series can connect to MS-DOS-compatible printers.

• MS-DOS-compatible printer models in the PR201 series
• MS-DOS-compatible printer models ESC/P24-J84, ESC/P-J84, and ESC/P Super

Connection Method
USB-A port connection

• Connect the USB-A port of the V10/V9 series unit to the parallel port of the printer with a USB-parallel conversion cable 
(commercially available).

Serial connection (MJ1 or MJ2)
• Connect the MJ port of the V10/V9 series unit with the serial port of the printer.

Hardware Settings
Configure the [System Setting] → [Hardware Setting] → [Printer] settings.

Printer model

For information on connectable models, visit our website at “www.monitouch.com”.

Item Description

Model

Select the control code of the target printer from the following options:
• PR201 Monochrome
• PR201 Color
• ESC-P Monochrome
• ESC-P Color

USB-A

Printer
USB to parallel conversion cable
UC-PGT (ELECOM)

MJ

Printer

Serial cable
Serial Port
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Printer properties

Target Port No.

Select the port where the printer cable is connected.
USB-A:

Select this option when connecting to a parallel interface printer with a USB-parallel conversion cable 
(commercially available).

MJ1/MJ2:
Select this option when connecting to a printer equipped with a serial interface.
Select either MJ1 or MJ2 on the V10/V9 series unit.

Item Description
Printer Control Device
(Yes/None)

When this setting is enabled and the bit is set to ON (0 → 1), screen images and data 
sheets can be printed out.

Printer Info Output Device
(Yes/None)

When using a device memory for outputting printer information, the printer state is 
output to the specified address.

Always Output Status Bit
(Yes/None)

The V10/V9 series outputs [0 → 1] when starting to transfer data upon receiving a print 
command, and outputs [1 → 0] upon finishing transfer. However, these signals may not 
be output if the print data is small.
Set to “Yes” when bit output is required regardless of the data size.
The output area is shown below.

• Bit 1 of the device memory for outputting printer information
• Bit 0 of internal device memory $s16

Item Description

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

0 → 1: Data sheet output
0 → 1: Screen image output

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

0: Not busy
1: Busy

0: End (standby)
1: Transferring print data

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB
$s16

0: End (standby)
1: Transferring print data
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* This setting is only available when MJ1 or MJ2 is selected for [Target Port No.].

Hard Copy

Orientation
(Horizontal, Vertical)

Select the orientation of the screen image printed on paper.
When [Vertical] is selected, the image for printing is rotated 90 degrees on the paper.

* This setting is disabled for edit models of SVGA (800 × 600 pixels) or higher.
• Hard copy example

Reversed Image
(Reversed, Normal)

Reversed: White and black are reversed for printing.
Normal: The exact state of the screen on the unit is printed.

Color adjustment
(Yes/None)

Enabled when [Reversed] is selected.
Enabling color adjustment also adjusts colors other than black and white (dark → light, 
light → dark).
Enable color adjustment when using TTF fonts.

Data Sheet Data Sheet Setting Configure settings for data sheet printing. For details, refer to page 16-18.

Serial Port *

Baud Rate Specify the baud rate.
4800 / 9600 / 19200 / 38400 / 57600 / 76800 / 115K BPS

Parity Set the parity.
None, Odd, Even

Data Length Set the number of bits for data.
7-Bit, 8-Bit

Stop Bit Set the number of stop bits.
1-Bit, 2-Bit

Item Description

A A

VerticalHorizontal
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16.1.5 CBM292/293 Printer
The V10/V9 series can connect to CBM line thermal printers (Citizen).

Connection Method
Serial connection (MJ1 or MJ2)

• Connect the MJ port of the V10/V9 series unit with the serial port of the printer.

Hardware Settings
Configure the [System Setting] → [Hardware Setting] → [Printer] settings.

Printer model

For information on connectable models, visit our website at “www.monitouch.com”.

Item Description
Model Select CBM292/293.

Target Port No.

Select the port where the printer cable is connected.
USB-A:

Select this option when connecting to a parallel interface printer with a USB-parallel conversion cable 
(commercially available).

MJ1/MJ2:
Select this option when connecting to a printer equipped with a serial interface.
Select either MJ1 or MJ2 on the V10/V9 series unit.

MJ

Printer

MJ-D25

Serial cable
Serial Port

CBM attached cable
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Printer properties

* This setting is only available when MJ1 or MJ2 is selected for [Target Port No.].

Item Description
Printer Control Device
(Yes/None)

When this setting is enabled and the bit is set to ON (0 → 1), screen images and data 
sheets can be printed out.

Printer Info Output Device
(Yes/None)

When using a device memory for outputting printer information, the printer state is 
output to the specified address.

Always Output Status Bit
(Yes/None)

The V10/V9 series outputs [0 → 1] when starting to transfer data upon receiving a print 
command, and outputs [1 → 0] upon finishing transfer. However, these signals may not 
be output if the print data is small.
Set to “Yes” when bit output is required regardless of the data size.
The output area is shown below.

• Bit 1 of the device memory for outputting printer information
• Bit 0 of internal device memory $s16

Data Sheet Data Sheet Setting Configure settings for data sheet printing. For details, refer to page 16-18.

Serial Port *

Baud Rate Specify the baud rate.
4800 / 9600 / 19200 / 38400 / 57600 / 76800 / 115K BPS

Parity Set the parity.
None, Odd, Even

Data Length Set the number of bits for data.
7-Bit, 8-Bit

Stop Bit Set the number of stop bits.
1-Bit, 2-Bit

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

0 → 1: Data sheet output
0 → 1: Screen image output

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

0: Not busy
1: Busy

0: End (standby)
1: Transferring print data

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB
$s16

0: End (standby)
1: Transferring print data
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16.1.6 Sato’s MR-400 Barcode Printer
The V10/V9 series can connect to Sato’s barcode printer for printing barcodes.

Read the instruction manual and command reference book for Sato’s MR-400 series barcode printer before 
using this function.

• For details on configuration and printing, refer to “16.4 Connecting to a Sato MR-400 Barcode 
Printer” page 16-29.

• For information on connectable models, visit our website at www.monitouch.com.
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16.2 Hard Copy
16.2.1 Overview

The displayed screen can be printed using the switch function or a command from the PLC.

16.2.2 Printing
Two methods are available for printing the currently displayed screen.

Command from a Switch
Output a hardcopy by tapping a switch placed on the screen. In this case, the switch image is also output.

Screen program setting
1) Place a switch set with “Hard Copy” for [Function] on the screen targeted for printing.
2) Transfer the screen data to the V10/V9 series unit.

Printing procedure
1) Display the screen to be printed.
2) Press the hard copy switch.
3) Printing starts.

* Printing can also be performed using a function switch with “Hard Copy” set for [Function].

copy PictBridge

Copy

PLC
D0005

PictBridge

Bit 1 of the device memory for printer control 
= Change “0” to “1” to print a hard copy of 
the screen

Press a switch which is set with “Hard Copy” 
for [Function].

copy PictBridge

copy
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Command from a Device Memory for Printer Control
Bit 1 of the device memory for printer control is the screen hard copy bit.
When this bit changes from “0” to “1”, a hard copy is printed.
Printing procedure

1) Display the screen to be printed.
2) Change bit 1 of the device memory for printer control from “0” to “1”.
3) Printing starts.

PLC
D0005

PictBridge

Bit 1 of the device memory for printer 
control = Change “0” to “1” to print a 
hard copy of the screen
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16.3 Printing Data Sheets
16.3.1 Overview

This section explains printing the data currently displayed on numerical data displays or character displays that are registered 
on a data sheet.
This print function also enables real-time printing of device memory data that is not shown on the V10/V9 series.

Data can also be output in PDF file format to a storage device.

Expanded functions
The expanded data sheet functions are available with a PictBridge-compatible printer, EPSON printer that supports “ESC/P-R”, 
a Hewlett-Packard printer that supports “HPLIP”, or an OKI “COREFIDO” printer.
The expanded functions allow the use of additional parts, such as lamps and graphs, and changing of the part sizes. In 
addition, the expanded functions allow for part placement regardless of the grid, thereby diversifying layouts on data sheet 
screens. These data sheets can be printed in color.

PictBridge

A

B

C

D

E

FPLC
Print

The V10/V9 series can print out data sheets 
showing the current PLC data.
Setting the bit for “data sheets” prints the 
respective data sheets.

The printed data sheets show the PLC data 
of when printing was initiated.

Printer
Setting the bit for “output data sheets” to ON...

SD

PDF

A

B

C

D

E

F

Storage device

PictBridge

Print

A        350    42.9%
B        209    25.5%
C        156    19.1%
D        100    12.2%

815

A B C D<

Current Production Statistics

Total

Numerical data display

Statistic pie graph

Data sheet screen No. 3

PictBridge
ESC/P-R
HP HPLIP
OKI COREFIDOSet bit 0 (for data sheet 

output) of the printer control 
device memory to ON.

One sheet of data sheet screen No. 3 
is printed out.

D100 = 3
D101 = 1

Data sheet screen No. 4

Trend graph

Trend
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Memo pad information created on the screen can be imported to the expanded data sheet and then output. By saving as a 
PDF, it is possible to create a file with an electronic signature.

Data sheet screen
The print screen is formatted in “Data Sheet” in the V10/V9 series screen program file.
Items usable on data sheets vary depending on whether the expanded functions are used.

*1 Notes on using trend graphs (real-time display)
- When the data sheet is printed with the number of points to display set to “0” in the control device memory, the graph is not displayed. 

Only the background is output.
- The [Overlap] and [Use the background operation function] checkboxes in the [Detail] settings cannot be selected.
- Trend data is read when printing is executed. Therefore, the printed trend graph may not be the same as that displayed on the screen.

*2 Notes on using the memo pad function
- The data of the memo pad page number stored at $s106 is imported.
- The dimensions of the memo pad data cannot be reduced. The data is imported in the dimensions that it was created on the screen.

For details on the memo pad function, refer to “13.1 Memo Pad”.

Item Without Expanded Functions
With Expanded Functions

(Only for EPSON “ESC/P-R”, Hewlett-Packard “HPLIP”, 
OKI “COREFIDO”, and PictBridge)

Graphics

Straight line
Rectangle
Text

Line/continuous line
Box/circle
Text/multi text
Pixel
Paint
Scaling
Pattern

Parts

Numerical data display
Character display

Lamp
Numerical data display
Character display
Message display
Bar graph
Pie graph
Panel meter
Statistic bar graph
Statistic pie graph
Time display/calendar
Trend graph (real-time display) *1
Memo pad *2

For details on editing data sheets, refer to the Operation Manual.

name

1
2
3
4
5
6
7

100
200
300

40
50

600
770

aaaa
bbbb
cccc
dddd
eeee
gggg
hhhh

SD

PDF

name

123
123
123
123
123
123
123

1234
1234
1234
1234
1234
1234
1234

ABCD
ABCD
ABCD
ABCD
ABCD
ABCD
ABCD

memo

Daily report Daily report

Expanded data sheet

Memo pad

PDF

Line A

Line B

Line C

Line D

Line E

Line F

A        350    42.9%
B        209    25.5%
C        156    19.1%
D        100    12.2%

815

Line or box

Data display
(Numerical data)

Data display
(Characters)

Text

• With the expanded functions• Without the expanded functions

Statistic pie graph
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16.3.2 Detailed Settings
Data Sheet Setting
Configure these settings via [System Setting] → [Hardware Setting] → [Printer] → [Printer Properties] → [Data Sheet Setting] 
or [Home] → [Registration Item] → [Data Sheet] → [Data Sheet Edit] → [Data Sheet Setting].

Use extension data sheet: unselected

Item Description
Print Data Sheet No. Setting Device Use this device memory when printing data sheets using a device memory for printer control (refer 

to page 16-24). Two words are used.

Paper Size
(A4 Portrait, A4 Landscape, 15-Inch 
Landscape, User Designation)

Select a paper size. According to the size selected, the numbers of characters and lines are set.
Printed images are always in portrait orientation.

* Only A4 portrait and A4 landscape are supported when outputting a PDF to a storage device.
Characters (16 to 152) Specify the number of characters per line on a data sheet page.
No. of Lines (2 to 152) Specify the number of lines per data sheet page.
Use Character Graphic Print Select this checkbox to change the set number of lines.

The numbers of characters and lines are automatically set as shown below.

* This setting is valid only for Japanese printers. (ESC/P-R and PictBridge are not supported)
* All characters and lines on the data sheet screen are handled as text. Consequently, the printed 

data sheet looks slightly different from the one on the editor screen.
Use PDF Output Function *1 Select this checkbox to output data sheets to the LIST folder of a storage device in PDF format.

The PDF output destination, filename, etc. should vary depending on the following settings.
Overwrite/Add *2 Select a PDF output method. If specified file does not exist, a new file will be created.

Overwrite: overwriting
Add: Append to the last page and after then save (File size up to 50MB)

n Print start data sheet number (→ V)
n+1 Number of pages to be printed (→ V)

Paper Size No. of 
Characters

No. of Lines
Character Graphics

Not used
Character Graphics

Used
A4 Portrait 80 66 108

A4 Landscape 114 40 64
15-Inch Landscape 136 64 64
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*1 When the storage capacity becomes less than 100MB, it operates according to the setting of [Delete from the oldest when the remaining 

storage space is less than 100Mbyte.] in [System Setting] → [Unit Setting] → [General Settings].
*2 If both [Command Device] and its equivalent settings by [Data Sheet Setting] are made, [Command Device] takes precedence. To specify 

a sub-folder name, you need to both check the [Designate sub-folder name] option of [Data Sheet Setting] and set a sub-folder name.

Command Device *2 Checking this option allows changes in output destination and method of the data sheet printing 
during RUN mode.

* When using the “STA_LIST” macro, select these conditions at $s1656. The settings are the same 
as the command device.

File Designation
(Maximum of 64 
one-byte alphanumeric 
characters)

Specify a filename.
Selecting a device memory address allows the output filename to be changed when the unit is in 
RUN mode.
32 consecutive words are used from the specified address.

* This is only available for the internal device memory of the V10/V9 series.
* Top page number is available only for the “overwrite” mode.
Example: With time stamp

- When specifying a filename
Filename: (filename)XXXX_YYYYMMDDHHMMSS

- When not specifying a filename or when the device memory contains “null”
Filename: LISTXXXX_YYYYMMDDHHMMSS

Append timestamp to 
filename

Select this checkbox to add a timestamp to a PDF filename. 
Filename:

• With timestamp
- Any file name xxxx_YYYYMMDDHHMMSS.pdf
- LISTxxxx_YYYYMMDDHHMMSS.pdf

• Without timestamp
- Any file name xxxx.pdf
- LISTxxxx.pdf

Designate the sub-folder 
name *2

Select this checkbox to specify a location for the PDF file.
When the device is selected, the sub-folder name can be changed during RUN mode.
32 consecutive words are occupied, starting with the specified device.

* This is only available for the internal device memory of the V10/V9 series.

Storage Location:
• Sub-folder Name unspecified 

/Access folder/LIST/Year and month folder/Year-month-date folder
• Sub-folder Name specified

/Access folder/LIST/Any folder

PDF Output Drive
(None, SD, USB)

Select the output target drive for the PDF file.
* If “None” is specified, the PDF file is output to [Storage Connection Target] in the [Storage 

Setting].

Item Description

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0

0: Printer
1: Storage device (PDF output)

0: With time stamp
1: Without time stamp

0: Use default sub-folder
1: Designate sub-folder name

0: Overwrite
1: Add

Year, month, day, hour, minute, 
second of output
Top page number

Year, month, day, hour, minute, 
second of output
Top page number

LIST

EXT0000SD

201904
20190413

ABCD

xxxxxx.pdf

xxxxxx.pdf

xxxxxx.pdf

← Year-month-date folder
← PDF files

← PDF files

← When the sub-folder name is blank:

← Year-month folder

← Any folder
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Use extension data sheet: selected

Item Description
Print Data Sheet No. Setting Device Use this device memory when printing data sheets using commands from a device memory for 

printer control (refer to page 16-24).
Two words are used.

Paper Size
(A4 Portrait, A4 Landscape)

Select the orientation of the data sheet screen. (Paper size: A4 fixed)

Use PDF Output Function *1 Select this checkbox to output data sheets to the LIST folder of a storage device in PDF format.
The PDF output destination, filename, etc. should vary depending on the following settings.

Overwrite/Add *2 Select a PDF output method. If specified file does not exist, a new file will be created.
Overwrite: overwriting
Add: Append to the last page and after then save (File size up to 50MB)

Command Device *2 Checking this option allows changes in output destination and method of the data sheet printing 
during RUN mode.

* When using the “STA_LIST” macro, select these conditions at $s1656. The settings are the same 
as the command device.

n Print start data sheet number (→ V)
n+1 Number of pages to be printed (→ V)

Paper Size
(Graphic area: height × width) Orientation

A4 Portrait (912 × 640 pixels) Vertical
A4 Landscape (640 × 912 pixels) Horizontal

A4 portrait A4 landscape

A A

Example: Print on A4 paper fed in portrait orientation

Data sheet 
screen

Data sheet screen 
rotated 90 degrees

Paper feed 
direction

Paper feed 
direction

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0

0: Printer
1: Storage device (PDF output)

0: With time stamp
1: Without time stamp

0: Use default sub-folder
1: Designate sub-folder name

0: Overwrite
1: Add
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*1 When the storage capacity becomes less than 100MB, it operates according to the setting of [Delete from the oldest when the remaining 
storage space is less than 100Mbyte.] in [System Setting] → [Unit Setting] → [General Settings].

*2 If both [Command Device] and its equivalent settings by [Data Sheet Setting] are made, [Command Device] takes precedence. To specify 
a sub-folder name, you need to both check the [Designate sub-folder name] option of [Data Sheet Setting] and set a sub-folder name.

File Designation
(Maximum of 64 
one-byte alphanumeric 
characters)

Specify a filename.
Selecting a device memory address allows the output filename to be changed when the unit is in 
RUN mode.
32 consecutive words are used from the specified address.

* This is only available for the internal device memory of the V10/V9 series.
* Top page number is available only for the “overwrite” mode.
Example: With time stamp

- When specifying a filename
Filename: (filename)XXXX_YYYYMMDDHHMMSS

- When not specifying a filename or when the device memory contains “null”
Filename: LISTXXXX_YYYYMMDDHHMMSS

Append timestamp to 
filename

Select this checkbox to add a timestamp to a PDF filename. 
Filename:

• With timestamp
- Any file name xxxx_YYYYMMDDHHMMSS.pdf
- LISTxxxx_YYYYMMDDHHMMSS.pdf

• Without timestamp
- Any file name xxxx.pdf
- LISTxxxx.pdf

Designate the 
sub-folder name *2

Select this checkbox to specify a location for the PDF file.
When the device is selected, the sub-folder name can be changed during RUN mode.
32 consecutive words are occupied, starting with the specified device.

* This is only available for the internal device memory of the V10/V9 series.

Storage Location:
• Sub-folder Name unspecified 

/Access folder/LIST/Year and month folder/Year-month-date folder
• Sub-folder Name specified

/Access folder/LIST/Any folder

PDF Output Drive
(None, SD, USB)

Select the output target drive for the PDF file.
* If “None” is specified, the PDF file is output to [Storage Connection Target] in the [Storage 

Setting].

Item Description

Year, month, day, hour, minute, 
second of output
Top page number

Year, month, day, hour, minute, 
second of output
Top page number

LIST

EXT0000SD

201904
20190413

ABCD

xxxxxx.pdf

xxxxxx.pdf

xxxxxx.pdf

← Year-month-date folder
← PDF files

← PDF files

← When the sub-folder name is blank:

← Year-month folder

← Any folder
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16.3.3 Printing
There are two methods for printing configured data sheets from the V10/V9 series unit.

• Command from a printer control device
• Command with macro

Command from a Device Memory for Printer Control
Bit 0 of the device memory for printer control is the data sheet output bit.
When this bit changes from “0” to “1”, a data sheet is printed.

Screen program setting
• [System Setting]→[Hardware Setting]→[Printer Properties]→[Printer Control Device]

• [Home]→[Registration Item]→[Data Sheet]→[Data Sheet Setting]→[Print Data Sheet No. Setting Device]

Printing procedure
1) Set the data sheet number that is the top page to [Print Data Sheet No. Setting Device] “n”.
2) Specify the number of output pages for [Print Data Sheet No. Setting Device] “n + 1”.

* When [Print Data Sheet No. Setting Device] “n + 1” is “0”, the printer will not print any data sheets.
3) Change bit 0 of the device memory for printer control from “0” to “1”.
4) Data sheet printing starts.

PictBridge

PLC
Line A

Line B

Line C

Line D

Line E

Data Sheet No. 3

D0010
D0011

D0009
3
1

D0005

Usage Example
[Printer Control Device] = D0005
[Designation Device for Print Data Sheet No.] = D0010

1)  2)

3)

D010: Top page setting device memory = “3”
D011: Number of data sheets to output = “1” specified

Change bit 0 of the device memory 
for printer control (for data sheet 
output) from “0” to “1”.

4)
One page of data sheet No. 3 is printed.
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Command with Macro
Use the “STA_LIST” macro command to print data sheets.

SYS(STA_LIST) F1
Device memory used

: Setting enabled (indirect designation disabled)  : Setting enabled (indirect designation enabled)
Range

* No printing is executed when “0” is set as the number of pages to be printed. When the range specified for 
printing includes an unregistered number, the page corresponding to the number will not be printed.

Printing procedure
1) Set $s1656=0.

2) Set the data sheet number which is to be the top page to the device memory “F1 + 0”.
3) Set the number of output pages to the device memory “F1+1”.
4) Execute the “STA_LIST” macro command.
5) Data sheet printing starts.

Internal Device Memory PLC1 to PLC8 Device Memory Constant
F1

Value Remarks
F0 STA_LIST
F1 Print start data sheet number

F1 + 1 Number of pages to be printed: 1 to 1,024 *

F1 + 2 to F1 + 33 Unused
$s1656-00=OFF (fixed)

F1 + 34 to F1 + 65 Unused

For details on $s1656, refer to   System Devices page 16-28 

PictBridge

Line A

Line B

Line C

Line D

Line E

Data Sheet No. 3

Print example:
To print data sheet No. 3 with F1 = $u100:

1) $s1656 = 0 (W)  Output target: printer
2) $u100 = 3 (W)    Print start data sheet number
3) $u101 = 1 (W)    Number of pages to be printed
4) SYS (STA_LIST)   $u100  Macro execution

5) One page from data sheet No. 3 
is printed.
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16.3.4 PDF Output
There are two ways to output registered data sheet screen.

• Command from a printer control device
• Command with macro

Command from a printer control device
Bit 0 of [Printer Control Device] is the output bit. The document is output in PDF with the rising edge [0→1].

Setting Procedure
• [System Setting] → [Hardware Setting] → [Printer] → [Printer Properties] → [Printer Control Device]

• [Home] → [Registration Item] → [Data Sheet] → [Data Sheet Edit]
- Print Data Sheet No. Setting Device
- Use PDF Output Function

PDF output procedure
1) Set the data sheet number that is the top page to [Print Data Sheet No. Setting Device] “n”.
2) Specify the number of output pages for [Print Data Sheet No. Setting Device] “n+1”.

* When [Print Data Sheet No. Setting Device] “n+1” is “0”, data sheets will not be generated.
3) Change bit 0 of [Printer Control Device] from “0” to “1”.
4) Data sheets are output in PDF.

* Set the other settings for PDF output 
according to your operation.

Line A

Line B

Line C

Line D

Line E

Data Sheet No. 3

SD

PDF

PLC

D0010
D0011

D0009
3
1

D0005

Usage Example:
[Printer Control Device] = D0005
[Designation Device for Print Data Sheet No.] = D0010

1) D010: Top page setting device memory = “3”
2) D011: Number of data sheets to output = “1” specified

4) One page of data sheet No. 3 is 
output in PDF.

3) Change bit 0 of [Printer Control 
Device] from “0” to “1”.



16.3    Printing Data Sheets

16-27

1

2

3

4

5

16

7

8

9

10

Command with Macro
Use the “STA_LIST” macro command to output data sheets in PDF format. Printer connection settings are not required when 
outputting in PDF format using a macro command.

SYS(STA_LIST) F1
Device memory used

: Setting enabled (indirect designation disabled)  : Setting enabled (indirect designation enabled)
Range

* No printing is executed when “0” is set as the number of pages to be printed. When the range specified for 
printing includes an unregistered number, the page corresponding to the number will not be printed.

PDF output procedure
1) Set $s1656 = 1.

2) Set the data sheet number which is to be the top page to the device memory “F1 + 0”.
3) Set the number of output pages to the device memory “F1+1”.
4) To give the PDF file an arbitrary file name, set the file name to “F1+2” through “F1+33”.
5) Execute the “STA_LIST” macro command.
6) Data sheet is output to a storage in PDF.

Quality of Text for PDF Output of Expanded Data Sheet
Text can be printed clearly by selecting the [System Setting] → [Unit Setting] → [General Setting] → [Make text rendering for 
printing extended data sheet PDF clear] checkbox.
Applicable parts

Numerical data display, character display, message display, trend graph, text, and multi-text

Notes
• This function is enabled only when TrueType font is selected on the [System Setting] → [Multi-language Setting] → [Font 

Setting] window 
Windows fonts are not supported.

• [Rotation + Direction], [Bold], [Italic], and [Spacing] settings are invalid.
• Characters are output to the foreground. Even if characters are placed behind other parts, they will be output on top of 

such parts in the PDF file.

Internal Device Memory PLC1 to PLC8 Device Memory Constant
F1

Value Remarks
F0 STA_LIST
F1 Print start data sheet number

F1 + 1 Number of pages to be printed: 1 to 1,024 *

F1 + 2 to F1 + 33 ASCII code: Output filename (maximum of 64 one-byte alphanumeric
characters)

Only available when $s1656-00 = ON 
(PDF output)

F1 + 34 to F1 + 65 ASCII code: Output sub-folder name (maximum of 64 one-byte 
alphanumeric
characters)

Only available when $s1656-00 = ON 
(PDF output) and $s1656-02 = ON 
(Designate sub-folder name)

For details on $s1656, refer to   System Devices page 16-28 

Line A

Line B

Line C

Line D

Line E

Data Sheet No. 3

SD

PDF

Operation example:
To output data sheet No. 3 in PDF with F1 = $u100:

1) $s1656 = 1 (W) Selected output target: PDF
2) $u100 = 3 (W) Print start data sheet number
3) $u101 = 1 (W) Number of pages to be printed
4) $u102 = TEST (STRING) Filename
5) SYS (STA_LIST) $u100 Macro execution

6) One page of data sheet No. 3 is 
output as a PDF file.
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16.3.5 System Devices
System devices related to the data sheet printing are as follows.

16.3.6 Notes
• When no data sheet screen has been registered, data sheets cannot be printed even if they are specified by number.

Print example:
[Printer Control Device] = D0005
[Print Data Sheet No. Setting Device] = D0010

• When abnormal termination occurs due to external factors such as turning off the V10/V9 or removing storage during 
PDF output:
- While writing a new file:

The corrupted file may remain in storage.
- While overwriting the file:

Files cannot be recovered, and the damaged file may remain in the storage.
- While appending the file: 

Unable to recover the file.
• When the storage capacity for PDF output is insufficient, the V10/V9 follows the setting of [System Settings] → [Unit 

Setting] → [General Setting].
- Delete folders from the oldest if Storage is lacking in space for backup
- Delete folders from the oldest when the remaining storage space is less than 100MByte.

Address Description Remarks

$s1655

Data sheet: PDF output error information
0: Normal termination
1: Out of storage capacity
2: File size error (the PDF file will exceed 50MB after appending data)
3: Other errors

← V

$s1656

Macro command [STA_ LIST] is executed according to this setting.

→ V

$s1807
Line spacing setting for data sheet printing (serial connection only)

0: 1/6 inches (default)
1: 1/8 inches (minimum)

Same as line spacing setting “0” of “OUT_PR” macro command
→ V

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0

0: Printer
1: Storage device (PDF output)

0: With time stamp
1: Without time stamp

0: Use default sub-folder
1: Designate sub-folder name

0: Overwrite
1: Add

 For details on General Setting, refer to   General Settings page 1-14 

A Line

B Line

C Line

D Line

E Line

F Line

G Line

H Line

I Line

J Line

A Line

B Line

C Line

D Line

E Line

F Line

G Line

H Line

I Line

J Line

A Line

B Line

C Line

D Line

E Line

F Line

G Line

H Line

I Line

J Line

A Line

B Line

C Line

D Line

E Line

F Line

G Line

H Line

I Line

J Line

PLC

A Line

B Line

C Line

D Line

E Line

F Line

G Line

H Line

I Line

J Line

Data Sheet No. 14
A Line

B Line

C Line

D Line

E Line

F Line

G Line

H Line

I Line

J Line

Data Sheet No. 12
A Line

B Line

C Line

D Line

E Line

F Line

G Line

H Line

I Line

J Line

Data Sheet No. 11
A Line

B Line

C Line

D Line

E Line

F Line

G Line

H Line

I Line

J Line

Data Sheet No. 10

Data Sheet No. 10 No. 11 No. 12 No. 13 No. 14

Data Sheet No. 14

Data Sheet No. 10

No. 12
No. 11

If data sheet pages are registered as 
shown on the left

D0010 (top page number of data sheet for printing) = 10
D0011 (number of pages of data sheet to output) = 5

Change bit 0 (data sheet output) of D0005 from “0” to “1”.

Data sheet No. 10 to 12 and 14 are printed.
The page that is not stored, No. 13, is ignored, and 
four pages are output.



16.4    Connecting to a Sato MR-400 Barcode Printer

16-29

1

2

3

4

5

16

7

8

9

10

16.4 Connecting to a Sato MR-400 Barcode Printer
The V10/V9 series can connect to Sato’s barcode printer for printing barcodes.

16.4.1 Connection Method
Serial connection (MJ1 or MJ2)

• Connect the MJ port of the V10/V9 series unit with the serial port of the printer.

Hardware Settings
Configure the [System Setting] → [Hardware Setting] → [Printer] settings.

Printer model

Read the instruction manual and command reference book for Sato’s MR-400 series barcode printer before 
using this function.

For information on connectable models, visit our website at “www.monitouch.com”.

Item Description
Model Select MR-400.

Target Port No. MJ1/MJ2
Select either MJ1 or MJ2 on the V10/V9 series unit.

MJ

MONITOUCH

Printer
Serial cable Serial Port
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Printer properties

16.4.2 Notes on Memory Cards
Memory Cards
To use this function, a memory card is required for the MR-400.
For the memory card type and mounting procedure, refer to the instruction manual for the MR-400 series.

Item Description
Print Info Output Device
(Yes/None)

When using a device memory for outputting printer information, the printer state is 
output to the specified address.

Always Output Status Bit
(Yes/None)

The V10/V9 series outputs [0 → 1] when starting to transfer data upon receiving a print 
command, and outputs [1 → 0] upon finishing transfer. However, these signals may not 
be output if the print data is small.
Set to “Yes” when bit output is required regardless of the data size.
The output area is shown below.

• Bit 1 of the device memory for outputting printer information
• Bit 0 of internal device memory $s16

MR400
MR400 Print 
Designation Device

This setting can be configured when MR400 is selected for the printer model.
Set the device memory used to issue printing commands to the MR400. For details, 
refer to “Print Command Device” page 16-40.

Format Table Register the printing format. For details, refer to “16.4.3 Format Tables” page 16-31.

Serial Port

Baud Rate Specify the baud rate.
4800 / 9600 / 19200 / 38400 / 57600 / 76800 / 115K BPS

Parity Set the parity.
None, Odd, Even

Data Length Set the number of bits for data.
7-Bit, 8-Bit

Stop Bit Set the number of stop bits.
1-Bit, 2-Bit

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

0: Not busy
1: Busy

0: End (standby)
1: Transferring print data

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB
$s16

0: End (standby)
1: Transferring print data



16.4    Connecting to a Sato MR-400 Barcode Printer

16-31

1

2

3

4

5

16

7

8

9

10

Card Slot Number Setting and Memory Card Formatting
To enable the use of memory cards, set the memory card slot number and format the memory card on the MR-400.

* “Memory card formatting” means the same as media initialization for USB flash drives etc.

1) Turn off the power to the MR-400 and insert a memory card into the card slot on the rear of the MR-400.
2) Hold down the LINE key on the front of MR-400, and turn the power ON.

“USER MODE” is displayed on the front panel.
3) Press the LINE key and FEED key at the same time.

“ADVANCED MODE” is displayed.
4) Press the LINE key and FEED key at the same time again.

“CARD MODE” is displayed.
5) Press the FEED key until “CARD DRIVE NO /  1  2” is displayed.

Set the memory card slot number.
(Press the LINE key to select, and press the FEED key to accept.)
This drive number is the memory card slot number.

6) Press the FEED key to accept the options. Select “YES” for “CARD FORMAT/YES   NO” and format the memory card.
If no error is given, formatting has completed successfully.

7) To quit “CARD MODE,” turn the printer off.

• Formatting is required if the screen program is transferred after editing the MR-400 format table (registration setting) 
described in the following section.
In addition to the above formatting procedure, it is possible to format the memory card by outputting the control 
command of MR-400 from the V10/V9 series. For details, refer to   Example 1: When the following commands are set in 
No. 22:   (page 16-39).

• When printing two-byte characters, select “JIS” for “Kanji Code” on MR-400.

16.4.3 Format Tables
Format Table Types
There are two types of format tables.
When the MR-400 commands are registered in this table, desired formats or data can be printed.

MR-400 format table (registration setting)
Set the print format.

* The “format” used in the format table includes settings for digits, position, typeface, barcode, etc. for the 
MR-400.

Write these settings on the memory card using the MR_REG macro command.
Once they are written on the memory card, it is not necessary to repeat this step until the registration setting is changed.

MR-400 format table (call setting)
Use the format (registration setting), and change the print data. Set the storage target, type, etc. of the changed data.

Print the data using the MR_OUT macro command.

1 2 3 4 5
1 2 3 4 5 6

0123456789012

ABCDEFGHI

Field No. 1
Field No. 2

Field No. 3

Field No. 1
Field No. 2
Field No. 3

6 6 6 6 66 6 6 6 6

4953103125773

MONITOUCH
5 5 5 5 55 5 5 5 5
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Format Table (Registration Setting)
Configure the [System Setting] → [Hardware Setting] → [Printer] → [Format Table (Registration Setting)] settings.
Format table settings (registration settings) range from No. 1 to No. 128.

Item Description
OK The format table setting is ended.
Cancel Format table editing is canceled.
Copy The currently open format table is copied into the specified table.
Jump The specified format table is opened.
Back The previous format table number is opened.
Next The following format table is opened.
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Setting example
To print in the following format:

• Description of escape sequence

• Description of the format table

1 2 3 4 5
1 2 3 4 5 6

Field No. 1
Field No. 2

Field No. 3

<A>

<CC> 2

<YS>, 1 0

</N>, 1, 1 0

<V> 1 0 <H> 5 0

<B> 2 0 2 0 8 0 1 2 3 4 5 6 7 8 9 0

</N>, 2, 5

<V>1 0 0 <H> 5 0 <L> 0 2 0 2 <P> 2 

<X22>, 1 2 3 4 5

</N>, 3, 6

<V> 1 5 0 <H> 3 0 0 <L> 0 1 0 1 <P> 2

<X2 2>, 1 2 3 4 5 6

<Z>

<Data send start>

<Card slot> Slot number

<Format register>, Format register number
Match this number to the 
registration setting number.

<Field register>, field number, print digits

<Vertical print position> dots <Horizontal print position> dots

<Barcode> Bar code type, bar width enlargement, bar top/bottom size (dots), data

<X22 characters>, data

<Data send end>

Data registered for 
field No. 1

Data registered for 
field No. 2

Data registered for 
field No. 3

Match these
numbers.
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Notes on inputting

The escape character (ESC) at the top of the escape sequence is expressed as “<>” on MR-400 and as “1B(H)” in 
hexadecimal notation.
In the format table, “\” denotes hexadecimal data.
Consequently, “1B(H)” is shown as “\1B”.

To use “\” as a character, enter “\\”.

MR400 Format Table (Call Setting)
Configure format table settings (call setting) at [System Setting] → [Unit Setting] → [MR400 Format Table] → [Call Setting]. 
Numbers 1 to 128 can be set in the format table.

*1 Field numbers 1 to 99 are used.
Settings for numbers 100 to 512 are invalid.

Setting example (1)
Printing “ABCDE” as a fixed string in field No. 1

Item Description
Memory Card Slot
(No. 1 / No. 2)

Select the card slot drive number set on the MR-400.

Device Select the checkbox when field data is stored in device memory.
OK The format table setting is ended.
Cancel Format table editing is canceled.
Copy The currently open format table is copied into the specified table.
Jump The specified format table is opened.
Back The previous format table number is opened.
Next The following format table is opened.

<X22>, 12345 Escape sequence

1BX22, 12345 Escape sequence
(HEX display)

\1BX22, 12345 Format table

Format table 
number

Field number *1



16.4    Connecting to a Sato MR-400 Barcode Printer

16-35

1

2

3

4

5

16

7

8

9

10

Setting example (2)
Printing data stored in a device memory in field No. 2

Select the [Device] checkbox of field No. 2.
Press the [Detail] button to display the [Detail] window.

• Select [Text] for [Type].

Item Description
Device Specify the top device memory address where data for printing is stored.
No. of Bytes The specified number of bytes is output in order from the device memory address specified for 

[Device].
* To print “ABCDEF” in one-byte characters, specify as shown below in the Shift JIS code.

Text Process LSB → MSB/MSB → LSB
Set the order of the first and second bytes within one word.

Add Start and End Codes Configure this setting when using “CODE 39” type barcodes. (Refer to page 16-37.)

D100 4241 [H]
D101 4443 [H]
D102 4645 [H]
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• Select [Numerical Data] for [Type].

Item Description
Device Print data in the specified device memory address in numerical form.

* When [Numerical Data] is selected, binary data is converted into characters (JIS code).
Example: When “0100 (BIN)” is set for D100, the characters 0100 (= “100”) are printed.

Digits Specify the number of digits for the display type.
Decimal Point Specify the number of decimal places.
Display Type Select from DEC-, HEX, OCT, DEC or BIN.

When [DEC-] is selected, data is shown in decimal notation with a ± sign.
Zero Suppress Select whether or not to use the zero suppress function.

When the [Zero Suppress] checkbox is selected, any suppressed zeros are filled with spaces.
Data Length Set the data length for the device memory.
Text Select one-byte or two-byte characters.
Add Start and End Codes Configure this setting when using “CODE 39” type barcodes. (Refer to page 16-37.)
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Barcode Type “CODE 39”
CODE 39 has “*” at the beginning and the end of each barcode.
When the format table is created, set “*” in the following two positions

• [MR-400 Format Table (Registration Setting)] settings
Set the number of digits including “*” for format registration.
For the following case for example, set “12” (10 characters + 2).

• [MR-400 Format Table (Call Setting)] settings
• Select [Text] for [Type].

Item Description
No. of Bytes Specify the number of bytes including “*”.
Add Start and End Codes Selected: “*” is not included in the data of [Device].

Unselected: “*” is included in the data of [Device].
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• Select [Numerical Data] for [Type].

Item Description
Add Start and End Codes Selected: “*” is not included in the data of [Device].

Unselected: “*” is included in the data of [Device].
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16.4.4 Printing
Macros
The “MR_REG” macro command is available to write the setting data from format tables (registration setting or call setting) to 
the MR-400. The “MR_OUT” macro command is available to print out the data.

MR_REG
Device memory used

: Setting enabled (indirect designation disabled)  : Setting enabled (indirect designation enabled)

Range

• Example 1: When the following commands are set in No. 22:

When the “MR_REG 22” macro command is executed, the memory card is formatted.

• Example 2: When the following commands are set in No. 1:

Execute the “MR_REG 1” macro command as the ON macro of a switch.
First: The format is registered on the memory card of the MR-400.
Second: The registered data is printed and the format can be checked.

MR_OUT
Device memory used

: Setting enabled (indirect designation disabled)  : Setting enabled (indirect designation enabled)
Range

• Example 1: When the “MR_OUT 50” macro command is executed:
Data of the MR-400 format table (call setting No. 50) is printed.

Internal Device Memory PLC1 to PLC8 Device Memory Memory Card Constant
F1

Value
F0 Format table registration setting numbers 1 to 128

Internal Device Memory PLC1 to PLC8 Device Memory Memory Card Constant
F1

Value
F0 Format table call setting numbers 1 to 128
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Print Command Device
Printing can be executed using an external command.

Item Description
n Control device memory

n+1 Format table No. designation device
Set the number of the format table (call setting) to be printed.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

0: Standby
1: Printing

* This is automatically reset when printing has been completed.
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17.1 Overview
The V10/V9 series reads barcode data, converts the necessary data into ASCII code, and stores the result in the specified PLC 
device memory address. This allows various types of information to be transferred immediately using a barcode reader.
Also, the V10/V9 series can show the read barcode data on the screen.

• The V10/V9 series does not perform “handshake” processing with the barcode reader. (The barcode reader is not 
synchronized with the V10/V9 series.)

• A barcode reader is connectable to either modular jack (MJ1 or MJ2), CN1, or the USB-A port of the V10/V9 series.
• Use a barcode reader which is compliant with USB-HID.
• A 2D barcode reader can be connected for data read/write operations.
• The V10/V9 series recognizes a barcode reader connection as a type of 8-way communication.

This means that the setting procedure is the same as that for 8-way communication.

For setting examples, refer to page 17-2.

For details on compatible barcode readers, refer to the following.
• Out website at: monitouch.fujielectric.com/img/en/pdf/barcode_list_e.pdf

Note on serial connection
The cable for connecting the barcode reader to the V10/V9 series differs depending on the type of barcode 
reader. Users should prepare an appropriate conversion cable if necessary.

4902580302447

PI ! PLC
4902580302474

4902580302474
Code No. :

The V10/V9 series reads barcode data and transfers it to the PLC.

Barcode reader

For details on wiring, refer to “17.4 Wiring” page 17-7.
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17.2 Setting Examples
The following describes the procedure for reading “CODE 39” barcode data using a barcode reader and transferring the data 
as ACSII codes to PLC device memory D1001.

I/F Device: D1000

1. Click [System Setting] → [Hardware Setting] to display the [Hardware Setting] window.
2. Double-click an empty position between [PLC2] and [PLC8] and select “Barcode” for [Connected Device] and set [Target 

Port No.].

3. Set the parameters of the barcode reader in the [Barcode Properties] window.
Set [I/F Device] to D1000.

4. Place a character display to display the read barcode data and set the PLC device memory to D1001.

This completes the necessary settings.

For details, refer to “Detailed Settings” page 17-3.

4902580302447

PI ! PLC
4902580302474

4902580302474
Code No. :

The V10/V9 series reads barcode data and transfers it to the PLC.

Barcode reader

D1001

D1000: Flag/amount of data read
D1001: Barcode data
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17.3 Detailed Settings
Location of settings: [System Setting] → [Hardware Setting] → “Barcode”

Item Description
Type Specify the type of barcode reader.

JAN (UPC, EAN)/ITF (Interleaved 2 of 5)/CODABAR (NW-7)/CODE39/CODE128/ANY (2D barcode)
Baud Rate
(serial connection)

Set the transmission speed.4800/9600/19200 BPS

Data Length
(serial connection)

Set the number of bits for data. 7-Bit, 8-Bit

Stop Bit
(serial connection)

Set the number of stop bits. 1-Bit, 2-Bit

Parity
(serial connection)

Set the parity. None, Odd, Even

Terminator
(serial connection)

Set the terminator.STX/ETX/CR/LF/CR

Check Digit Set the check digit. None, Do Not Delete, Delete
I/F Device This device memory stores the barcode data and the number of read bytes. Specify the top device memory 

address.
For details, refer to page 17-4.

Designate the Read Bytes 
Count

Specify the maximum number of bytes to be read. Always specify an even number of bytes.
For details, refer to page 17-5.

Use Control Device Control reading operations of the barcode reader.
When the 0th bit is set to “1” (permitted), store data using the I/F device memory.

Use Start/End Code
(Type: CODE 39)

Set whether or not to add a start and end code of “*” to the barcode data.
Yes: Add an “*” code.
None: Do not add an “*” code.

Storage Order Set the order in which barcode data is stored in the I/F device memory.
For details, refer to page 17-6.

Priority Set the order of precedence among PLC2 to PLC8.

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Read permission bit
0: Prohibited
1: Permitted

Not used (always set to “0”)
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I/F Device
I/F device memory allocation is shown below.

Type: JAN/ITF/CODABAR/CODE39/CODE128

Type: ANY

Flag details

Device Memory Description
n Flag / amount of data read

* All unused bits are reset to “0”.
n + 1 - n + m Data read (ASCII)

* “0” (null code) is attached to the end of the data

Device Memory Description
n Flag

* All unused bits are reset to “0”.
n + 1 Amount of data read: 0 to 2,048 bytes

n + 2 - n + m Data read (ASCII)
* “0” (null code) is attached to the end of the data

Flag Description
Communication error
(bit 14)

When an error occurs in communication between the barcode reader and the V10/V9 series, bit 14 changes 
to “1”.
Check that the barcode reader settings match the connected barcode reader and whether wiring has been 
performed correctly.

Reading complete
(bit 12)

When data from the barcode reader is received and written to the I/F device memory, bit 12 (reading 
complete) changes to “1”.
Check that the bit is set to “1” and prepare for reading subsequent data.
To read the next barcode data, reset the bit to “0” when the data has been read.

Amount of data read The number of bytes read by the barcode reader is stored.

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
0 0 0 0

0 to 256 bytes: Amount of data read1: Reading complete
1: Communication error

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
0 0 0 0 0 0 0 0 0 0 0 0 0 0

1: Reading complete
1: Communication error

Not used (always set to “0”)
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Read Bytes Setting
The number bytes to be read depends on the setting for [Type] and [Read Bytes Setting].

Operation example
• Type: CODE39
• I/F Device: D1000
• Read Bytes Setting: Selected
• No. of Bytes: 10 bytes
• Text Processing: LSB → MSB

- When data of “4902580302474” that exceeds 10 bytes is read:

- When data of “12345” that is less than 10 bytes is read:

Type Read Bytes Setting Number of Bytes Used
JAN
ITF

CORDERBAR
CODE39

CODE128

None Variable for codes to be read, maximum of 254 bytes

Selected
Fixed to the set number of words, 2 to 254 bytes

ANY
None Variable for codes to be read, maximum of 2046 bytes

Selected Fixed to the set number of words, 2 to 2046 bytes

4902580302

D1001

I/F Device Value
D1000 Flag

Amount of data read
D1001 3934HEX (94)
D1002 3230HEX (20)
D1003 3835HEX (85)
D1004 3330HEX (30)
D1005 3230HEX (20)
D1006 Not used

10 bytes of data is stored and 
the remainder is deleted.

I/F Device Value
D1000 Flag

Amount of data read
D1001 3231HEX (21)
D1002 3433HEX (43)
D1003 0035HEX (5)
D1004 0000HEX
D1005 0000HEX
D1006 Not used

12345

D1001

“0” is stored as the HEX value 
in device memory addresses 
when there is no 
corresponding data.
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Storage Order
Data is read in the following manner according to the [Storage Order] setting.

Operation example
• Type: CODE39
• I/F Device: D1000
• Barcode data: 4902580302474 (13 digits)

Storage Order Description
LSB → MSB Data is read in the order of LSB → MSB

MSB → LSB Data is read in the order of MSB → LSB

MSB LSB
2nd byte 1st byte

115

LSB MSB
1st byte 2nd byte

115

4902580302447

PI ! PLC
4902580302474

4902580302474
Code No. :

Barcode reader
Data is stored in D1000 
to D1007

I/F Device Value (Description)
D1000 100DHEX

(reading complete, 13 bytes)
D1001 3439HEX (49)
D1002 3032HEX (02)
D1003 3538HEX (58)
D1004 3033HEX (03)
D1005 3032HEX (02)
D1006 3437HEX (47)
D1007 3400HEX (40)

I/F Device Value (Description)
D1000 100DHEX

(reading complete, 13 bytes)
D1001 3934HEX (94)
D1002 3230HEX (20)
D1003 3835HEX (85)
D1004 3330HEX (30)
D1005 3230HEX (20)
D1006 3734HEX (74)
D1007 0034HEX (04)

• Storage Order: LSB → MSB • Storage Order: MSB → LSB
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17.4 Wiring
17.4.1 USB Connection

Barcode readers connect to the USB-A port of the V10/V9 series unit.
Connect the barcode reader using the USB cable provided with the barcode reader.

17.4.2 Serial Connection
Use CN1 or a modular jack (MJ1/MJ2) to connect the barcode reader to the V10/V9 series unit.

Connector: CN1

Modular jack: MJ1, MJ2

* When using Hakko Electronics’ cable (model: V6-BCD)
- Length: 3 m
- With modular plug

• For barcode readers with CS/RS control, it may be necessary to install a jumper between CS and RS to 
maintain proper operation.

• For details on the +5 V external power supply of MJ1/MJ2, refer to the Hardware Specifications Manual.

RD

SG

RS

CS

SD

No.Name NameDsub 9 (Male)

2

3

5

7

8

RD

SD

SG

RS

CS

FG

CN1

59

16

* Use shielded twisted pair wiring

RD

SG

RS

+5V

CS

SD

NameName No.RJ - 45

7

8

5

RD

SD

SG

4+5V

FG

MJ1/2

12345678

* Use shielded twisted pair wiring

12
34

56
78

Brown: + 5 V
Red: 0 V
Orange: RD
Yellow: SD
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17.5 Notes
• When connecting multiple USB devices to the V10/V9 series, refer to the Hardware Specifications Manual for precautions 

when using a USB hub.
• Since the USB barcode reader operates as a keyboard with a USB connection, it is necessary to switch the keyboard in the 

Local mode screen → [Language Settings] → [Keyboard].
Please set the language according to the specification of your USB barcode reader.

Default: English
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